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Microsemi makes no warranty, representation, or guarantee regarding the information contained
herein or the suitability of its products and services for any particular purpose, nor does
Microsemi assume any liability whatsoever arising out of the application or use of any product or
circuit. The products sold hereunder and any other products sold by Microsemi have been
subject to limited testing and should not be used in conjunction with mission-critical equipment
or applications. Any performance specifications are believed to be reliable but are not verified,
and Buyer must conduct and complete all performance and other testing of the products, alone
and together with, or installed in, any end-products. Buyer shall not rely on any data and
performance specifications or parameters provided by Microsemi. It is the Buyer's responsibility
to independently determine suitability of any products and to test and verify the same. The
information provided by Microsemi hereunder is provided “as is, where is” and with all faults,
and the entire risk associated with such information is entirely with the Buyer. Microsemi does
not grant, explicitly or implicitly, to any party any patent rights, licenses, or any other IP rights,
whether with regard to such information itself or anything described by such information.
Information provided in this document is proprietary to Microsemi, and Microsemi reserves the
right to make any changes to the information in this document or to any products and services
at any time without notice.

About Microsemi

Microsemi Corporation (NASDAQ: MSCC) offers a comprehensive portfolio of semiconductor
and system solutions for aerospace & defense, communications, data center and industrial
markets. Products include high-performance and radiation-hardened analog mixed-signal
integrated circuits, FPGAs, SoCs and ASICs; power management products; timing and
synchronization devices and precise time solutions, setting the world's standard for time; voice
processing devices; RF solutions; discrete components; enterprise storage and communication
solutions; security technologies and scalable anti-tamper products; Ethernet solutions; Power-
over-Ethernet ICs and midspans; as well as custom design capabilities and services. Microsemi
is headquartered in Aliso Viejo, California, and has approximately 4,800 employees globally.
Learn more at www.microsemi.com.
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Libero SoC Introduction

. gl
Libefo®

System-on-Chip

Welcome to Microsemis Liberos SoC v12.2

Microsemi Libero® System-on-Chip (SoC) design suite offers high productivity with its comprehensive, easy to
learn, easy to adopt development tools for designing with Microsemi’s power efficient flash FPGAs, SoC FPGAs,
and Rad-Tolerant FPGAs. The suite integrates industry standard Synopsys Synplify Pro® synthesis and Mentor
Graphics ModelSim® simulation with best-in-class constraints management, debug capabilities, and secure
production programming support.

More Information

To access datasheets and silicon user guides, visit www.microsemi.com, select the relevant product family and
click the Documentation tab. Tutorials, Application Notes, Development Kits & Boards are listed in the Design
Resources tab.

Click the following links for additional information:

e Libero SoC- Learn more about Libero SoC including Release Notes, a complete list of devices/packages,
and timing and power versions supported in this release.

e Programming — Learn more about Programming Solutions

e Power Calculators — Find XLS-based estimators for device families

e Licensing — Learn more about Libero licensing

Licensing and Additional Resources

Microsemi License Utility

The Microsemi License Utility enables you to check and update your license settings for the Libero SoC software.
It displays your current license settings, the license host-id for the current host, and allows you to add a new
license file to your settings.

To start the Microsemi License Utility, run it from Start > All Programs > Microsemi Libero SoC vx.xx>
Microsemi License Utility.

To request a license, click Request License to go to the Microsemi license website. You can select and copy
(right-click, Copy) the disk volume value displayed in the window and paste the value into the Microsemi license
web form.

The following licenses are available:
e 1-year Platinum - Purchased license that supports all devices
e 1-year Gold - Purchased licenses that supports a smaller set of devices than Platinum
e 1-year Silver - Free license that supports a smaller set of devices than Gold
e 30-day Evaluation - Free license that supports all devices but programming is disabled



https://www.microsemi.com/products/fpga-soc/fpgas
https://www.microsemi.com/products/fpga-soc/soc-fpgas
https://www.microsemi.com/products/fpga-soc/rad-tolerant-fpgas
https://www.microsemi.com/products/fpga-soc/design-resources/design-software/synplify-pro-me
https://www.microsemi.com/products/fpga-soc/design-resources/design-software/modelsim
https://www.microsemi.com/products/fpga-soc/fpga-and-soc
https://www.microsemi.com/products/fpga-soc/design-resources/dev-kits-boards
https://www.microsemi.com/products/fpga-soc/design-resources/design-software/libero-soc
https://www.microsemi.com/products/fpga-soc/design-resources/programming-debug
https://www.microsemi.com/products/fpga-soc/design-resources/power-calculator
https://www.microsemi.com/products/fpga-soc/design-resources/licensing

& Microsemi

a A3\ MicrRocHIP company

PolarFire FPGA Design Flow User Guide

When you have received your license file, follow the instructions and save the license to your local disk. In the
Microsemi License Utility window, click Add License File and browse/select the license file from your disk. If you
are using a floating license, click Add License Server and enter the Port Number and Name of the license server
host.

The list of features for which you are licensed will show all versions, but your license must have a version equal to
or greater than your design tools release version in order for the libero.exe and designer.exe tools to run.

The list at the lower right shows the order in which the license files are read, with the first file read at the top of the
list.

Click Write Report File to view and/or print the Microsemi Tools Licenses Report, or to save it as a TXT file.

o Microsemi License Utility == &
By write Report File...
|\c'a|id License Feat|Version erm |Expiration Quantity Host HostID |Souroe |Comment
Platinum (ACTEL_¢[99.99 Permanent none 200 users sage ald3c11847ab 1702@sage
4 [ [ - 3
Host name: 5Js0c0120 [lf Add License File.. ] I+ Add License Server...
Disk volume: 7053a3e4
Netwark card(s)™: a0d3c11847ab |sequence for searching license sources
1702
4 Reguest License (web) @sage
1717 @sage
= Multiple network cards may be listed; use 1800 @sage
only one network card identifier when
requesting a license.,

Figure 1 - Microsemi License Utility

The Microsemi Libero SoC License Information Web Page provides additional licensing-related information
including links to troubleshooting and FAQ documents.

License Selection
This topic describes the Select License and License Details dialog boxes.

Select License Dialog Box

The Select License dialog box appears when there is more than one license available and a default license has
not been selected. Available licenses are displayed in list format, and you can select the feature license you want
to use.
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Actions
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= Selact License =] % |
r T I r T T T T
| Festureline | License Mame |  License Type Cruantity Avsibble | Expination Heot | Comements
| 1 !-‘-L TEL_SUMBAIT  PlatnumnStand... Node locked Une curted Uncounted M-dec-2015 o< st W Good to use
=
|_1J'.‘-CTEL_\' STA | Gold Fleating 2 F 14-feb- 2020 HYD-DK-130370. @ Good to use
r
] | Canorl

Figure 2 - Select License Dialog Box

If a license will expire within 15 days, you will see a warning in the Comments field of the dialog box and also in
the Log window, as shown in the examples below.

Chssrneity Loaistia  covamanty,

1\ Licanas il evpirt on [14] durys. Plaasa contact datributon oo Msioochup sales taam 10 senw Seanse

. 20 MDD WP Geod b wae

.LI s | cmes

Figure 3 - Select License Dialog Box with License Expiration Warning Message
Log
(B)messages @ Errors i wWamings @ Info

&

Please contact Libero Support team for more details.

Info: Current
Reading cbjects
Reading objects

T T T e

repository cache\maddfitalog\cache.xml
l\repository_cache\www.§gClore\cache.xml

T T T

\AppData\Roaming\A
A2

C:\Users\seetharam.

-
i\
2 Wl ) oo e o e i Ll

Figure 4 - Log Window with License Expiration Warning Message

Click Select to use the selected license to invoke Libero. This button is disabled by default, and is enabled once a
License is selected.

Click Cancel to close the license selection window and exit Libero.
Click Help to open the online help topic for License Selection.

Check the Set Selected License as Default check box to save the selected license as the default license to be
used for future sessions.

Selecting this option skips the license selection step for future sessions. This option can be used if you want to
use the same license features for future sessions.

License Types

The License Type column indicates whether an available license is a Node Locked license or a Floating or
Server-based license.

The total number of licenses and number of available licenses are shown in the Quantity and Available columns,
respectively.

Floating or Server-based Licenses can be used by multiple users, depending on the number of seats available.
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< Select License =X
Feature Ling Ligense Name Licende Type I Craantity I Avadable I Expiration ! Host l Comments ]
1| ACTEL_SUMMAT  Platinuen/Stand... Node locked Uncounted Uncounted Vledec- 2019 locaihont V' Geodtouse
2|ACTELVSTA | Gold Floating 2 b 14-feb-2020 HYD-DK-30370.. | B Good to use
I Set Sele wrm ey Do
Help | Celect I Cancel I

If there are no valid licenses available, the following message appears:

< libero =0 X

@ There is no valid Libero license available. Please verify the available licenses.

oK

If a selected license has been acquired by another user, you will be notified with the following message:

[~ Sebect License |=]o] % |
Festure Line | License Mame | licenseType |  Quantity |  Avalsble | Expiraion | Host | Comments |
1 [ACTEL_SUMMIT | PlatinumyStand.. | Mode locked L] Ut cuanted 11-dec-2019 ko it V Goedto use
2 ACTELMSTA | Gold Floating 2 2 4-feb- 2020 HYD-DI-B0INL. | W Goodto use

k License has beon squired by other user. Plesse select another License.
i

=]

License Details Dialog Box

The License Details dialog box has two tabs:

e Tools
e |P Cores
Tools

The Tools tab displays tool license details.

IP Cores
The IP Cores tab displays IP Cores license details, as shown in the following example.




& Microsemi

a RS\ MicrocHIP company

PolarFire FPGA Design Flow User Guide

l License type: Flsatng

Core Name _| License Hame [ capacay| Epiration Dete ﬁ Most name: HYD-OK-130370.mcho-main. com
1 |coresaap APODIRECTCORECORESMIP F 14-4eb-2020 Lockap path:
Z COREAPBLSRAM :Mmcrcontcmm 2 :u-m-m :mfm.mu-m.cm
3 |coreaon APUDRECTCORECOREQOR 2 14-4eb-2020 :iﬂmiﬁiiﬁﬁﬁziﬁiﬁ
4 [CORESOR AN APUDRECTCORICORESORAY 2 1edeb-200
s— CORERFO IMCICOR!CWEO .2 .'ll—lcb-m
6 [contrssa | APUDRECTCORECORE1588 2 afeb-2020
7 [comtpantor  wpvomecTcomecoRTEOMITOP 2 1ateb-2020
s |conears | APUDRECTCORECOREAMS 2 ateb-2020 | -]

| _ome |

Figure 5 - IP Cores License Details
Actions

Click Close to close the current dialog box.

Click Help to open the online help topic for License Selection.

Click Filter to search for the pattern specified in the text edit box. Filtered rows will be shown in the Cores table.
Lookup Path: Shows the list of License hosts included in the LM_LICENSE_FILE.

Additional License Information

Set Default License After Libero Invocation
This Libero Help menu option sets/updates the default Libero license and allows it to be used for future sessions.
To set the default license after Libero invocation, click Select Default License, as shown below.

| Help

@ Help Topics
Reference Manuals

| &% Microsemi Technical Support
|C’- Microsemi SoC
& Release Notes
Check For Software Updates

Select Default License...

License Options...

About Libero

The Select License dialog box appears, as shown in the example below.
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< Sebect icense [
FestureLine | License Name | License Type Quantity | Avelsble | [Expustion | Heat | Comments |
|[.‘.C TEL_SUMMIT | PlatswurnStand... | Flosting 2 2 1 1-may-2019 HYD-DE-08TE. W Goodto e
2 |ACTEL WISTA Gotd Floating l 2 12-feb-2000 HYD-DK-303T0.. @ Goodtouse
Help Carcel

Actions

Click Set Default License to set the default Libero license. You can also double-click the license row to set the
default license. This button is enabled if you select any row in the list of licenses.

Click Cancel to close the default license selection window without performing any action.
Click Help to open the online help document for License Selection.

Set License Options in Libero Preferences Dialog Box
To set license options in the Libero Preferences dialog box, click Project > Preferences.
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@

Software update
Log window
Startup I Reset default license selection (This will be effective for future sessions only. )

License Options

Interne‘g Access ¥ Warn we when my Libero license is about to expire. !
Text editor |

IP Cores

Design Flow
License Options
Proxy

| Help OK | Cancel

Figure 6 - License Options in Libero Preferences Dialog Box

Reset Default License Selection: This check box is enabled only when there is a default license available.
When this check box is checked, the default license will be cleared and the check box will be disabled.

“Warn we when my Libero license is about to expire”: This check box enables/disables Notification of License
expiry. If the selected license expiry date is within 15 days, a popup message appears.

This option can be used only when the expiry date is more than 5 days and less than 15 days.

General Information about Microsemi's FPGA & SoC products is available here.

Information About PolarFire Technology

More information about PolarFire Technology is available here.

Information About Supported Families

Table 1 - Product Families and Derivatives

Device Family Description
Family Derivatives
PolarFire N/A New FPGA family that delivers the lowest power at mid-range densities,
and is optimized for cost while providing high end features.
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Information About Libero SoC PolarFire Software
More information about Libero SoC PolarFire Software is available here.

Application Notes and Tutorials
Application Notes and Tutorials for PolarFire can be found here on the Documentation tab of the PolarFire
Technology page.

Online Help - Libero SoC

This online help system is designed to open in the HTML Help Viewer — Microsoft's Help window for viewing
compiled HTML Help. If you do not have the HTML Help Viewer components installed on your system, you can
view it with Microsoft's Internet Explorer browser (use version 4.x or later for complete functionality).

Viewing HTML Files on Linux

You may need to set your LINUX_HTMLREADER variable such that it enables a HTML viewer. For example:
setenv LINUX HTMLREADER /usr/bin/firefox
If you do not set this variable then some HTML files, such as the help, will not be available from within software.

See Also

Navigation tabs
User's Guides

Using Navigation tabs

Libero SoC online Help, which is generated using Microsoft HTML Help, includes the following navigation tabs:

Contents
The Contents tab displays books and pages that represent the categories of information in the online Help
system. When you click a closed book, it opens to display its content (sub-books and pages). When you click an
open book, it closes. When you click pages, you select topics to view in the right-hand pane of the HTML Help
viewer.

Search

The Search tab enables you to search for words in the Help system and locate topics containing those words.
Full-text searching looks through every word in the online Help to find matches. When the search is completed, a
list of topics is displayed so you can select a specific topic to view.

Reading User Guides

Libero SoC includes online manuals. The online manuals are in PDF format and available from Libero SoC Start
Menu. Note that PDF files are for printing and viewing offline; use the online help to view user support on your
workstation.

From the Start menu, choose All Programs > Microsemi > Libero SoC > Libero SoC Reference Manuals
You must have Adobe Acrobat Reader or similar PDF viewer to open and view the PDF user guides.

Viewing PDF Files on Linux
You may need to set your LINUX_PDFREADER variable such that it enables a PDF viewer. For example:

11
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setenv LINUX PDFREADER /usr/bin/kpdf

If you do not set this variable then some PDF files, such as the SmartTime User's Guide, will not be available from
within software.

Microsemi SoC Products Group Headquarters

Microsemi Corporation is a supplier of innovative programmable logic solutions, including field-programmable
gate arrays (FPGAs) based on antifuse and flash technologies, high-performance intellectual property (IP) cores,
software development tools, and design services targeted for the high-speed communications, application-specific
integrated circuit (ASIC) replacement, and radiation-tolerant markets.

Address: Microsemi SoC Products Group
3870 North First Street
San Jose, CA 95134

Phone: 408-643-6000

Contact Information
For the most up-to-date contact information, check the Microsemi Home Page.
Contact information for FPGAs & SoCs can be found at the FPGAs and SoCs Support Page
If you do not have internet access, the following information was accurate at the time of publication:

e Technical Support
e Web: https://soc.microsemi.com/mycases
e Phone (NA): 800.262.1060
e Phone (Int'l): +1 650.313.4460
e Email: soc_tech@microsemi.com

e Customer (non-technical) Support

e Phone: +1 650.318.2470

e Email: customer.service@microsemi.com
e Sales Support

e For pricing, order status and lead time information for all Microsemi SoC products, contact your
Microsemi Sales Representative

e Technical Support for RH and RT FPGAs that are regulated by International Traffic in Arms Regulations
(ITAR)

e Phone (NA): 888.988.ITAR
e Phone (Int'l): +1 650.318.4900
e Email: soc_tech_itar@microsemi.com

12
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Libero SoC PolarFire Design Flow
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{
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Handoff for Debugging

Handoff for Production
Security Options

Figure 7 - Libero SoC Design Flow

Create Design
Create your design with any or all of the following design capture tools:
e Create SmartDesign
e Create HDL
o Create SmartDesign Testbench (optional, for simulation only)
e Create HDL Testbench (optional, for simulation only)

13
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Once the design is created, you can invoke simulation for pre-synthesis verification.

It is also possible to click the o button, to execute the Libero SoC software through Place and Route with
default settings. However, this bypasses constraint management.

Constraints

Implement

Manage Constraints

In the FPGA design world, constraint files are as important as design source files. Constraint files are
used throughout the FPGA design process to guide FPGA tools to achieve the timing and power
requirements of the design. For the synthesis step, SDC timing constraints set the performance goals
whereas non-timing FDC constraints guide the synthesis tool for optimization. For the Place-and-
Route step, SDC timing constraints guide the tool to achieve the timing requirements whereas
Physical Design Constraints (PDC) guide the tool for optimized placement and routing (Floorplanning).
For Static Timing Analysis, SDC timing constraints set the timing requirements and design-specific
timing exceptions for static timing analysis.

Libero SoC provides the Constraint Manager as the cockpit to manage your design constraint needs.
This is a single centralized graphical interface for you to create, import, link, check, delete, edit design
constraints and associate the constraint files to design tools in the Libero SoC environment. The
Constraint Manager allows you to manage constraints for SynplifyPro synthesis, Libero SoC Place-
and- Route and the SmartTime Timing Analysis throughout the design process.

Invocation of Constraint Manager From the Design Flow Window

After project creation, double-click Manage Constraints in the Design Flow window to open the
Constraint Manager.

| Reports @ X | my_usersde @ X | Constraint Manager &8 X | mddr_top_sb_CCC_0 FCCC.sde @ X | s

1/0 Attributes \/ Timing \/ Floor Planner \/ Netlist Attributes hd — Constraints Tab

[ New ] [ Import ] [ Link ] [Ed\twnh Constraint Editor V] [ Check v] [Derlve Ccnstramts] [Constramtl:overaga v] [ Help ] + '

y~ Synthesis Place and Route  Timing Verification —

constraint! top_derived_constraints.sdc

constraint\my.sdc &l &l B

cn:tramt\my_usar.sdc ] ] O
Constraints
File Order

File and Tool Association
Figure 8 - Constraint Manager
See Also

e Constraint Manager

e New Project Wizard to import/link design constraints when creating new projects

Open Netlist Viewer (User Guide)

Synthesize - Double-click Synthesize to run synthesis on your design with the default settings. The
constraints associated with Synthesis in the Constraint Manager are passed to Synplify.

Verify Post-Synthesis Implementation (Simulate)

14
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e Place and Route - Place and Route takes the design constraints from the Constraint Manager and

runs with default settings. This is the last step in the push-button o design flow execution.

o Verify Post Layout Implementation

o Verify Timing - Right click and select Configure Options to specify a timing report with your

& Microsemi

desired conditions.
e Open SmartTime
e Verify Power
e Open SSN Analyzer

Configure Hardware

e Programming Connectivity and Interface - Organizes your programmer(s) and devices.
e Configure Programmer - Opens your programmer settings; use if you wish to program using

settings other than default.
e Select Programmer

a A3\ MicrRocHIP company

o Device I/O States During Programming - Sets your device I/O states during programming; use if your

design requires that you change the default I/O states.

Program Design

e Generate FPGA Array Data
e Configure Design and Memory Initialization

o Configure I/0 States During JTAG Programming

e Configure Programming Options

e Configure Security Wizard
¢ Configure Permanent Locks (OTP)

¢ Generate Bitstream
¢ Run PROGRAM Action
e Program SPI Flash Image

Debug Design

¢ SmartDebug (User Guide)
¢ |dentify Debug Design

Handoff Design for Production

e Export Bitstream

e Export SPI Flash Image

e Export FlashPro Express Job
e Export Job Manager Data

e Export Pin Report

e Export BSDL
e Export IBIS Model

Handoff Design for Debugging (Export SmartDebug Data)
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Constraint Flow and Design Sources

The Constraint Flow supports HDL and Netlist design sources. The Libero SoC Design Flow window and the
Constraint Manager are context-sensitive to the type of design sources: HDL or Netlist.

Constraint Flow for HDL designs

When the design source is HDL, the Design Flow window displays Synthesis as a design step. The Constraint
Manager also makes available Synthesis as a target to receive timing constraints and netlist attribute constraints.
The options to promote or demote global resources of the chip are set in the Synthesis options.

Constraint Flow for EDIF designs

When the design source is a Netlist, the Design Flow window displays Compile Netlist as a design step. Timing
constraints can be passed to Place and Route and Timing Verification only.

The options to promote or demote global resources of the chip are setin the Compile Netlist options.
The HDL flow versus the Netlist Flow is compared and contrasted below.

HDL Flow Netlist Flow
Design Flow Design Flow
Top Module(root): top Top Module(root): top
Active Synthesis Implementation: synthesis Active Synthesis Implementation: synthesis
Tool Tool
B- B Create Design - » Create Design
- b Constraints #- » Constraints
El # Implement Design E- » Implement Design
:E Open Metlist Viewer P % Open Metlist Viewer
5 Synthesize i [El- » Verify Post-Synthesized Design
- B Verify Post-Synthesized Desig .+l Generate Simulation File
- +L] Generate Simulation File - B Simulate
- BB Simulate By Compile Netlist
: % Place and Route Pt % Place and Route
#- # Verify Post Layout Implemen [#- ® Verify Post Layout Implementad
E- P Configure Hardware +- b Configure Hardware
- » Program Design +- # Program Design
- » Debug Design +H- b Debug Design
- b Handoff Design for Production +- # Handoff Design for Production
B- P Handoff Design for Debugging +- #  Handoff Design for Debugging
Design Flow Window Design Flow Window

Constraint Manager & X | {7 1/0 Attributes VTIHIIHU ‘" Floor Planner |/ Netlist Attribuy

£ T/0 Atributes ) Tming '\ Fioor Planner '\ Netist Atiributes \

New Impaort Link Edit with Consi
Mew | Impest | Link Edit with Canglraint E]
Place an|
Synthes constraint/user.sdc o
| constraintiusersde [ Target | ¥l constraint/my2 sdc o
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HDL Flow

Netlist Flow

Constraint Manager

Constraint Manager

Constrant Manager & % |

10 Atrbates % Timing |/ Foor Mlanner /" Netlst Attributes

Pd=we | Import | LLink: Edit vaith Corstraint Eq
| Symithesy
constraint\usersdc | Target | [#]

Constraint Manager - Check *.fdc and *.ndc

[ 1/0 Attributes \[ Timing \/ Floor Planner /" Netlist 4

Mew h| Import | Lirk Check
Check

constraint/my nde o

Constraint Manager - Check *.ndc only
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HDL Flow Netlist Flow
W] Synthesize Options % | | 5 Compile Netlist Options
Global Nets
Minimum number of dock pins: 2 Global Promation
Minimum number of asynchronous pins: 800
Minimum fanout of non-dock nets to be kept on globals: 5000
Mumber of global resources:
Number of global resources: 24

Maximum number of global nets that could be demoted to row-globals: |16

Maximum number of global nets that could be demoted to row-glob
Minimum fanout of global nets that could be demoted to row-globals: | 1000

Optimizations

Minimum fanout of global nets that could be demoted to row-global
[™ Enable retiming

[™ Enable automatic compile paint
Minimum fanout of non-dodk nets to be kept on globals:

RAM optimized for: (+ High speed (" Low power
Map seq-shift register components to: (" Registers (v RAMG4x12
Map ROM companents to: * Logic " RAM

Additional options for SynplifyPro synthesis

o

Seript file:

Global Promotion/Demotion Options set in

Compile Netlist Options Dialog Box

Additional options:

Help Cancel

Global Promotion/Demotion Options set in

Synthesis Options Dialog Box

Figure 9 - HDL vs. Netlist Flow

File Types in Libero SoC

When you create a new project in Libero SoC it automatically creates new directories and project files. Your
project directory contains all of your local project files. When you import files from outside your current project, the
files are copied into your local project folder.

The Project Manager enables you to manage your files as you import them. If you want to store and maintain your
design source files and design constraint files in a central location outside the Project location, Libero gives you
the option to link them to your Libero project folders when you first create your project. These linked files are not
copied but rather linked to your project folder.
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Depending on your project preferences and the version of Libero SoC you installed, the software creates
directories for your project.

The top level directory (<project_name>) contains your *.prjx file; only one *.prjx file is enabled for each Libero
SoC project. If you associate Libero SoC as the default program with the *.prjx file (Project > Preferences >
Startup > Check the default file association (.prjx) at startup), you can double-click the *.prjx file to open the
project with Libero SoC.

component directory - Stores your SmartDesign components (SDB and CXF files) and the *_manifest.txt file for
each design components in your Libero SoC project. Refer to the *_manifest.txt file if you want to run synthesis,
simulation, and firmware development with your own point tools outside the Libero SoC environment. For each
design component, Libero SoC generates a <component_name>_manifest.txt file which stores the file name and
location of:

o HDL source files to be used for synthesis and simulations
e Stimulus files and configuration files for simulation

e Firmware files for software IDE tools

o Configuration files for programming

e Configuration files for power analysis.

constraint directory - All your constraint files (SDC timing constraint files, floorplanning PDC files, I/O PDC files,
Netlist Attributes NDC files)

designer directory - *_ba.sdf, *_ba.v(hd), STP, PRB (for Silicon Explorer), TCL (used to run designer),
impl.prj_des (local project file relative to revision), designer.log (logfile)

hdl directory - all hdl sources. *.vhd if VHDL, *.v.and *.h if Verilog

simulation directory - meminit.dat, modelsim.ini filesfiles and *.vec file, run.do file for simulation.

smartgen directory - GEN files and LOG files from generated cores

stimulus directory - BTIM, Verilog, and VHDL stimulus files

synthesis directory - *.vm (Verilog Netlist output), *_syn.prj (Synplify log file), *.psp (Precision project file), *.srr
(Synplify lodfile), precision.log (Precision logfile), *.tcl (used to run synthesis) and many other files generated by
the tools (not managed by Libero SoC)

viewdraw directory - viewdraw.ini files

Internal Files

Libero SoC generates the following internal files. They may or may not be encrypted. They are for Libero SoC
housekeeping and are not for users.

File File Extension Remarks
Routing Segmentation File *.seg
Combiner Info *.cob
Hierarchical Netlist *.adl
Flattened Netlist *.afl
map file *.map Fabric Programming File

Software Tools - Libero SoC

The Libero SoC integrates design tools, streamlines your design flow, manages design and log files, and passes

design data between tools.
For more information on Libero SoC tool

https://www.microsemi.com/products/fpga-soc/design-resources/design-software/libero-soc#overview

s, Visit:
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Function Tool Company
Project Manager, HDL Editor, Core Generation Libero SoC Microsemi
SoC
Synthesis Synplify® Pro ME | Synopsys
Simulation ModelSim® ME Mentor
Pro Graphics
Timing/Constraints, Power Analysis, Netlist Viewer, Floorplanning, Libero SoC Microsemi
Package Editing, Place-and-Route, Debugging SoC

Project Manager, HDL Editor targets the creation of HDL code. HDL Editor supports VHDL and Verilog with
color, highlighting keywords for both HDL languages.

Synplify Pro ME from Synopsys is integrated as part of the design package, enabling designers to target HDL
code to specific devices.

Microsemi SoC software package includes:
e Chip Planner displays I/O and logic macros in your design for floorplanning
o Netlist Viewer design schematic viewer
o SmartPower power analysis tool
e SmartTime static timing analysis and constraints editor

ModelSim ME Pro from Mentor Graphics enables source level verification so designers can verify HDL code line
by line. Designers can perform simulation at all levels: behavioral (or pre-synthesis), structural (or post-synthesis),
dynamic simulation. (ModelSim ME Pro is supported in Libero Gold and Platinum only.)
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Libero Design Flow

Starting the Libero GUI

When starting Libero SoC GUI, the user will be presented with the option of either creating a new project, or
opening an old one.

r v

@ Libero - O x
Project File Edit View Design Tools Help

NS 22 @03

Projects |
New... Welcome to Microsemi's Libero® SoC

Open...

Recant Projacts PolarFire™ v2.3 Release

4

Microsemi's Libero® SoC PolarFire™ software is specifically for designing with PolarFire
FPGAs, the fifth generation family of non-volatile FPGA devices from Microsemi, built on state-
of-the-art 28nm nan-volatile process technology. Cost-optimized PolarFire FPGAs deliver the
lowest power at mid-range densities.

For documentation about PolarFire FPGAs, see the PolarFire product information page on the
Microsemi website.

»

Welcome to Libero SoC = X X & . X .
Microsemi's Libero™ SoC is a comprehensive and powerful FPGA design and development

Libero 50C Quickstart software suite, providing start-to-finish design flow guidance and support for novice and
experienced users alike. Libero SoC combines Microsemi's tools with EDA tools such as

Libero SoC Interface Description iy -
Synplify Pro™ and ModelSim™.

Libero SoC Release Notes on the Web

Ubers Tutarials More Information
Product Tutorials
For more information about the Libera® SoC PolarFire v2.3 release, see the Libero SoC

Training Webcasts X
PolarFire Webh Page.

K1

Microsemi SoC Website

Log [E3]

@ Errors A Warnings @ Info

Log | Message
Fam: |Part:

Figure 10 - Libero SoC Start-up GUI
e Clicking on Open ... opens a pre-existing Libero SoC project.

e Clicking on New... starts the New Project Wizard. Upon completion of the wizard, a new Libero SoC project
is created and opened.

Having opened a project, the Libero SoC GUI presents a Design Flow window on the left hand side, a log and
message window at the bottom, and project information windows on the right. Below we see the GUI of a newly
created project with only the top level Design Flow Window steps visible.
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Project File Edit View Design Tools Help

Design Flow B ® Reports & X StartPage & X ¥

Tool sort_4 reports

Top Module{root): sort_4 B QO Fﬁ @‘ %‘% |[Ean | @oEmors A 0Wwarnings  § 0lInfo
Create Design L atestld
Constraints

Implement Design

Configure Hardware

Program Design

Debug Design

Handoff Design for Production “_
Handoff Design for Debugging g

- S -

-

Design Flow | Design Hierarchy | Stimulus Hierarchy = Catalog | Files 3 1 1})

Figure 11 - Design Flow Window

The Design Flow Window

The Design Flow Window for each technology family may be slightly different. The Constraint Flow choice made
during new project creation may also affect the exact elements of design flow. However, all flows include some
version of the following design steps:

e Create

e Constrain

e Implement

e Configure Hardware
e Program Design

o Debug Design

e Handoff

Design Report

The Design Report Tab lists all the reports available for your design, and displays the selected report.

Reports are added automatically as you move through design development. For example, Timing reports are
added when you run timing analysis on your design. The reports are updated each time you run timing analysis.

If the Report Tab is not visible, you can expose it at any time by clicking on the main menu item Design >
Reports

If a report is not yet listed, you may have to create it manually. For example, you must invoke Verify Power
manually before its report will be available.

Reports for the following steps are available for viewing here:

e Project Summary

e Synthesize

e Place and Route

o Verify Timing

o Verify Power

e Programming
e Generate FPGA Array Data
o Generate Bitstream

o Export
e Export Pin Report

22



PolarFire FPGA Design Flow User Guide

& Microsemi

a A3\ MicrRocHIP company

e Export BSDL File

Using the New Project Wizard to Start a Project

New Project Creation Wizard — Project Details

Project

You can create a Libero SoC project using the New Project Creation Wizard. You can use the pages in the wizard
to:

e Specify the project name and location

e Select the device family and parts

Set the I/O standards

e Import HDL source files and/or design constraint files into your project

e — =

Project details
Spedfy project details

Project Details

Project name: [

Projectlocation:  |x:/delete Browse...

Description:

Device Selection

Device Settings

Deslgn Template Preferred HOL type: |Verlog ¥

I™ Enable block creation

Add HDL Sources Block flow enables you to publish a reusable component that can be instantiated into another design. A block component may not contain 1/0 cells and cannot be programmed by itself.
It could include timing constraints, physical constraints, placement or routing.

Add Constraints

o 21
Libefo"
Help - Back ‘ ’TI Finish Cancel

Figure 12 - Libero SoC New Project Creation Wizard

Project Name - Identifies your project name; do not use spaces or reserved Verilog or VHDL keywords.
Project Location — Identifies your project location on disk.

Description — General information about your design and project. The information entered appears in your
Datasheet Report View.

Preferred HDL type - Sets your HDL type: Verilog or VHDL. Libero-generated files (SmartDesigns, SmartGen
cores, etc.) are created in your specified HDL type. Libero SoC supports mixed-HDL designs.

Enable Block Creation - Enables you to build blocks for your design. These blocks can be assembled in other
designs, and may have already completed Layout and been optimized for timing and power performance for a
specific Microsemi device. Once optimized, the same block or blocks can be used in multiple designs.

When you are finished, click Next to proceed to the Device Selection page.

See Also
New Project Creation Wizard - Device Selection

New Project Creation Wizard — Device Settings
New Project Creation Wizard — Add HDL Source Files
New Project Creation Wizard - Add Constraints
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New Project Creation Wizard — Device Selection

The Device Selection page is where you specify the Microsemi device for your project. Use the filters and drop-
down lists to refine your search for the right part to use for your design.

This page contains a table of all parts with associated FPGA resource details generated as a result of a value
entered in a filter.

When a value is selected for a filter:

e The parts table is updated to reflect the result of the new filtered value.

o All other filters are updated, and only relevant items are available in the filter drop-down lists.
For example, when PolarFire is selected in the Family filter:

e The parts table includes only PolarFire parts.

o The Die filter includes only PolarFire dies in the drop-down list for Die.

aQ New project o [ e
'_ Device selection
i Select a part for your project from the part number list Selected part: MPF300T_ES-1FCGA4B4E
2 b Part filter
Project Details
Family: | PolarFire = Die: | Al 3] Ppackage: Al 2
Device Selection
Device Settings Search part:
Part Number ~ | DFF User 1/0s USRAM LSRAM Math H-Chip Globald=]
MPF100TS_ES-1FULLPKGE | 108600 296 1008 352 336 48
Add HDL Sources MPF200TS_ES-1FULLPKGE 192408 368 1764 616 588 a8
MPF300T ES-1FCG1152E | 299544 512 2772 952 924 48
MPF300T ES-1FCGAB4E | 200544 244 2772 952 934 48
MPF300T_ES-1FCGTB4E 299544 388 2772 952 924 48
. MPF300T_ES-1FCSG536E 299544 300 2772 252 924 48
Add Constraints MPE300T_ES-1FCVGAS4E | 299544 284 2772 952 924 a8 | |
MPF300T_ES-FCG1152E 299544 512 2772 252 924 48
MPF300T ES-FCGABAE 299544 244 2772 952 924 48
MPF300T_ES-FCGTB4E 209544 ELE] 2772 252 924 48
- ’I\ MPF300T ES-FCSGS36E 299544 300 2772 952 924 48
MPF300T_ES-FCVG4B4E 299544 284 2772 952 924 48 ||
l ero MPF300TS ES-1FCGL152E 299544 512 2772 252 924 48 =
System-onChip & [ [ [v]
[ <Back |[ Next> ][ mnish |[ cancer |

Figure 13 - New Project Creation Wizard - Device Selection Page
Family — Specify the Microsemi device family. Only devices belonging to the family are listed in the parts table.

Die / Package / Speed - Select your device die, package, and speed grade. Use the Die/Package/Speed filters
to help in selection. The Die/Package/Speed grades available for selection depend on the level of Libero SoC
license (Evaluation/Silver/Gold/Platinum) - refer to the Libero SoC Licensing Web Page for details.

Range - Define the voltage and temperature ranges a device may encounter in your application. Tools such as
SmartTime, SmartPower, timing-driven layout, power-driven layout, the timing report, and back-annotated
simulation are affected by operating conditions.

Supported ranges include:
e All —All ranges
e EXT — All parts that support operating temperature range from 0 to 100 degrees Celsius
e IND — All parts that support operating temperature range from -40 to 100 degrees Celsius
Note: Supported operating condition ranges vary according to your device and package.
Refer to your device datasheet to find your recommended temperature range.
Reset Filters — Reset all filters to the default ALL option except Family.
Search Parts — Enter a character-by-character search for parts. Search results appear in the parts table.
When Device Selection is completed, click on:
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e Next to proceed to the Device Settings page
OR

¢ Finish to complete New Project Creation with all remaining defaults.

New Project Creation Wizard — Device Settings
The Device Settings page is where you set the Device I/O Technology and Reserve pins for Probes.

G" New project == i&

Device settings )
Choose device settings for your project Selected part: MPF200TS_ES- 1FULLPKGE

Project Details Core Voltage : [1.0 ~]
/O settings

Default I/O technology: LVCMOS 1.8V ~ | @ Please use the [/O Editor to change individual O attributes.

Device Selection =
[¥] Reserve pins for probes

Device Settings [”] system controller suspended mode
Add HDL Sources

Add Constraints

Libefo)

Systemon-Chip

[ < Back ] [ Next > ] [ Finish I I Cancel

Figure 14 - New Project Creation Wizard — Device Settings Page

Core Voltage - Set the core voltage for your device.

Default 1/0 Technology - Set all your I/Os to a default value. You can change the values for individual I/Os in the
I/O Attribute Editor. The I/O Technology available is family-dependent.

Reserve Pins for Probes - Reserve your pins for probing if you intend to debug using SmartDebug.

When you are finished, click Next to proceed to the next page, or click Finish to complete New Project Creation
with all remaining defaults.

New Project Creation Wizard — Add HDL Source Files

The Add HDL Source Files page is where you add HDL design source files to your Libero SoC project. The HDL
source files can be imported or linked to the Libero SoC Project.
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(-'\ New project - - = | [O] .S

Add HDL source files
Specify HDL files to import/link to your project.

Project Details Import file J [ Link file

File type File name File location

Selected part: MPF200TS_ES- 1FULLPKGE

Device Selection

‘ Device Settings

Add HDL Sources

Add Constraints

Libefo)

System-on-Chip

[ < Back ] [ Next > ] [ Finish I [ Cancel

Figure 15 - New Project Creation Wizard - Add HDL Source Files Page
Import File — Navigate to the disk location of the HDL source. Select the HDL file and click Open. The HDL file is
copied to the Libero Project in the <prj_folder>/hdl folder.

Link File — Navigate to the disk location of the HDL source. Select the HDL file and click Open. The HDL file is
linked to the Libero Project. Use this option if the HDL source file is located and maintained outside of the Libero
project.

Delete - Delete the selected HDL source file from your project. If the HDL source file is linked to the Libero
project, the link will be removed.

When Add HDL Sources is completed, click on:

o Next to proceed to the Add Constraints page
OR

o Finish to complete New Project Creation.

New Project Creation Wizard - Add Constraints

The Add Constraints page is where you add Timing constraints and Physical Constraints files to your Libero SoC
project. The constraints file can be imported or linked to the Libero SoC Project.
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Add constraints
Specify constraint files for timing or physical constraints.

Project Details wmport fle | | Link file

File type File name File location

Selected part: MPF200TS_ES- 1FULLPKGE

Device Selection
Device Settings
Add HDL Sources

Add Constraints

Libefo)

System-on-Chip

Next > [ Finish H Cancel

Figure 16 - New Project Creation Wizard — Add Constraints Page

Import File — Navigate to the disk location of the constraints file. Select the constraints file and click Open. The
constraints file is copied to the Libero Project in the <prj_folder>/constraint folder.

Link File — Navigate to the disk location of the constraints file. Select the constraints file and click Open. The
constraints file is linked to the Libero Project. Use this option if the constraint file is located and maintained
outside of the Libero project.

Delete - Remove the selected constraints file from your project. If the constraints file is linked to the Libero
project, the link will be removed.

When Add Constraints is completed, click on:
e Finish to complete New Project Creation.

The Reports tab displays the result of the New Project creation.
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Reports & X StartPage & X |

4 Project Summary
g5_prep_inst.log

€3 0 Errors & 0 Warnings 4} 0 Info

Project Name: g5_prep_ inst

Location: U:h\proj wvll 8\g5_prep inst
Description:

Preferred HDL Type: Verilog

P ——— e -
Device Details

# _____ _ ———— —

Part Number MPF200TS_ES-1FULLPEGE

Family : PolarFire

Die : MPF200TS_ES

Package : Fully Bonded Packags
Speed : -1

Core Voltage : 1.0

Eange » EXT

Figure 17 - Reports Tab
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Create and Verify Design

Create your design with any or all of the following design capture tools:
e Create SmartDesign
e Create HDL
e Create SmartDesign Testbench (optional, for simulation only)
o Create HDL Testbench (optional, for simulation only)

Create SmartDesign

About SmartDesign

SmartDesign is a visual block-based design creation/entry tool for the instantiation, configuration and connection
of Microsemi IPs, user-generated IPs, custom/glue-logic HDL modules. This tool provides a canvas for
instantiating and stitching together design objects. The final result from SmartDesign is a design-rule-checked and
automatically abstracted synthesis-ready HDL file. A generated SmartDesign can be the entire FPGA design or a
component subsystem to be re-used in a larger design.

The following design objects can be instantiated in the SmartDesign Canvas:
e Microsemi IP Cores
e User-generated or third-party IP Cores
o HDL design files
e HDL + design files
e Basic macros

e Other SmartDesign components (*.cxf files) generated from SmartDesign in the current Libero SoC project
or may be imported from other Libero SoC projects.

e Re-usable design blocks (*.cxz files) published from Libero SoC

For more information see the SmartDesign User Guide.

Create New SmartDesign
This SmartDesign component may be the top level of the design or it may be used as a lower level SmartDesign
component (after successful generation) in another design.

1. From the File menu, choose New > SmartDesign or in the Design Flow window or double-click Create
SmartDesign. The Create New SmartDesign dialog box opens.

Bl Create New SmartDesign

MName:
|
ox

Figure 18 - Create New SmartDesign Dialog Box

2. Enter a name and click OK. The component appears in the Design Hierarchy tab of the Design Explorer.
NOTE: The component name you choose much be unique in your project

For more information see the SmartDesign User Guide.
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Export Component Description(Tcl)
Components such as SmartDesign components, configured cores and HDL+ cores can be separately exported as
Tcl with the Export Component Description option. To export a SmartDesign component, configured core or HDL+
core as Tcl, right click the component and choose "Export Component Description(Tcl)" option

Note: The Export Component Description(Tcl) option is not supported for the SmartFusion2/IGLOO2 MSS
component and the System Builder component.
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@ Libero - ¥:\10_docs_review'12.0__Release'\poe_demo_tcl_example\DGOT56_PF_PCle_EP\new'p
Project File Edit View Design Tools Help

IR 1= -

——r

Design Hierarchy & x
MPHHU"'F' Show: |Components | a
= ﬁ work
= EJ PCle_EP_Demo

AX4_Interconnect (COREAXIINTERCONNECT v2.5.100)
[ AXltoAPB
C€CC_111MHz (PF_CCC_ w1.0.115)
= CoreDMA_IO_CTRL
®] CoreAXd Lite (COREAXIINTERCONNECT v2.5.100)
[P} CoreDMA_Controller (COREAXIMDMACONTROLLER v2.0.100)

S axiddma_init (AXMDMA_INIT ) [work]
Bk axi_io_ctrl (AX1_I0_CTRLW) [work]
B3 pCletp

i

#- B sw_debounce (

(8] PF DDR3 sS(pF DI Rename Component...
2] PF DDR4 S5 (PF DI

1P} pr ReseT (corere  OpenHDLFile

18] SRAM_AXI (PF SR2  Check HDL File

+ COREAXIADMACONTROLI
= COREAHBLITE_LIB Create I/0 Constrant from Module
i COREAHETOAPES LIB :
+- i} COREAXITOAHEL LIB fe—— :
2] ﬁ COREAPB3_LIB
% ¥ Duplicate Modules —eEs
.1_2 ;‘l User HDL Source Files Copy File Path
+ Components
Show Module Parameters
Properties
Show Module
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Figure 19 - Export As TCL option for SmartDesign Component
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Figure 20 - Export Script Dialog Box

Click the Browse button to specify the location where you wish to export the Tcl file and then click OK.

Examples

Example exported Tcl script for a SmartDesign Component(PCle_TL_CLK)

# Creating SmartDesign PCIe TL CLK

set sd name {PCIe TL_ CLK}

create_smartdesign -sd _name ${sd name}

# Disable auto promotion of pins of type 'pad'
auto_promote pad pins -promote all 0

# Create top level Ports

sd _create scalar port -sd name ${sd name} -port name {CLK 125MHz} -port direction {IN}

sd_create_scalar_port -sd_name ${sd_name} -port_name {TL CLK} -port_direction {OUT}

sd_create_scalar_port -sd_name ${sd_name} -port_name {DEVICE_ INIT DONE} -port_direction

{OoUT}
# Add CLK _DIV2 0 instance

sd_instantiate_component -sd_name ${sd_name} -component name {CLK_DIV2} -instance name

{CLK_DIV2 0}
# Add NGMUX 0 instance

sd_instantiate component -sd name ${sd name} -component name {NGMUX} -instance name

{NGMUX_0}
# Add OSC_160MHz 0 instance

sd_instantiate component -sd name ${sd name} -component name {OSC_160MHz} -instance name

{0SC_160MHz 0}
# Add PCIe INIT MONITOR_ O instance

sd_instantiate component -sd name ${sd name} -component name {PCIe INIT MONITOR} -

instance name {PCIe INIT MONITOR 0}

sd mark pins unused -sd name ${sd name} -pin names {PCIe INIT MONITOR 0:FABRIC POR N}
sd mark pins unused -sd name ${sd name} -pin names {PCIe INIT MONITOR 0:USRAM INIT DONE}

sd mark pins unused -sd name ${sd name} -pin names {PCIe INIT MONITOR 0:SRAM INIT DONE}
sd mark pins unused -sd name ${sd name} -pin names {PCIe INIT MONITOR 0:XCVR INIT DONE}

sd mark pins_unused -sd name ${sd name} -pin names
{PCIe INIT MONITOR 0:USRAM INIT FROM SNVM DONE }

sd mark pins unused -sd name ${sd name} -pin names
{PCIe INIT MONITOR 0:USRAM INIT FROM UPROM DONE}
sd mark pins_unused -sd name ${sd name} -pin names
{PCIe INIT MONITOR 0:USRAM INIT FROM SPI DONE}

sd mark pins unused -sd name ${sd name} -pin names
{PCIe INIT MONITOR 0:SRAM INIT FROM SNVM DONE}

sd mark pins_unused -sd name ${sd name} -pin names
{PCIe INIT MONITOR 0:SRAM INIT FROM UPROM DONE }

sd mark pins_unused -sd name ${sd name} -pin names
{PCIe INIT MONITOR 0O:SRAM INIT FROM SPI DONE}

sd mark pins unused -sd name ${sd name} -pin names {PCIe INIT MONITOR 0:AUTOCALIB_ DONE}

# Add scalar net connections
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sd _connect pins -sd name ${sd name} -pin names {"NGMUX 0:CLK1" "CLK 125MHz" }
sd_connect_pins -sd_name ${sd_name} -pin_names {"CLK_DIV2_0:CLK OUT" "NGMUX_ 0:CLKO" }

sd_connect_pins -sd_name ${sd _name} -pin_names {"PCIe INIT MONITOR 0:DEVICE INIT_ DONE"
"DEVICE INIT DONE" }

sd_connect_pins -sd_name ${sd_name} -pin_names {"CLK_DIV2_ 0:CLK IN"
"0SC_160MHz 0:RCOSC_160MHZ CLK DIV" }

sd_connect_pins -sd_name ${sd_name} -pin_names {"NGMUX 0:SEL"
"PCIe INIT MONITOR O0:PCIE INIT DONE" }

sd_connect_pins -sd_name ${sd_name} -pin_names {"NGMUX 0:CLK OUT" "TL_CLK" }
# Re-enable auto promotion of pins of type 'pad'
auto_promote pad pins -promote all 1
# Save the smartDesign
save smartdesign -sd name ${sd name}
# Generate SmartDesign PCIe TL CLK
generate component -component name ${sd name}
Example exported Tcl script for a System Builder Core(PF_DDR3_SS).
# Exporting core PF_DDR3_SS to TCL
# Create design TCL command for core PF_DDR3_SS

create_and_configure core -core vlnv {Actel:SystemBuilder:PF _DDR3:2.3.120} -
component name {PF _DDR3_SS} -params {\

"ADDRESS MIRROR:false" \
"ADDRESS_ORDERING:CHIP_ROW BANK_COL" \
"AUTO SELF REFRESH:1" \

"AXI ID WIDTH:6" \
"AXI_WIDTH:64" \
"BANKSTATMODULES :4" \
"BANK_ADDR_WIDTH:3" \
"BURST_LENGTH:0" \
"CAS_ADDITIVE_LATENCY:0" \
"CAS_LATENCY:9" \

"CAS WRITE LATENCY:7" \
"CCC_PLL_CLOCK_MULTIPLIER:6" \
"CLOCK_DDR:666.666" \
"CLOCK_PLL_REFERENCE:111.111" \
"CLOCK_RATE:4" \
"CLOCK_USER:166.6665" \
"COL_ADDR WIDTH:11" \
"DLL_ENABLE:1" \

"DM_MODE:DM" \
"DQ_DQS_GROUP_SIZE:8" \
"ENABLE_ECC:0" \

"ENABLE INIT INTERFACE:false" \
"ENABLE LOOKAHEAD PRECHARGE ACTIVATE:false" \
"ENABLE PAR ALERT:false" \
"ENABLE_REINIT:false" \
"ENABLE_TAG_IF:false" \
"ENABLE USER ZQCALIB:false" \
"EXPOSE TRAINING DEBUG IF:false" \
"FABRIC_ INTERFACE:AXI4" \
"FAMILY:26" \

"MEMCTRLR_INST NO:1" \

"MEMORY FORMAT:COMPONENT" \

33



PolarFire FPGA Design Flow User Guide

"MINIMUM READ IDLE:1" \

"ODT ENABLE RD RNKO ODTO:
"ODT ENABLE RD RNKO ODTI:
"ODT ENABLE RD RNK1 ODTO:
"ODT ENABLE RD RNK1 ODTI:
"ODT ENABLE WR RNKO ODTO:
"ODT ENABLE WR RNKO ODT1:
"ODT ENABLE WR RNK1 ODTO:
"ODT ENABLE WR RNK1 ODT1:

"ODT RD OFF SHIFT:0" \
"ODT_RD ON SHIFT:0" \
"ODT_WR_OFF_SHIFT:0" \
"ODT_WR ON SHIFT:0" \

false"
false"
false"

false"

P

true" \
false" \
false" \

true" \

"OUTPUT DRIVE STRENGTH:RZQ6" \

"PARAM IS FALSE:false" \

"PARTIAL ARRAY SELF REFRESH:FULL" \

"PHYONLY:false" \
"PIPELINE: false" \
"QOFF:0" \
"QUEUE_DEPTH:3" \
"RDIMM LAT:0" \

"READ BURST TYPE:SEQUENTIAL" \

"ROW_ADDR WIDTH:16" \
"RTT NOM:DISABLED" \
"RTT WR:OFF" \
"SDRAM NB RANKS:1" \
"SDRAM NUM CLK OUTS:1" \
"SDRAM TYPE:DDR3" \

"SELF REFRESH TEMPERATURE :NORMAL" \

"SHIELD ENABLED:true" \
"SIMULATION MODE:FAST" \
"TDQS ENABLE:DISABLE" \

"TGIGEN ADD PRESET WIDGET:true" \

"TIMING_DH:150" \
"TIMING_DQSCK:400" \
"TIMING_DQSQ:200" \
"TIMING_DQSS:0.25" \
"TIMING DS:75" \
"TIMING_DSH:0.2" \
"TIMING_DSS:0.2" \
"TIMING_FAW:30" \
"TIMING_IH:275" \
"TIMING_INIT:200" \
"TIMING IS:200" \
"TIMING_MODE: 0" \
"TIMING_MRD:4" \
"TIMING QH:0.38" \
"TIMING_QSH:0.38" \
"TIMING_RAS:36" \
"TIMING RC:49.5" \
"TIMING_RCD:13.5" \
"TIMING_REFI:7.8" \
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"TIMING RFC:350"
"TIMING RP:13.5"
"TIMING _RRD:7.5"
"TIMING RTP:7.5"
"TIMING WR:15" \
"TIMING WTR:5" \
"TURNAROUND RTR DIFFRANK:

s e

"TURNAROUND RTW_DIFFRANK:
"TURNAROUND WTR DIFFRANK:
"TURNAROUND WTW_DIFFRANK:
"USER_POWER DOWN:false" \
"USER SELF_REFRESH:false"
"WIDTH:16" \
"WRITE_LEVELING:ENABLE" \
"WRITE_RECOVERY:5" \

"ZQ CALIB PERIOD:200" \
"%ZQ CALIB TYPE:0" \

"zZQ CALIB TYPE TEMP:0" \
"ZQ CAL INIT TIME:512" \
"%ZQ CAL L TIME:256" \

"ZQ CAL_S TIME:64" } -inhibit configurator 0
# Exporting core PF_DDR3_SS to TCL done
Example exported Tcl script for a HDL+ core

# Exporting core pattern gen checker to TCL

1o
X
X
on

\

s s~
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# Exporting Create HDL core command for module pattern gen checker

create hdl core -file

{X:/10 _docs_review/12.0 Release/pcie demo tcl example/DG0756 PF PCIe EP/new/project/hdl/
PATTERN_GEN_CHECKER.v} -module {pattern gen checker} -library {work} -package {}

# Exporting BIF information of HDL core command for module pattern gen checker

Example exported Tcl script for a SgCore(PF_TX_PLL)
# Exporting core PCIe TX PLL to TCL

# Exporting Create design command for core PCIe TX PLL

create and configure core -core vlnv {Actel:SgCore:PF TX PLL:1.0.115} -component name

{PCIe TX PLL} -params {\
"CORE:PF_TX PLL" \
"FAMILY:26" \

"INIT:0x0" \
"PARAM IS FALSE:false" \

"SD_EXPORT HIDDEN PORTS:false" \

"TxPLL AUX LOW SEL:true"
"TxXPLL AUX OUT:125" \
"TxPLL CLK 125 EN:true" \

"TxPLL DYNAMIC RECONFIG INTERFACE EN:false" \

"TxPLL EXT WAVE SEL:0" \
"TxPLL FAB_LOCK EN:false"
"TxPLL FAB REF:200" \

"TxPLL JITTER MODE SEL:10G SyncE 32Bit" \

"TxPLL MODE:NORMAL" \
"TxPLL_OUT:2500.000" \
"TxPLL REF:100" \
"TxPLL_SOURCE:DEDICATED"
"TxPLL_SSM_DEPTH:0" \

\

\

\

35



& Microsemi

a A3\ MicrRocHIP company

PolarFire FPGA Design Flow User Guide

"TxXPLL SSM DIVVAL:1" \
"TxPLL_SSM DOWN SPREAD:false" \

"TxPLL_SSM FREQ: 64" \

"TxPLL SSM RAND PATTERN:0" \
"VCOFREQUENCY:1600" } -inhibit configurator 1
# Exporting core PCIe TX PLL to TCL done

Generating a SmartDesign Component

Before your SmartDesign component can be used by downstream processes, such as synthesis and simulation,
you must generate it.

Click the Generate button to generate a SmartDesign component.
This will generate a HDL file in the directory <libero_project>/components/<library>/<yourdesign>.

Note: The generated HDL file will be deleted when your SmartDesign design is modified and saved to
ensure synchronization between your SmartDesign component and its generated HDL file.

Generating a SmartDesign component may fail if there are any DRC errors. DRC errors must be corrected before
you generate your SmartDesign design.

If thes)rts of a sub-design have changed, then the parent SmartDesign component will be annotated with the

icon in the Design Hierarchy tab of the Design Explorer.

Generate Recursively vs. Non-Recursively
These options are set in the Project Preference Dialog Box - Design Flow Preferences section.

¢ In the "Recursive generation" mode, the Generate button will attempt to generate all sub-design
SmartDesigns, depth first. The parent SmartDesign will only be generated if all the sub-designs are
generated successfully.

¢ In the "Non-Recursive generation" mode, the Generate button will only attempt to generate the specified
SmartDesign. The generation can be marked as successful even if a sub-design is un-generated (either

never attempted or unsuccessful). An un-generated component will be annotated with the icon in the
Design Hierarchy tab of the Design Explorer.

Create Core from HDL

You can instantiate any HDL module and connect it to other blocks inside SmartDesign. However, there are
situations where you may want to extend your HDL module with more information before using it inside
SmartDesign.

e [f you have an HDL module that contains configurable parameters or generics.

e [f your HDL module is intended to connect to a processor subsystem and has implemented the appropriate
bus protocol, then you can add a bus interface to your HDL module so that it can easily connect to the bus
inside of SmartDesign.

To create a core from your HDL.:

1. Import or create a new HDL source file; the HDL file appears in the Design Hierarchy.

2. Select the HDL file in the Design Hierarchy and click the HDL+ icon or right-click the HDL file and choose
Create Core from HDL.
The Edit Core Definition — Ports and Parameters dialog appears. It shows you which ports and
parameters were extracted from your HDL module.

3. Remove parameters that are not intended to be configurable by selecting them from the list and clicking the
X icon. Remove parameters that are used for internal variables, such as state machine enumerations.
If you removed a parameter by accident, click Re-extract ports and parameters from HDL file to reset the
list so it matches your HDL module.
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Figure 21 - Edit Core Definition - Ports and Parameters Dialog Box
4. (Optional) Click Add/Edit Bus Interfaces to add bus interfaces to your core.

After you have specified the information, your HDL turns into an HDL+ icon in the Design Hierarchy. Click and
drag your HDL+ module from the Design Hierarchy to the Canvas.

If you added bus interfaces to your HDL+ core, then it will show up in your SmartDesign with a bus interface pin
that can be used to easily connect to the appropriate bus IP core.

If your HDL+ has configurable parameters then double-clicking the object on the Canvas (or right-click and select
Configure) invokes a configuration dialog that enables you to set these values. On generation, the specific
configuration values per instance are written out to the SmartDesign netlist.

el S |

Cancel |

-

|| Configurator

. prep9_0
g ot
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WIDTH: 16
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Figure 22 - HDL+ Instance and Configuration Dialog Box
You can right-click the instance and choose Modify HDL to open the HDL file inside the text editor.

Edit Core Definition

You can edit your core definition after you created it by selecting your HDL+ module in the design hierarchy and
clicking the HDL+ icon.
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Remove Core Definition

You may decide that you do not want or need the extended information on your HDL module. You can convert it
back to a regular HDL module. To do so, right-click the HDL+ in the Design Hierarchy and choose Remove Core
Definition. After removing your definition, your instances in your SmartDesign that were referencing this core
must be updated. Right-click the instance and choose Replace Component for Instance.

Designing with HDL

Create HDL

Create HDL opens the HDL editor with a new VHDL or Verilog file. Your new HDL file is saved to your /hdl
directory; all modules created in the file appear in the Design Hierarchy.

You can use VHDL and Verilog to implement your design.
To create an HDL file:

1. In the Design Flow window, double-click Create HDL. The Create new HDL file dialog box opens.

2. Select your HDL Type. Choose whether or not to Initialize file with standard template to populate your file
with default headers and footers. The HDL Editor workspace opens.

3. Enter a Name. Do not enter a file extension; Libero SoC adds one for you. The filename must follow Verilog
or VHDL file naming conventions.

4. Click OK.

After creating your HDL file, click the Save button to save your file to the project.

Using the HDL Editor

The HDL Editor is a text editor designed for editing HDL source files. In addition to regular editing features, the
editor provides keyword highlighting, line numbering and a syntax checker.

You can have multiple files open at one time in the HDL Editor workspace. Click the tabs to move between files.
Editing

Right-click inside the HDL Editor to open the Edit menu items. Available editing functions include cut, copy, paste,
Go to line, Comment/Uncomment Selection and Check HDL File. These features are also available in the toolbar.
Saving

You must save your file to add it to your Libero SoC project. Select Save in the File menu, or click the Save icon
in the toolbar.

Printing
Print is available from the File menu and the toolbar.

Note: To avoid conflicts between changes made in your HDL files, Microsemi recommends that you use
one editor for all of your HDL edits.

HDL Syntax Checker

To run the syntax checker:

In the Files list, double-click the HDL file to open it. Right-click in the body of the HDL editor and choose Check
HDL File.

The syntax checker parses the selected HDL file and looks for typographical mistakes and syntactical errors.
Warning and error messages for the HDL file appear in the Libero SoC Log Window.

Commenting Text

You can comment text as you type in the HDL Editor, or you can comment out blocks of text by selecting a group
of text and applying the Comment command.
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To comment or uncomment out text:
1. Type your text.
2. Select the text.
3. Right-click inside the editor and choose Comment Selection or Uncomment Selection.

Find

In the File menu, choose Find and the Find dialog box appears below the Log/Message window. You can search
for a whole word or part of a word, with or without matching the case.

You can search for:
e Match Case
e Match whole word
e Regular Expression

The Find to Replace function is also supported.
Column Editing
Column Editing is supported. Press ALT+click to select a column of text to edit.

Importing HDL Source Files

To import an HDL source file:

1. In the Design Flow window, right-click Create HDL and choose Import Files. The Import Files window
appears.

2. Navigate to the drive/folder that contains the HDL file.
3. Select the file to import and click Open.

Note: SystemVerilog (*.sv), Verilog (*.v) and VHDL (*.vhd/*.vhdl) files can be imported.

Mixed-HDL Support in Libero SoC

You must have ModelSim ME Pro to use mixed HDL in the Libero SoC. You must also have Synplify Pro to
synthesize a mixed-HDL design.

When you create a project, you must select a preferred language. The HDL files generated in the flow are created
in the preferred language.

The language used for simulation is the same language as the last compiled testbench. (For example, if tb_top is
in Verilog, <fam>.v is compiled.)

If your preferred language is Verilog, the post-synthesis and post-layout netlists are in Verilog 2001.

Designing with Block Flow

For information about designing with Block Flow, see Designing with Blocks for Libero SoC Enhanced Constraint
Flow.

Create New SmartDesign Testbench

The SmartDesign Testbench component may be the top level of the design or it may be used as a lower level
SmartDesign Testbench component (after successful generation) in another design.

1. From the File menu, choose New > SmartDesign Testbench, or in the Design Flow window double-click
Create SmartDesign Testbench. The Create New SmartDesign Testbench dialog box opens.
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Figure 23 - Create New SmartDesign Testbench

2. Enter a name, select the Set as Active Stimulus radio button if you want have this SmartDesign Testbench
as your active stimulus, and click OK. The component appears in the Stimulus Hierarchy tab of the Design
Explorer.

Note: The component name you choose much be unique in your project.

For more information see the SmartDesign User Guide.

HDL Testbench

You can create a HDL Testbench by right-clicking a SmartDesign in the Design Hierarchy and choosing Create
Testbench > HDL.

HDL Testbench automatically instantiates the selected SmartDesign into the Component.

You can also double-click Create HDL Testbench to open the Create New HDL Testbench dialog box. The
dialog box enables you to create a new testbench file and gives you the option to include standard testbench
content and your design data.

HDL Type
Set your HDL Type: Verilog or VHDL for the testbench.

Name
Specify a testbench file name. A *.v or a *.vhd file is created and opened in the HDL Editor.

Clock Period (ns)
Enter a clock period in nanoseconds (ns) for the clock to drive the simulation. The default value is 100 ns (10
MHz). Libero creates in the testbench a SYSCLK signal with the specified frequency to drive the simulation.
Set as Active Stimulus sets the HDL Testbench as the stimulus file to use for simulations. The active stimulus
file/testbench is included in the run.do file that Libero generates to drive the simulation. Setting one testbench as
the Active Stimulus is necessary when there are multiple testbenches in the stimulus hierarchy.
Initialize with Standard Template adds boilerplate for a minimal standard test module. This test module does
not include an instantiation of the root module under test.

Instantiate Root Design Creates a test module that includes an instance of the root module under test, and
clocking logic in the test module which drives the base clock of the root module under test.
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Figure 24 - Create New HDL Testbench File Dialog Box

e Bt e e LT T T

2 | -- Created by Microsemi SmartDesign Mon Mar 27 15:07:29 2017

3 | -- Testbench Template

4 | -- This is a basic testbench that instantiates your design with basic

5 clock and reset pins connected. If your design has special

6 | -- clock/reset or testbench driver requirements then you should

7 | -- copy this file and modify it.

] (e Car AR e, S M e e gt e e AR S P g S T e e Sy e xS e e i 1t S B e

g L
R L T
T - Company: <Name=>

12 -

13 | -- File: counter_th.vhd

14 | -- File history:

15 | - =Revision number>: =Date>: <Comments>

b | -- <Revision number>: <Date>: <Comments=

ir | -- <Revision number>: <Date>. <Comments=

18

19 | -- Description:

200 | --

21 | -- <Description here>

22 | --

23 | -- Targeted device: <Family::PolarFire> <Die::MPF200TS_ES> <Package.:Fully Bonded Package>
24 | -- Author: <Name=

25

| e e e
27

28 L

29 library ieee;
30 wuse ieee,std_logic_1164.all;

32 Tentlty counter_tb is

33 | end counter_tb;

34

35 (Harchitecture behavioral of counter_tb 1is

36

37 constant SYSCLK_PERIOD : time := 160 ns; -- 10MHZ
38

39 signal SYSCLK : std_logic i= '@";

4a signal NSYSRESET : std_logic := '@°;

41

42 component countlf

Figure 25 - HDL Testbench Example - VHDL, Standard Template and Root Design Enabled

Verify Pre-Synthesized Design - RTL Simulation

To perform pre-synthesis simulation, double-click Simulate under Verify Pre-Synthesized Design in the Design
Flow window. Alternatively, in the Stimulus Hierarchy right-click the testbench and choose Simulate Pre-Synth
Design > Run.
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The default tool for RTL simulation in Libero SoC PolarFire is ModelSim™ ME Pro. ModelSim ME works with all
levels of Libero SoC license (Eval, Silver, Gold and Platinum) whereas ModelSim Pro ME works with all levels of

Libero SoC license except Silver.

ModelSim ME and ModelSim ME Pro are custom editions of ModelSim PE that are integrated into Libero SoC's
design environment. ModelSim for Microsemi is an OEM edition of Mentor Graphics ModelSim tools. ModelSim
ME Pro supports mixed VHDL, Verilog, and SystemVerilog simulation but ModelSim ME does not. Both ModelSim
editions only work with Microsemi simulation libraries and they are supported by Microsemi.

Other editions of ModelSim are supported by Libero SoC. To use other editions of ModelSim, do not install
ModelSim ME from the Libero SoC media.
Note: ModelSim for Microsemi includes online help and documentation. After starting ModelSim, click the
Help menu.
See the following topics for more information on simulation in Libero SoC:

e Simulation Options

e Selecting a Stimulus File for Simulation

e Selecting additional modules for simulation
e Performing Functional Simulation

Project Settings: Simulation - Options and Libraries

DO file

Using this dialog box, you can set change how Libero SoC handles Do files in simulation, import your own Do
files, set simulation run time, and change the DUT name used in your simulation. You can also change your

library mapping.
To access this dialog box, from the Project menu choose Project Settings and click to expand Simulation
options or Simulation libraries.

For Simulation options click the option you wish to edit: DO file, Waveforms, Vsim commands, Timescale.
For Simulation libraries click on the library you wish to change the path for.

N Preject 5
] s sutomartc 0O e
Smulaton runtime: .
o gl Tasthand mode RamE!  testhench
00 file Top level rstance name:  ctops 0
Wrsefeams - D
Vsim commands
Timeszale VCD fle name:
+ Samulstion libraries
Sruntfusiond User defired DO fle:
00 command parsmeters:
g —_—J

Figure 26 - Project Settings: DO File

o Use automatic DO file - Select if you want the Project Manager to automatically create a DO file that will
enable you to simulate your design.

e Simulation Run Time - Specify how long the simulation should run. If the value is 0, or if the field is empty,
there will not be a run command included in the run.do file.

o Testbench module name - Specify the name of your testbench entity name. Default is “testbench,” the
value used by WaveFormer Pro.
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e Top Level instance name - Default is <top_0>, the value used by WaveFormer Pro. The Project Manager
replaces <top> with the actual top level macro when you run simulation (presynth/postsynth/postlayout).

e Generate VCD file - Click the checkbox to generate a VCD file.

e VCD file name - Specifies the name of your generated VCD file. The default is power.vcd; click power.ved
and type to change the name.

o User defined DO file - Enter the DO file name or click the browse button to navigate to it.
¢ DO command parameters - Text in this field is added to the DO command.

Waveforms

¢ Include DO file - Including a DO file enables you to customize the set of signal waveforms that will be
displayed in ModelSim.

o Display waveforms for - You can display signal waveforms for either the top-level testbench or for the
design under test. If you select top-level testbench then Project Manager outputs the line 'add wave
/testbench/*' in the DO file run.do. If you select DUT then Project Manager outputs the line 'add wave
/testbench/DUT/*" in the run.do file.

e Log all signals in the design - Saves and logs all signals during simulation.

Vsim Commands

e Resolution - The default is 1ps.Some custom simulation resolutions may not work with your simulation
library. Consult your simulation help for more information on how to work with your simulation library and
detect infinite zero-delay loops caused by high resolution values.

e Additional options - Text entered in this field is added to the vsim command.

e SRAM ECC Simulation -
Two options can be added to specify the simulated error and correction probabilities of all ECC
SRAMs in the design.

¢ -gERROR_PROBABILITY=<value>, where 0 <= value <=1
e -gCORRECTION_PROBABILITY=<value>, where 0 <= value <= 1

e During Simulation, the SB_CORRECT and DB_DETECT flags on each SRAM block will be
raised based on generated random numbers being below the specified <value>s.

Timescale

¢ TimeUnit - Enter a value and select s, ms, us, ns, ps, or fs from the pull-down list, which is the time base for
each unit. The default setting is ns.

e Precision - Enter a value and select s, ms, us, ns, ps, or fs from the pull-down list. The default setting is ps.
Simulation Libraries

o Restore Defaults- Sets the library path to default from your Libero SoC installation.

e Library path - Enables you to change the mapping for your simulation library (both Verilog and VHDL).
Type the pathname or click the Browse button to navigate to your library directory.

Selecting a Stimulus File for Simulation

Before running simulation, you must associate a testbench. If you attempt to run simulation without an associated
testbench, the Libero SoC Project Manager asks you to associate a testbench or open Model Sim without a
testbench.

To associate a stimulus:

1. Run simulation or in the Design Flow window under Verify Pre-Synthesized Design right-click Simulate and
choose Organize Input Files > Organize Stimulus Files. The Organize Stimulus Files dialog box appears.
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2. Associate your testbench(es):
In the Organize Stimulus Files dialog box, all the stimulus files in the current project appear in the Source
Files in the Project list box. Files already associated with the block appear in the Associated Source Files list
box.
In most cases you will only have one testbench associated with your block. However, if you want
simultaneous association of multiple testbench files for one simulation session, as in the case of PCl cores,
add multiple files to the Associated Source Files list.

¢ To add a testbench: Select the testbench you want to associate with the block in the Source Files
in the Project list box and click Add to add it to the Associated Source Files list.

o Toremove a testbench: To remove or change the file(s) in the Associated Source Files list box,
select the file(s) and click Remove.

o To order testbenches: Use the up and down arrows to define the order you want the testbenches
compiled. The top level-entity should be at the bottom of the list.

3. When you are satisfied with the Associated Source Files list, click OK.

Selecting Additional Modules for Simulation
Libero SoC passes all the source files related to the top-level module to simulation.

If you need additional modules in simulation, in the Design Flow window right-click Simulate and choose
Organize Input Files > Organize Source Files. The Organize Files for Simulation dialog box appears.

Select the HDL modules you wish to add from the Simulation Files in the Project list and click Add to add them to
the Associated Stimulus Files list

Performing Functional Simulation

To perform functional simulation:

1. Create your testbench.

2. Right-click Simulate (in the Design Flow window, Implement Design > Verify Post-Synthesis Implementation
> Simulate) and choose Organize Input Files > Organize Simulation Files from the right-click menu.
In the Organize Files for Source dialog box, all the stimulus files in the current project appear in the Source
Files in the Project list box. Files already associated with the block appear in the Associated Source Files list
box.
In most cases you will only have one testbench associated with your block. However, if you want
simultaneous association of multiple testbench files for one simulation session, as in the case of PCl cores,
add multiple files to the Associated Source Files list.

¢ To add a testbench: Select the testbench you want to associate with the block in the Source Files
in the Project list box and click Add to add it to the Associated Source Files list.
o Toremove a testbench: To remove or change the file(s) in the Associated Source Files list box,
select the file(s) and click Remove.
3. When you are satisfied with the Associated Simulation Files list, click OK.
4. To start ModelSim ME Pro, right-click Simulate in the Design Hierarchy window and choose Open
Interactively.

ModelSim starts and compiles the appropriate source files. When the compilation completes, the simulator
runs for 1 “s and the Wave window opens to display the simulation results.

5. Scrollin the Wave window to verify that the logic of your design functions as intended. Use the zoom buttons
to zoom in and out as necessary.

6. From the File menu, select Quit.
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Libero SoC Constraint Management

In the FPGA design world, constraint files are as important as design source files. Constraint files are used
throughout the FPGA design process to guide FPGA tools to achieve the timing and power requirements of the
design. For the synthesis step, SDC timing constraints set the performance goals whereas non-timing FDC
constraints guide the synthesis tool for optimization. For the Place-and-Route step, SDC timing constraints guide
the tool to achieve the timing requirements whereas Physical Design Constraints (PDC) guide the tool for
optimized placement and routing (Floorplanning). For Static Timing Analysis, SDC timing constraints set the
timing requirements and design-specific timing exceptions for static timing analysis.

Libero SoC provides the Constraint Manager as the cockpit to manage your design constraint needs. This is a
single centralized graphical interface for you to create, import, link, check, delete, edit design constraints and
associate the constraint files to design tools in the Libero SoC environment. The Constraint Manager allows you
to manage constraints for SynplifyPro synthesis, Libero SoC Place-and- Route and the SmartTime Timing
Analysis throughout the design process.

Invocation of Constraint Manager From the Design Flow Window

After project creation, double-click Manage Constraints in the Design Flow window to open the Constraint

Manager.
| Reports & X | my_usersdc & X | Constraint Manager & X | mddr_top_sb_CCC_0_FCCC.sdc & X | ¥
1/0 Attributes /" Timing /" Floor Planner \/” Netiist Attributes \__) %— Constraints Tab
~
[ Mew ] [ Import ] [ Link. ] [Editwith Constraint Editor V] [ Check V] [Derive Constrainis] [ConstraintCaverage V] [ Help ](f '
N—
y Synthesis Place and Route  Timing Verification
constraint\ top_derived_constraints.sdc
constraint\my.sdc a ] B
Qnstraint\my_usensdc [ B ]

Constraints
File Order

File and Tool Association

Figure 27 - Constraint Manager

Libero SoC Design Flow

The Constraint Manager is Libero SoC’s single centralized Graphical User Interface for managing constraints files
in the design flow.
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Figure 28 - Constraint Manager in Libero SoC Design Flow

Introduction to Constraint Manager

Synthesis Constraints
The Constraint Manager manages these synthesis constraints and passes them to SynplifyPro:
Synplify Netlist Constraint File (*.fdc)
Compile Netlist Constraint File (*.ndc)
SDC Timing Constraints (*.sdc)
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e Derived Timing Constraints (*.sdc)
Synplify Netlist Constraints (*.fdc)

These are non-timing constraints that help SynplifyPro optimize the netlist. From the Constraint Manager Netlist
Attribute tab import (Netlist Attributes > Import) an existing FDC file or create a new FDC file in the Text Editor
(Netlist Attributes > New > Create New Synplify Netlist Constraint). After the FDC file is created or imported,
click the checkbox under synthesis to associate the FDC file with Synthesis.

Compile Netlist Constraints (*.ndc)

These are non-timing constraints that help Libero SoC optimize the netlist by combining I/Os with registers. 1/0s
are combined with a register to achieve better clock-to-out or input-to-clock timing. From the Constraint Manager
Netlist Attribute tab import (Netlist Attributes > Import) an existing NDC file or create a new NDC file in the Text
Editor (Netlist Attributes > New > Create New Compile Netlist Constraint). After the NDC file is created or
imported, click the checkbox under synthesis to associate the NDC file with Synthesis.

SDC Timing Constraints (*.sdc)

These are timing constraints to guide SynplifyPro to optimize the netlist to meet the timing requirements of the
design. From the Constraint Manager Timing tab, import (Timing > Import) or create in the Text Editor (Timing >
New) a new SDC file. After the SDC file is created or imported, click the checkbox under synthesis to associate
the SDC file with Synthesis.

After the synthesis step, you may click Edit with Constraint Editor > Edit Synthesis Constraints to edit existing
constraints or add new SDC constraints.

Derived Timing Constraints (*.sdc)

These are timing constraints LiberoSoC generates for IP cores used in your design. These IP cores, available in
the Catalog, are family/device-dependent. Once they are configured, generated and instantiated in the design, the
Constraint Manager can generate SDC timing constraints based on the configuration of the IP core and the
component SDC. From the Constraint Manager Timing tab, click Derive Constraints to generate the Derived
Timing Constraints (*.sdc). Click the *derived_constraints.sdc file to associate it with synthesis.

Place and Route Constraints
The Constraint Manager manages these constraints for the Place-and-Route step:
e |/O PDC Constraints (*io.pdc)
e Floorplanning PDC Constraints (*fp.pdc)
e Timing SDC constraint file (*.sdc)

1/0 PDC Constraints

These are I/0O Physical Design Constraints in an *io.pdc file. From the Constraint Manager I/O Attribute tab, you
may import (/O Attributes > Import) or create in the Text Editor (1/O Attributes > New) an *io.pdc file.

Click the checkbox under Place and Route to associate the file with Place and Route.

Floorplanning PDC Constraints

These are floorplanning Physical Design Constraints in a *fp.pdc file. From the Constraint Manager Floor Planner
tab, you may import (Floor Planner > Import) or create in the Text Editor (Floor Planner > New) a *fp.pdc file.
Click the checkbox under Place and Route to associate the file with Place and Route.

47



& Microsemi

a A3\ MicrRocHIP company

PolarFire FPGA Design Flow User Guide

Timing SDC Constraint file (*.sdc)

These are timing constraint SDC files for Timing-driven Place and Route. From the Constraint Manager Timing
tab, you may import (Timing > Import) or create in the Text Editor (Timing > New) a timing SDC file. Click the
checkbox under Place and Route to associate the SDC file with Place and Route. This file is passed to Timing-
driven Place and Route (Place and Route > Configure Options > Timing Driven).

Timing Verifications Constraints

The Constraint Manager manages the SDC timing constraints for Libero SoC’s SmartTime, which is a Timing
Verifications/Static Timing analysis tool. SDC timing constraints provide the timing requirements (e.g.
create_clock and create_generated_clock) and design-specific timing exceptions (e.g. set_false_path and
set_multicycle_path) for Timing Analysis.

From the Constraint Manager Timing tab, you may import (Timing > Import) or create in the Text Editor (Timing
> New) a SDC timing file. Click the checkbox under Timing Verifications to associate the SDC timing constraints
file with Timing Verifications.

Note: You may have the same set of SDC Timing Constraints for Synthesis, Place and Route and Timing
Verifications to start with in the first iteration of the design process. However, very often and particularly when the
design is not meeting timing requirements you may find it useful in subsequent iterations to have different sets of
Timing SDC files associated with different tools. Take for example; you may want to change/modify the set of
SDC timing constrains for Synthesis or Place and Route to guide the tool to focus on a few critical paths. The set
of SDC timing constraints associated with Timing Verifications can remain unchanged.

The Constraint Manager lets you associate/dis-associate the constraint files with the different tools with a mouse
click.

Constraint Manager Components
The Constraint Manager has four tabs, each corresponding to a constraint type that Libero SoC supports:
e |/O Attributes
e Timing
e Floor Planner
o Netlist Attribute
Clicking the tabs displays the constraint file of that type managed in the Libero SoC project.

Constraint File and Tool Association
Each constraint file can be associated/dis-associated with a design tool by checking and unchecking the
checkbox corresponding to the tool and the constraint file. When associated with a tool, the constraint file is
passed to the tool for processing.

E
T 1/0 Attributes \/ Timing \/ Fioor Planner \{ Netlist Attributes \

New Import Link Edit with Constraint Editor }" Check i‘* Derive Constraints | | Constraint Coverage [" Help + '6
Synthesis Place and Route Timing Verification
constraint/user.sdc L o L
constraint/mytiming2.sdc o 4
constraint/myuserl.sdc v v

Figure 29 - Constraint File and Tool Association
Note: Libero SoC’s Design Flow window displays the state the tool is in. A green check mark V indicates

successful completion. A warning icon ! indicates invalidation of the state because the input files for the tool
have changed since the last successful run. Association of a new constraint file with a tool or dis-association of an
existing constraint file with a tool invalidates the state of the tool with which the constraint file is associated.

All Constraint files except Netlist Attributes can be opened, read and edited by Interactive Tools invoked from the
Constraint Manager directly. The Interactive Tools are:

e |/O Editor
e Chip Planner
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Constraint Constraint File Location inside Project Associated with Interactive
Type Extension Design Tool Tool (For
Editing)
I/O Attributes PDC (*.pdc) <proj>\constraints\io\*.pdc Place and Route I/O Editor
Floorplanning PDC (*.pdc) <proj>\constraints\fp\*.pdc Place and Route Chip Planner
Timing SDC (*.sdc) <proj>\constraints\*.sdc Synthesis, Place and Constraint
Route, Timing Editor
Verification
Netlist Attributes | FDC (*.fdc) <proj>\constraints\*.fdc Synthesis n/a
NDC (*.ndc) <proj>\constraints\*.ndc Synthesis n/a

Derive Constraints in Timing Tab

The Constraint Manager can generate timing constraints for IP cores used in your design. These IP cores,
available in the Catalog, are family/device-dependent. Once they are configured, generated and instantiated in
your design, the Constraint Manager can generate SDC timing constraints based on the configuration of the IP
core and the component SDC. A typical example of an IP core for which the Constraint Manager can generate
SDC timing constraints is the IP core for Clock Conditioning Circuitry (CCC).

Create New Constraints
From the Constraint Manager, create new constraints in one of two ways:

e Use the Text Editor
e Use Libero SoC'’s Interactive Tools

To create new constraints from the Constraint Manager using the Text Editor:
Select the Tab that corresponds to the type of constraint you want to create.

Click New.

When prompted, enter a file name to store the new constraint.

Enter the constraint in the Text Editor.

Click OK.
The Constraint file is saved and visible in the Constraint Manager in the tab you select:

e /O Attributes constraint file (<proj>\io\*.pdc) in the I/O Attributes tab
e Floorplanning constraints (<proj>\fp\*.pdc) in the Floor Planner tab
e Timing constraints (<proj>\constraints\*.sdc) in the Timing tab

ok~ 0DdN =~

6. (Optional) Double-click the constraint file in the Constraint Manager to open and add more constraints to the
file.

To create new constraints from the Constraint Manager using Interactive Tools:

Note: Netlist Attribute constraints cannot be created by an Interactive Tool. Netlist Attribute files can only be
created with a Text Editor.

Note: Except for timing constraints for Synthesis, the design needs to be in the post-synthesis state to enable
editing/creation of new constraints by the Interactive Tool.

Note: The *.pdc or *.sdc file the Constraint Manager creates is marked [Target]. This denotes that it is the target
file. A target file receives and stores new constraints from the Interactive Tool. When you have multiple constraint
files of the same type, you may select any one of them as target. When there are multiple constraint files but none
of them is set as target, or there are zero constraint files, Libero SoC creates a new file and set it as target to
receive and store the new constraints created by the Interactive Tools.
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Select the Tab that corresponds to the type of constraint you want to create.
Click Edit to open the Interactive Tools. The Interactive Tool that Libero SoC opens varies with the constraint
type:

e /O Editor to edit/create I/O Attribute Constraints. See |/O Editor User Guide for details.

e Chip Planner to edit/create Floorplanning constraints. See Chip Planner User Guide for details.

e Constraint Editor to edit/create Timing Constraints. See Timing Constraints Editor User Guide for
details.

Create the Constraints in the Interactive Tool. Click Commit and Save.

Check that Libero SoC creates these files to store the new constraints:
e Constraints\io\user.pdc file when I/O constraints are added and saved in I/O Editor.
e Constraints\fp\user.pdc file when floorplanning constraints are added and saved in Chip Planner.
e Constraints\user.sdc file when Timing Constraints are added and saved in Constraint Editor

Constraint File Order

When there are multiple constraint files of the same type associated with the same tool, use the Up and Down
arrow to arrange the order the constraint files are passed to the associated tool. Constraint file order is important
when there is a dependency between constraints files. When a floorplanning PDC file assigns a macro to a
region, the region must first be created and defined. If the PDC command for region creation and macro
assignment are in different PDC files, the order of the two PDC files is critical.

1.
2.

To move a constraint file up, select the file and click the Up arrow.
To move a constraint file down, select the file and click the Down arrow.

{110 Attributes \/ Timing \/ Floor Planner \/ Netlist Attributes \ |
New Import Link Edit with Constraint Editor }' Check " Derive Constraints | | Constraint Coverage Ev Help + |4
Synthesis Place and Routi Timing Verification Move Up
constraint/top_derived_constraints.sdc L4 v v
constraint/usersdc < b4
constraint/mytiming.sdc v o
constraint/mytiming2.sdc v 04 4
constraint/sdfsadf.sdc

Figure 30 - Move constraint file Up or Down

Note: Changing the order of the constraint files associated with the same tool invalidates the state of that tool.

Import a Constraint File

Use the Constraint Manager to import a constraint file into the Libero SoC project. When a constraint file is
imported, a local copy of the constraint file is created in the Libero Project.

Hwh =

To import a constraint file:

Click the Tab corresponding to the type of constraint file you want to import.
Click Import.

Navigate to the location of the constraint file.

Select the constraint file and click Open. A copy of the file is created and appears in Constraint Manager in
the tab you have selected.

Link a Constraint File

Use the Constraint Manager to link a constraint file into the Libero SoC project. When a constraint file is linked, a
file link rather than a copy is created from the Libero project to a constraint file physically located and maintained
outside the Libero SoC project.

1.
2.
3.

To link a constraint file:

Click the Tab corresponding to the type of constraint file you want to link.
Click Link.
Navigate to the location of the constraint file you want to link to.
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4. Select the constraint file and click Open. A link of the file is created and appears in Constraint Manager
under the tab you have selected. The full path location of the file (outside the Libero SoC project) is
displayed.

Check a Constraint File
Use the Constraint Manager to check a constraint file.
To check a constraint file:
1. Select the tab for the constraint type to check.
2. Click Check.

Note: I/O constraints, Floorplanning constraints, Timing constraints, and Netlist Attributes can be checked only
when the design is in the proper state. A pop-up message appears when the check is made and the design state
is not proper for checking.

%' Information ﬁ

Jo:I Please run 'Synthesize' before executing Check Operation

All constraint files associated with the tool are checked. Files not associated with a tool are not checked.
For Timing Constraints, select from the Check drop-down menu one of the following:

e Check Synthesis Constraints
e Check Place and Route Constraints
e Check Timing Verification Constraints

{170 Attributes \/ Timing \/ Figor Planner \/[_Netlist Attributes \
New Impaort | Link Edit with Constraint Editor i' Check I" Derive Cunstraintsf Constraint Coverage [" ' Help 3+ {
Synthesis Place ai Check Synthesis Constraints
constraintitop_derived_constraints.sdc =~ ~ Check Place And Route Constraints
constraint/user.sdc b4 Check Timing Verification Constraints
constraint/mytiming.sdc ¥ ™7 =
constraint/mytiming2.sdc v v 4

constraint/sdfsadf.sdc

Figure 31 - Check Constraints
Check Synthesis Constraints checks only the constraint files associated with the Synthesis.
Check Place and Route Constraints checks only the constraint files associated with Place and Route
Check Timing Verification Constraints checks only the Constraint Files associated with Timing Verification.
For the constraint files and tool association shown in the SDC file and Tool Association Figure below:
¢ Check Synthesis Constraints checks the following files:
e top_derived_constraints.sdc
e user.sdc
o mytiming2.sdc
e Check Place and Route Constraints checks the following files:
o top_derived_constraints.sdc
o mytiming.sdc
e mytiming2.sdc
e Check Timing Verification Constraints checks the following files:
e top_derived_constraints.sdc
e user.sdc
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e mytiming.sdc
e mytiming2.sdc
Note: sdfsadf.sdc Constraint File is not checked because it is not associated with any tool.

{1/ Attributes \/ Timing \/ Floor Planner \/_Netlist Attributes \

k New Import | Link | Edit with Constraint Editor Il' I Check |L' Derive Constraint5| Constraint Coverage ]' Help + ¥
Synthesis Place and Route Timing Verification
constraint/tep_derived_constraints.sdc o4 o4 o
constraint/user.sdc v v
constraint/mytiming.sdc 4 bd
constraint/mytiming 2.sdc L4 td L4

constraint/sdfsadf.sdc

Figure 32 - Timing Constraints SDC file and Tool Association
When a constraint file is checked, the Constraint Manager:
e Checks the SDC or PDC syntax.

e Compares the design objects (pins, cells, nets, ports) in the constraint file versus the design objects in the
netlist (RTL or post-layout ADL netlist). Any discrepancy (e.g. constraints on a design object which does not
exist in the netlist) are flagged as errors and reported in the *.log file or message window.

Check Result

If the check is successful, this message pops up.

5 Information I&

Figure 33 - Check Successful Message

If the check fails, this error message pops up.
B Emror @

a2 '\__
[Q_I Checking of Timing constraints assodated with Timing Verification failed. See the message window for more details,
k. _/

Figure 34 - Check Fails Message

Constraint Type Check for Tools | Required Design Netlist Used Check Result
State for Details
Before Checks Checks

I/O Constraints Place and Route | Post-Synthesis ADL Netlist Libero Message
Window

Floorplanning Place and Route | Post-Synthesis ADL Netlist Libero Message

Constraints Window

Timing Constraints Synthesis Pre-Synthesis RTL Netlist synthesis_sdc_check.
log

Place and Route | Post-Synthesis ADL Netlist placer_sdc_check.log
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Constraint Type Check for Tools | Required Design Netlist Used Check Result
State for Details
Before Checks Checks

Timing Post-Synthesis ADL Netlist timing_sdc_check.log
Verifications

Netlist Attributes Synthesis Pre-Synthesis RTL Netlist *cck.str file

(*.fdc)

Netlist Attributes Synthesis Pre-Synthesis RTL Netlist Libero Log Window

(*.ndc)

Edit a Constraint File
The Edit button in the Constraint Manager allows you to:

e Create new constraint files. See To create new constraints from the Constraint Manager using the Text
Editor for details.

o Edit existing constraint files.

To edit a constraint file

Note: Netlist Attributes cannot be edited by an Interactive Tool. Use the Text Editor to edit the Netlist Attribute
constraint (*.fdc and *.ndc) files.

1. Select the tab for the constraint type to edit. An Interactive Tool is opened to make the edits.

2. Click Edit.
e All constraint files associated with the tool are edited. Files not associated with the tool are not
edited.

e \When a constraint file is edited, the constraints in the file are read into the Interactive Tool.
e Different Interactive Tools are used to edit different constraints/different files:

e |/O Editor to edit I/O Attributes (<proj>\io\*.pdc). For details, refer to the I/O Editor User
Guide.

e Chip Planner to edit Floorplanning Constraints (<proj>\fp\*.pdc). For details, refer to the
Chip Planner User's Guide (Chip Planner > Help > Reference Manuals)

e Constraint Editor to edit Timing Constraints (constraints\*.sdc). For details, refer to the
Timing Constraints Editor User's Guide (Help > Constraints Editor User's Guide)

Note: I/O constraints, Floorplanning constraints, Timing constraints can be edited only when the design is in the
proper state. A message pops up if the file is edited when the design state is not proper for edits. If, for example,
you open the Constraints Editor (Constraint Manager > Edit) to edit timing constraints when the design state is not
post-synthesis, a pop-up message appears.

5| Information &

IOI Please run 'Synthesize' before executing Edit Operation

Figure 35 - Pop-up Message
3. For Timing Constraints, click one of the following to edit from the Edit with Constraint Editor drop-down
menu.
e Edit Synthesis Constraints

e Edit Place and Route Constraints
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e Edit Timing Verification Constraints
{10 Attributes Y/ Timing \/ Floor Planner \/” Netlist Attributes \

New Import Link | | Edit with Constraint Editor [wl | Check |v Derive Constraints | Constraint Couefageiv Help + 4

Edit Synthesis Constraints [Timing Verification

constraint/top_derived_constraints.sdc IR MR AT N SR
constraint/user.sdc Edit Timing Verifitation Constraints |¥
Ui

constraint/mytiming.sdc h \ |
constraint/mytiming2.sdc Ld v L4
constraint/sdfsadf.sdc

Figure 36 - Edit Drop-down Menu
For the constraint files and tool association shown in the Timing Constraint File and Tool Association below:
o Edit Synthesis Constraints reads the following files into the Constraint Editor:
e user.sdc
e myuseri.sdc
e Edit Place and Route Constraints reads the following files into the Constraint Editor:
e user.sdc
e mytiming2.sdc
e myuseri.sdc
e Edit Timing Verification Constraints reads the following files into the Constraint Editor:
e user.sdc
e mytiming2.sdc

k
T 1/0 Attributes \/ Timing \/ Floor Planner \/ Netlist Attributes \

New Import Link Edit with Constraint Editor 'v Check 'v Derive Constraints | Constraint Coverage 'v Help + ¥
Synthesis Place and Rout: Timing Verification
constraint/user.sdc Cd L4 v
constraint/mytiming2.sdc L4 4
constraint/myuserl.sdc | d

Figure 37 - Timing Constraint File and Tool Association

4. Edit the constraint in the Interactive Tool, save and exit.
5. The edited constraint is written back to the original constraint file when the tool exits.

Refer to the Timing Constraints Editor User's Guide (Help > Constraints Editor User's Guide) for details on how to
enter/modify timing constraints.

Note: When a constraint file is edited inside an Interactive Tool, the Constraint Manager is disabled until the
Interactive Tool is closed.

Note: Making changes to a constraint file invalidates the state of the tool with which the constraint file is
associated. For instance, if Place and Route has successfully completed with user.sdc as the associated
constraint file, then making changes to user.sdc invalidates Place and Route. The green checkmark (denoting
successful completion) next to Place and Route turns into a warning icon when the tool is invalidated.

Constraint Types

Libero SoC manages four types of constraints:

o 1/O Attributes Constraints — Used to constrain placed I/Os in the design. Examples include setting I/O
standards, I/O banks, and assignment to Package Pins, output drive, and so on. These constraints are used
by Place and Route.

+ Timing Constraints — Specific to the design set to meet the timing requirements of the design, such as
clock constraints, timing exception constraints, and disabling certain timing arcs. These constraints are
passed to Synthesis, Place and Route, and Timing Verification.

¢ Floor Planner Constraints — Non-timing floorplanning constraints created by the user or Chip Planner and
passed to Place and Route to improve Quality of Routing.
o Netlist Attributes - Microsemi-specific attributes that direct the Synthesis tool to synthesize/optimize the,

leveraging the architectural features of the Microsemi devices. Examples include setting the fanout limits,
specifying the implementation of a RAM, and so on. These constraints are passed to the Synthesis tool only.

The following table summarizes the features and specifics of each constraint type.
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Constraint File Location File User Constraints Constraints | Changes
Type Ext. Actions Edited By Used By Invalidate
Design
State?

/O <proj>/constraints/io | *.pdc | Create I/O Editor Place and YES
Attributes folder New, Route

Import, Or user editing

Link, Edit, | the *.pdc file in

Check Text Editor
Timing <proj>/constraints *sdc | Create Constraint Synplify YES
Constraints | folder New, Editor

Imoort Place and

nporL, i Route
Link, Edit, Or user editing
Check the *.sdf; file in Verify Timing
Text Editor (SmartTlme)

Floor <proj>/constraints/fp | *.pdc | Create Chip Planner Place and YES
Planner folder New, Route
Constraints Import, Or user Editing

Link, Edit, | the *.pdc file in

Check Text Editor
Netlist <proj>/constraints *fdc | Create User to Open in | Synplify YES
Attributes folder New, Text Editor to

Import, Edit

Link,

Check
Netlist <proj>/constraints *.ndc | Import, User to Open in | Synplify YES
Attributes folder Link, Text Editor to

Check Edit

Constraint Manager — I/O Attributes Tab

The I/O Attributes tab allows you to manage I/O attributes/constraints for your design’s Inputs, Outputs, and
Inouts. All I/O constraint files (PDC) have the *.pdc file extension and are placed in the
<Project_location>/constraint/io folder.

Available actions are:

o New - Creates a new I/O PDC file and saves it into the <Project_location>\constraint\io folder. There are
two options:

e Create New /O Constraint

e Create New I/O Constraint From Root Module -- This will pre-populate the PDC file with information
from the Root Module

e Having selected the create method:
o When prompted, enter the name of the constraint file.
e The file is initially opened in the text editor for user entry.

e Import — Imports an existing /O PDC file into the Libero SoC project. The I/O PDC file is copied into the
<Project_location>\constraint\io folder.

e Link — Creates a link in the project’s constraint folder to an existing I/O PDC file (located and maintained
outside of the Libero SoC project).

o Edit — Opens the I/O Editor tool to modify the I/O PDC file(s) associated with the Place and Route tool.
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View - Opens the I/O Editor tool to view the /O PDC file(s) associated with the Place and Route tool. You
cannot save/commit any changes made to the constraints file. However, you can export the PDC file(s)
using the 1/O Editor.

Check — Checks the legality of the PDC file(s) associated with the Place and Route tool against the gate
level netlist.

When the I/O Editor tool is invoked or the constraint check is performed, all files associated with the Place and
Route tool are being passed for processing.

When you save your edits in the I/O Editor tool, the /O PDC files affected by the change will be updated to reflect
the change you have made in the I/O Editor tool. New I/O constraints you add in the I/O Editor tool are written to
the Target file (if a target file has been set) or written to a new PDC file (if no file is set as target) and stored in the
<project>\constraint\io folder.

VO Attributes | Timing ] Floor Planner | Netlist Attrihukesi

New |' Import J Link I Edit |v View I Check I Help I iiﬂ

| Place and Route |

constraint\io\user.pdc [ Target | ]

¥ Reserve Pins for Device Migration

Select the devices you are targetting for migration. Pins not bonded on these devices will be reserved in the device selected for this
project.

Selected Device: MPF500TS - FCG1152

T MPF300T_ES q
Target Devices: g mEEigg;S_ES
M sancannTc ﬂ

General

¥ Reserve Pins for Probes

Figure 38 - Constraint Manager — I/O Attributes Tab

Right-click the I1/0O PDC files to access the available actions:

Set/UnSet as Target — Sets or clears the selected file as the target to store new constraints created in the
I/O Editor tool. Newly created constraints only go into the target constraint file. Only one file can be set as
target. This option is not available for linked files.

Open in Text Editor — Opens the selected constraint file in the Libero Text Editor.

Clone — Copies the file to a file with a different name. The original file name and its content remain intact.
This option is not available for linked files.

Rename — Renames the file to a different name. This option is not available for linked files.
Copy File Path - Copies the file path to the clipboard.
Delete — Deletes the file from the project and from the disk. This option is not available for linked files.

Unlink - Removes the linked file from the project. The original file is untouched. This option is only available
for linked files.

Unlink: Copy file locally — Removes the link and copies the file into the <Project_location>\constraint\io
folder. This option is only available for linked files.

File and Tool Association

Each I/O constraint file can be associated or disassociated with the Place and Route tool.

Click the checkbox under Place and Route to associate/disassociate the file from the tool.
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/0 Settings

Reserve Pins for Device Migration — This option allows you to reserve pins in the currently selected device that
are not bonded in a device or list of devices you may later decide to migrate your design to. Select the target
device(s) you may migrate to later to ensure that there will be no device/package incompatibility if you migrate
your design to that device.

Reserve Pins for Probes — Check this box if you plan to use live probes when debugging your design with
SmartDebug.

Constraint Manager — Timing Tab

The Timing tab allows you to manage timing constraints throughout the design process. Timing constraints files
(SDC) have the *.sdc file extension and are placed in the <Project_location>\constraint folder.

Available actions are:
¢ New - Creates a new timing SDC file and saves it into the <Project_location>\constraint folder.
o When prompted, enter the name of the constraint file.
o The file is initially opened in the text editor for user entry.

B " Create New SDC ? X

Name:
[
Help Cancel

Figure 39 - Create New SDC Dialog Bob

¢ Import — Imports an existing timing SDC file into the Libero SoC project. The timing SDC file is copied into
the <Project_location>\constraint folder.

e Link — Creates a link in the project’s constraint folder to an existing timing SDC file (located and maintained
outside of the Libero SoC project).

o Edit — Opens the Timing Constraints Editor (see Timing Constraints Editor User Guide for details) to
modify the SDC file(s) associated with one of the three tools:

o Synthesis — When selected, the timing SDC file(s) associated with the Synthesis tool is loaded in
the constraints editor for editing.

o Place and Route - When selected, the timing SDC file(s) associated with the Place and Route tool
is loaded in the constraints editor for editing.

o Timing Verification - When selected, the timing SDC file(s) associated with the Timing Verification
tool is loaded in the constraints editor for editing.

1O Attrbutes  Timina | Fioor Planner | Netist Attributes|

New | wmpot | uk | Est [+ ched |v Derweconstants| consvantcoversge Y nep | 2| #]

e ytuesstotstat s loute | Timing Verification |

Edit Place And Route Constraints
Edit Timing Verification Constraints

constraint\user.sdc [ Target |

Figure 40 - Timing Constraints Edit Options in Constraint Manager
e Check — Check the legality of the SDC file(s) associated with one of the three tools described below:
o Synthesis — The check is performed against the pre-synthesis HDL design.
o Place and Route — The check is performed against the post-synthesis gate level netlist.
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o Timing Verification — The check is performed against the post-synthesis gate level netlist.

1/0 Attributes  Timing ismmﬂ Netiist Attributes |

New I Import ‘ Link | Edit |v Check |v Derive Cmstrants| Constraint Coverage |v Help I ﬁ ﬂ
| Syn Check Synthesis Constraints Lification J
constraint\user.sdc_[ Target | (] Check Place And Route Constraints
Check Timing Verification Constraints

Figure 41 - Timing Constraints Check Options in Constraint Manager

e Derive Constraints — When clicked, Libero generates a timing SDC file based on user configuration of IP
core, components and component SDC. It generates the create_clock and create_generated_clock SDC
timing constraints. This file is named <top_level_> derived_constraints.sdc. The component SDC and the
generated <root>_derived_constraint.sdc files are dependent on the IP cores and vary with the device
family.

Examples:
create -name {REF CLK PAD 0O} -period 5 [ get ports { REF CLK PAD 0 } ]

create generated clock -name {PF TX PLL 0/txpll isnt 0/DIV_CLK} -divide by 2 -
source [ get pins { PF_TX PLL O0/txpll isnt O/REF CLK P } ] [ get pins {
PF TX PLL 0/txpll isnt 0/DIV_CLK } ]

e Constraint Coverage - When clicked, a pull-down list displays. Select the Constraint Coverage Reports you
want:

o Generate Place and Route Constraint Coverage Report
o Generate Timing Verification Constraint Coverage Report

10 Attrbutes  Timina | Floor Planner | Netist Atiributes|

new | mmport | wk | Eat || cred: [ DeriveConstrants| constrantCoverage [+ Heb +| €|
E Synthesis I Pl Raate | 1 Generate Place and Route Constraint Coverage
constraint\usersdc [ Target | ] @] 3 Generate Timing Verification Constraint Coverage

Figure 42 - Constraint Coverage Options for Timing Constraints in Constraint Manager

Note: Constraint Coverage Reports can be generated only after synthesis. A warning message
appears if the design is not in the post-synthesis state when this button is clicked.

The generated report will be visible in the respective nodes of the report view (Design > Reports).
When the SmartTime Constraint Editor tool is invoked or the constraint check is performed all the files associated
with the targeted tool — Synthesis, Place and Route, Timing Verification — are being passed for processing.
When you save your edits in the SmartTime Constraint Editor tool, the timing SDC files affected by the change
are updated to reflect the changes you have made in the SmartTime Constraints Editor tool. New timing

constraints you add in the SmartTime Constraint Editor tool are written to the Target file (if a target file has been
set) or written to a new SDC file (if no file is set as target) and stored in the <project>\constraint folder.

New | mpot | wk | Est [+ check [¥| Deriveconstraints| ConstantCoverage [¥Y|  Hep | 4| ¢
ISynthesis IPIece and Route ETiming Verification |
constraint\TVS_Demo_derived_constraints.sdc O | O

constraint\prep1_derived_constraints.sdc
constraint\newtiming.sdc [ Target ]
constraint\prep1_sdc.sdc

o®
O=E
EE

Figure 43 - Constraint Manager — Timing Tab
Right-click the timing SDC files to access the available actions for each constraint file:

e Set/Unset as Target — Sets or clears the selected file as the target to store new constraints created in the
SmartTime Constraint Editor tool. Newly created constraints only go into the target constraint file. Only one
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file can be set as target, and it must be a PDC or SDC file. This option is not available for the derived
constraint SDC file. This option is not available for linked files.

e Open in Text Editor — Opens the selected constraint file in the Libero Text Editor.

o Clone - Copies the file to a file with a different name. The original file name and its content remain intact.
This option is not available for linked files.

o Rename - Renames the file to a different name. This option is not available for linked files.
e Copy File Path - Copies the file path to the clipboard.

o Delete - Deletes the selected file from the project and from the disk. This option is not available for linked
files.

e Unlink - Removes the linked file from the project. The original file is untouched. This option is only available
for linked files.

« Unlink: Copy file locally — Removes the link and copies the file into the <Project_location>\constraint
folder. This option is only available for linked files.

File and Tool Association

Example

Each timing constraint file can be associated or disassociated with any one, two, or all three of the following tools:
e Synthesis
e Place and route
e Timing Verification

Click the checkbox under Synthesis, Place and Route, or Timing Verification to associate/disassociate the file
from the tool.

When a file is associated, Libero passes the file to the tool for processing.

[ /0 Attributes \/ Timing \[" Floor Planner \/”Netlist Attributes \

'-l: New Import Link Edit with Constraint Editor i" Check ‘L" Derive Constraints | | Constraint Coverage ll\' Help 4 I
Synthesis Place and Routt Timing Verification

constraint/top_derived_constraints.sdc Ci ¥ ¥

constraint/user.sdc ¥ v

constraint/mytiming.sdc v v

constraint/mytiming2.sdc v v v

constraint/sdfsadf.sdc

Figure 44 - File and Tool Association Example

In the context of the graphic above, when Edit Synthesis Constraint is selected, user.sdc,
top_derived_constraints.sdc, and mytiming2.sdc are read (because these three files are associated with
Synthesis); mytiming.sdc and sdfsadf.sdc are not read (because they are not associated with Synthesis). When
the SmartTime Constraint Editor opens for edit, the constraints from all the files except for sdfsadf.sdc are read
and loaded into the Constraint Editor. Any changes you made and saved in the Constraint Editor are written back
to the files.

Note: sdfsadf.sdc Constraint File is not checked because it is not associated with any tool.

Derived Constraints

Libero SoC is capable of generating SDC timing constraints for design components when the root of the design
has been defined. Click Derive Constraints in the Constraint Manager's Timing tab to generate SDC timing
constraints for your design’s components.

The generated constraint file is named <root>_derived.sdc and is created by instantiating component SDC files
created by IP configurators (e.g., CCC) and oscillators used in the design.
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The <root>_derived.sdc file is associated by default to the Synthesis, Place and Route and Timing Verification
tool. You can change the file association in the Constraint Manager by checking or unchecking the checkbox
under the tool.

To generate SDC timing constraints for IP cores:
Configure and generate the IP Core.

From the Constraint Manager's Timing tab, click Derive Constraints (Constraint Manager > Timing >
Derive Constraints).

The Constraint Manager generates the <root>_derived_constraints.sdc file and places it in the Timing Tab
along with other user SDC constraint file.

When prompted for a Yes or No on whether or not you want the Constraint Manager to

automatically associate the derived SDC file to Synthesis, Place and Route, and Timing Verification, click
Yes to accept automatic association or No and then check or uncheck the appropriate checkbox for tool
association.

Note: Microsemi recommends the <root>_derived_constraints.sdc be always associated with all three tools:
Synthesis, Place and Route, and Verify Timing. Before running SynplifyPro Synthesis, associate the
<root>_derived_constraints.sdc file with Synthesis and Place and Route. This will ensure that the design
objects (such as nets and cells) in the <root>_derived_constraints.sdc file are preserved during the
synthesis step and the subsequent Place and Route step will not error out because of design object
mismatches between the post-synthesis netlist and the <root>_derived_constraints.sdc file.

Note: Full hierarchical path names are used to identify design objects in the generated SDC file.

Note: The Derive Constraints button is available for HDL-based and SmartDesign-based design flows. It is not
available for Netlist Designs (Project > Project Settings > Design Flow > Enable Synthesis [not checked]).

Constraint Manager — Floor Planner Tab

The Floor Planner tab allows you to manage floorplanning constraints. Floorplanning constraints files (PDC) have
the *.pdc file extension and are placed in the <Project_location>\constraint\fp folder.

Available actions are:

New — Creates a new floorplanning PDC file and saves it into the <Project_location>\constraint\fp folder.
Import — Imports an existing floorplanning PDC file into the Libero SoC project. The floorplanning PDC file is
copied into the <Project_location>\constraint\fp folder.

Link — Creates a link in the project’s constraint folder to an existing floorplanning PDC file (located and
maintained outside of the Libero SoC project).

Edit — Opens the Chip Planner tool to modify the floorplanning PDC file(s) associated with the Place and
Route tool.

View - Opens the Chip Planner tool to view the floorplanning PDC file(s) associated with the Place and
Route tool. You cannot save/commit any changes made to the constraints file. However, you can export the
PDC file(s) using Chip Planner.

Check — Checks the legality of the PDC file(s) associated with the Place and Route tool against the gate
level netlist.

When the Chip Planner tool is invoked or the constraint check is performed, all files associated with the Place and
Route tool are passed for processing.

When you save your edits in the Chip Planner tool, the floorplanning PDC files affected by the change are
updated to reflect the change you made in the Chip Planner tool. New floorplanning constraints that you add in
the Chip Planner tool are written to the Target file (if a target file has been set) or written to a new PDC file (if no
file is set as target) and stored in the <project>\constraint\fp folder.
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Figure 45 - Constraint Manager — Floor Planner Tab
Right-click the floorplanning PDC files to access the available actions:

o Set/Unset as Target — Sets or clears the selected file as the target to store new constraints created in the
Chip Planner tool. Newly created constraints only go into the target constraint file. Only one file can be set
as target. This option is not available for linked files.

e Open in Text Editor — Opens the selected constraint file in the Libero Text Editor.

o Clone - Copies the file to a file with a different name. The original file name and its content remain intact.
This option is not available for linked files.

o Rename - Renames the file to a different name. This option is not available for linked files.
e Copy File Path - Copies the file path to the clipboard.

o Delete - Deletes the selected file from the project and from the disk. This option is not available for linked
files.

e Unlink - Removes the linked file from the project. The original file is untouched. This option is only available
for linked files.

* Unlink: Copy file locally — Removes the link and copies the file into the <Project_location>\constraint\fp
folder. This option is only available for linked files.

File and Tool Association
Each floorplanning constraint file can be associated or disassociated to the Place and Route tool.
Click the checkbox under Place and Route to associate/disassociate the file from the tool.
When a file is associated, Libero passes the file to the tool for processing.

See Also
Chip Planner User Guide

Constraint Manager — Netlist Attributes Tab

The Netlist Attributes tab allows you to manage netlist attribute constraints to optimize your design during the
synthesis and/or compile process. Timing constraints should be entered using SDC files managed in the Timing
tab. Netlist Attribute constraints files are placed in the <Project_location>\constraint folder. Libero SoC manages
two types of netlist attributes:

e FDC constraints are used to optimize the HDL design using Synopsys SynplifyPro synthesis engine and
have the *.fdc extension.

o NDC constraints are used to optimize the post-synthesis netlist with the Libero SoC compile engine and
have the *.ndc file extension

Available operations are:

e New — Creates a new FDC or NDC netlist attribute constraints file in the <Project_location>\constraint folder.

o Import — Imports an existing FDC or NDC netlist attribute constraints file into the Libero SoC project. The
FDC or NDC netlist attribute constraints file is copied into the <Project_location>\constraint folder.

e Link — Creates a link in the project’s constraint folder to an existing existing FDC or NDC netlist attribute
constraints file (located and maintained outside of the Libero SoC project).

e Check — Checks the legality of the FDC and NDC file(s) associated with the Synthesis or Compile tools.
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When the constraint check is performed, all files associated with the Synthesis or Compile tools are passed for
processing.

{110 Attrioutes \/ Timing \/ Floor Planner \/” Methst Attributes \

Mew vl [ Import | k| [ chede [v] [ Hep | 1 [#
Synthesis

constraintitest. fde i

constraint\my.ndc ")

Figure 46 - Constraint Manager — Netlist Attributes Tab
Right-click the FDC or NDC files to access the available actions:

e Open in Text Editor — Opens the selected constraint file in the Libero SoC Text Editor.

o Clone - Copies the file to a file with a different name. The original file name and its content remain intact.
This option is not available for linked files.

¢ Rename - Renames the file to a different name. This option is not available for linked files.
o Copy File Path - Copies the file path to the clipboard.
o Delete — Deletes the file from the project and from the disk. This option is not available for linked files.

o Unlink - Removes the linked file from the project. The original file is untouched. This option is only available
for linked files.

« Unlink: Copy file locally — Removes the link and copies the file into the <Project_location>\constraint
folder. This option is only available for linked files.

File and Tool Association
Each netlist attributes constraint file can be associated with or disassociated from the Synthesis tool.
Click the checkbox under Synthesis (Compile) to associate/disassociate the file from Synthesis (Compile).
When a file is associated, Libero passes the file to Synthesis (Compile) for processing when Synthesis is run.

When Synthesis is ON (Project > Project Settings > Design Flow > Enable synthesis [checked]) for a project, the
Design Flow Synthesis action runs both the synthesis engine and the post-synthesis compile engine.

When Synthesis is OFF (Project > Project Settings > Design Flow > Enable synthesis [not checked]) for a project,
the Design Flow Synthesis action is replaced by the Compile action and runs the compile engine on the gate-level
netlist (EDIF or Verilog) available in the project.
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Implement Design

Synthesize
Double-click Synthesize to run synthesis on your design with the default settings specified in the synthesis tool.
If you want to run the synthesis tool interactively, right-click Synthesize and choose Open Interactively. If you
open your tool interactively, you must complete synthesis from within the synthesis tool.
The default synthesis tool included with Libero SoC is Synplify Pro ME. If you want to use a different synthesis
tool, you can change the settings in your Tool Profiles.
You can organize input synthesis source files via the Organize Source Files dialog box.

Synthesize Options
Some families enable you to set or change synthesis configuration options for your synthesis tool. To do so, in the
Design Flow window, expand Implement Design, right-click Synthesize and choose Configure Options. This

opens the Synthesize Options dialog box.
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7 Synthesize Options @

—Global Mets
Minimurm number of dodk pins: |2
Minimum number of asynchronous pins: IBDD
Minimurn fanout of non-dock nets to be kept on globals: IEDUU
Mumber of global resources: |24

Maximum number of global nets that could be demoted to row-globals: IlE

Minimurn fanout of global nets that could be demoted to row-globals: IlUUD

—Optimizations
™ Enable retiming

[ Enable automatic compile point

RAM optimized for: * High speed " Low power
Map seg-shift register components to; " Registers * RAMG4x12
Map ROM components to: i« Loagic " RaM

—Additional options for SynplifyPro synthesis

script file: I _|

Additional options:

Help | oK Cancel

Figure 47 - Synthesize Options Dialog Box

HDL Synthesis Language Settings

HDL Synthesis language options are no longer specified in this dialog box. Please refer to Project Settings:
Design Flow Options.
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Global Nets (Promotions and Demotions)

Use the following options to specify to the Synthesis tool the threshold value beyond which the Synthesis tool
promotes the pins to globals:
e Minimum number of clock pins — Specifies the threshold value for Clock pin promotion. The default value
is 2.
¢ Minimum number of asynchronous pins — Specifies the threshold value for Asynchronous pin promotion.
The default is 800 for PolarFire.

o Minimum fanout of non-clock nets to be kept on globals — Specifies the threshold value for data pin
promotion to global resources. It is the minimum fanout of non-clock (data) nets to be kept on globals (no
demotion). The default is 5000 (must be between 1000 and 200000).

o Number of global resources — This can be used to control number of Global resources you want to use in
your design. By default this displays the number of available global resources for the die you have selected
for the project and varies with different die sizes. For PolarFire, the default is 24 for all dies.

o Maximum number of global nets that could be demoted to row-globals — Specifies the maximum
number of global nets that could be demoted to row-globals. The default is 16 (must be between 0 to 50).

e Minimum fanout of global nets that could be demoted to row-globals — Specifies the minimum fanout of
global nets that could be demoted to row-global. It is undesirable to have high fanout nets demoted using
row globals because it may result in high skew. The default is 300. (Must be between 25 to 5000). If you run
out of global routing resources for your design, reduce this number (to allow more globals to be demoted to
Row Globals) or select a bigger die for your design.

Note: Hardwired connections to global resources, such as CCC hardwired connections to GB , IO Hardwired
connections to GB, and so on, cannot be controlled by these options.

Optimizations

Enable retiming — Check this box to enable Retiming during synthesis. Retiming is the process of automatically
moving registers (register balancing) across combinational gates to improve timing, while ensuring identical logic
behavior. The default is no retiming during synthesis.

Enable automatic compile point — Check this box to enable Automatic Compile Point during synthesis. The
Automatic Compile Point is disabled by default .

RAM optimized for:
Use this option to guide the Synthesis tool to optimize RAMs to achieve your design goal.

o High speed — RAM Optimization is geared towards Speed. The resulting synthesized design achieves
better performance (higher speed) at the expense of more FPGA resources.

e Low power — RAM Optimization is geared towards Low Power. RAMs are inferred and configured to ensure
the lowest power consumption.

Map seq-shift register components to:
Use this option to select the mapping of sequential logic:
o Registers — When selected, sequential shift logic in the RTL is mapped to registers.

¢ RAM64x12 — When selected, sequential shift logic in the RTL is mapped to a 64x12 RAM block. This is the
default setting.

Map ROM components to:

Use this option to select the mapping of ROM components. Libero default is to map ROM components to Logic
during synthesis.

e Logic - When selected, ROM components will be mapped to Logic.
¢ RAM - When selected, ROM components will be mapped to RAM.
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Additional options for Synplify Pro synthesis

Script File

Click the Browse L"""! button to navigate to a Synplify Tcl file that contains the Synplify Pro-specific options.
Libero passes the options in the Tcl file to Synplify Pro for processing.
Additional Options
Use this field to enter additional Synplify options. Put each additional option on a separate line.
Note: Libero passes these additional options “as-is” to Synplify Pro for processing; no syntax checks are
performed. All of these options are set on the Active Implementation only.
The list of recommended Synthesis Tcl options below can be added or modified in the Tcl Script File or Additional
Options Editor.
Note: The options from the Additional Options Editor will always have priority over the Tcl Script file options if they
are same.

set _option -use fsm explorer 0/1

set_option -frequency 200.000000

set_option -write verilog 0/1

set option -write vhdl 0/1

set _option -resolve multiple driver 1/0

set_option -rw_check on_ram 0/1

set _option -auto_constrain io 0/1

set _option -run prop extract 1/0

set option -default enum encoding default/onehot/sequential/gray

set_option -maxfan 30000

set option -report path 5000

set_option -update models cp 0/1

set _option -preserve registers 1/0

set_option -continue_on_error 1/0

set_option -symbolic_fsm compiler 1/0

set_option -compiler compatible 0/1

set_option -resource_sharing 1/0

set_option -write apr constraint 1/0

set _option -dup 1/0

set option -enable6d4bit 1/0

set_option -fanout limit 50

set option -frequency auto

set_option -hdl _define SLE_INIT=2

set _option -hdl param -set "width=8"

set option -looplimit 3000

set _option -fanout guide 50

set_option -maxfan hard 1/0

set option -num critical paths 10

set _option -safe case 0/1

set option -automatic compile point 1
Any additional options can be entered through the Script File or Additional Options Editor. All of these options can
be added and maodified outside of Libero through interactive SynplifyPro.
Refer to the Synplify Pro Reference Manual for detailed information about the options and supported families.
The following options are already set by Libero. Do not include them in the additional options field or Script File:

add file <*>

impl <*>

project folder <*>
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add folder <*>

constraint file <*>

project <*>

project file <*>

open_file <*>

set option -part

set option -package

set_option -speed grade

set option -top module

set_option -technology

set_option -opcond

set option -vlog std

set_option -vhdl2008

set_option -disable io_insertion
set option -async globalthreshold
set_option -clock globalthreshold
set option -globalthreshold

set option -low power ram decomp
set_option -retiming

set option -automatic compile point

Synplify Pro ME
Synplify Pro ME is the default synthesis tool for Libero SoC.

To run synthesis using Synplify Pro ME and default settings, right-click Synthesize and choose Run.

If you wish to use custom settings you must run synthesis interactively.

w

To run synthesis using Synplify Pro ME with custom settings:

If you have set Synplify as your default synthesis tool, right-click Synthesize in the Libero SoC Design Flow
window and choose Open Interactively. Synplify starts and loads the appropriate design files, with a few
pre-set default values.

From Synplify’s Project menu, choose Implementation Options.

Set your specifications and click OK.

Deactivate synthesis of the defparam statement. The defparam statement is only for simulation tools and is
not intended for synthesis. Embed the defparam statement in between translate_on and translate_off

synthesis directives as follows :
/* synthesis translate off */
defparam MO.MEMORYFILE = "meminit.dat"

/*synthesis translate_on */

// rest of the code for synthesis

Click the RUN button. Synplify compiles and synthesizes the design into an HDL netlist. The resulting *.vm
files are visible in the Files list, under Synthesis Files.

Should any errors appear after you click the Run button, you can edit the file using the Synplify editor.
Double-click the file name in the Synplify window showing the loaded design files. Any changes you
make are saved to your original design file in your project.
From the File menu, choose EXxit to close Synplify. A dialog box asks you if you would like to save any
settings that you have made while in Synplify. Click Yes.
Note: See the Microsemi Attribute and Directive Summary in the Synplify online help for a list of attributes
related to Microsemi devices.

Note: To add a clock constraint in Synplify you must add "n:<net_name>"in your SDC file. If you put the
net_name only, it does not work.
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Identify Debug Design

Libero SoC integrates the Identify RTL debugger tool. It enables you to probe and debug your FPGA design
directly in the source RTL. Use Identify software when the design behavior after programming is not in
accordance with the simulation results.

To open the Identify RTL debugger, in the Design Flow window under Debug Design double-click Instrument
Design.

Identify features:
e Instrument and debug your FPGA directly from RTL source code.
o Internal design visibility at full speed.

e Incremental iteration - Design changes are made to the device from the Identify environment using
incremental compile. You iterate in a fraction of the time it takes route the entire device.

e Debug and display results - You gather only the data you need using unique and complex triggering
mechanisms.

You must have both the Identify RTL Debugger and the Identify Instrumentor to run the debugging flow outlined
below.

To use the Identify Instrumentor and Debugger:

—_

Create your source file (as usual) and run pre-synthesis simulation.

(Optional) Run through an entire flow (Synthesis - Compile - Place and Route - Generate a Programming
File) without starting Identify.

Right-click Synthesize and choose Open Interactively in Libero SoC to launch Synplify.
In Synplify, click Options > Configure Identify Launch to setup Identify.
In Synplify, create an Identify implementation; to do so, click Project > New Identify Implementation.

In the Implementations Options dialog, make sure the Implementation Results > Results Directory points to
a location under <libero project>\synthesis\, otherwise Libero SoC is unable to detect your resulting Verilog
Netlist file.

7. From the Instumentor Ul specify the sample clock, the breakpoints, and other signals to probe. Synplify
creates a new synthesis implementation. Synthesize the design.

8. InLibero SoC, run Synthesis, Place and Route and Generate a Programming File.
Note: Libero SoC works from the edif netlist of the current active implementation, which is the
implementation you created in Synplify for Identify debug.

n

o ok w

9. Double-click Identify Debug Design in the Design Flow window to launch the Identify Debugger.

The Identify RTL Debugger, Synplify, and FlashPro must be synchronized in order to work properly. See the
Release Notes for more information on which versions of the tools work together.

Verify Post-Synthesized Design

Generate Simulation File
This step generates the post-synthesis *.v Verilog or *.vhd VHDL netlist for post-synthesis simulation. Post-
synthesis simulation verifies the post-synthesis implementation of the design.

The netlist file is located in the synthesis folder of the project. Libero SoC passes this file to the simulator for the
post-synthesis simulation run. This step must be preceded by a successful synthesis. If synthesis is not yet run,
generating Simulation Files automatically initiates a synthesis run as a requirement to this step

Verify Post-Synthesis Implementation - Simulate

The steps for performing functional (post-synthesis) and timing (post-layout) simulation are nearly identical.
Functional simulation is performed before place-and-route and simulates only the functionality of the logic in the
design. Timing simulation is performed after the design has gone through place-and-route and uses timing
information based on the delays in the placed and routed designs.

Note: Post-Layout Simulation is not supported for PolarFire Family.
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To perform functional simulation:

1. If you have not done so, back-annotate your design and create your testbench.
2. Right-click Simulate (in the Design Flow window, Implement Design > Verify Post-Synthesis Implementation
> Simulate) and choose Organize Input Files > Organize Simulation Files from the right-click menu.

In the Organize Files for Source dialog box, all stimulus files in the current project appear in the
Source Files in the Project list box. Files already associated with the block appear in the Associated
Source Files list box.
In most cases you will only have one testbench associated with your block. However, if you want
simultaneous association of multiple testbench files for one simulation session, as in the case of PCI
cores, add multiple files to the Associated Source Files list.
To add a testbench: Select the testbench you want to associate with the block in the Source Files in
the Project list box and click Add to add it to the Associated Source Files list.
To remove a testbench: To remove or change the file(s) in the Associated Source Files list box,
select the file(s) and click Remove.
To order testbenches: Use the up and down arrows to define the order you want the testbenches
compiled. The top level-entity should be at the bottom of the list.

3. When you are satisfied with the Associated Simulation Files list, click OK.

4. To start ModelSim ME, right-click Simulate in the Design Hierarchy window and choose Open

Interactively. ModelSim starts and compiles the appropriate source files. When the compilation completes,
the simulator runs for 1 s and the Wave window opens to display the simulation results.

5. Scroll in the Wave window to verify the logic works as intended. Use the cursor and zoom buttons to zoom in
and out and measure timing delays.

6. When you are done, from the File menu, choose Quit.

Compile Netlist

Options

Compile contains a variety of functions that perform legality checking and basic netlist optimization. Compile
checks for netlist errors (bad connections and fan-out problems), removes unused logic (gobbling), and combines
functions to reduce logic count and improve performance. Compile also verifies that your selected device has
sufficient resources to fit your design.

The Compile Netlist step appears in the Design Flow window only after unchecking the Enable Synthesis option in
the Project > Project Settings > Design Flow page. This option is only visible after importing or linking your HDL
Netlist files into the project and building the design hierarchy.

To compile your device with default settings, right-click Compile Netlist in the Design Flow window and choose
Run (or simply double-click Compile Netlist).

During compile, the Log window displays information about your design, including warnings and errors. Libero
SoC issues warnings when your design violates recommended Microsemi design rules. Microsemi recommends
that you address all warnings, if possible, by modifying your design before you continue.

If the design fails to compile due to errors, you must modify the design to remove the errors and re-Compile.

To compile your design with custom settings, right-click Compile Netlist in the Design Flow window and choose
Configure Options.

The Compile Netlist Options sets the threshold value for global resource promotion and demotion when Place and
Route is executed.
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1 Compile Netlist Options |2

Global Promotion

Mumber of global resources: 24

Maximum number of global nets that could be demoted to row-globals: | 16|

Minimum fanout of global nets that could be demoted to row-globals: 1000

Minimum fanout of non-dodk nets to be kept on globals: 5000

Help QK ] I Cancel

Figure 48 - Compile Netlist Options Dialog Box

Number of global resources - The number of available global resources for the die is reported in this field. The
number varies with the die size you select for the Libero SoC project.

The following options allow you to set the maximum/minimum values for promotion and demotion of global routing
resources.

Maximum Number of global nets that could be demoted to row-globals — Specifies the maximum number of
global nets that can be demoted to row-globals. The default is 16.

Minimum fanout of global nets that could be demoted to row-globals — Specifies the minimum fanout of
global nets that can be demoted to row-global. The default is 1000. If you run out of global routing resources for
your design, reduce this number (to allow more globals to be demoted) or select a larger die for your design.

Minimum fanout of non-clock nets to be kept on globals — Specifies the minimum fanout of non-clock (data)

nets to be kept on globals (no demotion). The default is 5000 (valid range is 1000 to 200000). If you run out of
global routing resources for your design, increase this number or select a larger die for your design.

Constraint Flow in Implementation

Design State Invalidation

The Libero SoC Design Flow window displays status icons to indicate the status of the design state. For any
status other than a successful run, the status icon is identified with a tooltip to give you additional information.

Status Tooltip Description Possible Causes/Remedy
Icon
N/A Tool has not NEW state Tool has not run or it has been cleaned.
run yet.
| vf Tool runs Tool runs with no N/A
successfully. errors. PASS state.
‘,3\' Varies with the | Tool runs but with Varies with the tool (e.g., for the Compile Netlist
B tool. Warnings. step, not all I/Os have been assigned and locked).
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Status Tooltip Description Possible Causes/Remedy
Icon
-0 Tool Fails. Tool fails to run. Invalid command options or switches, invalid

design objects, invalid design constraints.

Design State is | Tool state changes Since the last successful run, design source design
l Out of Date. from PASS to OUT OF | files, constraint files or constraint file/tool
DATE. association, constraint files order, tool options,

and/or project settings have changed.

x Timing Timing Verification Design fails Timing Analysis. Design has either set-
Constraints runs successfully but up or hold time violations or both. See PolarFire
have not been | the design fails to meet | FPGA Timing Constraints User Guide on how to
met. timing requirements. resolve the timing violations.

Constraints and Design Invalidation

A tool in the Design Flow changes from a PASS state (green check mark) to an OUT OF DATE state when a
source file or setting affecting the outcome of that tool has changed.

The out-of-date design state is identified by the icon in the Design Flow window.
Sources and/or settings are defined as:

e HDL sources (for Synthesis), gate level netlist (for Compile), and Smart Design components

e Design Blocks (*.cxz files) — low-level design units which may have completed Place and Route and re-used
as components in a higher-level design

e Constraint files associated with a tool

e Upstream tools in the Design Flow:

o If the tool state of a Design Flow tool changes from PASS to OUT OF DATE, the tool states of all
the tools below it in the Design Flow, if already run and are in PASS state, also change to OUT OF
DATE with appropriate tooltips. For example, if the Synthesis tool state changes from PASS to
OUT OF DATE, the tool states of Place and Route tool as well as all the tools below it in the Design
Flow change to OUT OF DATE.

o If a Design Flow tool is CLEANED, the tool states of all the tools below it in the Design Flow, if
already run, change from PASS to OUT OF DATE.

o If a Design Flow tool is rerun, the tool states of all the tools below it in the Design Flow, if already
run, are CLEANED.

e Tool Options

o If the configuration options of a Design Flow tool (right-click the tool and choose Configure
Options) are modified, the tool states of that tool and all the other tools below it in the Design Flow,
if already run, are changed to OUT OF DATE with appropriate tooltips.

o Project Settings:
Device selection

o Device settings
o Design Flow
o Analysis operating conditions

71


https://coredocs.s3.amazonaws.com/Libero/pf_2_2_0/Tool/pf_timing_constr_flow_ug.pdf
https://coredocs.s3.amazonaws.com/Libero/pf_2_2_0/Tool/pf_timing_constr_flow_ug.pdf

PolarFire FPGA Design Flow User Guide

& Microsemi

a A3\ MicrRocHIP company

Setting Changed Note Design Flow Tools Affected New State of the
Affected Design Flow
Tools
Die Part# is All CLEANED/NEW
changed
Package Part# is All CLEANED/NEW
changed
Speed Part# is All CLEANED/NEW
changed
Core Voltage Part# is All CLEANED/NEW
changed
Range Part# is All CLEANED/NEW
changed
Default I/O Technology Synthesize, and all tools below it | OUT OF DATE
Reserve Pins for Place and Route, and all tools OUT OF DATE
Probes below it
PLL Supply Voltage (V) Verify Power, Generate FPGA OUT OF DATE
Array Data and all other “Program
and Debug Design” tools below it
Power On Reset Delay Generate FPGA Array Data and OUT OF DATE
all other “Program and Debug
Design” tools below it
System controller Generate FPGA Array Data and OUT OF DATE
suspended mode all other “Program and Debug
Design” tools below it
Preferred Language None N/A
Enable synthesis All OUT OF DATE
Synthesis gate level Synthesize CLEANED/NEW
netlist format
Reports(Maximum None N/A
number of high fanout
nets to be displayed)
Abort flow if errors are None N/A
found in PDC
Abort flow if errors are None N/A
found in SDC
Temperature range(C) Verify Timing, Verify Power OUT OF DATE
Core voltage range(V) Verify Timing, Verify Power OUT OF DATE
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Setting Changed

Note

Design Flow Tools Affected

New State of the
Affected Design Flow
Tools

Default I/O voltage

range

Verify Timing, Verify Power

OUT OF DATE

¢ Note: Cleaning a tool means the output files from that tool are deleted including log and report files, and

the tool’s state is changed to NEW.

Check Constraints
When a constraint file is checked, the Constraint Checker does the following:

e Checks the syntax

e Compares the design objects (pins, cells, nets, ports) in the constraint file versus the design objects in the

netlist (RTL or post-layout ADL netlist). Any discrepancy (e.g., constraints on a design object which does not
exist in the netlist) are flagged as errors and reported in the *_sdc.log file

Design State and Constraints Check

Constraints can be checked only when the design is in the right state.

Constraint Type | Check for Required Design Netlist Used for Check Result
Tools State Before Design Objects
Checking Checks
I/O Constraints Place and Post-Synthesis ADL Netlist Reported in
Route Libero Log
Window
Floorplanning Place and Post-Synthesis ADL Netlist par_sdc.log
Constraints Route
Timing Synthesis Pre-Synthesis RTL Netlist synthesis_sdc.log
Constraints
Place and Post-Synthesis ADL Netlist par_sdc.log
Route
Timing Post-Synthesis ADL Netlist vt_sdc.log
Verification
Netlist Attributes | FDC Check Pre-Synthesis RTL Netlist Libero Message
Window
Netlist Attributes | NDC Check Pre-Synthesis RTL Netlist Reported in
Libero Log
Window

A pop-up message appears when the check is made and the design flow has not reached the right state.
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%' Information

|23
[0] Please run 'Synthesize’ before executing Chedk: Cperation

b 5

Figure 49 - Pop-Up message: Design State insufficient for Constraints Check operation

Edit Constraints

Click the Edit with I/O Editor/Chip Planner/Constraint Editor button to edit existing and add new constraints.
Except for the Netlist Attribute constraints (*.fdc and *.ndc) file, which cannot be edited by an interactive tool, all
other constraint types can be edited with an Interactive Tool. The *.fdc and *.ndc files can be edited using the
Libero SoC Text Editor.
The I/0O Editor is the interactive tool to edit I/O Attributes, Chip Planner is the interactive tool to edit Floorplanning
Constraints, and the Constraint Editor is the interactive tool to edit Timing Constraints.
For Timing Constraints that can be associated to Synthesis, Place and Route, and Timing Verification, you need
to specify which group of constraint files you want the Constraint Editor to read and edit:

o Edit Synthesis Constraints - reads associated Synthesis constraints to edit.

o Edit Place and Route Constraints - reads only the Place and Route associated constraints.

o Edit Timing Verification Constraints - reads only the Timing Verification associated constraints.
For the three SDC constraints files (a.sdc, b.sdc, and c.sdc, each with Tool Association as shown in the table
below) when the Constraint Editor opens, it reads the SDC file based on your selection and the constraint file/tool
association.

Synthesis Place and Route Timing Verification
a.sdc X X
b.sdc X X
c.sdc [target] X X X

o [Edit Synthesis Constraints reads only the b.sdc and c.sdc when Constraint Editor opens.
o Edit Place and Route Constraints reads a.sdc, b.sdc and c.sdc when Constraint Editor opens.
o Edit Timing Verification Constraints reads a.sdc and c.sdc when Constraint Editor opens.

Constraints in the SDC constraint file that are read by the Constraint Editor and subsequently modified by you will
be written back to the SDC file when you save the edits and close the Constraint Editor.

When you add a new SDC constraint in the Constraint Editor, the new constraint is added to the c.sdc file,
because it is set as target. If no file is set as target, Libero SoC creates a new SDC file to store the new

constraint.

Constraint Type and Interactive Tool

Constraint Type

Interactive Tool For
Editing

Design Tool the
Constraints File is
Associated

Required Design
State Before
Interactive Tool
Opens for Edit

/0O Constraints

I/O Editor

Place and Route Tool

Post-Synthesis
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Constraint Type

Interactive Tool For
Editing

Design Tool the
Constraints File is
Associated

Required Design
State Before
Interactive Tool
Opens for Edit

Floorplanning
Constraints

Chip Planner

Place and Route Tool

Post-Synthesis

Timing Constraints

SmartTime Constraints
Editor

Synthesis Tool
Place and Route

Timing Verification

Pre-Synthesis
Post-Synthesis
Post-Synthesis

Compile Netlist
Constraint (*.ndc)

Available Open the Text
Editor to edit.

Netlist Attributes Interactive Tool Not Synthesis Pre-Synthesis
Synplify Netlist Available Open the Text

Constraint (*.fdc) Editor to edit.

Netlist Attributes Interactive Tool Not Synthesis Pre-Synthesis

Note: If the design is not in the proper state when Edit with <Interactive tool> is invoked, a pop-up message

appears.

#

# | Information

[ ox ]

=

S

-oi Please run 'Synthesize' before executing Edit Operation

Note: When an interactive tool is opened for editing, the Constraint Manager is disabled. Close the Interactive

Tool to return to the Constraint Manager.

Place and Route

Double-click Place and Route to run Place and Route on your design with the default settings.

Place and Route Options

To change your Place and Route settings from the Design Flow window, expand Implement Design, right-click

Place and Route and choose Configure Options. This opens the Layout Options dialog box.
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e Layout Options

- ¥ Timing-driven
™ Power-driven
[T 1/0 Register Combining
v Global Pine Demation
[ Driver Replication
[~ High Effort Layout

[ Repair Minimum Delay Violations

[T Incremental Layout

[ Use Multiple Passes

Configure... |

Help I

Ok

Cancel

Figure 50 - Layout Options Dialog Box
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57 (¥yout Options (=]
[+ Timing-driven
| Power-driven
[ IO Register Combining
Iv Global Fins Demotion
[ Driver Replication
[ High Effort Layout

[ Repair Minimum Delay Violations

[ Incremental Layout

[ Use Multiple Passes

Configure...

Block Creation

Mumber of row-global resources | 18

Help QK Cancel

Figure 51 - Layout Options Dialog Box - with Block Flow enabled

Timing-Driven

Timing-Driven Place and Route is selected by default. The primary goal of timing-driven Place and Route is to
meet timing constraints, specified by you or generated automatically. Timing-driven Place and Route typically
delivers better performance than Standard Place and Route.

If you do not select Timing-driven Place and Route, timing constraints are not considered by the software,
although a delay report based on delay constraints entered in SmartTime can still be generated for the design.

Power-Driven

Enable this option to run Power-Driven layout. The primary goal of power-driven layout is to reduce dynamic
power while still maintaining timing constraints.
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I/0 Register Combining

Enable this option to combine any register directly connected to an I/O when it has a timing Constraint. If there
are multiple registers directly connected to a (bi-directional) I/O, select one register to combine in the following
order: input-data, output-data, output-enable.

See the online help for more information.

Global Pins Demotion

This option is selected by default when Timing-Driven Place and Route is enabled. When this option is enabled,
the layout tool selects the most timing critical pins on any Global network and moves them to the source that
drives the Global resource (proactively attempts to improve timing by putting timing-critical pins onto routed
resources).

In addition, if the driver for the global was a fabric register, the driver is replicated. When a driver register is
replicated, the duplicate names are printed. Each set of names should be used in place of the original register in
any specified timing constraint.

Driver Replication

Enable this option to enable an algorithm to replicate critical net drivers to reduce timing violations. The algorithm
prints the list of registers along with the duplicate names. Each set of names should be used in place of the
original register in any specified timing constraint.

High Effort Layout

Enable this option to improve the likelihood of achieving layout success. The layout runtime will increase if you
select this option. Timing performance may suffer as well. Users are urged to consider other methods for
achieving layout success before utilizing this option.

Repair Minimum Delay Violations

Enable this option to instruct the Router engine to repair Minimum Delay violations for Timing-Driven Place and
Route mode (Timing-Driven Place and Route option enabled). The Repair Minimum Delay Violations option, when
enabled, performs an additional route that attempts to repair paths that have minimum delay and hold time
violations. This is done by increasing the length of routing paths and inserting routing buffers to add delay to the
top 100 violating paths.

When this option is enabled, Libero adjusts the programmable delays through I/Os to meet hold time
requirements from input to registers. For register-to-register paths, Libero adds buffers.

Libero iteratively analyzes paths with negative minimum delay slacks (hold time violations) and chooses suitable
connections and locations to insert buffers. Not all paths can be repaired using this technique, but many common
cases will benefit.

Even when this option is enabled, Libero will not repair a connection or path which:

e Is a hardwired, preserved, or global net

e Has a sink pin which is a clock pin

e s violating a maximum delay constraint (that is, the maximum delay slack for the pin is negative)
e May cause the maximum delay requirement for the sink pin to be violated (setup violations)

Typically, this option is enabled in conjunction with the Incremental Layout option when a design’s maximum
delay requirements have been satisfied.

Every effort is made to avoid creating max-delay timing violations on worst case paths.

Min Delay Repair produces a report in the implementation directory which lists all of the paths that were
considered.

78



& Microsemi

a A3\ MicrRocHIP company

PolarFire FPGA Design Flow User Guide

If your design continues to have internal hold time violations, you may wish to rerun repair Minimum Delay
Violations (in conjunction with Incremental Layout). This will analyze additional paths if you originally had more
than 100 violating paths.

Incremental Layout

Choose Incremental Layout to use previous placement data as the initial placement for the next run. If a high
number of nets fail, relax constraints, remove tight placement constraints, deactivate timing-driven mode, or select
a bigger device and rerun Place and Route.

You can preserve portions of your design by employing Compile Points, which are RTL partitions of the design
that you define before synthesis. The synthesis tool treats each Compile Point as a block which enables you to
preserve its structure and timing characteristics. By executing Layout in Incremental Mode, locations of
previously-placed cells and the routing of previously-routed nets is preserved. Compile Points make it easy for
you to mark portions of a design as black boxes, and let you divide the design effort between designers or teams.
See the Synopsys FPGA Synthesis Pro ME User Guide for more information.

Use Multiple Pass

Check Multiple Pass to run multiple pass of Place and Route to get the best Layout result. Click Configure to
specify the criteria you want to use to determine the best layout result. For details see Multiple Pass Layout

Configuration.

Block Creation — Number of row-global resources

This option is available only when the Block Creation option is turned on (Project > Project Settings > Design
Flow > Enable Block Creation). The value entered here restricts the number of row-global resources available in
every half-row of the device. During Place and Route of the block, the tool will not exceed this capacity on any
half-row. The default value is the maximum number of row-globals. If you enter a value lower than the maximum
capacity (the default), the layout of the block will be able to integrate with the rest of the design if they consume
the remaining row-global capacity.

See Also
Multiple Pass Layout Configuration.

extended run_lib

Multiple Pass Layout Configuration

Multiple Pass Layout attempts to improve layout quality by selecting from a greater number of Layout results. This
is done by running individual place and route multiple times with varying placement seeds and measuring the best
results with specified criteria.

o Before running Multiple Pass Layout, save your design.
o Multiple Pass Layout is supported by all families.

o Multiple Pass Layout saves your design file with the pass that has the best layout results. If you want to
preserve your existing design state, you should save your design file with a different name before
proceeding. To do this, from the File menu, choose Save As.

e Four types of reports (timing, maximum delay timing violations, minimum delay timing violations, and power)
for each pass are written to the working directory to assist you in later analysis:

e <root_module_name>_timing_r<runNum>_s<seedIndex>.rpt

e <root_module_name>_timing_violations_r<runNum>_s<seedIndex>.rpt

e <root_module_name>_timing_violations_min_r<runNum>_s<seedIndex>.rpt

e <root_module_name>_power_r<runNum>_s<seedIndex>.rpt

e <root_module_name>_iteration_summary.rpt provides additional details about the saved files.
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To configure your multiple pass options:
1. When running Layout, select Use Multiple Passes in the Layout Options dialog box.
2. Click Configure. The Multi-Pass Configuration dialog box appears.

] Multi-Pass Configuration I. ? -?:hl

Mumber of passes: 5

L

Start at seed index (1 - 101): 11 (=

Measurement:
) Slowest dodk
(™) spedfic dock CLE_ibuffuo0_IOINFF:Y

1 Timing violations

Maximum delay @ Minimum delay
Select by: Total Megative Slack
Stop on first pass without violations
@ Total power

o] [l

Figure 52 - Multi-Pass Configuration Dialog Box
3. Set the options and click OK.

Number of passes: Set the number of passes (iterations) using the slider. 1 is the minimum and 25 is the
maximum. The default is 5.

Start at seed index: Set the specific index into the array of random seeds which is to be the starting point for the
passes. If not specified, the default behavior is to continue from the last seed index that was used.

Measurement: Select the measurement criteria you want to compare layout results against.

o Slowest clock: Select to use the slowest clock frequency in the design in a given pass as the performance
reference for the layout pass.

e Specific clock: Select to use a specific clock frequency as the performance reference for all layout passes.

Timing violations: This is the default. Select Timing Violations to use the pass that best meets the slack or
timing-violations constraints.

Note: You must enter your own timing constraints through SmartTime or SDC.

¢ Maximum delay: Select to examine timing violations (slacks) obtained from maximum delay analysis. This
is the default.

¢ Minimum delay: Select to examine timing violations (slacks) obtained from minimum delay analysis.
o Select by: Worst Slack or Total Negative Slack to specify the slack criteria.
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e When Worst Slack (default) is selected, the largest amount of negative slack (or least amount of
positive slack if all constraints are met) for each pass is identified, and the largest value of all
passes determines the best pass.

o When Total Negative Slack is selected, the sum of negative slacks from the first 100 paths in the
Timing Violations report for each pass is identified, and the largest value of all the passes
determines the best pass. If no negative slacks exist for a pass, the worst slack is used to evaluate
that pass.

e Stop on first pass without violations: Select to stop performing remaining passes if all timing
constraints have been met (when there are no negative slacks reported in the timing violations
report).

e Total power: Select to determine the best pass to be the one that has the lowest total power (static +
dynamic) of all layout passes.

Iteration Summary Report

The file <root_module>_iteration_summary.rpt records a summary of how the multiple pass run was invoked
either through the GUI or extended_run_lib Tcl script, with arguments for repeating each run. Each new run
appears with its own header in the lteration Summary Report with fields RUN_NUMBER and INVOKED AS,
followed by a table containing Seed Index, corresponding Seed value, Comparison data, Report Analyzed, and
Saved Design information.

g0 teaten st @ X Repaty @ X | e 8 X maliv  # K molv & X mady # ¥ =

Figure 53 - lteration Summary Report

See Also
Place and Route
extended run lib

Resource Usage

After layout, you can check the resource usage of your design.

From the Design menu, choose Reports (Design > Reports). Click <design_name>_layout_log.log to open the
log file.

The log file contains a Resource Usage report, which lists the type and percentage of resource used for each
resource type relative to the total resources available for the chip.

Type Used Total Percentage
4LUT 400 86184 0.46
DFF 300 86184 0.34
I/O Register 0 795 0.00
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Type Used Total Percentage

Logic Element 473 86184 0.55

4L UTs are 4-input Look-up Tables that can implement any combinational logic functions with up to four inputs.

The Logic Element is a logic unit in the fabric. It may contain a 4LUT, a DFF, or both. The number of Logic
Elements in the report includes all Logic Elements, regardless of whether they contain 4LUT only, DFF only, or
both.

Overlapping of Resource Reporting

The number of 4LUTs in the report are the total number used for your design, regardless of whether or not they
are combined with the DFFs. Similarly, the number of DFFs in the report are the total number used for your
design, regardless of whether or not they are combined with 4LUT's.

In the report above, there is a total of 473 Logic Elements (LEs) used for the design.

300 of the 473 LEs have DFFs inside, which means 173 (473-300) of them have no DFFs in them. These 173
LEs are using only the 4LUTs portion of the LE.

400 of the 473 LEs have 4LUTs inside, which means 73 (473-400) of them have no 4LUTS in them. These 73
LEs are using only the DFF portion of the LE.

LEs using DFF Only = 473-400 = 73

LEs using 4LUTS only = 473-300= 173

= | 246 (Total of LEs using 4LUTS ONLY or DFF ONLY)

Report’s Overlapped resource = 227 (LEs using both 4LUTS and DFF)

Total number of LEs used = 473

LE Using
DFF
Only
(73)

LE Using
ALUTS Only
(173)

The area where the two circles overlap represents the overlapped resources in the Resource Usage report.
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Global Net Report

The Global Net Report displays all the nets that use the global routing resources of the device. This report is
generated after the Place and Route step and available in XML format in the Reports tab (Libero SoC > Design
> Reports > <design_name>_glb_net_report.xml).

The global routing resources in Microsemi FPGA devices offer a low-skew network for effective distribution of high
fanout nets including clock signals. Global routing resources include the following:

e Fabric CCC
e Global Buffers (GB)

¢ Row Global Buffers (RGB)
E Reports & X ¥

= rammer reports

= rammer
rammer_manifest. txt

<1 sram Global Net Report
sram_manifest.txt

=l sram2 pp— A
sram2_manifest.txt Microsemi Corporation - Microsemi Libero Software Release PolarFire v2. 2SP1 (Version 12 200.35.1)

= Synthesize
synplify.log
,{, rammer.srr
run_options. txt
rammer_dsp_rpt.txt M
rammer_compiie n..Global Nets Information
rammer_compile_n..
¥ rammer_compil

=l Place and Route

I3

Date: Fri Jun 1 10:55:58 2018

From GB Location Net Name Fanout
1 CLK_O_ibuf_RMIEETQA/UO (1165, 162) CLK_D_ibuf_RNIETQA/LO_Y 32
rammer_pinrpt_na
rammer_pinrpt_nu 2| CLK_ibuf_RNIVQO4/UD (1152, 162)  CLK_ibuf_RNIVQO4/UO_Y 16
rammer_bankrpt.rpt
rammer_ioff.xmi
¥ rammer_layout.

110 to GB Connections

(none)

Fabric to GB Connections

From )
From L fon To Net Name Net

1/ CLK_O_ibuf_RNIETQA_CLK_GATING_ANDZ:Y g?;

CLK_0_ibuf_RMIETQAJUD CLK_0_ibuf_Z_CLK_GATING ROU

-
3

Figure 54 - Global Net Report
The Global Net Report has following sections:

Global Nets Information

The GB Location refers to the location of the Global routing resource/instance name of the macro on the chip. The
location is indicated by X-Y co-ordinates of the global resource macro.
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Global Nets Information

From GBLocation Net Name Fanout
1 GB[4] (726, 156) reset_ctri_i/R_core_reset_out RNIFUQG/UC_YWn 35701
2 | GB[8] (734, 139) pll_i/GLO_INST/UD_YWn 35488
3 | GB[15] (741, 156) pll_i/GL3_INST/UO_YWn 2006
4 | GB[13] (739, 156) reset_ctrl_i/R_global_reset RNIOT36/U0_YWn 1848
5 GB[14] (740, 156) pll_i/lGL2_INST/UO_YWn_GEast 1104
6 | GB[2] (724, 156) serdes_i/SERDES_IF_O0/EPCS_1_RX CLK_keep RNIEDL3/U0_YWn 514
7 GB[O] (722, 156) serdes_iI/SERDES _IF_0/EPCS_0_RX CLK keep RNID1JSUD YWn | 513
8 |GB[3] (725, 156) serdes_i/SERDES_IF_0/EPCS_2_RX CLK_keep_RNIFPN1/U0_YWn 511
9 GH[7] (729, 156) serdes_i/pcs_gl 0 pes_O/mx_rst_p_i_0 RMNIST3C/UO_YWn N2
10 GB[11] | (737, 156) serdes_i/pcs_gl_1_pcs_Oimx_rst_n_i_0_RNIAGFA/UO_YWn 310
111 GB[1] | {723, 156) serdes_i/SERDES_IF_O/EPCS_D_TX CLK_keep RNIFLD&/UO YWn | 178
12| GB{5] | (727, 156) serdes_i/SERDES_IF_0/EPCS_2_TX CLK_keep RNIHDI4/UO_YWn 178
13 GB[6] | (728, 156) serdes_I/SERDES_IF_O0/EPCS_1_TX CLK_keep RNIG1G6/U0_YWn | 178
14 GB[10] | (736, 156) SPI_SCLK_ibufl_RNIT4T&/U0_Y Wn_GEast 149
151 GB[9] | (735, 156) SRAM_CQ_ibuf_ RNIBAC/UD_YWn_GEast 111
16 GB[12] (738, 156) SRAM_CQn_ibuf_RNIPMM6/U0_Y Wn_GEast 18

Figure 55 - Global Net Information

/0 to GB Connections

This section lists all the I/Os connected to the Global Resource/instance name of the macro.
/0 to GB Connections

PortName Pin Number /0 Function From From Location To Net Name Net Type Fanout
1/SPLSCLK | D33 | MSIO176NB18 SPI_SCLK JbulUO/U_IOINY | (6, 307) |GB[10] SPI_SCLK bul ROUTED |1
2 SRAM_CQ |G16 DDRIC120NB2/MDDR_DQ_ECCOVCOC_NE1_CLKI3 SRAN_CQ_ibuf UYU_IOIN.Y North 10 #7 (1005, 313) | GB[Y SRAM_CQ_ibuf  ROUTED 1
3 SRAM_CQOn | F16 DDRIO120PB2MDDR_DQ_ECC1/GB12/CCC_NE1_CLKI2 SRAM_COn_ibuffU0/U_IOPAD:Y | North 10 #5 (1002, 313) | GB[12] SRAM_COn_ibuf HARDWIRED | 1

Figure 56 - I/0O to GB Connections

Net type is either routed or hardwired. Hardwired net types are dedicated wiring resources and have lower
insertion delays. Routed net types are implemented using fabric routing resources and the insertion delay
(generally higher than hardwired nets), varies from iteration to iteration.

The I/O function name column describes all the connection details about the 1/0 such as the bank name,
hardwired GB or hardwired CCC connections, if any, and/or dedicated SERDES/DDR connections, if any. For
hardwired connections, the function name (DDRIO120PB2/MDDR_DQ_ECC1/GB12/CCC_NE1_CLKI2) contains
the GB index (GB12 in this case) that matches the GB index in the To column (GBL[12] in this case) whereas for
routed connections the Function name does not contain the proper GB index.

Fabric to GB Connections

This section lists all the nets originating from the fabric to the Global Resources/Instance name of the macro. The
From Location refers to the X-Y co-ordinates of the driver pin of the net. Generally speaking, the nets are routed
nets (not hardwired).
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Fabric to GB Connections

From From Location To Net Name Net Type Fanout
1 .resel_mrl_n'R_:ore_reser_out'o (720, 160) GB[4] |reset_cirl_icore_reset_out ROUTED 1
2 | reset_ctrl_VR_global_resetQ (722, 160) GB[13] | reset_cir_i/global_reset_0 ROUTED 3
3 | serdes_SERDES_IF_(VSERDESIF_INSTINST_SERDESIF_IP.EPCS_RXCLK_1 (72, 2) GB[2] |serdes_VSERDES_IF_(VEPCS_1_RX CLK ROUTED 1
4 | serdes_ISERDES_IF_0/SERDESIF_INSTANST_SERDESIF_IP:EPCS_RXCLK_0 | (72, 2) GBI0] | serdes_ISERDES_IF_VEPCS_0_RX CLK ROUTED 1
5 |serdes_VSERDES_IF_(YSERDESIF_INSTANST_SERDESIF_IP.EPCS_RXCLK[0] (72, 2) GB[3 |serdes_VSERDES_IF_(VEPCS_2 RX_CLK ROUTED 1
6 |serdes_¥pcs_gl_0_pcs_O/m_rsi_n_i_O:Y (269, 54) GB[7] |serdes_i'pcs_gi.0.pcs_O/m_rst_n_i_0_1 ROUTED |1
7 |serdes_iipcs_gl_1_pcs_O/mc_rst_n_i_O:Y (266, 96) GB[11] | serdes_i/pcs_gi.1.pes_0/mx_rst_n_i_0 ROUTED 1
8 | serdes_VSERDES_IF_(/SERDESIF_INSTINST_SERDESIF_IP.EPCS_TXCLK 0 | (72, 2) GB[1] |serdes VSERDES_IF_0/EPCS_0_TX CLK ROUTED 1
9 | serdes_iSERDES_IF_(/SERDESIF_INSTINST_SERDESIF_IP. EPCS_TXCLK[0] | (72, 2) GB[5] | serdes_iISERDES_IF_'EPCS_2 TX CLK ROUTED 1
10| serdes_VSERDES_IF_/SERDESIF_INSTANST_SERDESIF_IP.EPCS_TXCLK 1 (72, 2) GB[6] |serdes_ISERDES IF_(WEPCS_1 TX CLK ROUTED 1

Figure 57 - Fabric to GB connections

CCC to GB Connections

This section lists the nets originating from the Clock Conditioning Circuitry (CCC) outputs (GLx) to the Global
Resources/instance name of the macro. CCC clock outputs are usually hardwired (dedicated connection) to
Global resources (GB) to minimize clock skew.

CCC to GB Connections

From From Location To Net Name  Net Type Fanout
1 pll_i/fCCC_INST/INST_CCC_IP:GLO | CCC-NEO (1428, 302) GB[8] | pll_i/GLO_net HARDWIRED 1
2 pll_i/fCCC_INST/INST_CCC_IP:GL3 | CCC-NEO (1428, 302) GB[15] | pll_i/GL3 net HARDWIRED 1
3 pll_i/CCC_INST/INST_CCC_IP:GL2  CCC-NEO (1428, 302) | GB[14] pl_i/GL2_net HARDWIRED 1

Figure 58 - CCC to GB Connections

CCC Input Connections
This section lists the nets from the 1/O Pins to the CCC inputs.

CCC Input Connections

PortName  Pin Number VO Function From From Location To (Pin Swapped for Back Annotation Only) CCC Location NetName Net Type Fanout
1|FPGA_CLK P | V12 MSIOISPBS/COC_NEO_CLKIO | pil_VCLKO_PAD INST/U_IOPADPIOUT_P East 10 #0 (1455, 112) pll_¥COC. INSTINST GCG IP-CLKD_PAD CCC-NED (1428, 302) fixed_chk | HARDWIRED 1

Figure 59 - CCC Input Connections

Net type can be routed or hardwired. Hardwired net types are dedicated wiring resources and have lower
insertion delays. Routed net types are implemented using fabric routing resources and the insertion delay
(generally higher than that of hardwired nets), varies from iteration to iteration.

The 1/0 function column describes all the connection details about the /O such as the bank name, hardwired GB
or hardwired CCC connections, if any, and/or dedicated SERDES/DDR connections, if any. For hardwired
connections, the 1/0 function name contains the CCC location (CCC_NEO in this case) and the To (Pin
Swapped for Back Annotation Only) column contains the actual input pin of the CCC in the backannotated
netlist.

Local Clock Nets to RGB Connections

This section lists the clock nets from the local clock nets to RGB (Row globals). RGBs are situated on the vertical
stripes of the global network architecture inside the FPGA fabric. The global signals from the GBs are routed to
the RGBs. Each RGB is independent and can be driven by fabric routing in addition to being driven by GBs. This
facilitates the use of RGBs to drive regional clocks spanning a small fabric area, such as the the clock network for
SERDES.
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Local Clock Nets to RGB Connections

From From Location NetName Fanout RGB Location Local Fanout
1/ serdes_ifjpcs_gl 2 pes_Omx_rst_n_i 0¥ (216, 111) serdes_ifpcs_gl.2 pcs_Ofm_rst_n_i_0 0310 1 (364, 72) 15
2 (364, 15) 44
3 (364, 78) 37
4 (364 81) 19
5 | (364, 84) 28
6 | (364, B7) 20
7 (364, 90) 25
8 | (364, 93) 25
9 | (364, 96) 36
10/ (364, 99) 19
11/ (364, 102) 14
12| (364, 111) 17
13| (364, 114) 11

Figure 60 - Local Clock Nets to RGB Connections

The location refers to the X-Y co-ordinates on the chip. The fanout column gives the total fanout of the net and the
local fanout column gives the fanout at the local RGB only. The driver in the From column is routed to different
RGBs each with different local fanout.

The From column refers to the X-Y co-ordinates of the driver of the net. The driver in the From column is routed
to different RGBs each with different local fanout. The Fanout column gives the total fanout of the net and the
Local Fanout column gives the fanout at the local RGB only.

Global Clock Nets to RGB Connections
This section lists all nets from Globals (GBs) to Row Globals (RGBs).

The From location refers to the X-Y co-ordinates on the chip. The Fanout column gives the total fanout of the net
and the Local Fanout column gives the fanout local to RGB. The driver in the From column is hardwired to
different RGBs each with different local fanout.
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Global Clock Nets to RGB Connections

From From Location Net Name
1 GBR[16] (736, 154) clk16_ibuf RNIGIL/UQ_Y

Fanout
5003

[{=T = - TN s~ T & o [ - S U N
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RGB Location Local Fanout

(1166, 114)
(1166, 120)
(1166, 123)
(1166, 129)
(1166, 132)
(1166, 135)
(1166, 138)
(1166, 141)
(1166, 144)
(1166, 147)
(1166, 150)
(1166, 156)
(1166, 159)
(1166, 162)
(1166, 165)
(1166, 168)
(1166, 171)
(1166, 174)
(1166, 177)
(1166, 180)
(1166, 183)
(1166, 186)
(1166, 189)
(1166, 192)
(1166, 195)
(1166, 198)
(1166, 201)

Figure 61 - Global Clock Nets to RGB Connections

Verify Post Layout Implementation
Verify Timing

Verify Timing Configuration

Use this dialog box to configure the ‘Verify Timing’ tool to generate a timing constraint coverage report and
detailed static timing analysis and violation reports based on different combinations of process speed, operating

voltage, and temperature.
For the timing and timing violation reports you can select:
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-
53
40
39
48
50
7
100
64
53
63
39
128
146
146
130
139
146
164
20
145
127
121
127
110
94
30
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¢ Max Delay Static Timing Analysis report based on Slow process, Low Voltage, and High Temperature
operating conditions.

¢ Min Delay Static Timing Analysis report based on Fast process, High Voltage, and Low Temperature
operating conditions.

o Max Delay Static Timing Analysis report based on Fast process, High Voltage, and Low Temperature
operating conditions.

e Min Delay Static Timing Analysis report based on Slow process, Low Voltage, and High Temperature
operating conditions.

¢ Max Delay Static Timing Analysis report based on Slow process, Low Voltage, and Low Temperature
operating conditions.

¢ Min Delay Static Timing Analysis report based on Slow process, Low Voltage, and Low Temperature
operating conditions.

The following figures show examples of the Verify Timing Configuration dialog box for various operating
conditions and report selections.

[N Verify Timing Configuratic @g

Timing Reports

Slow process, Law voltage and High temperature
Max Delay Analysis Timing Report

[] Min Delay Analysis Timing Report

Max Delay Analysis Timing Violations Repart
[] Min Delay Analysis Timing Violations Report 1

Fast process, High voltage and Low temperature

[] Max Delay Analysis Timing Report
Min Delay Analysis Timing Repart
[] Max Delay Analysis Timing Violations Report
Min Delay Analysis Timing Violations Report

Slow process, Low voltage and Low temperature
[7] Max Delay Analysis Timing Report

[] Min Delay Analysiz Timing Report

[] Max Delay Analysis Timing Viclations Repart
[] Min Delay Analysic Timing Violations Repart

Constraints Coverage Report

Generate constraints coverage report

& [

Figure 62 - Verify Timing Configuration Settings
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Types of Timing Reports

From the Design Flow window > Verify Timing, you can generate the following types of reports:

Timing reports — These reports display timing information organized by clock domain. Four types of timing
reports are available. You can configure which reports to generate using the ‘Verify Timing’ configuration dialog
box (Design Flow > Verify Timing > Configure Options). The following reports can be generated:

Max Delay Static Timing Analysis report based on Slow process, Low Voltage, and High Temperature
operating conditions.

Min Delay Static Timing Analysis report based on Fast process, High Voltage, and Low Temperature
operating conditions.

Max Delay Static Timing Analysis report based on Fast process, High Voltage, and Low Temperature
operating conditions.

Min Delay Static Timing Analysis report based on Slow process, Low Voltage, and High Temperature
operating conditions.

Max Delay Static Timing Analysis report based on Slow process, Low Voltage, and Low Temperature
operating conditions.

Min Delay Static Timing Analysis report based on Slow process, Low Voltage, and Low Temperature
operating conditions.

Timing violations reports — These reports display timing information organized by clock domain. Four types of
timing violations reports are available. You can configure which reports to generate using the ‘Verify Timing’
configuration dialog (Design Flow > Verify Timing > Configure Options). The following reports can be
generated:

Max Delay Analysis Timing Violation report based on Slow process, Low Voltage, and High Temperature
operating conditions.

Min Delay Analysis Timing Violation report eport based on Fast process, High Voltage, and Low
Temperature operating conditions.

Max Delay Analysis Timing Violation report based on Fast process, High Voltage, and Low Temperature
operating conditions.

Min Delay Analysis Timing Violation report based on Slow process, Low Voltage, and High Temperature
operating conditions.

Max Delay Analysis Timing Violation report based on Slow process, Low Voltage, and Low Temperature
operating conditions.

Min Delay Analysis Timing Violation report based on Slow process, Low Voltage, and Low Temperature
operating conditions.

Constraints coverage report — This report displays the overall coverage of the timing constraints set on the
current design.

<root>_timing_constraints_coverage.xml (generated by default)
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4 Verify Timing
pf_pcie_to_ddr3_top_max_timing_slow_lv_ht.aml
T pf_pcie_to_ddr3_top_min_timing_slow_kv_ht.xml
V pf_pcie_to_ddr3_top_max_timing_violations_slow_lv_ht.oml
? pf_pcie_to_ddr3_top_min_timing_viclations_slow_hk_htxml
? pf_pcie_to_ddr3_top_max_timing_fast_hv_ltxm|
pf_pcie_to_ddr3_top_min_timing_fast_hv_l.xm]
T pf_pcie_to_ddr3_top_max_timing_violations_fast_hv_[t.xml
v pf_pcie_to_ddr3_top_min_timing_violations_fast_hwv_ltaxm|
7 pf_pcie_to_ddr3_top_max_timing_slow_hv_ltxml
? pf_pcie_to_ddr3_top_min_timing_slow_lv_ltxml
V' pf_pcie_to_ddr3_top_max_timing_violations_slow_lv_it.xml
V' pf_pcie_to_ddr3_top_min_timing_violations_slow_lv_ltxml
pf_pcie_to_ddr3_top_timing_constraints_coverage.xml
pf_pcie_to_ddr3_top_timing_combinational_loopsxml

Report Listing Icon Legend
Icon Definition
v‘ Timing requirement met for this report
x Timing requirement not met (violations) for this
report
‘? Timing report available for generation but has not
been selected/configured for generation

Figure 63 - Reports Example

SmartTime

SmartTime is the Libero SoC gate-level static timing analysis tool. With SmartTime, you can perform complete
timing analysis of your design to ensure that you meet all timing constraints and that your design operates at the
desired speed with the right amount of margin across all operating conditions.

See the Timing Constraints Editor User Guide for help with creating and editing timing constraints.
Static Timing Analysis (STA)

Static timing analysis (STA) offers an efficient technique for identifying timing violations in your design and

ensuring that it meets all your timing requirements. You can communicate timing requirements and timing

exceptions to the system by setting timing constraints. A static timing analysis tool will then check and report
setup and hold violations as well as violations on specific path requirements.

STA is particularly well suited for traditional synchronous designs. The main advantage of STA is that unlike
dynamic simulation, it does not require input vectors. It covers all possible paths in the design and does all the
above with relatively low run-time requirements.

The major disadvantage of STA is that the STA tools do not automatically detect false paths in their algorithms as
it reports all possible paths, including false paths, in the design. False paths are timing paths in the design that do
not propagate a signal. To get a true and useful timing analysis, you need to identify those false paths, if any, as
false path constraints to the STA tool and exclude them from timing considerations.

Timing Constraints
SmartTime supports a range of timing constraints to provide useful analysis and efficient timing-driven layout.
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Timing Analysis
SmartTime provides a selection of analysis types that enable you to:
e Find the minimum clock period/highest frequency that does not result in a timing violations
o |dentify paths with timing violations
e Analyze delays of paths that have no timing constraints
e Perform inter-clock domain timing verification
e Perform maximum and minimum delay analysis for setup and hold checks

To improve the accuracy of the results, SmartTime evaluates clock skew during timing analysis by individually
computing clock insertion delays for each register.

SmartTime checks the timing requirements for violations while evaluating timing exceptions (such as multicycle or
false paths).

SmartTime and Place and Route

Timing constraints impact analysis and place and route the same way. As a result, adding and editing your timing
constraints in SmartTime is the best way to achieve optimum performance.

SmartTime and Timing Reports
From SmartTime > Tools > Reports, the following report files can be generated:
e Timing Report (for both Max and Min Delay Analysis)
e Timing Violations Report (for both Max and Min Delay Analysis)
e Bottleneck Report
e Constraints Coverage Report
¢ Combinational Loop Report

SmartTime and Cross-Probing into Chip Planner

From SmartTime, you can select a design object and cross-probe the same design object in Chip Planner. Design
objects that can be cross-probed from SmartTime to Chip Planner include:

e Ports

e Macros

e Timing Paths
Refer to the SmartTime User’'s Guide for details (Libero SoC > Help > Reference Manual > SmartTime User’s
Guide).

SmartTime and Cross-Probing into Constraint Editor

From SmartTime, you can cross-probe into the Constraint Editor. Select a Timing Path in SmartTime’s Analysis
View and add a Timing Exception Constraint (False Path, Multicycle Path, Max Delay, Min Delay) . The Constraint
Editor reflects the newly added timing exception constraint.

Refer to the SmartTime Static Timing Analyzer User Guide for details.

Verify Power
Right-click on the Verify Power command in the Design Flow window to see the following menu of options:
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Tool

¥ Create Design
¥ Constraints

¥ = » Implement Design
:E Open Metlist Viewer
v S Synthesize

=I- I Verify Post-Synthesized Design
*L| Generate Simulation File

. Simulate
v % Place and Route
=I- I Verify Post Layout Implementation
(4 Verify Timing
- E i C}Een SmartTime
£ Open 55N Analyzer Run
+- » Configure Hardware Clean and Fun All
+- » Program Design :
5 b Debug Design Open Interactively
#- » Handoff Design for Producti  Clean
+- » Handoff Design for Debuggi
Help

Figure 64 - Verify Power right-click menu

Verify Power sub-commands

Run - Runs the default power analysis and produces a power report. This is also the behavior of a double-click to
Verify Power.

Clean and Run All - Identical to the sequence of commands "Clean" (see below) and "Run"
Open interactively - Brings up the SmartPower for Libero SoC tool (see below)
Clean - Clears the history of any previous default power analysis, including deletion of any reports. The flow task

completion icon V will also be cleared.

Configure Options ... - This sub-command is only available if there are options to configure, in which case a
dialog box will pop-up presenting the user with technology-specific choices.

View Report - This sub-command is only available and visible if a report is available. When View Report is
invoked, the Report tab will be added to the Libero SoC GUI window, and the Power Report will be selected and
made visible.

SmartPower

SmartPower is the Microsemi SoC state-of-the-art power analysis tool. SmartPower enables you to globally and
in-depth visualize power consumption and potential power consumption problems within your design, so you can
make adjustments — when possible — to reduce power.

SmartPower provides a detailed and accurate way to analyze designs for Microsemi SoC FPGAs: from top-level
summaries to deep down specific functions within the design, such as gates, nets, I0s, memories, clock domains,
blocks, and power supply rails.

You can analyze the hierarchy of block instances and specific instances within a hierarchy, and each can be
broken down in different ways to show the respective power consumption of the component pieces.

SmartPower also analyses power by functional modes, such as Active, Flash*Freeze, Shutdown, Sleep, or Static,
depending on the specific FPGA family used. You can also create custom modes that may have been created in
the design. Custom modes can also be used for testing "what if* potential operating modes.
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SmartPower has a very unique feature that enables you to create test scenario profiles. A profile enables you to
create sets of operational modes, so you can understand the average power consumed by this combination of
functional modes. An example may be a combination of Active, Sleep, and Flash*Freeze modes — as would be
used over time in an actual application.

SmartPower generates detailed hierarchical reports of the power consumption of a design for easy evaluation.
This enables you to locate the power consumption source and take appropriate action to reduce the power if
possible.

SmartPower supports use of files in the Value-Change Dump (VCD) format, as specified in the IEEE 1364
standard, generated by the simulation runs. Support for this format lets you generate switching activity information
from ModelSim or other simulators, and then utilize the switching activity-over-time results to evaluate average
and peak power consumption for your design.

See SmartPower User Guide

Simultaneous Switching Noise

Introduction

Simultaneous Switching Noise (SSN) is the Libero SoC voltage noise analysis tool. It provides a detailed analysis
of the noise margin on each I/O pin in the design based on the pin information as well as all the other active pins
placed in the same I/O bank of the design. The tool computes the noise margin based on /O Standards, Drive
Strength, and placement of the pin. The SSN Analyzer helps you achieve the desired voltage noise margin,
resulting in improved signal integrity.

Right-click SSN Analyzer in the Design Flow window and select Open Interactively to open the SSN Analyzer.

Supported Die/Package

Family Die Package

PolarFire MPF300XT FCG1152
MPF100T FCG484
MPF200T FCG484
MPF300T FCG484/FCG11

52

MPF500T FCG1152

Note: 1 ns pulse width is only supported for MPF300XT/FCG1152.

Dies and packages for which characterization data is unavailable are not supported.
Supported I/O Standard

The SSN Analyzer supports the following I/O Standards:
¢ LVCMOS 3.3V
¢ LVCMOS 2.5V
e LVCMOS 1.8V
¢ LVCMOS 1.5V
e LVCMOS 1.2V
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e LVTTL

Supported 1/O Types

Only single-end I/Os are supported. Differential I/Os are not supported.
SSN Analyzer

Three tabs are available in the SSN Analyzer:
¢ Noise Report
e Excluded IOs
e Summary

Noise Report

The Noise Report tab displays by default when the SSN Analyzer opens, and lists all of the design’s Output and
Inout ports. Input I/Os are not supported. The displayed columns are:

¢ Bank Name/Pin Number — Shows the Bank Number and the Package Pin Number of the Port

o Port Name — Shows the Port Name

¢ Instance Name — Shows the Instance Name of the Port

e 1/O Standard — Shows the I/O Standards supported by SSN Analyzer. Supported standards are: LVCMOS
3.3V, LVCMOS 2.5V, LVCMOS 1.8V, LVCMOS 1.5V and LVCMOS 1.2V and LVTTL.

e Drive Strength (mA) — Drive Strength selections are available from 2 to 12.

e Static — When this checkbox is checked, the I/O is considered neither as an Aggressor nor as a Victim. It is
excluded from SSN Analysis.

e Don’t Care — When this checkbox is checked, the I/O is excluded from consideration as a Victim for Noise
Margin computation. However, it is considered as an Aggressor for Noise Margin computation of other I/Os.
Note: Static and Don’t Care are mutually exclusive.
o Noise Margin (%) — This is the Noise Margin number computed by the SSN Analyzer. A negative number
(shown in red) indicates that it is outside the guideline of SSN analysis.

o Within Guideline— Either Yes (Positive Noise Margin) or No (Negative Noise Margin). The Yes (within
guideline) or No (outside guideline) guideline is different for different I/O standards:
e LVTTL/LVCMOS (3.3V) — A Yes (within guideline) is defined as follows:
e A ground bounce voltage less than or equal to 1.25V and a pulse width of less than or
equal to 1 ns

o A VDD dip voltage greater than or equal to VIH,,;, and a pulse width of less than or equal
to1ns

e All other LVCMOS Standards (2.5V, 1.8V, 1.5V, 1.2V) - A Yes (within guideline) is defined as
follows:

e A ground bounce voltage less than or equal to VIL,., for ground bounce and a pulse width
of less than or equal to 1 ns

o A VDD dip voltage greater than or equal to VIH,,;, and a pulse width of less than or equal
to1ns

* Noise margin violating the criteria for “Yes” is considered to fall outside the specified guidelines,
and is reported as a “No”
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£ SSNAnehyzer [
File Edit View Help
cBa
MoseReport | Excloded10s | Summary
Port Name : | Search Puse Width : |ns x
Bank Name/ Pin Number  PortName Instance Name 10 Standard Drive Strength (mA) Static Don't Care  Noise Margin (%) Within Guideline
4 Bank0 (1.5v)
Al6 wr wr_obuf/UD/U_IOPAD LVCMOSLS 4 7 99.01 Yes
Al5 datao|28] datac_obuf[28)/UD/U_IOPAD  LVCMOS1S 4 99,01 Yes
4 Bankl (3.3w) E
8 datac|29] datac_obuf[29)/U0/U_IOPAD  LVTTL 4 98.38 Yes l
s datac|25] datac_obuf[25)/U0/U_IOPAD  LVCMOS33 4 9838 Yes
4 Bank2 (2.5v)
M0 datanfd] datac_obuf[41/U0/UJOPAD  LVCMOSZS 12 1156 Ne
N26 addressl[T]  addressi_obuf7LUOMIOR.,  LVCMOSZS 15 4 e
Mz3 addressl[4] address1_obuf[/U0/U_IOP. LVCMO525 16 No [ |
130 address1[3] LVCMOS25 16 Ne
N7 addressl[2] LVCMOS2S 16 No
Mz7 address1(25] LVCMOS2S 16 No
L8 address1[24] LYCMOS2S 16 Ne
(35} address1[23) LVEMOS2S 16 Mo
M6 address1(22] LVEMOS2S 16 No
N2S addrese1[21] LVEMOS2S 16 Mo
K28 addressl[20]  addressi obuff 10..  LVCMOS25 16 Mo
24 addressl[l]  addressl obuf1UOU_ICP..  LVCMOSZS 16 Mo
P24 addressi[19]  address]_obuf19)U0/LID.  LVCMOS2S 16 Mo
129 addressl[IS]  addressi_obuf[1SJ/UOLIO.  LVCMOS2S 16 Ne
ral address1[14]  address]_obuf[14/UD/LID . LVCMOSZS 16 No
130 address1[13]  addressi_obuf[13J/UD/UIO..  LVCMOS2S 16 - No
P30 address1[12] addressi_obuf[12]/UD/U_TO LVCMOS25 16 100.00 Yes
4 Bank3 (2.5%)
AR mio mio_obuf/U0/U_JOPAD LVCMOS25 6 7052 es
w2 datac[20] datac_obuf[20]/U0/U_IOPAD  LVCMOS2S A 7407 Yes
u2s datao{15] datac_obuf[15])/U0/U_ICPAD  LVCMOS25 12 68.75 Yes Nl
v Aatanfld] Astan ahifLALAALIGDAD. _INFAACIE 12 2. e
| Runanalyss | [ saveReport |

Ready Fam:SmartFusion? |Die:M25050T |Pkg:B96 FEGA |Speed: -1

Figure 65 - SSN Analyzer — Noise Report Tab

Right-click Menu Items

The following menu items are available when you right-click an 1/O. You can select multiple I/Os and then right-
click to apply the menu items to all selected I/Os. Available menu items are:

e Show in IO Editor/Chip Planner — Allows you to cross-probe or reconfigure the selected I/Os in 1/0
Editor or Chip Planner.
Note: This menu item is only active when the 1/0 Editor is open.

e Mark Selected Static — Marks the selected I/Os as static (excluded from Noise Analysis).

o Unmark Selected Static — Unmarks the selected I/Os as static (included for Noise Analysis).

e Mark Selected Don’t Care — Marks the selected I/O as Don’'t Care (Not to be considered as Victim).

o Unmark Selected Don’t Care — Unmarks the selected 1/0s as Don’t Care (to be considered as Victim).
e Copy Selection — Copies the selected I/Os to the Clipboard for pasting into other applications.

¢ Print Selection - Copies the selected I/Os and sends to the printer.

e Sort by Package Die Pad Number — Sorts the Pin Number by the order of the I/O Pad number. Use this
option to find a pin and its neighboring pins. All used pins are arranged in order of proximity (geographical
proximity).

Search and Filter
Filtering is available for Port Names. For example, if you enter the search pattern “DATA*” in the Port Name field

and click Search , the list is populated with all I/O names beginning with DATA. Names not beginning with DATA
are excluded from the list. Filtering allows you to focus on I/Os you are interested in for SSN Analysis.

Pulse Width
The Pulse Width is the settling time of the signal bounce. It is a threshold value which the signal bounce must
exceed before the signal bounce is recognized for SSN calculation. Select 1ns or Ons. Selecting Ons means that
any signal bounce with a pulse width above Ons is recognized for SSN calculation. A selection of 1ns means only
signal bounces with a pulse width at or above 1ns are recognized for SSN calculation.
Changing the Pulse Width selection discards all the changes made for the current Pulse Width selection and
triggers a re-analysis based on the new Pulse Width.

Note: 1 ns pulse width is only supported for the MPF300XT/FCG1152 die/package.

95



& Microsemi

a A3\ MicrRocHIP company

PolarFire FPGA Design Flow User Guide

Run Analysis

This button is not active when SSN first opens. It is activated only when you have made changes in the Noise
Report. These changes may include one or more of the following:

e Checking/unchecking the Don’'t’ Care checkbox for one or more 1/Os.
e Checking/unchecking the Static checkbox for one or more I/Os.
When you have made your changes, click Run Analysis and SSN will recompute the Noise Margin number.

Save Report
Click Save Report to save the Noise Report in one of three formats:
o Text — Text file with *.txt file extension
e (CSV — Spreadsheet file with *.csv file extension
e XML — XML file with *.xml file extension

Excluded 1/Os

This tab displays all I/Os excluded from Noise Analysis. Excluded I/Os include:
e |/Os on unsupported I/O standards
e |/Os marked as Static in the Noise Analysis tab
e JTAG I/Os for which Noise Analysis is irrelevant

£ 5SNAnalyzer =6 %
B
m Excluded I0s ,Tmary‘
BankNamefPinl\iumber Port Name Instance Name 10 Standard Comment
Bank8 (2.5v)
Bank7 (2.5v)
Banké (L.2v)
4 Bank5 (1.8v)
AK19 ast? ast2_obuf/U0/U_IOPAD LPDDRI 10 Standard is not supported
AE2T astl astl_ebuf/UD/U_IOPAD LPDDRI 10 Standard is not supported
AF18 datac[30] datac_obuf[30]/U0/U_IOPAD SSTL18I 10 Standard is not supported
Bank3 (2.5v)
Bank2 (2.5v)
Bank1 (3.3v)
4 BankD (L.5v)
D15 datac[10] datac_obuf[10]/U0/U_IOPAD HSTLL 10 Standard is not supported
D14 datac([11] datac_obuf[11]/U0/U_IOPAD HSTLE 10 Standard is not supported
Fam:SmartFusion? | Die:M25050T |Pkg:896 FBGA | Speed: -1

Figure 66 - SSN Analyzer — Excluded I/Os Tab
The Noise Report includes these columns:
e Bank Name/Pin Number
e Port Name
e Instance Name
e |/O Standard
¢ Comment — Specifies the reason for exclusion, e.g., unsupported /O Standards or Marked as Static 1/Os

You can right-click an I/O previously marked as static in the Excluded 1/Os list and select Unmarked Selected
Static to include it in Noise Report Analysis.
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Summary

The Summary tab displays a summary of the SSN Analyzer. Click Save Summary to save the summary in Text,
CSV, or XML format.
l.-[:g- SSNAnalyzer
Window Menu Help

2B S

Nolse Report Excluded 10s Summary

SSN Analyzer Summary:

Vendor: Microsemi Corporation

Program Microsemi Libero Software, Release PolarFire w2.25P1 (Version 12.200.35.1)
Copyright (C) 1989-2018

Date Mon Jun 4 13:12:00 2018

Version: 1.0

Family PolarFire

Die : MPF300XT

Package FCG1152

Speed : STD

Pulse Width :1ns

SSN Analyzer Status : Successful

DRC Vialations :
None

Save Summary

Fam:PolarFire |Die:MPF300XT Pkg:FCG1152 Speed: STD

Figure 67 - SSN Analyzer - Summary
User Action When SSN Noise Analyzer Reports Failure

When the SSN Noise Analyzer reports poor Noise Margin or Failure, take the following steps to improve the noise
margin:
1. Change the I/O Standard to one that has a lower noise impact for the failing /0O Bank.

2. Select the lower Drive-Strength to reduce the noise. Open the /O Advisor to see the power/timing impact of
the specific 1/O cell.

3. After making these changes, rerun the SSN Analyzer to see if the noise margin of the I/O Cell improves. In
this scenario, Place and Route information remains intact.

4. If the improvement is not significant, open the Pin Attributes Editor and change the placement of the pin
within the I/O bank to a location farther away from the noisy pins.

5. Spread the failing pins across multiple I/O banks. This will reduce the number of aggressive outputs on the
power system of the I/O bank.

6. Rerun Place and Route and rerun SSN Analyzer to check the Noise Report.

97



& Microsemi

a RS\ MicrocHIP company

PolarFire FPGA Design Flow User Guide

Com |.'l':|l='

Place & Route

Changs 10

Pin- Placement

Attributes

Mo

SSN Analyzer

Figure 68 - SSN Analyzer in the Design Flow

See Also
Simultaneous Switching Noise and Signal Integrity Application Notes
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Configure Hardware

Programming Connectivity and Interface

In the Libero SoC Design Flow window, expand Configure Hardware and double-click Programming
Connectivity and Interface to open the Programming Connectivity and Interface window. The Programming
Connectivity and Interface window displays the physical chain from TDI to TDO or SPI Slave configuration.

The Programming Connectivity and Interface view enables the following actions:

Select Programming Mode — Select JTAG or SPI Slave mode. SPI Slave mode is supported by FlashPro5
for SmartFusion2 and IGLOO2 devices. SPI Slave mode is not supported for RTG4 or PolarFire devices.
JTAG is the default interface.

Construct Chain Automatically - Automatically construct the physical chain

Add Microsemi Device — Add a Microsemi device to the chain

Add Non-Microsemi Device — Add a non-Microsemi device to the chain

Add Microsemi Devices From Files — Add a Microsemi device from a programming file
Delete Selected Device — Delete selected devices in the grid

Scan and Check Chain — Scan the physical chain connected to the programmer and check if it matches the
chain constructed in the grid

Zoom In — Zoom into the grid
Zoom Out — Zoom out of the grid

Hover Information
The device tooltip displays the following information if you hover your pointer over a device in the grid:

Name - Editable field for a user-specified device name. If you have two or more identical devices in your
chain you can use this field to give them unique names.

Device - Device name.
File - Path to programming file.

Programming action — When a programming file is loaded, the user can select a programming action for
any device which is not the Libero design device.

IR Length - Device instruction length.

TCK - Maximum clock frequency in Hz to program a specific device; Libero uses this information to ensure
that the programmer operates at a frequency lower than the slowest device in the chain.
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Libero design device

[Name: |MPF300TS_ES
|Device: |MPF300TS_ES
|File: |

|F'r-:ugrarr1rr1ing action: |
IIR: 8
|TCk: 10000000

Figure 69 - Device Information

Device Chain Details
The device within the chain has the following details:

Libero design device — Has a red circle within Microsemi logo. Libero design device cannot be disabled.
Left/right arrow — Move device to left or right according to the physical chain.

Enable Device - Select to enable the device for programming; enabled devices are green, disabled devices
are gray.

Name - Displays your specified device name.
File - Path to programming file.

Right-Click Properties

Set as Libero Design Device - The user needs to set Libero design device when there are multiple
identical Libero design devices in the chain.

Enable Device for Programming - Select to enable the device for programming; enabled devices are
green, disabled devices are gray.

Configure Device — Ability to reconfigure the device (for a Libero SoC target device the dialog appears but
only the device name is editable).

Load Programming File — Load programming file for selected device. (Not supported for Libero SoC target
design device.)

Set Serial Data - Opens the Serial Settings dialog box; enables you to set your serialization data.
Select Program Procedure/Actions (Not supported for Libero SoC target design device):
e Actions - List of programming actions for your device.

o Procedures - Advanced option; enables you to customize the list of recommended and optional
procedures for the selected Action.

Move Device Left/Right — Move device in the chain to left or right.
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iweeoT Es(2)
+[MPF300T_ES] <
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| SetAslibero Design Device
Configure Device...
Enable Device for Programming..
Load Programming File...
Set Serial Data...
Select Program Procedure/Actions...
Move Device Left..

Figure 70 - Right-click Properties

See Also
set_programming interface

Programmer Settings

In the Libero SoC Design Flow window, expand Configure Hardware, double-click Configure Programmer, or
right-click Configure Programmer and choose Programmer Settings to view the Programmer Settings dialog.
For the JTAG interface, you can set specific voltage and force TCK frequency values for your programmer in this
dialog. For the SPI Slave interface, you can set specific voltage and force SCK frequency values for your
programmer in this dialog (supported only for FlashPro5, SmartFusion2 and IGLOO2 devices).

-1

# | Programmer Settings |88

FlashPro6 | FlashPros | FlashPros | FlashPro3 | FlashProLite | Fias < [P ]

A || set vpump

JTAG interface SPI Slave interface
TCK Mode: Free Running Clock SCK Mode: Free Running Clock
| Force TCK Frequency [ ] Force SCK Frequency
4 * | MHz 20.00 * | MHz

Set Defaults

o ][ cuen |

Figure 71 - Programmer Settings (FlashPro6 shown)
Note: SPI Slave programming is currently not supported for FlashPro6.
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The Programmer Settings dialog includes setting options for FlashPro6/5/4/3/3X, FlashPro.
Limitation of the TCK frequency for the selected programmer:

e FlashPro6:1,2,3,4,5,6,7,8,9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20 MHz

e FlashPro5: 1,2, 3, 4,5, 6,10, 15, 30 MHz

e FlashPro4:1,2,3,4,5,6 MHz

e FlashPro3/3X: 1, 2, 3, 4,6 MHz

e FlashPro supports 1-4 MHz
TCK frequency limits by target device:

o Refer to target device data sheet

During execution, the frequency set by the FREQUENCY statement in the PDB/STAPL file overrides the TCK
frequency setting selected by you in the Programmer Settings dialog box unless you also select the Force TCK
Frequency checkbox.

Limitation of the SCK frequency for the selected programmer: 1.00, 2.00, 2.50, 3.33, 4.00, 5.00, 6.67, 8.00, 10.00,
13.33, 20.00 MHz

FlashPro5/4/3/3X Programmer Settings

For FlashPro5/4/3/3X, you can choose the Set Vpump setting or the Force TCK Frequency. If you choose the
Force TCK Frequency, select the appropriate MHz frequency. For FlashPro4/3X settings, you can switch the TCK
mode between Free running clock and Discrete clocking. Discrete clocking should be used when there is a JTAG
non-compliant device in a chain with Microsemi devices. After you have made your selections(s), click OK.

Default Settings

e The Vpump option is checked to instruct the FlashPro5/4/3/3X programmer(s) to supply Vpump to the
device.
NOTE: VPUMP voltage will not be checked for the SmartFusion2/IGLOO2 and newer families of devices.
VPUMP does not need to be connected to the programmer for these devices.

e The Force TCK Frequency option is unchecked to instruct the FlashPro5/4/3/3X to use the TCK frequency
specified by the Frequency statement in the PDB/STAPL file(s).

e FlashPro5/4/3/3X default TCK mode setting is Free running clock.

TCK Setting (ForceTCK Frequency)

If Force TCK Frequency is checked (in the Programmer Setting), the selected TCK value is set for the
programmer and the Frequency statement in the PDB/STAPL file is ignored.

Default TCK frequency

When the IPD/STAPL file or Chain does not exist, the default TCK frequency is set to 4MHz. When more than
one Microsemi flash device is targeted in the chain, the FlashPro Express software passes through all of the files
and searches for the "freq" keyword and the "MAX_FREQ" Note field. The FlashPro Express software uses the
lesser value of all the TCK frequency settings and the "MAX_FREQ" Note field values.

FlashPro Programmer Settings

Choose your programmer settings for FlashPro (see the above figure). If you choose to add the Force TCK
Frequency, select the appropriate MHz frequency. After you have made your selection(s), click OK.

Default Settings

e The Vpp, Vpn, Vdd(l), and Vddp options are checked (Vddp is set to 2.5V) to instruct the FlashPro
programmer(s) to supply Vpp, Vpn, Vdd(l) and Vddp.
e The Driver TRST option is unchecked to instruct the FlashPro programmer(s) NOT to drive the
TRST pin.

o The Force TCK Frequency option is unchecked to instruct FlashPro to use the TCK frequency
specified by the Frequency statement in the STAPL file(s).
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In the Libero SoC Design Flow window, expand Configure Hardware and double-click Select Programmer to
open the Select Programmer dialog. You can also right-click Select Programmer to open it. The dialog displays

the name, type, and port of your programmer if it is connected.

A drop-down list shows all connected programmers, allowing you to select the programmer you want. If no
programmers are connected, you can connect a programmer without closing the dialog and then click
Refresh/Rescan Programmers. The connected programmer will appear in the drop-down list.

Refresh/Rescan Programmers

Programmer

189313
Type: FlashPro4

Port: usb89313 (USB 2.0)

Help OK

Figure 72 - Select Programmer Dialog
See Also

Programmer Settings
Tcl command select programmer

Cancel | ‘
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Program Design

Generate FPGA Array Data

The Generate FPGA Array Data tool generates database files used in downstream tools:
e *map files used for Programming
e RAM structural information used in ‘Configure Design Initialization and Memories’ tools

Double-click Generate FPGA Array Data or right-click Generate FPGA Array Data in the Design Flow window
and click Run to generate FPGA Array Data. Before running this tool, the design should have completed the
Place and Route step. If not, Libero SoC runs implicitly the upstream tools (Synthesis, Compile Netlist, and Place
and Route) before it generates the FPGA Array Data.

Design Flow B X

Top Madule(root): top o @'

Active Synthesis Implementation: synthesis

Tool
-k Create Design
i - F  Constraints
¢ = b Implement Design
#- # Configure Hardware
R
[ #l Generate FPGA Array Data

~+L| Configure Design Initialization Data and Memories
+L| Generate Design Initialization Data

- tas Configure I/0 States During JTAG Programming

« Configure Programming Options

; @. Configure Security
'5‘3 Generate Bitstream

- % Run PROGRAM Action

¥ Program 5Pl Flash Image

Debug Design

Handoff Design for Production

Handoff Desian for Debuaaing

Figure 73 - Generate FPGA Array Data

v v v |t

Configure Design Initialization Data and Memories

User design blocks such as LSRAM, uSRAM, XCVR (transceivers), and PCle can be initialized using data stored
in non-volatile uPROM, sNVM, or external SPI Flash storage memory. The Configure Design Initialization Data
and Memories tool allows you to define the specification of this Design Initialization sequence, and the
specification of the initialization clients in separate tabs:

e Design Initialization Specification
e Configure uPROM

e Configure SNVM
e Configure SPI Flash

e Configure Fabric RAMs Initialization
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Note: The Configure Design Initialization Data and Memories tool can be invoked only after successful completion
of the Generate FPGA Array Data step.

Use the tabs in this GUI to configure the Design Initialization data and memories.

Once the Configuration is complete, follow these remaining steps to program the initialization data:
1. Generate initialization clients

2. Generate or export the bitstream
3. Program the device

See Also
Generate Design Initialization Data
Configure Fabric RAMSs Initialization

Configure Programming Options

Configure Security Wizard

Design Initialization Specification Tab
Desian Infalzation | uPROM | shVM | SPLFiash | Fabric s |

soy | oserd | hep |

In design initialization, user design blocks such as LSRAM, LUSRAM, transceivers, and PCle can be initialized as an option using data stored in the non-volatile storage memary.
The initizlization data can be stored in JPROM, sNVM, or an external SPI Flash.

Follow the below steps to program the initialization data:

1. Set up your fabric RAMs initialization data, if any, using the ‘Fabric RAMs' tab
2. Define the storage location of the initialization data

3. Generate the initialization dients

4. Generate or export the bitstream

5. Program the device

Design initialization specification

First stage (sNVM)

In the first stage, the initialization sequence de-asserts FABRIC_POR_N.

In the third stage, the initialization sequence initializes the Fabric RAMs present in the design.

lach, please use 'Fabric RAMs' tab to make your selection for each RAM dient,

Time Out (s): 128 3:
Auto Calibration Time Out (ms): 3000
Custom configuration fle: [

Figure 74 - Design Initialization Tab
Common Commands for All Configure Design Initialization Data and Memories Tabs

If a Configure Design Initialization Data and Memories Tab title has an asterisk (*) next to it, an item on that
tab has been changed, but not yet "Applied". The common options on every tab page are:

o Apply - Click the Apply button to save the changes made in this tab.
Note: The Apply button only saves the configuration changes. For the initialization of the memory block to
take effect, go back to the Device Initialization tab and click Generate Initialization Clients.

e Discard - Click the Discard button to discard any changes made in this tab.
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First Stage (SNVM)

In the first stage, the initialization sequence de-asserts the FABRIC_POR_N signal and starts the I/O calibration
routine. The initialization client for this stage is always placed in sSNVM, and it uses the last two pages of the
sNVM memory space. There are no options for this stage

Second Stage (sSNVM)

In the second stage, the initialization sequence initializes the PCle and XCVR blocks present in the design. This
stage is grayed out if the design does not have PCle or XCVR Blocks. The initialization client for this stage is
named INIT_STAGE_2_SNVM_CLIENT. Itis always placed in sNVM at the start address of the user’s choice.
The start address can only be at the start of an SNVM page (page boundary). Each sNVM page is 256 bytes in
size, so the valid start addresses (Hex) are 0x0, 0x100, 0x200, and so on. Only the plain text non-authenticated
client is supported for initialization.

Third Stage (WPROM/sNVM/SPI Flash)

In the third stage, the initialization sequence initializes the Fabric RAMs present in the design. The initialization
client for this stage is placed in the memory type of the user’s choice (UPROM/sNVM/External SPI Flash). If the
design does not have any Fabric RAMs, this stage of the initialization sequence is not needed and is grayed out.
Each logical RAM block can be initialized from any of the three memory types. Use the Fabric RAMs configuration
tab to assign the memory type to the logical RAM blocks.

Only the memory types used by the design, as defined in the Fabric RAMs configuration tab, are selected and
enabled.

e UuPROM - For uPROM, the name of the initialization client is INIT_STAGE_3_UPROM_CLIENT. lts start
address is at the user's choice, subject to the limitation that the start address can only be at the start of a
UPROM block. Each UPROM block is 256 words, so the allowed start addresses (Hex) are 0x0, 0x100,
0x200, and so on.

e sNVM - For sNVM, the name of the initialization client is INIT_STAGE_3 SNVM_CLIENT. lIts start address
is at the user's choice, subject to the limitation that the start address can only be at the start of an SNVM
page (page boundary). Each sNVM page is 256 bytes long, so the allowed start addresses (HEX) are 0x0,
0x100, 0x200, and so on.

e SPI-Flash - For SPI-Flash, the name of the initialization client is INIT_STAGE_3_SPIFLASH_CLIENT.
e SPI-Flash Binding: there are four Binding Options from which the user can select:

1. No Binding Plaintext: When this option is selected, the <root>_uic.bin file is a script file
that can be opened to see readable text.

2. Binding Encrypted with Default Key: When this option is selected, the <root>_uic.bin file is
encrypted with the default encryption key. Also, the design version is displayed and this
design version can be modified from Configure Programming Options. When Default key
is selected, the user does not need to specify any other details.

3. Binding Encrypted with User Encryption Key 1 (UEK1): When this option is selected, the
<root>_uic.bin file is encrypted with UEK1. Also, the design version is displayed and this
design version can be modified from Configure Programming Options. The user needs to
configure SPM along with UEK1. If UEK1 is not specified, the Generate SPI Flash Image
and Export SPI Flash Image steps will result in error. UEK1 can be configured using the
Configure Security Tool.

4. Binding Encrypted with User Encryption Key 2 (UEK2): When this option is selected, the
<root>_uic.bin file is encrypted with UEK2. Also, the design version is displayed and this
design version can be modified from Configure Programming Options. The user must
configure SPM along with UEK2. If UEK2 is not specified, the Generate SPI Flash Image
and Export SPI Flash Image steps will result in error. UEK2 can be configured using the
Configure Security Tool.

o SPI Clock divider value: The user can also select the SPI clock divider value using the adjacent
drop-down menu to set the clock divider value. Choose the value that meets the minimum clock
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width requirement of the external SPI Flash. The allowed values are 1, 2, 4, or 6. The default value
is 1.
¢ Broadcast instructions to initialize RAM's to zero's - This global option affects all RAM blocks (LSRAM

and uSRAM) in the device. When this option is selected, all RAM blocks will be initialized to zeros before
FABRIC PoR is asserted. To accommodate the additional instructions, the sNVM start page will be 202.
Note: To initialize the individual logical RAM blocks to zeros without using this global option, select the
'Content filled with 0s' option in the Add Data Storage Client dialog box. In this case, you must wait for the
corresponding RAM INIT complete signal before accessing those RAMs (refer to the PolarFire FPGA Device
Powerup and Reset User Guide, which describes the INIT DONE/COMPLETE signals). The sNVM start
page will be 219 when this global option is not selected.

Time Out

A time-out of up to 128 seconds can be selected from the drop-down menu for the completion of all three stages
of initialization process. The default setting is 128.

Auto Calibration Time Out

The Auto Calibration Time Out value specifies the time out before which the 10 Calibration instructions must be
completed. The default value is 3000 milliseconds. This time out value is applicable only for MPF100T, MPF200T,
MPF300T and MPF500T devices.

Custom Configuration File

The Custom Configuration File contains signal integrity parameters for Transceivers. Click the Browse button at
the far right to navigate to and select a custom configuration file for Transceiver solutions. Contact Microsemi
Tech Support for details.

See Also
Configure Fabric RAMSs Initialization

Configure Security Wizard

Configure uPROM

Use the uPROM tab to manage and configure user-specific data clients targeted for uPROM memory.
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Design Inih’alizat'on sNVM | SPIFlash | Fabric RAMs

Apply | Discard | Help |

~Usage statistics - 1 rClients -
Available memory (3-bit words): 52224 Add ... |V= Edit ... J Delete | Load design configuration |
Used memory(9-bit words): 0 - =
HReImem [ Ee ] 53974 Client Mame | Start Address | 9-bit words |

|| Used space
] Free space

Figure 75 - Configure uPROM Tab
Common Commands for All Configure Design Initialization Data and Memories Tabs

If a Configure Design Initialization Data and Memories Tab title has an asterisk (*) next to it, an item on that
tab has been changed, but not yet "Applied". The common options on every tab page are:

o Apply - Click the Apply button to save the changes made in this tab.

Note: The Apply button only saves the configuration changes. For the initialization of the memory block to
take effect, go back to the Device Initialization tab and click Generate Initialization Clients.

Discard - Click the Discard button to discard any changes made in this tab.

Add

Use the Add button to add a uPROM client. When a uPROM client is added, it appears in the spreadsheet-like
list.

See Add uPROM Client
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Use the Edit button to edit the uPROM client. If there are multiple uPROM clients, first select the client from the

spreadsheet-like list and then click Edit.

When changes are made to the configuration of any of the uPROM client, then their ‘Edited’ state is indicated by
an asterisk (*) next to the uPROM tab’s title, and an asterisk (*) next to the title of the main window of the Design
and Memory Initialization step. When the edits are saved , then the uPROM tab’s asterisk (*) disappears. All the
edits present in all the tab can be saved in one go by clicking on the ‘Save’ icon on Libero’s toolbar. When there
are no edits present in any of the tabs, then the asterisk (*) next to the title of the main window disappears.

See Add uPROM Client

Use the Delete button to delete an uPROM client. If there are multiple uPROM clients, first select the client and
then click Delete.

Load Design Configuration

Click this button to load in the design’s original yPROM configuration file in
<project>/component/work/UPROM.cfg. This button is grayed out if the design does not have an original uPROM
configuration file. This configuration is changed whenever the design is updated in the design window. If there are
changes made to this design configuration after the latest Apply, Libero SoC gives a clear visual indication that a
newer design configuration is available by two means:

e an info icon appears next to the button ‘Load design configuration’,
e an infoicon is shown next to the uPROM tab title.

The tool-tip on both icons contains the time-stamp information of the design configuration file. The icons
disappear after the user clicks Apply the next time.

Usage Statistics

Memory usage for the uPROM is reported in the pie chart.

See Also
Tcl command configure _uprom

Add/Edit uPROM Client

Click Add or Edit to open a dialog to add/edit a uPROM client.
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e = a a

Client name:

uPR.OM

{* Content from file: |

Format: |I'~"Ii|:r-:|semi Binary 3-hit j

" Content filled with 0s

Start address: 0x |I:I :I

Murnber of 9-bit words: | Dedmal

[ Uze for initialization of RAMs

[ Use content for simulation

Help Ok Cancel

Figure 76 - Add uPROM Client Dialog

Client name

Enter the name of the uPROM client to be added
Content from File

Navigate to and specify a file, the content of which is to be used to fill the uPROM.
Content filled with 0s

Populates the uPROM with zero’s.

Start Address

Specifies the start address (in HEX) of the uPROM client. If there are multiple uPROM clients, the start address
must not overlap. A warning message appears if there is address overlapping of uPROM clients. Valid start

addresses range from 0 to CBFF (Hex).
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Number of 9-bit words

Specifies the number (in decimal) of 9-bit words to populate the uPROM. If the number of 9-bit words exceeds the
memory size of the uPROM, an “out-of —bounds” warning message appears.

Use for initialization of RAMs

This option is disabled and unavailable from the Design and Memory Initialization tool.

Use Content for simulation

This option is disabled and unavailable from the Design and Memory Initialization tool.

Configure sNVM
Use the sNVM tab to manage and configure sSNVM clients.

Desian Initisization | UPRO SPIFIashl Fabric RAMs

Apply | Discard | Help |
Usage statistics Clients
Available memory (n pages): 221 Add ... |" Edit... | Delete t Load design configuration
Used memory (in pages): 0 e
Free memory (in pages): 221 Client Namel Start Page | 36-bit words [

Figure 77 - sSNVM Tab
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Common Commands for All Configure Design Initialization Data and Memories Tabs

Add

If a Configure Design Initialization Data and Memories Tab title has an asterisk (*) next to it, an item on that
tab has been changed, but not yet "Applied". The common options on every tab page are:

o Apply - Click the Apply button to save the changes made in this tab.
Note: The Apply button only saves the configuration changes. For the initialization of the memory block to
take effect, go back to the Device Initialization tab and click Generate Initialization Clients.

e Discard - Click the Discard button to discard any changes made in this tab.

Click Add to open the Add Client dialog. Four different types of sSNVM clients can be added:
e PlainText NonAuthenticated: 252 user bytes per page.
e PlainText Authenticated: 236 user bytes per page.
o CipherText Authenticated: 236 user bytes per page.
o USK: 96 user bytes. The USK client occupies exactly 1 page.
Note: Only one USK client in the sNVM is allowed.
When an authenticated client is present in the sNVM, a USK client must be necessarily present too.

Adding Text Clients

See Add Text Client

Adding a USK Client

Edit

Delete

See Add USK Client

Use the Edit button to edit the SNVM client's configuration. If there are multiple sNVM clients, first select the client
you want and then click Edit.

When changes are made to the configuration of any of the sSNVM client, then their ‘Edited’ state is indicated by an
asterisk (*) next to the sNVM tab’s title, and also an asterisk (*) next to the title of the main window of the Design
and Memory Initialization step. When the edits are saved , then the sNVM tab’s asterisk (*) disappears. All the
edits present in all the tab can be saved in one go by clicking on the ‘Save’ icon on Libero’s toolbar. When there
are no edits present in any of the tabs, then the asterisk (*) next to the title of the main window disappears.

Use the Delete button to delete an sNVM client. If there are multiple sNVM clients, , first select the client you want
and then click Delete.

Load Design Configuration

Click this button to load in the design’s original SNVM configuration file in <project>/component/work/sNVM.cfg.
This button is grayed out if the design does not have an original sSNVM configuration file. This configuration is
changed whenever the design is updated in the design window. If there are changes made to this design
configuration after the latest Apply, Libero SoC gives a clear visual indication that a newer design configuration is
available by two means:

e an info icon appears next to the button ‘Load design configuration’,
e aninfo icon is shown next to the sSNVM ftab title.
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The tool-tip on both icons contains the time-stamp information of the design configuration file. The icons

disappear after the user clicks Apply the next time.
Usage Statistics

Memory usage for the sNVM is reported in the pie chart.

See Also
Tcl command configure _snvm
PolarFire FPGA Programming User Guide

Add sNVM Clients

Two different kinds of sSNVM clients can be added:
e Text Client
e USK Client

Add Text client
Use the dialog box to add text clients:

e PlainText NonAuthenticated: 252 user bytes per page.
e PlainText Authenticated: 236 user bytes per page.
o CipherText Authenticated: 236 user bytes per page.
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5| Add PlainText Nonfuthenticated client

Client name: |
sMyVM
(71 Content from file:
Farmat: Microsemi-Binary 8/16/32 hit
(71 Content filled with Os
@ Mo content {dient is a placeholder and will not be programmed)
Start page (decimal): i = Ox0

Mumber of bytes {dedmal): 0 0 page

[] Use content for simulation

D Use as ROM

J [ Cancel

Figure 78 - Add Plain Text client
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Client name

Enter the name of the sNVM client to be added.

Content from File

Navigate to and specify a file, the content of which is to be used to fill the SNVM.

Content filled with 0s

Populates the sNVM with zero’s.

No Content

client is a placeholder and will not be programmed.

Start Page

Specifies the start page (in decimal) of the sSNVM client. sSNVM client address starts at page boundaries. If there
are multiple sNVM clients, their start page cannot be the same. A warning message appears if there is address
overlapping of sSNVM clients. Valid start page range from 0 to 220 (Decimal).

Number of bytes

Specifies the total number (in decimal) of bytes to populate the sSNVM. If the number of bytes exceeds the
memory size of the sNVM, an “out-of —bounds” warning message appears. Valid ranges is from 1 to 47376

Use Content for simulation

Check if this client should be loaded for the simulation run.

Use as ROM

Check if this client should be used as read-only-memory (ROM).

Add USK client
This client holds the USK. It is always 1 page (96 bytest) in size. There is no total byte entry for the USK client.
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#| Add USK Client

L9 o

This dient holds the USK., Itis always 1 page in size,

A[¥]

Start page (dedmal): b
UISK Key (24 HEX chars): 0

Eﬂ Reprogram
[7] Use content for simulation

Use as ROM

Help

Ox0

ok || cancel

Figure 79 - Add USK Client

Enter a USK key (24 Hex characters). A random key can be generated by clicking the padlock icon to the right of

Start Page

Start page can vary between 0 and 220.
USK Key

this field.
Reprogram

Check if this client should be programmed.
Use Content for Simulation

Check if this client should be loaded for the simulation run.
Use as ROM

Check if this client should be used as read-only-memory (ROM).

Configure SPI Flash

The SPI Flash tab allows you to enable Auto Update, select the SPI Flash Manufacturer, and configure SPI Flash
Clients. The configuration is saved in the spiflash.cfg file in the Libero design implementation folder.
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Desgn Intaizaton | uPROM | svM ST F\ash‘ Fabric RAMS

I Enable Auto Update
Manufacturer: [MICRON — ~ Part No: MT250L0 1GBBBESF-0SIT
Usage statistics 5P Flash Clients
Available memory (KB): 131071 Add... |v Edt... ‘ Delete |
Used memory {KB): ]
Free memory (KB) : 131071

Bypass Back Level
Program Protection for

Recovery/ Golden bitstream

Name Type Index Content File

Start
Address | Ad

m
T

Figure 80 - SPI Flash Tab
Common Commands for All Configure Design Initialization Data and Memories Tabs

If a Configure Design Initialization Data and Memories Tab title has an asterisk (*) next to it, an item on that
tab has been changed, but not yet "Applied". The common options on every tab page are:
o Apply - Click the Apply button to save the changes made in this tab.
Note: The Apply button only saves the configuration changes. For the initialization of the memory block to
take effect, go back to the Device Initialization tab and click Generate Initialization Clients.

Discard - Click the Discard button to discard any changes made in this tab.

Enable Auto Update

Check Enable Auto Update to enable Auto Update on the target device. The bitstream generated within Libero will
enable this feature. If this is checked, a total of two SPI Bitstreams can be added. One SPI Bitstream will be for
Auto Update and the other will be for Recovery/Golden. The tool enforces the Recovery/Golden bitstream to be at
index 0 and the Auto Update bitstream to be at Index 1. The Auto Update Bitstream Design version must be
greater than the Design Version of the Recovery/Golden bitstream.

Manufacturer

Click the pull-down menu to see the supported SPI Flash manufacturer/vendors and the part number. The table
below lists the supported vendors and part number.

Manufacturer Part Number Capacity Sector Size

MICRON MT25QL01GBBB8ESF-0SIT | 1GB 4KB

The SPI Flash Part Number is displayed to the right of the manufacturer/vendor name. The Memory size (in MB)
for the SPI Flash is displayed in the Usage Statistics above the pie chart.

Note: This version of the programmer does not support SPI Flash security. Device security options such as
"Hardware Write Protect” should be disabled for the External SPI Flash device.
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Usage Statistics

Available Memory (MB) reflects the SPI Flash vendor and part selected.
¢ MICRON

Memory usage for the SPI Flash is reported in the pie chart.
SPI Flash Clients

SPI flash clients appear in a spreadsheet-like format when they are added and configured.
Design Inialzaton | WPROM | WM SPI Flash | Fobric RaMs
Lo ] oe reb

I~ Enable Auto Update

Manufacturer: [MIRON ~| Part No: MT25QLD 1GRBBSESF-OSIT

Usage statistics SPI Flash Clients

Avaiatie memry (ME): 27 [ ] e |
Used memory (MB): 18
Free memory () : 109

Start
Address

covery/ Golden bitstrea
: X:
N v :daml SPI Bitstream for Recovery/Golden |0 \10_docs_review'pF2.2 sp1iprog, , [0400 | 0x9095cf i Enabled
o dent SP1 Bitstream for IAP 2 "‘ 0. |0X0000__|0x9911600 1 Disbled
P |doents Data Storage X o docs reviewlof2.2 spifrog.. |OXS9116...| 0991176 )

Name. Type Index Content File

W Usedspace ST Btstream for Recovery fGokden
ke [EPTBmean for A Updte |

Figure 81 - SPI Flash Clients

Note: Bypass Back Level protection feature is only supported for SPI Bitstream clients for
Recovery/Golden.

SPI Bitstream Client for Recovery/Golden

A SPI client for Recovery/Golden is required if a SPI Bitstream is added. There can only be one SPI Bitstream
configured as Recovery/Golden. It is highlighted in yellow in the spreadsheet-like display. An error message
appears if none is configured or more than one is configured.

If Auto Update is enabled, then the SPI Bitstream Client for Recovery/Golden must have a Design Version smaller
than the Design Version for the SPI Bitstream Client for Auto Update.

The master file should not be used for Recovery/Golden client with 1AP.

If Back Level Protection is enabled in Configure Security tool, then Programming Recovery will fail if the Back
Level Version programmed in the device is greater than or equal to the Design Version of the SPI Bitstream Client
for Recovery/Golden. To allow for programming Recovery to pass in this situation, you can import a Bitstream that
has been exported with the Bypass Back Level Protection option.

Index O is reserved for this client.

SPI Bitstream Client for Auto Update

This client is highlighted in green in the spreadsheet-like display. To add a SPI Client for Auto Update, the Enable
Auto Update checkbox must first be checked. This client is optional. The Design Version of this client must be
greater than the Design Version for the SPI Bitstream Client for Recovery/Golden.

Index 1 is reserved for this client.
Note: The tool will reject a Bitstream file with Bypass Back Level Protection enabled for this type of client.

SPI Bitstream Client for IAP

To add a SPI Client for IAP, select the SPI Bitstream file for IAP in Add/Edit SPI Bitstream Client window. The
total number of SPI Bitstream Clients allowed including Recovery/Golden and Auto Update Clients is 255.
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Index for this client can be range of 2-255.

Data Storage Client

See add_data_storage_client to add a Data Storage Client. Bypass Back Level Protection feature is not
applicable to Data Storage Client. Also, they don’t have a Design Version number and an Index value.

Click Add to add a SPI Bitstream client or Data Storage client. A total of up to 255 SPI Bitstream clients (including
one client for Recovery/Golden and one client for Auto Update and the rest for IAP) can be added. One of the
clients must be the Recovery/Golden client.

Click Edit to modify the configuration of the SPI Bistream client or Data Storage client. If there are multiple clients
in the list, select the client you want to modify and click Edit.

Use Delete to delete a SPI Flash client. If there are multiple SPI Flash clients, first select the client you want to
delete and then click Delete.

See Also
Add/Edit SPI Bitstream Client

Add Data Storage Client
Tcl command configure spiflash

PolarFire FPGA Programming User Guide

Add/Edit SPI Bitstream Client

Click the Add button in the SPI Flash tab of the Configure Design Initialization Data and Memories tool to add a
SPI Bitstream client and the Edit button to modify an existing SPI Bitstream client.
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(™ Add SPI Bitstream Client (=

Marme: |

Content
@ SPI Bitstream file for IAP
() SP1 Bitstream file for Recovery/Golden

SP1 Bitstream file for Auto Update

Design wersion:

() Filled with 1s
Start address (HEX): 0x 400 =
Size in bytes (decimal): 0

|

Figure 82 - Add/Edit SPI Client

Name

Enter the name of the SPI Bistream client to be added. Up to 32 alphanumeric characters are allowed. When
editing an existing SPI Flash client, the client name cannot be changed.

Content
Check one of the following to select the type of SPI Bitstream to be added. A total of 255 SPI clients can be
added for IAP.
SPI Bitstream for IAP
Check this checkbox to add a SPI bitstream client for IAP.

SPI Bitstream for Recovery/Golden

Check this checkbox to add a client for Recovery/Golden. It is mandatory and only one is allowed. This option is
disabled if one is already added. The existing one can be edited or deleted.

SPI Bitstream for Auto Update

This is available only when Auto Update is checked in the Configure SPI Bitstream tab. The SPI bitstream client is
optional and only one is allowed. This option is disabled if one is already added. The existing one can be edited or

deleted.
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Browse Button
Click the Browse button to navigate to a SPI file (*.spi) location. The content of this file is used to export the SPI
Bitstream Image file.

Filled with 1s

Check this checkbox to fill the content of the SPI Bitstream client with 1s. If the content is filled with 1s, specify a
client size. It must be greater than 0. Golden or Auto Update SPI clients cannot be filled with zeros. They require
a content file.

Start Address (HEX)
The first available start address is 0x400 (the first 1024 bytes are reserved for the SPI directory and are not
available).

Size in bytes (decimal)

This field displays the number of bytes (in decimal) of the client based on the specified bitstream (*.spi) file used
to load in the content. The size can be increased but not decreased.

A new client is validated against existing clients. Address overlapping of clients is not allowed and is flagged as
an error.
See Also
Tcl command "set_client " on page 175
PolarFire FPGA Programming User Guide

Add/Edit Data Storage Client for SPI Flash

Click the Add button in the SPI Flash tab of the Configure Design Initialization Data and Memories tool to add a
Data Storage client. Click the Edit button to modify an existing Data Storage client.

Reports & X | StartPage & X | e sdl 8 X Design and Memory Initialization & X

{ Design mnitislization \/ uFrROM /" stivia /" SPIFlash \/” Fabric RAMs \

Help
Enable Auto Update
Manufacturer: | MICRON - Part Ho: MT25QL01GBEBBESF-OSIT
Usage statistics SPI Flash Clients
Available memory (MB):127 Add... E|

Remwch e ey { g . Add SPI Bitstream Client |

Free memory (MB) : 127

Figure 83 - Add Data Storage Client (SPI Flash Tab)

Type Index
Add Data Storage Client [ "
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() Add SPI Flash Data Storage Client @

Name:

Content

@ Memory file: [ ‘

Format:
Filled with 1s

Start address (HEX): 0x 400
Size in bytes (decimal): 0
_ Help \ oK f Cancel

Figure 84 - Add/Edit Data Storage Client Dialog
Note: Intel Hex file type is supported for this release.

Name

Enter the name of the Data Storage client to be added. Up to 32 alphanumeric characters are allowed. When
editing an existing Data Storage client, the client name cannot be changed.

Content
Select one of the following options.

Memory file

Enter the name of the Memory file or click the Browse button to navigate to a Memory file location. Currently, only
Intel-Hex format memory files are supported. The memory file will be loaded into the SPI-Flash at the desired start
address.

Filled with 1s

Check this checkbox to fill the content of the Data Storage client with 1s. If the content is filled with 1s, specify a
client size. It must be greater than 0.

Start Address (HEX)

The first available start address is 0x400 (the first 1024 bytes are reserved for the SPI directory and are not
available).

Size in bytes (decimal)
This field displays the number of bytes (in decimal) of the client based on the specified Data Storage file used to
load in the content. The size can be increased but not decreased.

A new client is validated against existing clients. Address overlapping of clients is not allowed and is flagged as
an error.
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See Also
Tcl command configure spiflash
Configure SPI Flash
PolarFire FPGA Programming User Guide

Configure Fabric RAMs Initialization

The Fabric RAMs Initialization tab allows you to select the Initialization options for the memory blocks in the
design. The memory blocks include:

e Dual-Port SRAM
e Two-Port SRAM

e UuSRAM
Design Intakzation | WPROM | M w[ﬁ.@
(o | ooed | wo |

Usage sramncs Cherts
LSRAM Memary Lo cenge cniguaton | Iniiaie af ients fom: [Doer Selcson o
Avaable M Eytes) L Wi ——
e Memary (ytes) o]+ =
" s F T
oe= Momeryyies) 27120 Lagical Instance Name M;:'fxm m;ﬂoflfm Memary Cantent | Storage Type | Memory Source

04z 2048t Content filled with Dz | sNVIA

102412 102412 Content Filled with 0s | $9-Flash | Configuratar

Avadable Memary {Bies): 6111
Used Memory (vies] 608
Fres MemoryiByies) 261504

Figure 85 - Fabric RAMSs Initialization
Common Commands for All Configure Design Initialization Data and Memories Tabs

If a Configure Design Initialization Data and Memories Tab title has an asterisk (*) next to it, an item on that
tab has been changed, but not yet "Applied". The common options on every tab page are:

o Apply - Click the Apply button to save the changes made in this tab.
Note: The Apply button only saves the configuration changes. For the initialization of the memory block to
take effect, go back to the Device Initialization tab and click Generate Initialization Clients.

e Discard - Click the Discard button to discard any changes made in this tab.
Fabric RAM Clients Configuration:

e Click on Load design configuration to reset all Fabric RAM clients to their first configuration (the values
specified by the first Apply for each client). This overrides any subsequent Apply commands that have
been made.

e Click the Initialize all clients from pull-down menu to select from:

e sNVM
¢ UuPROM
e SPI-Flash

e User Selection

¢ Instruction commands generated by Libero to initialize the memory blocks (Fabric RAM clients) can be
saved in any of the storage types (sNVM, uPROM, or SPI-Flash). As a convenience, however, the user
can select to initialize all Fabric RAM clients from the same storage type. If you select any one of the
storage types from this pick-list, the instruction commands to initialize all clients are generated in sNVM,
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uPROM, or SPI, as you selected. Choosing User Selection indicates that each Fabric RAM Client will be
configured separately.

Fabric RAM Client Table

Each row in the Fabric RAM Client Table provides information about a Fabric RAM Client. The first three items
are information-only, and cannot be modified from this dialog box:

1. Logical Instance Name
2. PortA Depth x Width
3. PortB Depth x Width

ltems 4-6 are configurable; either by the Initialize all clients mechanism previously described for all clients, or by
individual User Selection configuration:

4. Memory Content
5. Storage Type
6. Memory Source

To configure a Fabric RAM client with client-specific initialization options, double-click the Fabric RAM client row
(or right-click on the row and select Edit..., or single click on the row and click on the Edit button above the table).
This will bring up an Edit Fabric RAM Initialization Client dialog box (see below) for this particular client.

Note: If you change the Storage Type for a specific client to something other than that previously chosen for all
clients, this will also change the Initialize all clients from value to User selection.

Edit Fabric RAM Initialization Client
Q) ? | =

Physical Name: |sram_0fusram_usram_0_PF_URAM_ROCO/RAMG4x12_PHYS_O/INST_RAMG4x12_IP

RAM Initialization Options

" Content from file: [ |

(" Content filled with 0s

(¥ No content (client is a placeholder and will not be programmed)

Optimize for: * H gh Speed ™ Low power

Storage Type |SPI-FIash I
Help I OK Close

Figure 86 - Edit Fabric RAM Initialization Client Dialog Box
Dialog Box Sections:

e Client Name - Information only. Cannot be changed in this dialog box
o Physical Name - Information only. Cannot be changed in this dialog box
¢ RAM Initialization Options:
o No Content - The memory block is not initialized.
e Content Filled with Zeros - The memory block is filled with zeros for initialization.

o Memory File - Click the Browse button to navigate to the location of a memory file and import the
file to the memory block. By default, the same memory file as specified in the memory configurator
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is used. The supported memory file formats are Intel-HEX (*.hex), Motorola (*.s), Simple-Hex
(*.shx), or Microsemi-Binary (*.mem).

e Optimize for - Information only. Cannot be changed in this dialog box.
e Storage Type - User can select from the available Storage Types:

e sNVM

e UuPROM

e SPI-Flash
See Also

Configure Design Initialization Data and Memories

Generate Design Initialization Data

To generate the initialization clients, do one of the following in the Design Flow window:
e Double-click Generate Design Initialization Data
or
e Right-click Generate Design Initialization Data and choose Run
Libero SoC carries out the following three actions:
o Generates the memory files corresponding to the three stages of the initialization sequence.
o Removes all pre-existing initialization clients.
e Creates the initialization clients for each stage and places them in their target memories.

o The first stage initialization client is always created, and is always placed in sSNVM. It is always
placed at start address 0xDCOO0 (page 220).

o The second stage initialization client is created only when there are PCle blocks presentin the
design. It is always placed in sNVM. It is placed at the start address specified by the user in the
‘Design Initialization’ tab of the ‘Configure Design Initialization Data and Memories’ tool.

o The third stage initialization client is created only when there are Fabric RAMs in the design or non-
PCle transceiver blocks in the design. It can be placed in any of uPROM, sNVM, or SPI memories
at the user-specified start address. The user can specify both the target memory and the target
start address in the ‘Design Initialization’ tab of the ‘Configure Design Initialization Data and
Memories’ tool.

See Also
Configure Design Initialization Data and Memories

generate design initialization data

Configure I/O States During JTAG Programming

In the Libero SoC Design Flow window expand Program Design and double-click Configure /O States During
JTAG Programming to specify the I/O states prior to programming. This feature is only available once Layout is
completed.

The default state for all I/Os is Tri-state.

To specify I/O states during programming:

1. Sort the pins as desired by clicking any of the column headers to sort the entries by that header. Select the
I/Os you wish to modify (as shown in the figure below).

2. Set the /O Output state. You can set Basic I/O settings if you want to use the default I/O settings for your
pins, or use Custom /O settings to customize the settings for each pin. See the Specifying I/0O States During
Programming - I/O States and BSR Details help topic for more information on setting your I/O state and the
corresponding pin values. Basic I/O state settings are:

e 1-1/Ois set to drive out logic High
e 0-1/Ois set to drive out logic Low
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o Last Known State: I/O is set to the last value that was driven out prior to entering the programming
mode, and then held at that value during programming

e Z- Tri-State: I/O is tristated with weak pull up (10k ohm)

= Specify 1/O States During Programming - JTAG Mode Only x
Load from file.. | | Save to file... Show BSR Details
Port Name Macro Cell Pin Number I/O State (Output Only)
1| UNUSED UNUSED 31 z
2| UNUSED UNUSED 30 Z

(o [ cnee

Figure 87 - /0 States During Programming Window
3. Click OK to save your settings.

Note: I/O States During programming will be used during programming or when exporting the bitstream.

Configure Programming Options

Sets your Design version, Back Level version and Silicon signature.
Design name is a read-only field that identifies your design.

Design version (number between 0 and 65535) - Specifies the Design version to be programmed to the device.
This value is also used for Back Level protection in "Update Policy" on page 129 of the Configure Security
tool.

Back Level version (number between 0 and 65535) - Specifies the Back Level version to be programmed to
the device. This has to be always less than or equal to Design version number. A warning message appears if the
Back Level version is equal to the Design version and an info message appears if it is less than the Design
version. Move your mouse over warning or info icon to view the message respectively. This value is used for Back
Level protection (if enabled) in Update Policy of the Configure Security tool.

Silicon signature (max length is 8 HEX chars) - 32-bit user configurable silicon signature to be programmed
into the device. This field can be read from the device using the JTAG (IEEE 1149-1) USERCODE instruction or
by running the DEVICE INFO programming action.
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"
U

Design name: fftausram_new

Design version (number between 0 and 65535): | 3

1. Back Level version (number between 0 and 65535); | 3

Silicon signature (max length is 8 HEX chars):  Ox | 2

Help oK Cancel

Figure 88 - Configure Programming Options Dialog Box

Notes

SPI file programming for Auto Programming, Auto Update (IAP) and IAP/ISP Services currently can only
program security once with the master file. Update files cannot update the Security settings. In addition,

Silicon signature, and Tamper Macro can only be programmed with the master file and cannot be
updated.

Configure Security

Configure Security Wizard
The Configure Security Wizard is a GUI-based wizard that guides the user step by step on how to configure
custom security settings. The wizard has five steps executed in this sequential order:
1. Userkeys
Update Policy
Debug Policy

Microsemi Policy
JTAG/SPI Slave Commands

ok wbd
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Encrypt bitstream with default key. No user keys or security settings are enabled.

Security key mode

' Bitstream encryption with default key " Custom security options

User Keys
| Update Policy
Debug Policy

—

Microsemi

Back Next | Finish Cancel

Figure 89 - Configure Security Wizard

Summary Window

The summary window displays the summary of the current configuration settings. The window will scroll to the
current page as you move from page to page.

Security Key Mode

Two security key modes are available.

o Bitstream encryption with default key
This mode uses the default encryption key for security. The Next and Back button are disabled. All steps are
disabled. Custom User Keys and security settings are disabled.

e Custom security Mode
This mode allows you to configure custom security keys and settings. All steps are enabled. The Next and
Back button are enabled.

Back

Click Back to return to the previous step.
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Next
Click Next to proceed to the next step.
Finish
Click Finish to skip steps and complete the configuration.

User Keys
The User Keys are configured in this step. All keys are 256 bits (64 HEX characters).

5| Configure Security Wizard w
Disable all factory key modes and configured security settings. -
Use FlashLock/UPK1 to temporarily enable settings during one p ing/del il i

UPK1 and UEK1 will be programmed and available for use.
UPK2 and UEK2 will be programmed and available for use.

m

Update Palicy
Fabric can be updated using a bitstream encrypted with UEK1 or UEK2,
sNVM can be updated using a bitstream encrypted with UEK1 or UEK2.

Debug Palicy
DFK has not been provided and will not be programmed.
SmartDebug user debug access and active probes are enabled.
SmartDebug Live Probe debug access is enabled,
SmartDebug sMVM debug is enabled.
JTAG or SPI Slave UJTAG is enabled, -

Security key mode

() Bitstream encryption with default key @ Custom security options

User Key Set 1 {UK51)
User keys FlashLock/UPK 1 protects all security settings. You are required to configure it.

FlashLock/UPK1 (64 HEX chars):

| &Ox

Update policy 'fiu can use User Enaryption Key 1 (UEK1) for updating the Fabric, uPROM, and sMYM or disable it.
|| Disable UEK1
| LEK1 (User Encryption Key 1) (64 HEX charg):
B
Debug policy

User Key Set 2 (UKS2)
You can optionally configure User Key Set 2 (UKSZ) for a second encryption key.
| [ Disable UEK2

LEK2 {User Encryption Key 2) (64 HEX charg):

& o

| User Pass Key 2 (UPK2) protects UEK2 and is required if you use UEK2.

UPK2 {User Pass Key 2) (64 HEX chars):

&Dx

Help |SavesummarymFiIe.‘. Back Next ] l Finish | I Cancel ]

Figure 90 - User Keys
FlashLock/UPK1

FlashLock/UPK1 is enabled by default. This key protects all security settings. This key is required and must be a
string of 64 HEX characters. Enter the key or click the padlock icon at the far right to generate a random key.
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User Encryption Key 1 (UEK1)

UEK1 is enabled by default. Click Disable if you want to disable it. If enabled, the key is required and must be a
string of 64 HEX characters. Enter the key or click the padlock icon at the far right to generate a random key.

Use UEK1 for updating the Fabric, uPROM, and sNVM or disable it.
User Encryption Key 2 (UEK2)

UEK2 is enabled by default. Click Disable if you want to disable it. If enabled, the key is required and must be a
string of 64 HEX characters. Enter the key or click the padlock icon at the far right to generate a random key.

Use UEK2 as a second encryption key for updating the Fabric, uPROM, and sNVM or disable it
User Pass Key 2 (UPK2)

UPK?2 is required if UEK2 is enabled. Enter the key or click the padlock icon at the far right to generate a random
key.

Update Policy

Field updates are enabled by default. Use this page to disable field updates and to specify field-update protection
parameters.
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H
5

Disable all factory key modes and configured security settings.
Use FlashLock/UPK1 to temporarily enable settings during one programming/debugging session.

User Keys
Enable UEK1. FlashLock/UPK1 is required to change this setting.
UPK1 and UEK1 will be programmed and available for use.
Disable UEK2. FlashLock/UPK1 is required to change this setting.

Update Policy
Fabric can be updated using a bitstream encrypted with UEK1.
=MVM can be updated using a bitstream encrypted with UEK1,

Back Level protection is enabled. Use FlashLock/UPK1 to bypass Back Level protection,

Degign version: 3 Back Level version: 2

Auto Programming, Auto Update, [AP Services, and Programming Recovery are enabled for update.

JTAG interface is enabled for update, j
SPT Slave interfare is enahled for nndate

Security key mode

" Bitstream encryption with default key {« Custom security options

Field updates are enabled by default. You can disable updates by setting options below.
Use FlashLock/UPK1 to temporarily enable disabled settings.

User Keys

Fabric update protection: ‘Updates allowed using user defined encryption keys; FlashLock/UPK1 is not required for updates

L L]

sMVM update protection: ‘Updabes allowed using user defined encryption keys; FlashLock/UPK1 is not required for updates
¥ Enable Back Level protection

Update Policy o Design version: 3

0 Back Level version: 2

‘ Disable programming interfaces:

[ Auto Programming and IAP Services

Debug Palicy W

*'7 I~ sP1Slave

Disable bitstream programming actions (JTAG/SPI Slave):
™ Program
I Authenticate
™ verify

Reset to default

Save Summary to File... | Back Mext Finish Cancel

Figure 91 - Update Policy
Fabric update protection

Two options are available:
e Disable Erase/rite operations
WARNING: The field update STAPL files (_uek1/_uek2) will include plain-text FlashLock/UPK1
e Updates allowed using user defined encryption keys; FlashLock/UPK1 is not required for updates

sNVM update protection options:

Two options are available:
o Disable Write operations
WARNING: The field update STAPL files (_uek1/_uek?2) will include plain-text FlashLock/UPK1

e Updates allowed using user defined encryption keys; FlashLock/UPK1 is not required for updates

a A3\ MicrRocHIP company
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When enabled, a field update design being programmed must be of a version higher than the Back Level version
value in the programmed device. This protection will prevent field update designs with back level versions less

than or equal to the design version programmed in the device.

Design version (number between 0 to 65535)

Displays the current Design version (as set in the Configure Programming Options tool).

Back Level version (number between 0 to 65535)

Displays the current Back level version ( as set in the Configure Programming Options tool). Back Level version
uses the Design version value to determine which bitstreams are allowed for programming. The Back Level
version must be smaller than or equal to Design version.

Note: If Back Level Protection is disabled and Back Level version is greater than zero, then Generate Bitstream
and Export Bitstream tools will error out.

The following are the examples with Back Level protection enabled in the Configure Security tool:
Example 1: Programming the Back Level version to the same version as the Design version

Step Bitstream Action Bitstream Bitstream Device Result
Design Back Level Back
version version Level
version
1 _master PROGRAM 1 1 Pass
2 _master VERIFY 1 1 Pass, if device has
UPK1
3 _master ERASE 1 1 Pass, if device has
UPKA1
4 _master AUTHENTICATE 1 1 Pass, if device has
UPKA1
5 _master DEVICE_INFO 1 1 Always passes
6 _uek1 PROGRAM 2 2 Pass
7 _master PROGRAM 1 2 Fail, due to back
level protection
Example 2: Programming the Back Level version less than the Design version
Step Bitstream Action Bitstream Bitstream Device Result
Design Back Level Back
version version Level
version
1 _master PROGRAM 1 1 Pass
2 _uek1 PROGRAM 1 1 Pass
3 _uek1_1 PROGRAM 1 1 Pass
4 _uek1_2 PROGRAM 4 4 Pass
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Step Bitstream Action Bitstream Bitstream Device Result
Design Back Level Back
version version Level
version
5 _master PROGRAM 2 1 4 Fail, due to back

level protection

6 _uek1 PROGRAM 3 1 4 Fail, due to back
level protection

7 _uek1_1 PROGRAM 4 1 1 Fail, due to back
level protection

8 uek1_2 VERIFY 5 4 4 Pass

Disable programming interfaces

The following programming interfaces can be disabled
e Auto Programming and IAP services
o JTAG
e SPISlave
Disabling of all three interfaces is not allowed and an error message appears if all three interfaces are disabled.

Disable Bitstream Programming Actions (JTAG/SPI Slave)

* Program

* Authenticate

* Verify

WARNING: The field update STAPL files (_uek1/_uek?2) will include plain-text FlashLock/UPK1
The summary at the top of the wizard summarizes the result of the selection.

Reset to Default

Reset the options to default values. All options are unchecked.

Debug Policy
The Debug Policy page allows you to configure Debug Protections. By default, debugging is enabled.

Debug with DPK (Debug Pass Key) - Optional

Protect Debug with a 256-bit (64-character HEX) Debug Pass Key. Enter the key in the field or click the padlock
icon at the far right to generate a random key. This key is optional if you want a separate passkey to enable
access to disabled debug features during one debugging session.

If the DPK key is entered, then at least one option must be checked.
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| Configure Security Wizard ﬁ

Debug Policy -
DPK has not been provided and will not be programmed.
SmartDebug user debug access and active probes are enabled.
SmartDebug Live Probe debug access is enabled.
SmartDebug sNVM debug is enabled.
JTAG or SPI Slave UITAG is enabled.
JTAG (1149.1) boundary scan is enabled.
JTAG or SPI Slave reading of temperature and voltage sensor is enabled.

Microsemi Factory Access
Allow Microsemi factory test mode access. This is required to perform Failure Analysis on the device. -

Security key mode

Bitstream encryption with default key @) Custom security options

" Debugging is enabled by default at this stage for design and debug.
Use FlashLock/UPK1 or DPK to temporarily enable access to disabled debug features during one debugging session,

DPK (Debug Pass Key) (64 HEX chars):
I 0x &
Update policy SmartDebug access control
| Disable user debug access and active probes

I Disable Live Probe

- Disable sNvM
A Debug policy e
I Disable UITAG command through JTAG interface
. Disable JTAG (1149.1) boundary scan
Microsemi i
factory || Disable reading temperature and voltage sensor (JTAG/SFI Slave)
R access

I iReset to default|
L

:_Save Summaryloﬁle...] Back [ Next J Finish j [ Cancel

Figure 92 - Debug Policy
SmartDebug Access Control

All of the following are enabled by default for SmartDebug access. Check to disable access.
e Disable User Debug Access and Active Probe
e Disable Live Probe
e Disable sNVM

WARNING: Leaving SmartDebug access control enabled on production devices will allow anyone to
debug or access active probes, access Live Probe, or read the content of sNVM.

Three additional options are:
e Disable UJTAG command through JTAG Interface

e Disable JTAG (1149.1) boundary scan
Disables JTAG (1149.1) commands. The following JTAG commands will be disabled: HIGHZ, EXTEST,
INTEST, CLAMP, SAMPLE, and PRELOAD. I/Os will be tri-stated when in JTAG programming mode and
BSR control during programming is disabled. BYPASS, IDCODE, and USERCODE instructions will remain
functional.

o Disable reading temperature and voltage sensor (JTAG/SPI Slave)

The summary at the top of the page displays the results of the selection.

Microsemi Factory Access Policy

The page allows you to configure the policy for Microsemi Test Mode Access. Test mode access is required for
Failure Analysis on the device.
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[ Configure Security Wizard

)

JTAG or SPI Slave UTTAG is enabled.
JTAG (1149.1) boundary scan is enabled.
JTAG or SFI Slave reading of temperature and voltage sensor is enabled.

Microsemi Factory Access

JTAG/SPI Slave User Commands Policy
FUF emulation is available.

External zeroization through JTAG/SFI Slave is available.
Security key mode

Microsemi factory test mode access is allowed by default.
This is required to perform Failure Analysis on the device.

User keys Use FlashLock/UPK1 to change access level.

Microsemi factory test mode access level
Update policy @) Allow factory test mode access
") Disable factory test mode access

Debug policy

Reset to default

Microsemi
factory
access

|
JTAG/SFI Slave
commands
policy

Allow Microsemi factory test mode access. This is required to perform Failure Analysis on the device.

External Fabric/sMVM design digest check requests through JTAG and SFI Slave are available.

(7)) Bitstream encryption with default key (@) Custom security options

1

| Help [Sa\re Summary to Fl\e...l |

I [ Cancel

Figure 93 - Microsemi Access Policy

Two options are available:

+ Allow factory test mode access (default setting).

WARNING: This is not recommended for production devices.

+ Disable factory test mode access

NOTE: Use FlashLock/UPK1 to change access level

JTAG/SPI Slave Command Policy

The page allows you to configure the policy for JTAG/SPI Slave User Commands. Three options are available.
Enabled is the default setting for all three options. Click the checkbox to disable any of the settings.

* Disable all external access to PUF emulation through JTAG/SPI Slave
* Disable external Fabric/sNVM digest requests through JTAG/SPI Slave

WARNING: Repeated external Fabric digest calculations can impact device reliability. View Datasheet for

additional information.
+ Disable external zeroization through JTAG/SPI Slave

WARNING: It is not recommended to leave zeroization enabled for production devices
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[»1| Configure Security Wizard &J

JTAG or SPI Slave UTTAG is enabled. -
JTAG (1149.1) boundary scan is enabled.
JTAG or SFI Slave reading of temperature and voltage sensor is enabled.

Microsemi Factory Access
Allow Microsemi factory test mode access. This is required to perform Failure Analysis on the device.

JTAG/SPI Slave User Commands Policy
PUF emulation is available.
External Fabric/sMVM design digest check requests through JTAG and SPI Slave are available.
External zeroization through JTAG/SFI Slave is available.

m

Security key mode

() Bitstream encryption with default key @ custom security options

PUF emulation is available by default

User keys || pisable all external access to PUF emulation

External Fabric/sNVM digest requests JTAG/SPI Slave are available by default
[ pisable external Fabric/sNVM digest requests through JTAG/SPI Slave

Update policy External zeroization through JTAG/SPI Slave is available by default
[] pisable external zeroization through TTAG/SPT Slave

Debug policy

focory (Gt

Microsemi
access

JTAG/SPI Slave
commands

palicy

Help [Sa\re Summary to Fl\e...l | Back ] Next ‘ Finish I [ Cancel

Figure 94 - JTAG/SPI Slave Commands Policy

Security Features Frequently Asked Questions

I have configured the Security Wizard and enabled security in my design but | do not want to program my
design with the Security Policy Manager features enabled. What do | do?

Go to Configure Bitstream and uncheck Security.

What is programmed when | click Program Device?

All features configured in your design and enabled in the Configure Bitstream tool. Any features you have
configured (such as sNVM or Security) are enabled for programming by default.

When | click Program Device is the programming file encrypted?
All programming files are encrypted. To generate programming files encrypted with UEK1 or UEK2 you must
generate them from Export Bitstream for field updates.
Note: Once security is programmed, you must erase the security before attempting to reprogram the
security.
How do | generate encrypted programming files with User Encryption Key 1/2?
o Configure the Security Wizard and specify User Key Set 1, User Key Set 2. Ensure the Security

programming feature is enabled in Configure Bitstream; it is enabled by default once you configure the
Security Policy Manager.

e Export Bitstream from Handoff Design for Production - <filename>_uek1.(stp/spi/dat),
<filename>_uek2.(stp/spi/dat) files are encrypted with UEK1, UEK2,respectively. See Security Programming
File Descriptions below for more information on programming files.

What are Security Programming Files?
See the Security Programming Files topic for more information.

135



PolarFire FPGA Design Flow User Guide

& Microsemi

a A3\ MicrRocHIP company

Configure Permanent Locks for Production

Configure Permanent Locks for Production is a GUI-based tool that guides the user step by step on how to
configure the Permanent Locks for Production. The wizard has six steps/pages executed in sequential order. One
Time Programmable (OTP) settings in the Permanent Locks page are applied to configured Security settings from
the Configure Security tool. The subsequent pages have read only fields, which will be affected by Permanent
Lock settings. These settings can only be configured by the Configure Security tool.

If you configure any Permanent Lock settings, you will be forced to go through each page to review the Security
settings to make sure they are as desired. The settings cannot be changed once they have been programmed.

. Permanent Locks
. User keys in Configure Security

. Update Policy in Configure Security

. Microsemi Factory Access in Configure Security

1
2
3
4. Debug Policy in Configure Security
5
6

. JTAG/SPI Slave Commands Policy in Configure Security

Summary Window

Back

Next

Finish

The summary window displays the summary of the current page configuration settings. Based on the selection
made in the first page, the summary for the subsequent pages change. The window will scroll to the current page
as you move from page to page.

Click Back to return to the previous step.

Click Next to proceed to the next step.

Click Finish to complete the configuration after executing the all the steps in sequential order.

Save Summary to File

Click Save Summary to File to save the display in the Summary field to a file.

Permanent Locks

This page allows you to configure Permanent Locks for Production programming. Permanent Locks should be
configured after the Design/Debug phase has been completed. The Permanent Lock settings will not be applied
to programming within Libero. They are only applied to the Export tools used for Production programming. Once
the Permanent Locks are programmed, they cannot be changed. Configuring the Permanent Locks will affect the
settings on the subsequent pages and should be reviewed carefully. The settings cannot be changed once they
are programmed.
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Disable all factory key modes and configured security settings.
Use FlashLock/UPK1 to temporarily enable settings during one programming/debugging session.

Permanent Locks
Mo permanent locks selected,

User Keys
Enable UEK 1. FlashLock/UPK 1 is required to change this setting,
UPK1 and UEK1 will be programmed and available for use.
Disable UEK2. FlashLock/UPK1 is required to change this setting.

Update Policy
Fabric can be updated using a bitstream encrypted with UEK1.
sNVM can be updated using a bitstream encrypted with UEK1.

Back Level protection is enabled, Use FlashLock/UPK 1 to bypass Back Level protection,
Design version: 3 Back Level version: 2 j

User keys and security policies are protected with FlashLock.

You can make any of the settings below permanent (one-time programmable]).
Permanent

Locks

All one-time programming bits are located in the same segment.

Once one of these bits iz programmed they cannot be changed,

this entire segment becomes non-changesble.

User Keys
g ™ Permanently disable UPK1

User Encryption Key 1 (UEK1) and security polides will be permanently write-protected.
™ Permanently disable UPK2

User Encryption Key 2 (UEK2) will be permanently write-protected.

Permanently disable SmartDebug access control and
reading temperature and voltage sensor (JTAG/SPI)

[ Permanently disable Debug Pass Key (DPK)
[ Permanently write-protect Fabric

™ Permanently disable Microsemi factory test mode access

This will permanently disable access to the programming interfaces. Al pins are disabled.

r Permanently disable Auto Programming, JTAG, and SP1 Slave
programming interfaces

All

Figure 95 - Configure Permanent Lock for Production
the user keys and security policies are protected with FlashLock and can be made One-Time Programmable,

by configuring the Permanent Lock settings.

You can select one or more of the below options to be locked permanently:

Permanently disable UPK1 - This will permanently disable FlashLock/UPK1 from being able to be matched
by the device. Any feature that is disabled will be permanently disabled. Any feature that is available will be
permanently available.

Permanently disable UPK2 - This will permanently disable FlashLock/UPK2 from being able to be matched
by the device. If UEK2 is enabled and selected for programming, then it cannot be changed.

Permanently disable SmartDebug access control and reading temperature and voltage sensor -This
will permanently disable SmartDebug access control for user debug and active probes, live probes and,
sNVM along with the ability to read the temperature and voltage sensor.

Permanently disable Debug Pass Key(DPK) - This will permanently disable the FlashLock/DPK from
being able to be matched by the device. If DPK was programmed, then it can no longer be used for
SmartDebug access.

Permanently write-protect Fabric - This will make the Fabric One-Time Programmabile. Verify of the
Fabric will still be possible. Erase/Program of the Fabric is permanently disabled.

Permanently disable Microsemi factory test mode access - This will permanently disable Microsemi
factory test mode access. Microsemi will not be able to perform a Failure Analysis on this device.

Permanently disable Auto Programming, JTAG and SPI Slave programming interfaces - This will
permanently disable all programming interfaces. The actual JTAG and SPI Slave ports are disabled and you
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cannot access the device for any operations including reading the IDCODE of the device. The device will
become One-Time Programmable and there will be no way to Erase/Program/Verify the device.

The summary window displays the summary of the current configuration set in Permanent Locks page. The
summary can be exported to a file and is recommended to keep a record of the settings configured. It is important
to review the summary carefully and ensure the settings and behaviors are as expected since they cannot be
changed once the device is programmed.

Remove Permanent Locks

You can remove the Permanent Lock settings by either right-clicking on the tool in the Design Tree or by clicking
the button in the Ul.

When selected removes all the Permanent Locks selected and restores to initial security settings configured in
Configure Security tool. This option is highlighted only when at least one of the Permanent Locks is enabled.
See Also

Configure Security
Tcl command for Permanent Locks

remove permanent locks

Configure Bitstream
Right-click Generate Bitstream in the Design Flow window and choose Configure Options to open the
Configure Bitstream dialog box.

The Configure Bitstream dialog box enables you to select which components you wish to program. Only features
that have been added to your design are available for programming.

If the design includes uPROM, it will be included in the Fabric.

138



& Microsemi

a A3\ MicrRocHIP company

# | Configure Bitstream

Program

PolarFire FPGA Design Flow User Guide

v | Fabric

Help | ok || cancel

Figure 96 - Configure Bitstream Dialog Box
Notes:
e Custom security is enabled if security was configured.
o All available features are selected by default.
e sNVM is always programmed with Fabric.

See Also
Note: "Generate Bitstream " on page 139

Generate Bitstream
Generates the bitstream for use with the Run PROGRAM Action tool.

The tool incorporates the Fabric design, sSNVM configuration and custom security settings (if configured) to
generate the bitstream file. You need to configure the bitstream before you generate the bitstream. Otherwise,
default settings with all available features included will be used. Right-click Generate Bitstream and choose
Configure Options to open the Configure Bitstream dialog box to select which components you wish to program.
Only features that have been added to your design are available for programming.

If the design includes uPROM, it will be included in the Fabric.

Modifications to the Fabric design, sSNVM configuration, or security settings will invalidate this tool and require
regeneration of the bitstream file.

The Fabric programming data will only be regenerated if you make changes to the Fabric design, such as in the
Create Design, Create Constraints and Implement Design sections of the Design Flow window.

When the process is complete a green check appears next to the operation in the Design Flow window (as shown
in the figure below) and information messages appear in the Log window.
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- # Program and Debug Design
=L | Generate FPGA Array Data
@ Update uPROM Memory Content
- ¢ Configure Hardware
I*[ Programming Connectivity and Interface
: & Configure Programmer
.ﬂu Select Programmer
- &y Configure 1/0 States During JTAG Programming
-_,, Configure Programming Options

4@ Run PROGRAM Action
=l- » Debug Design
b iy Identify Debug Design
€ SmartDebug Design

Figure 97 - Generate Bitstream (Complete)

See also
Configure Bitstream Dialog Box

Run Programming Device Actions

If you have a device programmer connected, you can double-click Run PROGRAM Action to execute your
programming in batch mode with default settings.

If your programmer is not connected, or if your default settings are invalid, the Reports view lists the error(s).
Right-click Run PROGRAM Action and choose Configure Action/Procedures to open the Select Action and
Procedures dialog box.

Programming File Actions
Libero SoC enables you to program security settings, FPGA Array, and sNVM features.
Note: If the design includes UPROM, it will be included in the Fabric.

You can program these features separately using different programming files or you can combine them into one
programming file.

In the Design Flow window, expand Program Design, click Run PROGRAM Action, and right-click Configure
Actions/Procedures.
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-

| | Select Action and Procedures

===

Action:

| PROGRAM

Procedures:

VERIFY_IDCODE
PROC_ENABLE
DO_PROGRAM
| DO_VERIFY
DO_EXIT

wo | [0 ]|

Cancel

Figure 98 - Select Actions and Procedures

Left-click on the Action: picklist to select from the following actions:

Action:

DEVICE_INFO
ENC_DATA_AUTHENTICATION
ERASE

READ_IDCODE
VERIFY
VERIFY_DIGEST

PROGRAM

Figure 99 - Action Choices

The following table lists programming file actions and supported procedures.

Table 2 - Programming File Actions and Supported Procedures

Action

Procedures

DO_EXIT

DEVICE_INFO VERIFY_IDCODE
DO_DEVICE_INFO

DO_EXIT

ENC_DATA_AUTHENTICATION VERIFY_IDCODE
DO_AUTHENTICATION
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Action Procedures

ERASE VERIFY_IDCODE
PROC_ENABLE
DO ERASE
DO_EXIT

PROGRAM VERIFY_IDCODE
PROC_ENABLE
DO_PROGRAM
DO_VERIFY
DO_EXIT

READ_IDCODE VERIFY_IDCODE
PRINT_IDCODE
DO_EXIT

VERIFY VERIFY_IDCODE
PROC_ENABLE
DO_VERIFY
DO_EXIT

VERIFY_DIGEST VERIFY_IDCODE
PROC_ENABLE
DO_VERIFY_DIGEST
DO_EXIT

The table below lists programming file actions and descriptions.
Table 3 - Programming File Actions

Action Description
PROGRAM Programs all selected family features: FPGA Array, targeted sNVM clients, and
security settings.
ERASE Erases the selected family features: FPGA Array and Security settings.
VERIFY_DIGEST Calculates the digests for the components (Custom Security, Fabric, or sSNVM)

included in the bitstream and compares them against the programmed values.

VERIFY Verifies all selected family features: FPGA Array, targeted sNVM clients, and
security settings.

ENC_DATA_AUTHEN | Encrypted bitstream authentication data.

TICATION

READ_IDCODE Reads the device ID code from the device.

DEVICE_INFO Displays the IDCODE, the design name, the checksum, and device security
settings and programming environment information programmed into the
device.
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Options Available in Programming Actions

The table below shows the options available for specific programming actions.

Table 4 - Programming File Actions - Options

Action

Option and Description

PROGRAM

DO_VERIFY - Enables or disables programming
verification

VERIFY_DIGEST

DO_ENABLE_FABRIC - Includes Fabric and Fabric
configuration in the digest check

DO_ENABLE_SNVM - Includes the sSNVM in the
digest check

DO_ENABLE_SECURITY - Includes security policy
settings and UPK1 security segments in the digest
check

DO_ENABLE_UEK1 - Includes UEK1 in the digest
check

DO_ENABLE_UKS2? - Includes User Key Set 2 (UPK2
and UEK2) security segment in the digest check

DO_ENABLE_DPK - Includes DPK security segment
in the digest check

DO_ENABLE_SMK - Includes the SMK security
segment in the digest check

DO_ENABLE_USER_PUBLIC_KEY - Includes the
User Public Key security segment in the digest check

Exit Codes (PolarFire)

Error Exit Message Exit Possible Cause Possible Solution
Code Code
Passed (no error) 0 - -
0x8002 Failed to disable 5 Unstable voltage level Monitor related power supplies that cause the
programming mode issue during programming; check for transients
Signal integrity issues on outside of Microsemi specifications. See your
Failed to set JTAG pins device datasheet for more information on
programming mode transient specifications.
Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection.
0x8032 Device is busy 5 Unstable VDDIx voltage Monitor related power supplies that cause the
level issue during programming; check for transients
outside of Microsemi specifications. See your
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Error Exit Message Exit Possible Cause Possible Solution
Code Code
device datasheet for more information on
transient specifications.
0x8003 Failed to enter 5 Unstable voltage level Monitor related power supplies that cause the
programming mode issue during programming; check for transients
Signal integrity issues on outside of Microsemi specifications. See your
JTAG pins device datasheet for more information on
transient specifications.
DEVRST_N is tied to LOW
Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection.
Tie DEVRST_N to HIGH prior to programming
the device.
0x8004 Failed to verify 6 Incorrect programming file Choose the correct programming file and select
IDCODE the correct device in the chain.
Incorrect device in chain
Measure JTAG pins and noise for reflection. If
Signal integrity issues on TRST is left floating then add pull-up to pin.
JTAG pins
Reduce the length of Ground connection.
0x8005 Failed to verify FPGA | 11 Device is programmed with | Verify the device is programmed with the
0x8006 Array a different design or the correct data/design.
0x8007 component is blank.
0x8008 Failed to verify Fabric Monitor related power supplies that cause the
Configuration Unstable voltage level. issue during programming; check for transients
outside of Microsemi specifications. See your
Failed to verify Signal integrity issues on device datasheet for more information on
Security JTAG pins. transient specifications.
Failed to verify sSNVM Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection.
0x8013 External digest check |-18 External Digest check via Need to use a bitstream file which has a valid
via JTAG/SPI Slave is JTAG/SPI Slave is disabled. | FlashLock/UPK1 to enable external digest
disabled. check via JTAG/SPI Slave.
0x8015 FPGA Fabric digest -20 FPGA Fabric is either If the Fabric is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_FABRIC" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_FABRI
C' to remove this
digest check.
0x8016 sNVM digest -20 sNVM is either erased or the | If the sSNVM is erased, deselect procedure

verification: FAIL

Deselect procedure
'DO_ENABLE_SNVM'
to remove this digest
check.

data has been corrupted or
tampered with

"DO_ENABLE_SNVM" from action
"VERIFY_DIGEST"
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Error Exit Message Exit Possible Cause Possible Solution
Code Code
0x8018 User security -20 Security segment is either If the security is erased, deselect procedure
policices segment erased or the data has been | "DO_ENABLE_SECURITY" from action
digest verification: corrupted or tampered with | "VERIFY_DIGEST"
FAIL
Deselect procedure
'DO_ENABLE_SECU
RITY' to remove this
digest check.
0x8019 UPK1 segment digest | -20 UPK1 segment is either If the UPK1 is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_SECURITY" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_SECU
RITY' to remove this
digest check.
0x801A UPK2 segment digest | -20 UPK2 segment is either If the UPK2 is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_UKS2" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_UKS?2'
to remove this digest
check.
0x801B Factory row and -20 Factory row and factory key
factory key segment segment have been erased
digest verification: through zeroization or the
FAIL data has been corrupted or
tampered with
0x801C Fabric configuration -20 Fabric configuration If the Fabric configuration is erased, deselect
segment digest segment is either erased or | procedure "DO_ENABLE_FABRIC" from action
verification: FAIL has been corrupted or "VERIFY_DIGEST"
tampered with
Deselect procedure
'DO_ENABLE_FABRI
C' to remove this
digest check.
0x8052 UEK1 segment digest | -20 UEK1 segment is either If the UEK1 is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_UEK1" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_UEKT'
to remove this digest
check.
0x8053 UEK2 segment digest | -20 UEK2 segment is either If the UEK2 is erased, deselect procedure

verification: FAIL

Deselect procedure
'DO_ENABLE_UEK?2'

erased or the data has been
corrupted or tampered with

"DO_ENABLE_UEK2" from action
"VERIFY_DIGEST"
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Error Exit Message Exit Possible Cause Possible Solution
Code Code
to remove this digest
check.
0x8054 DPK segment digest | -20 DPK segment is either If the DPK is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_DPK" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_DPK'
to remove this digest
check.
0x8057 SMK segment digest | -20 SMK segment is either If the SMK is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_SMK" from action
corrupted or tampered with | "VERIFY_DIGEST"
0x8058 User Public Key -20 User Public Key segmentis | If the User Public Key is erased, deselect
segment digest either erased or the data procedure
verification: FAIL has been corrupted or "DO_ENABLE_USER_PUBLIC_KEY" from
tampered with action "VERIFY_DIGEST"
0x801D Device security -21 The device is protected with | Run DEVICE_INFO to view security features
prevented operation user pass key 1 and the that are protected.
bitstream file does not
contain user pass key 1. Provide a bitstream file with a user pass key 1
that matches the user pass key 1 programmed
User pass key 1 in the into the device.
bitstream file does not
match the device.
0x801F Programming Error. -22 Bitstream file has been Regenerate bitstream file
corrupted or was incorrectly
Bitstream or data is generated. Monitor related power supplies that cause the
corrupted or noisy issue during programming; check for transients
Unstable voltage level. outside of Microsemi specifications. See your
device datasheet for more information on
Signal integrity issues on transient specifications.
JTAG pins. Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection.
0x8021 Programming Error. -23 File contains an encrypted Provide a programming file with an encryption
key that does not match the | key that matches that on the device
Invalid/Corrupted device
encryption key First program security with master programming
File contains user file, then program with user encryption 1/2 field
encryption key, but device update programming files
has not been programmed
with the user encryption key
0x8023 Programming Error. -24 Design version is not higher | Generate a programming file with a design
than the back-level version higher than the back level version
Back level not programmed device
satisfied
0x8001 Failure to read DSN -24 Device is in System TRSTB should be driven High or disable

Controller Suspend Mode

"System Controller Suspend Mode".
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Error Exit Message Exit Possible Cause Possible Solution
Code Code
Check board connections
0x8027 Programming Error. -26 Device does not support the | Generate a programming file with the correct
capabilities specified in capabilities for the target device
Insufficient device programming file
capabilities
0x8029 Programming Error. -27 Incorrect programming file Choose the correct programming file and select
the correct device in chain
Incorrect DEVICEID Incorrect device in chain
Measure JTAG pins and noise or reflection. If
Signal integrity issues on TRST is left floating, then add pull-up to pin
JTAG pins
Reduce the length of ground connection
0x802B Programming Error. -28 Programming file version is | Generate programming file with latest version of
out of date Libero SoC
Programming file is
out of date, please
regenerate.
0x8030 Programming Error -31 FAB_RESET N is tied to FAB_RESET_N should be tied to HIGH
ground
Invalid or inaccessible
Device Certificate
0x8032 Instruction timed out | -32 Unstable voltage level Monitor related power supplies that cause the
0x8034 issue during programming; check for transients
0x8036 Signal integrity issues on outside of Microsemi specifications. See your
0x8038 JTAG pins device datasheet for more information on
transient specifications.
Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection.
0x8010 Failed to unlock user |-35 Pass key in file does not Provide a programming file with a pass key that
pass key 1 match device matches pass key programmed into the device.
0x8011 Failed to unlock user |-35 Pass key in file does not Provide a programming file with a pass key that
pass key 2 match device matches pass key programmed into the device.
0x804F Bitstream -38 Unstable voltage level Monitor related power supplies that cause the
programming action is issue during programming; check for transients
disabled Bitstream programming outside of Microsemi specifications. See your
action has been disabled in | device datasheet for more information on
Security Policy Manager transient specifications.
Need to use a bitsream file which has a valid
FlashLock/UPK1 to enable the bitstream
programming action.
0x805B Error, security must -42 Security only bitstream Use this bitstream on a blank device or

be either programmed
on a blank device or

programming on a
programmed device

generate a new bitstream that contains the
FPGA Fabric design along with the security
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Error
Code

Exit Message Exit Possible Cause Possible Solution
Code

with the FPGA Fabric
design

Program SPI Flash Image

Generate SPI Flash Image

This tool generates the <design> spi flash.bin file in the implementation folder.
To run this tool; under the Program SPI Flash Image, right-click Generate SPI Flash Image and choose Run

- i@ Run PROGRAM Action
= ¢ Program 5Pl Flash Image
> Generate SPI Elozi oo
- i Run PROGRA Run
- # Debug Design Clean and Run All
¥ Handoff Design fo
- ¢ Handoff Design fo Clean

NN

Help

— = :
This tool depends on the Configure Design Initialization Data and Memories tool and the Generate Design
Initialization Data tool. When running, the tool verifies that the SPI Flash configuration data is saved and valid;
and that the SPI Flash initialization client was generated successfully (if required).

Configure SPI Flash Image Actions and Procedures
If SPI Flash is configured, you can select supported SPI Flash Image actions and procedures in the Select Action

and Procedures dialog box. See the following example.
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® | Select Action and Procedures

Action:

I FROGRAM_SFI_IMAGE

Procedures:

VERIFY_DEVICE ID
ERASE_DIE

PROGRAM_IMAGE

] [ o

Figure 100 - Select Action and Procedures Dialog Box

The following table lists the actions and procedures for the Run PROGRAM_SPI_Flash tool.

Action

Mandatory
Procedures

Description

PROGRAM_SPI_IM
AGE

D SPlimage.
ERASE_DIE
PROGRAM_IMAGE

VERIFY_DEVICE_I | This action will erase the entire SPI flash then program the

VERIFY_SPI_IMAG
E

VERIFY_DEVICE_I | This action verifies the SPI Image on the SPI Flash.

READ_SPI_IMAGE

VERIFY_DEVICE_| | This action reads the SPI Image from the SPI Flash.

ERASE_SPI|_FLASH

D
VERIFY_IMAGE
D
READ_IMAGE
D

ERASE_DIE

VERIFY_DEVICE_I | This action erases the entire SPI Flash.

Note: If the device ID does not match when running any action, the action will fail.

Run Programming SPI Flash Actions

This tool allows the user to program the SPI Flash device connected to the PolarFire device through the JTAG
programming interface. Currently, only the Micron 1Gb SPI flash is supported, and is included with the Evaluation
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Kit. This feature minimizes cost by not requiring a mux and external SPI pins on the board for SPI flash
programming by another tool. This tool always erases the entire SPI flash prior to programming. Programming
starts at address 0 of the SPI flash until the last client. Any gaps in the SPI flash are programmed with all 1’s.
Note: This version of the programmer does not support SPI Flash security. Device security options such as
"Hardware Write Protect” should be disabled for the External SPI Flash device.
VDDIx (x = JTAG/DEDIO Bank Mumber)

PolarFire FPGA External

SPI Flash

System Controller

. plcs
o 5 ek
* soold s0 ==0.1F
sl o
ITAG
Controller

ITAG Programmer

Host PCwith
EF] Flamn Bimary Fos

Note: The SPI pins are controlled by the Boundary Scan Register one bit at a time.

-

Tool

& Select Programmer
4 F Program Design
« ] Generate FPGA Array Data
+[] Configure Design Initialization Data and Memories
+| Generate Design Initialization Data
= Configure [/O States During JTAG Programming
» Configure Programming Options
@B Configure Security
@ Configure Permanent Locks (OTP)
& Generate Bitstream
3 Run PROGRAM Action
4 F Program SPI Flash Image
v e Generate SPI Flash Image
i /& Run PROGRAM_SPLIMAGE Action

|

4 p Debug Design
+{] Generate SmartDebug FPGA Array Da
€ SmartDebug Design
'+ Identify Debug Design
4 p Handoff Design for Production
#* Export Bitstream
4 Export FlashPro Express Job
% Export SPI Flash Image
+] Export Pin Report
+[] Export BSDL

Run
Clean and Run All
Clean

Configure Action/Procedures...

Help

-

Figure 101 - SPI Flash Programming with PolarFire Device
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The following table provides the expectations of programming the SPI flash with a FP5 programmer. Future
programmers are planned, and should greatly improve programming times. All times are in hh:mm:ss.

SPI Size | ERASE PROGRAM VERIFY/READ TCK Programmer
1 MB 3:55 00:00:45 00:10:46 4MHz | FP5
1 MB 3:55 00:00:28 00:10:05 15MHz | FP5
9 MB 3:55 00:06:38 01:19:15 4MHz | FP5
9 MB 3:55 00:04:26 01:08:49 10MHz | FP5
18 MB 3:55 00:09:04 02:32:43 10MHz | FP5
128 MB | 3:55 00:58:38 22:07:55 15MHz | FP5

Recommendations:

1. Since the verify time is currently not optimized, it is recommended to authenticate the SPI bitstreams with
system services for quicker verification.

2. Since this tool erases the SPI flash prior to programming and currently does not support Data Storage
clients for user data, it is recommended to program the SPI flash with Libero prior to programming other data
on the SPI flash.

3. Since programming time is currently not optimized, it is recommended to not have huge gaps between
clients in the SPI flash, since gaps are currently programmed with 1’s.

If SPI Flash is configured, you can execute Run PROGRAM_SPI_IMAGE Action and select SPI Flash Image
actions and procedures.

In the Design Flow window, under Program SPI Flash Image, right-click Run PROGRAM_SPI_Image Action and
choose Configure Action/Procedures.

Note: In this release, SPI Flash programming is supported for MICRON devices only.
See Configure SPI Flash Image Actions and Procedures for information about supported actions and procedures.
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Debug Design

Generate SmartDebug FPGA Array Data

The Generate SmartDebug FPGA Array Data tool generates database files used in downstream tools:
e *.db used for debugging FPGA Fabric in SmartDebug

Double-click Generate SmartDebug FPGA Array Data or right-click Generate SmartDebug FPGA Array Data
in the Design Flow window and click Run to generate SmartDebug FPGA Array Data. Before running this tool, the
design should have completed the Place and Route step. If not, Libero SoC runs implicitly the upstream tools
(Synthesis, Compile Netlist, and Place and Route) before it generates the FPGA SmartDebug Array Data.

Design Flow F X

Top Madule(root): top

Active Synthesis Implementation: synthesis

Tool

+

Create Design

Constraints

Implement Design

Configure Hardware

Program Design

Debug Design

+[| Generate SmartDebug FPGA Array Data
€ SrnartDebug Design

{'_“4. Identify Debug Design

¥ Handoff Design for Production
¥ Handoff Design for Debugging

<[] [ [

b A . . . .

Figure 102 - Generate SmartDebug FPGA Array Data

SmartDebug

Design debug is a critical phase of FPGA design flow. Microsemi’s SmartDebug tool complements design
simulation by allowing verification and troubleshooting at the hardware level. SmartDebug can provide access to
Microsemi FPGA device's built-in probe logic, which enables designers to check the state of inputs and outputs in
real-time without re-layout of the design.

SmartDebug can be run in three modes:
e Integrated mode from the Libero Design Flow
e Standalone mode
e Demo mode

Integrated Mode

When run in integrated mode from Libero, SmartDebug can access all design and programming hardware
information. No extra setup step is required. In addition, the Probe Insertion feature is available in Debug FPGA
Array.

To open SmartDebug in the Libero Design Flow window, expand Debug Design and double-click SmartDebug
Design.

152



& Microsemi

a A3\ MicrRocHIP company

PolarFire FPGA Design Flow User Guide

Standalone Mode

SmartDebug can be installed separately in the setup containing FlashPro Express and Job Manager. This
provides a lean installation that includes all the programming and debug tools to be installed in a lab environment
for debug. In this mode, SmartDebug is launched outside of the Libero Design Flow. Prior to launch of
SmartDebug standalone mode, you must to go through SmartDebug project creation and import a Design Debug
Data Container (DDC) file, exported from Libero, to access all debug features in the supported devices.

Note: In standalone mode, the Probe Insertion feature is not available in FPGA Array Debug, as it requires
incremental routing to connect the user net to the specified I/0.

Demo Mode

Demo mode allows you to experience SmartDebug features (Active Probe, Live Probe, Memory Blocks,
SERDES) without connecting a board to the system running SmartDebug.

Note: SmartDebug demo mode is for demonstration purposes only, and does not provide the functionality of
integrated mode or standalone mode.

Note: You cannot switch between demo mode and normal mode while SmartDebug is running.

See Also

SmartDebug User Guide

|dentify Debug Design

Libero SoC integrates the Identify RTL debugger tool. It enables you to probe and debug your FPGA design
directly in the source RTL. Use Identify software when the design behavior after programming is not in
accordance with the simulation results.

To open the Identify RTL debugger, in the Design Flow window under Debug Design double-click Instrument
Design.

Identify features:
e Instrument and debug your FPGA directly from RTL source code.
e Internal design visibility at full speed.

e Incremental iteration - Design changes are made to the device from the Identify environment using
incremental compile. You iterate in a fraction of the time it takes route the entire device.

e Debug and display results - You gather only the data you need using unique and complex triggering
mechanisms.

You must have both the Identify RTL Debugger and the Identify Instrumentor to run the debugging flow outlined
below.

To use the Identify Instrumentor and Debugger:

—_

Create your source file (as usual) and run pre-synthesis simulation.

2. (Optional) Run through an entire flow (Synthesis - Compile - Place and Route - Generate a Programming
File) without starting Identify.

3. Right-click Synthesize and choose Open Interactively in Libero SoC to launch Synplify.

4. In Synplify, click Options > Configure Identify Launch to setup Identify.

5. In Synplify, create an Identify implementation; to do so, click Project > New Identify Implementation.

6. In the Implementations Options dialog, make sure the Imple

7. mentation Results > Results Directory points to a location under <libero project>\synthesis\, otherwise Libero

SoC is unable to detect your resulting Verilog Netlist file.

8. From the Instumentor Ul specify the sample clock, the breakpoints, and other signals to probe. Synplify
creates a new synthesis implementation. Synthesize the design.

9. In Libero SoC, run Synthesis, Place and Route and Generate a Programming File.
Note: Libero SoC works from the edif netlist of the current active implementation, which is the
implementation you created in Synplify for Identify debug.
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9. Double-click Identify Debug Design in the Design Flow window to launch the Identify Debugger.

The Identify RTL Debugger, Synplify, and FlashPro must be synchronized in order to work properly. See the
Release Notes for more information on which versions of the tools work together.
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Handoff Design for Production

Export Bitstream
Export Bitstream enables you to export PPD, STAPL, DAT, and SPI programming files.

To export a bitstream file

1. Under Handoff Design for Production, double-click Export Bitstream. The Export Bitstream dialog box
opens. The dialog box options depend on your Custom Security settings and Permanent Locks for
Production settings:

e Export Bitstream tool when the device is configured with Bitstream Encryption with Default key
option in the Configure Security tool

e Export Bitstream tool when the device is configured with Custom Security options in the Configure

Security tool
e Export Bitstream tool when the device is configured with Permanent Locks for Production tool

2. Enter your Bitstream file name and select the location to export the bitstream file.

3. Choose your options, such as DAT file if you wish to include support for Embedded ISP, SPI file if
you need support for Auto programming, Auto Updata and IAP services, PPD or STAPL if you need
support for ISP.

4. You can choose whether you want to export the ASCII HEX file for debugging when DAT bitstream
file format is selected.

5. Select whether you want to export files for Microsemi In House Programming (IHP).

6. Select to inlcude the bitstream components, Bypass Back Level protection option for Recovery/Golden
Bitstream and Include Pass Keys in Plaintext.

7. Choose the Zeroization Action that you want to use to reprogram the device. Note: Zeroization
Action is not supported for XT and ES devices.

8. Click OK to export the selected bitstream files.

See Also
Digest File

Export Bitstream tool when the device is configured with Bitstream Encryption with
Default Key in the Configure Security tool

See the Export Bitstream topic for more information about exporting your bitstream.

155



& Microsemi

a A3\ MicrRocHIP company

PolarFire FPGA Design Flow User Guide

B Export Bitstream *

Design settings
Programming options set with the Configure Programming Options tool:

Design version -0 Back Level version -0

Security options set with the Configure Security tool:
Encrypt bitstream with default key. Mo user keys or security settings are enabled.

Bitstream file(s)

Name: |TVS_Demo Location: Lru_Projact\TVS_DemoWeslgnarWS_Demo\ﬁxport

Existing files:

This folder is empty.

Formats:

W prD Support for ISP (TTAG and SPI Slave)

¥ DaT Support for Embedded ISP (TTAG and SPI Slave) | Export separate ASCII HEX file for debugging
™ starL Support for ISP

™ Chain 5TAPL Support for ISP, Single Microsemi device in a JTAG chain

I spr Support for Auto Programming, Auto Update, and IAP Services

I svr Support for ISP

0 Export files for Microsemi In House Programming (IHP): ¢ Yes & Mo

File types:

| Fabric/sNVM

File to program at trusted fadility W

Zeroization actions:
I™ Like New (Erases all user data; device can be immediately reprogrammed by user)

I Unrecoverable (Erases all data and destroys reprogrammability; device must be scrapped)

Help Cancel
Figure 103 - Export Bitstream with Default Key Dialog box

Design Settings:

e Programming Options set with Configure Programming Options tool- Displays the Design version and
Back Level version set in the Configure Programming Options tool. They are read-only options and cannot
be modified.

Note: Info and warning messages appear based on the value set for Back Level version.

e Security options set with the Configure Security tool- Provides a brief description of current security
options.

Bitstream file(s):
¢ Name - Sets the name of your bitstream file. The default name is the design name.
e Location - Location to save the exported file.
e Existing files - Lists bitstream files previously created.
¢ Formats - Select the Bitstream File format you want to export:

e PPD
o DAT
e STAPL
e SPI

o Export separate ASCII HEX file for debugging — Exports DAT file in HEX format. This option is
active only when DAT file format is selected.

o Export files for Microsemi In House Programming (IHP) — Exports DAT and STP file formats if ‘Yes
is selected.

PPD and DAT file formats are the default file formats.

o File types: Lists all the bitstream files to be exported

o File to program at trusted facility — Click to include Fabric /sNVM into the bitstream files to be
programmed at a trusted facility.
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e Zeroization Actions — Select the Like New checkbox to erase all user data to make the device like new
and reprogram the device immediately, or select the Unrecoverable checkbox to erase all data and destroy
reprogrammability (in this case, the device must be scrapped).

Export Bitstream tool when the device is configured with Custom Security option in the
Configure Securitytool
Note: If Permanent Locks for Production are configured along with Custom Security settings, Export
Bitstream Security options are set with Configure Permanent Lock for Production tool. Otherwise, they
are set with the Configure Security tool. The Permanent Lock Security settings can be removed by either
right-clicking on the tool in the Design Tree or by clicking the Remove Permanent Locks button in the Ul.

See the Export Bitstream topic for information on exporting your bitstream.

" Export Bitstream X

Design settings -
Programming options set with the Configure Programming Options toal:
Design version -0 Back Level version -0

Security options set with the Configure Security tool:

Disable all factory key modes and configured security settings.

Use FlashLock/UPK1 to temporarily enable settings during one programming or debugging session.
SmartDebug access control is enabled. Internal data may be accessible. Anyone can debug or access active probes, access Live Probe, and read the content of shvM.
Factory test mode is alowed. This will allow Microsemi to perform Failure Analysis.

¥, Zeroization through JTAG/SPI Slave is enabled. This is not recommended for production devices.

External Fabric/sNVM design verify and read digest requests through JTAG/SPI Slave are enabled.
Repeated external Fabric digest calculations can impact its relisbility. View Datasheet for additional information.

Bitstream file(s)

Name: ‘TVS_DEITID Location: Iru_PruJe:t‘\TVS_Demu\plesigner\T\fS_DEmu\gxpurt

Existing files:

This folder is empty.

Formats:
W pPD Support for 15P (JTAG and SPI Slave)
v paT Suppart for Embedded ISP (JTAG and 5P1Slave) | Export separate ASCIT HEX file for debugging
[~ sTapL Support for ISP
™ Chan STAFL Support for ISP, Single Microsemi device in a JTAG chain
I sp1 Support for Auto Programming, Auto Update, and IAP Services
I~ sve Support for 15P

ﬂ Export files for Microsemi In House Programming (IHP):  © Yes % Mo

File types:
Bypass Back Level protection for .
Custom Security | Fabric/sNVM Recovery/Golden bitstream juckice P\am:ext P@s; e
il (MN/A for *.spi files)
(*.spi files only)
Master file = v r |
File encrypted with UEK1 2 r
File encrypted with UEK2 2 r

Zeroization actions:

I™ Like New (Erases all user data; device can be immediately reprogrammed by user)

I™ Unrecoverable (Erases all data and destroys reprogrammabiity; device must be scrapped) j

Figure 104 - Export Bitstream Dialog Box with Custom Security Options set with the Configure Security Tool
Design Settings:

e Programming Options set with Configure Programming Options tool- Displays the Design version and
Back Level version set in the Configure Programming Options tool. They are read-only options and cannot
be modified.

Note: Info and warning messages appear based on the value set for Back Level version.

e Security options set with the Configure Security tool- Provides a brief description of current security
settings.

Bitstream file(s):

e Name - Sets the name of your bitstream file. The default name is the design name.
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e Location - Location to save the exported file.
e Existing files - Lists bitstream files previously created.
o Formats - Select the Bitstream File format you want to export:

« PPD
« DAT
e STAPL
e SPI

o Export separate ASCII HEX file for debugging — Exports DAT file in HEX format for debugging. This
option is active only when DAT file format is selected.

o Export files for Microsemi In House Programming (IHP) — Exports DAT and STP file formats if ‘Yes’
is selected.

PPD and DAT file formats are the default file formats.
o File types:
Note: Refer to the Include Plaintext Pass Keys online help topic to check the availability of Export
Pass keys for Plaintext option for the following Bitstream files.
Lists all the bitstream files to be exported
o Master file — Click to include:
e Fabric/sNVM.
e Bypass Back Level protection for Recovery/Golden bitstream (this
option is available only if Back Level protection is enabled in the
Configure Security tool and SPI file format is selected).
e Include Plaintext Pass Keys.
Notes
1. Custom Security is always programmed in the Master file.

2. Security-only programming must be performed only on erased or new devices. If
performed on a device with fabric programmed, the fabric will be disabled after
performing security-only programming. You must reprogram the fabric to re-
enable it.

3. Depending on the Permanent Locks configured in the Configure Permanent
Locks for Production tool, some of the bitstream components for Master file are
selected by default and are unavailable for users to change.

¢ File encrypted with UEK1 to program at untrusted facility or for
Broadcast field update - Click to include:

e Fabric/sNVM.

e Bypass Back Level protection for Recovery/Golden bitstream
(this option is available only if Back Level protection is enabled
in the Configure Security tool and SPI file format is selected).

e Include Plaintext Pass Keys.

¢ File encrypted with UEK2 to program at untrusted facility or for
Broadcast field update - Click to include:

e Fabric/sNVM.

¢ Bypass Back Level protection for Recovery/Golden bitstream
(this option is available only if Back Level protection is enabled
in the Configure Security tool and SPI file format is selected).

e Include Plaintext Pass Keys.
Note: If sSNVM/Fabric is One Time Programmable, it is precluded from bitstream encrypted with UEK1/2.

e Zeroization Actions — Select the Like New checkbox to erase all user data to make the device like new and
reprogram the device immediately, or select the Unrecoverable checkbox to erase all data and destroy
reprogrammability (in this case, the device must be scrapped).
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Bypass Back Level protection for Recovery/Golden bitstream- If Back Level protection is enabled in the
Configure Security tool, you can bypass the back level protection for SPI bitstreams to prevent Programming
Recovery failures.

The following examples show the usage of Bypass Back Level Protection.
Example 1 — Fails without Bypass Back Level Protection

Step Bitstream Action Result Design Back Device
version Level Back
version Level
version
1 Golden/Recovery Auto Programming Pass 2 1 1
2 IAP/Update Bitstream | Auto Update/IAP Pass 3 2 2
3 IAP/Update Bitstream | Auto Update/IAP Fail, Attempt 4 N/A 2
Programming
Recovery

In the above example, the device will have Back Level version 2 after step 2. If you attempt to program with
bitstream in step 3, it will fail. If the device attempts to reprogram, it will initiate Programming Recovery with the
Golden/Recovery bitstream. Since the Golden/Recovery Bitstream has Design version 2, which is less than or
equal to the Back Level version in the device, it will fail. If the Bypass Back Level version option is selected, this
back level protection check will be bypassed for the Golden/Recovery Bitstream only and it will succeed.

Example 2 — Does not require Bypass Back Level Protection

Step Bitstream Action Result Design Back Device
version Level Back
version Level
version
1 Golden/Recovery Auto Programming Pass 2 1 1
2 IAP/Update Bitstream | Auto Update/IAP Pass 3 1 1
3 IAP/Update Bitstream | Auto Update/IAP Fail, Attempt 4 N/A 1
Programming
Recovery

In this example, the device will have Back Level version 1 after step 2. If you attempt to program with bitstream in
step 3, it will succeed since the Golden/Recovery Design version is greater than the Back Level version on the

device.
Example 3 — Requires Bypass Back Level Protection
Step Bitstream Action Result Design Back Device
version Level Back
version Level
version
1 Golden/Recovery Auto Programming Pass 1 1 1
2 IAP/Update Bitstream | Auto Update/IAP Pass 2 1 1
3 IAP/Update Bitstream | Auto Update/IAP Fail, Attempt 3 N/A 1
Programming
Recovery
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In this example, the device will have Back Level version 1 after step 2. If you attempt to program with bitstream in
step 3, it will fail. If the device attempts to reprogram, it will initiate Programming Recovery with the
Golden/Recovery bitstream. Since the Golden/Recovery Bitstream has Design version 1, which is less than or
equal to the Back Level version in the device, it will fail. If the Bypass Back Level version option is selected, this
back level protection check will be bypassed for the Golden/Recovery Bitstream only and it will succeed.

Export Bitstream tool when the device is configured with Permanent Locks for
Production tool
Note: If Permanent Locks for Production are configured along with Custom Security settings, Export Bitstream
Security options are set with the Configure Permanent Lock for Production tool. Otherwise, they are set with the
Configure Security tool. The Permanent Lock Security settings can be removed by either right-clicking on the tool
in the Design Tree or by clicking the Remove Permanent Locks button in the UL

See the Export Bitstream topic for information on exporting your bitstream.

B Export Bitstream x

Design settings 7

Programming options set with the Configure Programming Options tool:
Design version -0 Back Level version - 0

Security options set with the Configure Permanent Locks for Production tool:
i, Permanently disable all factory key modes and configured security settings.

Fabric update is one-time programmable.
sNVM update is one-time programmable.
Auto Programming and IAP Services are permanently disabled for update.
Factory test mode is permanently disabled. Microsemi will not be able to perform Failure Analysis on the device.
Zeroization through JTAG/SPI Slave is permanently enabled. This is not recommended for production devices.
External Fabric/sNVM design verify and read digest requests through JTAG/SPI Slave are permanently enabled.
Repeated external Fabric digest calculations can impact its reliability. View Datasheet for additional information.

Bitstream file(s)

Name: [TVS_Demo Location:  tro_Project{TVS_Demo'designer TVS_Demalexport

Exdisting files:
This folder is empty.

Formats:
¥ pPD Support for ISP (ITAG and SPI Slave)
¥ DAT Support for Embedded ISP (TTAG and SPISlave) | Export separate ASCII HEX file for debugging
[~ sTAPL Support for ISP

4P Support for ISP, Single Microsemi device in a JTAG chain
Support for Auto Programming, Auto Update, and IAP Services

Support for 1P

0 Export fles for Microsemi In House Programming (IHP):  © Yes  No

File types:
Bypass Back Level protection for
Custom Security | Fabric/sNVM | Recovery/Golden bitstream | '<lude Plaintext Pass Keys
(N/A for *.spi files)
(".spi files only)
Master file = = r
File encrypted with UEK1 ] r
File encrypted with UEK2 r r

Zeroization actions:
I Like New (Erases all user data; device can be immediately reprogrammed by user)

I Unrecoverable (Erases all data and destroys reprogrammability; device must be scrapped)

Figure 105 - Export Bitstream Dialog Box with Security Options set with the Configure Permanent Locks for Production Tool

Design Settings:

e Programming Options set with the Configure Programming Options tool- Displays the Design version
and Back Level version set in the Configure Programming Options tool. They are read-only options and
cannot be modified.

Note: Info and warning messages appear based on the value set for Back Level version.

o Security options set with the Configure Permanent Locks for Production tool- Provides a brief
description of current security settings.
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Bitstream file(s):
e Name - Sets the name of your bitstream file. The default name is the design name.
e Location - Location to save the exported file.
o Existing files - Lists bitstream files previously created.
o Formats - Select the Bitstream File format you want to export:

« PPD
« DAT
e STAPL
e SPI

o Export separate ASCII HEX file for debugging — Exports DAT file in HEX format for debugging. This
option is active only when DAT file format is selected.

o Export files for Microsemi In House Programming (IHP) — Exports DAT and STP file formats if ‘Yes’
is selected.
PPD and DAT file formats are the default file formats.
o File types:
Note: Refer to the Include Plaintext Pass Keys online help topic to check the availability of Include
Plaintext Pass keys option for the following Bitstream files.
Lists all the bitstream files to be exported
o Master file — Click to include:
e Fabric/sNVM.

o Bypass Back Level protection for Recovery/Golden bitstream (this
option is available only if Back Level protection is enabled in the
Configure Security tool and SPI file format is selected).
e Include Plaintext Pass Keys.
Notes
1. Custom Security is always programmed in the Master file.

2. Security-only programming must be performed only on erased or new devices. If
performed on a device with fabric programmed, the fabric will be disabled after
performing security-only programming. You must reprogram the fabric to re-
enable it.

3. Depending on the Permanent Locks configured in the Configure Permanent
Locks for Production tool, some of the bitstream components for Master file are
selected by default and are unavailable for users to change.

* File encrypted with UEK1 to program at untrusted facility or for
Broadcast field update - Click to include:

e Fabric/sNVM.

e Bypass Back Level protection for Recovery/Golden bitstream
(this option is available only if Back Level protection is enabled
in the Configure Security tool and SPI file format is selected).

e Include Plaintext Pass Keys.
¢ File encrypted with UEK2 to program at untrusted facility or for
Broadcast field update - Click to include:
e Fabric/sNVM.

o Bypass Back Level protection for Recovery/Golden bitstream
(this option is available only if Back Level protection is enabled
in the Configure Security tool and SPI file format is selected).

e Include Plaintext Pass Keys.
Note: If sSNVM/Fabric is One Time Programmable, it is precluded from bitstream encrypted with UEK1/2.

e Zeroization Actions — Select the Like New checkbox to erase all user data to make the device like
new and reprogram the device immediately, or select the Unrecoverable checkbox to erase all data
and destroy reprogrammability (in this case, the device must be scrapped).
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Bypass Back Level protection for Recovery/Golden bitstream- If Back Level protection is enabled in the
Configure Security tool, you can bypass the back level protection for SPI bitstreams to prevent Programming
Recovery failures.

The following examples show the usage of Bypass Back Level Protection.
Example 1 — Fails without Bypass Back Level Protection

Step Bitstream Action Result Design Back Device
version Level Back
version Level
version
1 Golden/Recovery Auto Programming Pass 2 1 1
2 IAP/Update Bitstream | Auto Update/IAP Pass 3 2 2
3 IAP/Update Bitstream | Auto Update/IAP Fail, Attempt 4 N/A 2
Programming
Recovery

In the above example, the device will have Back Level version 2 after step 2. If you attempt to program with
bitstream in step 3, it will fail. If the device attempts to reprogram, it will initiate Programming Recovery with the
Golden/Recovery bitstream. Since the Golden/Recovery Bitstream has Design version 2, which is less than or
equal to the Back Level version in the device, it will fail. If the Bypass Back Level version option is selected, this
back level protection check will be bypassed for the Golden/Recovery Bitstream only and it will succeed.

Example 2 — Does not require Bypass Back Level Protection

Step Bitstream Action Result Design Back Device
version Level Back
version Level
version
1 Golden/Recovery Auto Programming Pass 2 1 1
2 IAP/Update Bitstream | Auto Update/IAP Pass 3 1 1
3 IAP/Update Bitstream | Auto Update/IAP Fail, Attempt 4 N/A 1
Programming
Recovery

In this example, the device will have Back Level version 1 after step 2. If you attempt to program with bitstream in
step 3, it will succeed, since the Golden/Recovery Design version is greater than the Back Level version on the

device.
Example 3 — Requires Bypass Back Level Protection
Step Bitstream Action Result Design Back Device
version Level Back
version Level
version
1 Golden/Recovery Auto Programming Pass 1 1 1
2 IAP/Update Bitstream | Auto Update/IAP Pass 2 1 1
3 IAP/Update Bitstream | Auto Update/IAP Fail, Attempt 3 N/A 1
Programming
Recovery
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In this example, the device will have Back Level version 1 after step 2. If you attempt to program with bitstream in
step 3, it will fail. If the device attempts to reprogram, it will initiate Programming Recovery with the
Golden/Recovery bitstream. Since the Golden/Recovery Bitstream has Design version 1, which is less than or
equal to the Back Level version in the device, it will fail. If the Bypass Back Level version option is selected, this
back level protection check will be bypassed for the Golden/Recovery Bitstream only and it will succeed.

Security Programming Files
Export Bitstream (expand Handoff Design for Production in the Design Flow window) creates the following files:
<filename>_master.(stp/spi/dat) - Created when Enable custom security options is specified in the Security
Wizard. This is the master programming file; it includes all programming features enabled, User Key Set 1, User
Key Set 2 (optionally if specified), and your security policy settings.
<filename>_security_only_master.(stp/spi/dat) — Created when Enable custom security options is specified in
the Security Wizard. Master security programming file; includes User Key Set 1, User Key Set 2 (optionally if
specified), and your security policy settings.
<filename>_uek1.(stp/spi/dat) — Programming file encrypted with User Encryption Key 1 used for field updates;
includes all your features for programming except security .
<filename>_uek2.(stp/spi/dat) — Programming file encrypted with User Encryption Key 2 used for field updates;
includes all your features for programming except security.

Export FlashPro Express Job

To program the design using standalone FlashPro Express tool on Linux or Windows, the user must export a
FlashPro Express Job. The job file will include chain configuration, Programmer Settings and programming files
loaded from Programming Connectivity and Interface.

Note: The Export FlashPro Express Job uses Permanent Locks for Production configuration, if
Permanent Locks are configured. If Permanent Locks are not configured, it uses the Configure Security
configuration.

Use the Configure Security tool before you export the programming job to add security. The Export FlashPro
Express Job dialog box displays the Security Options you have configured through the Configure Security tool or
Configure Permanent Locks for Production tool.

The Export FlashPro Express Job dialog box options vary depending on the Security Settings.
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—Design settings
Programming options set with the Configure Programming Options tool:

Design version -0 Back Level version - 0

Security options set with the Configure Security tool:
Encrypt bitstream with default key. Mo user keys or security settings are enabled.

—FlashPro Express Job file

Configured device chain with bitstream files and programmer settings will be induded in the programming job.

Existing files:
| TVS_Demo.job

Program {JTAG programming interface):
v Design

I~ sPiFlash i

Design bitstream file format: IPPD (*.ppd) 'I 0

Design bitstream file type:

Fabric/sNVM

File to program at trusted fadility 1

Zeroization actions:
™ Like New (Erases all user data; device can be immediately reprogrammed by user)

[~ Unrecoverable (Erases all data and destroys reprogrammability; device must be scrapped)

Name: ITVS_Demo Location: }ro_Project‘l,TVS_Demo\designer‘l,TVS_Demo\e)cport

Help I

[ ox |

Cancel

=
|

7

Figure 106 - Export FlashPro Express Job Dialog Box with Bitstream encryption with default key
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3 Export FlashPro Express Job X

—Design settings -
Programming options set with the Configure Programming Options tool:

Design version -0 Back Level version - 0

Security options set with the Configure Security tool:

Disable all factory key modes and configured security settings.

Use FlashLod/UPK 1 to temporarily enable settings during one programming or debugging session.
SmartDebug access control is enabled. Internal data may be accessible. Anyone can debug or access active probes, access Live Probe, and read the content of shvM,
Factory test mode is allowed. This will allow Microsemi to perform Failure Analysis,

4, Zeroization through JTAG/SPI Slave is enabled. This is not recommended for production devices.
External Fabric/sNVM design verify and read digest requests through JTAG/SPI Slave are enabled.
Repeated external Fabric digest calculations can impact its reliability. View Datasheet for additional information.

r—FlashPro Express Job file

Configured device chain with bitstream files and programmer settings will be induded in the programming job.

Name: ITVS_Demn Location: *ru_PmJect\TVS_Demn\designer\T\dS_Demo\export

Existing files:
| TVS_Demo.job

Program (JTAG programming interface):
I°d Design

™ spiFiash
Design bitstream file format: IPPD (*.ppd) o o

Design bitstream file type:

Custom Security | Fabric/sNVM | Include Plaintext Pass Keys
* Master fie F I3 O
File encrypted with UEK1 & r
File encrypted with UEK2 r r

Zeroization actions:
I Like New (Erases all user data; device can be immediately reprogrammed by user)

™ Unrecoverable {Erases all data and destroys reprogrammability; device must be scrapped)

|
Help | Cancel
Figure 107 - Export FlashPro Express Job Dialog Box with Custom Security Options
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B Export FlashPro Express Job x

Design settings .

Programming options set with the Configure Programming Options tool:
Design version -0 Back Level version - 0

Security options set with the Configure Permanent Locks for Production tool:

FlashPro Express Jab file
Configured device chain with bitstream files and programmer settings will be induded in the programming job.

Name: ‘T\IS_DamD Location:  ro_Project{TVS_Demo\designer\TVS_Demo\export

Existing files:

Permanently disable all factory key modes and configured security settings.

Fabric update Is one-tme programmable.

sNVM update is one-time programmable.

Auto Programming and IAP Services are permanently disabled for update.

Factory test mode is permanently disabled. Microsemi will not be able to perform Failure Analysis on the device.
Zeroization through JTAG/SPI Slave is permanently enabled. This is not recommended for production devices.
External Fabric/sNVM design verify and read digest requests through JTAG/SPI Slave are permanently enabled.
Repeated external Fabric digest calculations can impact its reliability. View Datasheet for additional information.

Program (JTAG programming interface):

Design bitstream file format: |PPD (=ppd) | @B

Design bitstream file type:

TWs_Demo,job

¥ Design

" spiFlash i

[ ] | Custom Security | Fabric/sNVM| Include Plaintert Pass Keys

Zeroization actions:
I™ Like New (Erases all user data; device can be immediately reprogrammed by user)

I Unrecoverable (Erases all data and destroys reprogrammability; device must be scrapped)

& Master file F F r
& File encrypted with UEK1 & r
(] File encrypted with UEK2 r r

=]

Figure 108 - Export FlashPro Express Job Dialog Box with Permanent Locks for Production Security Options
Design Settings:

Programming Options set with Configure Programming Options tool- Displays the Design version and
Back Level version set in the Configure Programming Options tool. They are read-only options and cannot
be modified.

Note: Info and warning messages appear based on the value set for Back Level version.

Security options set with the Configure Security tool- Provides a brief description of current security
settings.

FlashPro Express Job file:

Name - Sets the name of your bitstream file. The default name is the design name.
Location - Location of the file to be exported.
Existing files - Lists any existing programming job files at the selected location.

Program(JTAG Programming Interface) - Existing files - Click Design or SPI Flash or both to include the
configured device chain with bitstream files and/or SPI flash binary file. JTAG is the default programming
interface for PolarFire Devices. SPI Flash option is only available if SPI Flash is configured in Configure
Design Initialization Data and Memories tool. Otherwise it remains grayed out. Info message appears
based on the configuration selected.

Design Bitstream File Format- Lists all the available bitstream files, one of which will be included in the
programming job for the current target device. The format of the Bitstream file can be selected from the
Format drop down menu. PPD is the default bitstream file format.

Design Bitstream File Type

o File to Program at trusted facility(only available when the design is configured with
Bitstream Encryption with Default Key in the Configure Security tool- Click to enable
programming for Fabric/sNVM bitstream components at a trusted facility.

o Master file to program at trusted facility(available when the design is configured with
Custom Security options in the Configure Security tool or when the design is configured
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with Permanent Locks in the Configure Permanent Locks for Production tool) — Click to
include:

e Fabric/sNVM.
¢ Include Plaintext Pass Keys into the bitstream files to be programmed at a trusted facility.

Note:
e Custom Security is always programmed in the Master file.

e Security-only programming must be performed only on erased or new devices. If performed on a
device with fabric programmed, the fabric will be disabled after performing security-only
programming. You must reprogram the fabric to re-enable it.

o File encrypted with UEK1 to program at untrusted facility or for Broadcast field update —
Click to include:

e Fabric/sNVM.
¢ Include Plaintext Pass Keys into the bitstream files to be programmed.

¢ File encrypted with UEK2 to program at untrusted facility or for Broadcast field update -
Click to include:

e Fabric/sNVM.
¢ Include Plaintext Pass Keys into the bitstream files to be programmed.
Note: Refer to the Export Pass Keys for Plaintext online help topic to check the availability of Export Pass
keys for Plaintext option for the following Bitstream files.
e Zeroization Actions — Click the Like New option to erase all user data to make the device like new and

reprogram the device immediately, or click the Unrecoverable option to erase all data and destroy
reprogrammability (in this case, the device must be scrapped).

Prepare Design for Production Programming in FlashPro Express

After you have exported a programming job you can handoff this programming job to the FlashPro Express tool
for production programming. To do so:

In FlashPro Express, from the File menu choose Create Job Project From a Programming Job. You will be
prompted to specify the Programming Job location that you just exported from Libero and the location of where to
store the Job Project. The Job Project name automatically uses the programming job name and cannot be
changed. Click OK and a new Job Project will be created and opened for production programming.

Export Job Manager Data

Job Manager is Microsemi’'s HSM-based security software for job management.

As a part of the SPPS flow, the Export Job Manager Data dialog box allows a design engineer (user) to export
Libero design data to Job Manager. Exported data is used by an operation engineer (OE) using Job Manager to
prepare the manufacturing process for HSM or non-HSM flow.

Job Manager Data export is only provided for SmartFusion2, IGLOO2, PolarFire devices.
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L Export Job Manager Data X

Programming data file

Name: [5&cand| l

Location: |9_newcons/spps/designer/secand/export E]
Existing programming data files:

=MNo programming data files found=

Include bitstream components

Custom security |« Fabric elvM

Qo [F5)

Figure 109 - Export Job Manager Data Dialog Box
Programming data file — export Job Data Container (JDC) file.
Name - All names use a prefix as shown in your software.
Location - Location of the file to be exported.

Existing programming job files - Lists any existing programming job files already in your project.
Include bitstream components - Lists the components of the design that can be saved to the file.

Export SPI Flash Image

This tool depends on the “Configure Design Initialization Data and Memories” tool. The SPI Flash configuration
can be exported to a binary file here. Use this dialog to export a SPI Flash Image file.
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| Export SPI Flash Image &

SPI Flash Image file

Mame: muxa

Location:  D:\2Work'junk_projinewpfi\designer imuxa\export E
Existing files:
muxd.bin

s

e

Figure 110 - Export SPI Flash Image

Name

This is the top level design name by default. Use this field to change the default name. SPI Flash Image files are
exported in binary format and have the *.bin file extension and are named <design_name>.bin.

Location

The default location for the exported image file is <project_folder>\designer\<top_level_design>\export. Use the
browse button to navigate to and specify a different location for the exported SPI Flash Image file.

Existing files
Existing SPI Flash Image files are listed.

See Also
Tcl command "export_spiflash_image" on page 211
PolarFire FPGA Programming User Guide

Export Pin Report

In the Design Flow window, expand Handoff Design for Production. Right-click Export Pin Report to export a
pin report.

The Export Pin Reports dialog box opens. Click Browse to navigate to a disk location where you want the pin
report to be saved to.

Check the checkbox to make your selections:
e Pin Report sorted by Port Name
e Pin Report sorted by Package Pin Name
e |/O Bank Report
e |/O Register Combining Report

The pin report lists the pins in your device sorted according to your preference: sort by Port Name or Sorted by
Package Pin Name. The pin report generates two files:

e <design>_pinrpt_name.rpt - Pin report sorted by name.
e <design>_pinrpt_number.rpt - Pin report sorted by pin number.
You must select at least one report.
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Export Pin Report generates a Bank Report by default; the filename is <design>-bankrpt.rpt. Export Pin Report
also generates an I/O Register Combining Report listing the I/Os which have been combined into a Register for
betting timing performance.

#| Export Pin Reports @l-ﬁ;—h]
Location: D:\2Work\dsfeda\designer count 18] Browse...

[¥] Pin Report Sorted by Port Mame

[¥] Pin Report Sorted by Package Pin Name
[¥] 1j0 Bank Repart

[¥] 1j0 Register Combining Repart

&) [t

Figure 111 - Export Pin Report Dialog Box

Export BSDL File

Double-click Export BSDL File (in the Libero SoC Design Flow window, Handoff Design for Production >
Export BSDL File) to generate the BSDL File report to your Design Report.

The BSDL file provides a standard file format for electronics testing using JTAG. It describes the boundary scan
device package, pin description and boundary scan cell of the input and output pins. BSDL models are available
as downloads for many Microsemi SoC devices.

See the Microsemi website for more information on BSDL Models.

Export IBIS Model

Note: Export Input Output Buffer Information Specification (IBIS) is supported for all the “T” devices of PolarFire
Family except the “XT” device.

Export IBIS feature is supported in the following two stages:

e Pre-Layout Flow

e Post-Layout Flow
To export the IBIS Model in the Pre-Layout Flow, the design has to pass until the Synthesis/Compile stage. You
need to provide the I/O placement and configuration details in the /O PDC files to export the resultant IBIS files in
Pre-Layout Flow.
To export the IBIS Model in the Post-Layout Flow, the design has to pass until the Place and Route stage. If a
design has run through the Place and Route tool, the IBIS model for the Post-Layout Flow will be exported by
default.
Double-click Export IBIS Model (in the Libero SoC Design Flow window, Handoff Design for Production >
Export IBIS Model) to open the Export IBIS Model dialog box.
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i . [ 52 |

Export IBIS Model

Output File: | Browse...

Export Options

[ Enable Model Selector

Maximum length of signal names |Unlimited

K Cancel

Figure 112 - Export IBIS Model Dialog Box
Output File:
Click Browse to specify the location to export the IBIS output file along with the output file name.
Export Options:

The IBIS report *.ibs file exported from Libero SoC can optionally support the [Model Selector] keyword as
specified in the IBIS [BIS 5.0 Specifications. To generate Model Selector support in the exported IBIS file, check
the Enable Model Selector box in the Export Options. Using this, the user can also optionally limit the maximum
signal name to 40 characters.

Click OK to export the IBIS Model.
The IBIS model report provides an industry-standard file format for recording parameters like driver output

impedance, rise/fall time, and input loading, which may then be used by software applications such as Signal
Integrity tools or IBIS simulators.

The exported IBIS file has the file extension *.ibs (named <root>.ibs) and is displayed in the Files tab.

In the [Pin] section of the IBIS *.ibs file, listed under the model_name are the Model Selector tag. The IBIS *.ibs
file has a [Model Selector] section that describes the model selector and its list of models. The Model Selector tag
in the [Pin] section establishes the relationship between the pin and the [Model Selector].
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[Fin] signal_nams node]l nams E_pin I pin C_pin
AE33 PAD_0¢27> L?leﬁ_B.n‘.nleGmupl m=iod 0.75142 5. 683 4d6=-009 2. 14353=-012
E3l PAD_I<105» LYCMOS2S_BanklGroupl_ddrio 0. 609967 S.61206e-009 2.47835e-012
A2 FAD Q¢33> LVCHOS2S Bank2Groupl ddrio 0.786904 7.592853e-009 2.87418e=-012
[/

o=

LVYCHOS15_BanklSGroupl_msicd
LYCHOS15 émA MSIOD
LVCHMOS15 2md MSIOD

VCHOS1E_4mh_MSIOD LYCHOS1E 4mA MSIOD

IVCHOS2E_BanklGroupl_ddrie
IVCHOSZS Zmd MEDFAST DDRIO
INCHOS25 2mA SLOV DDRIO
LVCHOS25 2md MED DDRIO
LVCHOSZS ZmA FAST DDRIO
INCHOSZE imk MEDFAST DDRIO
INCHOS25 4wk SLOW DORIO
IVCHOSZS 4md MED DDRIO
LVCHOS2S 4mA FAST DDRIO

rlt_ﬁdel Salector]
LVCHOS25_ZnA_MEDFAST_DDRIO
LYCHOS25_2wnh_SLOV_DDRIO
LYCHOS25_2nh_MWED_CDDRIO
LYCHOS2E Imh_FAST_DDRIO
LYCHOS25_4nA_MEDFAST_LDRIO
LVCHOS25_dnh_SLOVW_DDRIO
VCHOS2E_4mA_MED_CDRIO

\ 0525 _4mh _FAST DDRIO

|
|

{Eds:. Selestor] LVCHOS2S_Bank2Groupl ddnc?‘\
YCHOS25_4nk_SLOV_DDRIO

LVCHMOSZE 4mid SLOW DORIO
LVCHOS25_dnh_MED DDR LVCHOS2E dmik HED DDRIO
LVCHOS25_dnk_| HEDFﬁST DDRID LVCHOS2S 4ma MEDFAST DDRIO
LYCHOS25 -h.i_E'luST DDRIO LVCHMOSZS 4ma FAST DDRIO
LVCHOS2E 2mA_SLOW DDRIO LYCMOS2E 2mA SLOW DDRIO
IYCHOS2S 2nk_MED_DDRIO INCMOS2E 2mid MED DDRIO
VCHOS25_2mA_MEDFAST_CDRIO LVCHOS2E 2Zmi MHEDFAST DDRIO

Figure 113 - Model Selector
The advantage of Model Selector feature is that you can load the

e Model Selector for Pin AE33

@ Model Selector for Pin E31

€= Modél Selector for Pin A2

*.ibs File
*.ibs file from Libero SoC into Signal Integrity

applications or IBIS simulators and switch the I/O to different models for individual I/Os on-the-fly in the tools.
There is no need to go back to the Libero SoC I/O Attribute Editor to change the I/O settings and run Compile to

switch to different I/O settings.

See the Microsemi Website for more information on IBIS Models.
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Export SmartDebug Data (Libero SoC)

Export SmartDebug Data allows the export of SmartDebug Data from Libero to be handed off to the Standalone
SmartDebug environment.

In the Libero SoC Design Flow window, expand Handoff Design for Debugging, right-click Export SmartDebug
Data and click Export to open the Export SmartDebug Data dialog box. Specify the design debug data file
(*.ddc)) to be exported. This file is also used as one of the ways to create a Standalone SmartDebug project.

See the following figure for an example.

Design debug data file

MName: |tesb:ase

Location: I_3 2 512 32 v/DPRAM_512 32 512 32 v/designer/topfexport i

Existing design debug data files:

top_ppd.ddc

| ~Indude design components
I¥ FPGA Array Probe Points
I¥ FPGA Array Memory Blocks
¥ Searity [ Display DPK or UPKLin SmartDebug
¥ ITAG Chain
v Programmer Settings

¥ Device /0 States During Programming

[ Indude bitstream file to program at trusted facility

Help oK | Cancel

Figure 114 - Export SmartDebug Data Dialog Box
Note: SmartDebug data can be exported without connecting the hardware.
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Design debug data file (*.ddc)
Name

The name of the design.
Location

The location of the exported debug file. By default, the *.ddc file is exported to the
<project_location>/designer/<design>/export folder and has the *.ddc file extension.

Existing Design Debug Data Files
The existing *.ddc file, if any, in the export folder.
SmartDebug data can be exported after you run Generate FPGA Array Data for the design in the Libero Design
Flow. You can also directly export SmartDebug data after running Synthesize on the design. Other tools, such as
Place and Route, Generate FPGA Array Data, and so forth) are implicitly run before the Export SmartDebug Data
dialog box is displayed.
Include design components
A DDC file can contain the following components:

o FPGA Array Probe Points — When checked, Libero SoC exports Live and Active probes information

(<design>_probe.db file) into the *.ddb container file.

e FPGA Array Memory Blocks — When checked, Libero SoC exports information about FPGA memories
(<design>_sii_block.db) into the *.ddb container file:

o names and addresses of the memory blocks instantiated by the design
o data formats selected by the user in the design
o sNVM - When checked, Libero SoC exports sNVM components.

e Security — This contains the security locks, keys, and security policy information needed for debug. This
may be default or custom security (<design>.spm file). It is hidden if security is not supported for the device.

o Display DPK or UPK1 in SmartDebug - This option is enabled only when custom security is
provided, and is unchecked by default.

e JTAG Chain (device chain information configured using Programming Connectivity and Interface in Libero)
—When checked, Libero SoC exports chain data including devices, their programming files if loaded, device
properties, and so on (<design>.pro file). If JTAG chain is uchecked, the default JTAG chain with Libero
design device only is added to the *.ddc file.

o Programmer Settings (<design>.pro file) — If Programmer Settings is unchecked, the default programmer
settings are added to the *.ddc file.

e Device I/O States During Programming (<design>.ios file) — This setting is used by some SmartDebug
features, for example, for programming sNVM . It is NOT used during device programming in SmartDebug;
programming files used to program devices already have I/O states data.

In addition, you can include bitstream file information, which can be used for programming the device in
Standalone SmartDebug.

Programming Options set with Configure Programming Options tool- Displays the Design version and Back
Level version set in the Configure Programming Options Wizard. They are read only options and cannot be
modified.

Note: Info and warning messages appear based on the value set for the Back Level version.
Include Bitstream file to program at trusted facility

e Bitstream components: Fabric

e Bitstream components: sNVM

e Bitstream components: Custom security (this option is only visible if Custom Security Option is selected in
Configure Security wizard).

Note: If the Fabric Bitstream component is programmed, the sNVM Bitstream component must be programmed
and it is selected by default. In this case, sSNVM is disabled for the user to unselect. Otherwise, the sSNVM
component can either be enabled or disabled for programming.

The default location of the DDC file is: <Libero_Project_directory>/designer/<design_name>/export.
The DDC file can be exported to any user-specified location if the location has read and write permission.
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References

set_client

This Tcl command specifies the client that will be added to SPI Flash Memory. This command is added to the SPI
Flash Memory configuration file that is given as the parameter to the configure_spiflash command.

set client \
-client name {} \
-client_type {(FILE SPI | FILE SPI_GOLDEN | FILE_SPTI UPDATE |FILE_ DATA STORAGE INTELHEX

-content type {MEMORY FILE | STATIC FILL} \
-content file {} \

-start_address {} \

-client size {} \

-program {0]1}

Arguments
-client_name
The name of the client. Maximum of 32 characters, letters or numbers or “-“ or “_".
-client type

The -client type canbe FILE SPI, FILE SPI_GOLDEN, FILE SPI_ UPDATE Of
FILE DATA STORAGE INTELHEX.

FILE SPI — SPI Bitstream
FILE SPI GOLDEN — Recovery/Golden SPI Bitstream

FILE spI_UPDATE — Auto Update SPI Bitstream; available only if Auto Update is enabled. See
set auto update mode.

FILE DATA STORAGE INTELHEX - Data Storage client

-content type

The -content_type can be MEMORY_FILE or STATIC_FILL.

MEMORY FILE — content_file parameter must be specified. See below.
SsTATIC FILL — client memory will be filled with 1s; no content memory file
-content_file

Absolute or relative path to the content memory file.

-start_address

The client start address. Note that some space is reserved for the SPI Flash Memory directory. Note: This
is a decimal value of bytes.

-client_size

Client’s size in bytes. If a content file is specified, the size must be equal to or larger than the file size.
Note: this is a decimal value.

-program {1}
Note: Only program | 1 is supported in this release.

Examples
The following examples show the set client Tcl command for SPI Flash.
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Absolute path

set client \
-client name {golden} \
-client type {FILE SPI GOLDEN} \
-content type {MEMORY FILE} \
-content file {E:\top design ver 1.spi} \
-start _address {1024} \
-client size {9508587} \
-program {1}
set client \
-client name {ds} \
-client type {FILE DATA STORAGE INTELHEX} \
-content type {MEMORY FILE} \
-content file {E:\intel hex.hex} \
-start address {9509611} \
-client size {128} \
-program {1}

Relative path

set client \
-client name {golden} \
-client type {FILE SPI GOLDEN} \
-content type {MEMORY FILE} \
-content_file {.\..\..\top design _ver 1l.spi} \
-start address {1024} \
-client size {9508587} \
-program {1}

set _client \
-client name {ds} \
—clientitype {FILE DATA STORAGE INTELHEX} \
-content type {MEMORY FILE} \
-content file {.\..\..\intel hex.hex} \
-start address {9509611} \
-client size {128} \
-program {1}

configure_uprom

Tcl command; configures the uPROM clients in the uPROM tab of the Design and Memory Initialization tool. Can
specify user uPROM clients using this command.

Note: You must run Generate Design Initialization Data (generate_design_initialization_data) after configuring
uPROM (configure_uprom) and/or Design Initialization (configure_design_initialization_data).

configure uprom \
-cfg file <path to configuration file.cfg>

Arguments
-cfg_file path to configuration file.cfg
Specifies the path to the configuration file of the uPROM client. It is mandatory.

Examples
configure uprom \
-cfg file
{../../Downloads/mpf_dg0852 liberosocvl2p0_df/Libero_Project/TVS_Demo/designer/TVS_Demo/
UPROM. cfg}

See Also
generate design_initialization data
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configure_spiflash

Tcl command; configures the SPI Flash clients in the SPI Flash tab of the Design and Memory Initialization tool.
Can specify user SPI FLASH clients using this command.

Note: You must run Generate Design Initialization Data (generate_design_initialization_data) after configuring
SPI Flash(configure_spiflash) and/or Design Initialization (configure_design_initialization_data).

configure spiflash \
-cfg file <path to configuration file.cfg>

Arguments
-cfg file path to configuration file.cfg
Specifies the path to the configuration file of the SPI FLASH client. It is mandatory.

Examples
configure spiflash \
-cfg file

{../../Downloads/mpf dg0852 liberosocvl2p0 df/Libero Project/TVS Demo/designer/TVS Demo/
spiflash.cfg}

See Also
generate design_initialization data

Archive Project Dialog Box

The Archive Project dialog box enables you to create an archive (*.zip file) of your existing project and save it at
the specified location. This is useful if you want to create a quick zip file of your project. Internally, Archive
Project and Save As Project do the same task, but if you are saving your Libero application to the SVN
repository, it is important to archive your project. When you do an SVN checkout after check in, there is a chance
that the timestamps will be outdated and the tool states will remain invalidated. Archive Project helps in retaining
the tool states by preserving the database in compressed format.

To access this dialog box, choose Archive Project from the Project menu.
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Q)

Project location:

|!{: Y10_docs_review\12.0_Release'\g4_exp

Content

[ ] Copy links locally

Files:

Help

All

Ok

Cancel

Figure 115 - Archive Project Dialog Box

Project Location
Accept the default location or Browse to a new location where the archive (*.zip) file is to be created and stored.

The *.zip file is named <project_name>.zip.

Content

Copy links locally - Select this checkbox to copy the links from your current project into your archive. If you do
not select this checkbox, the links will not be copied and you must add them manually.

Files: Specifies what kind of files are archived.

e All - Includes in the archive all your project and source files; the state of the project is retained.

e Project files only — Includes in the archive only the project-related information required to retain the state of
the project.

e Source files only - Includes in the archive only the source files. This means the configuration of all the tools
in the tool chain is retained but the states are not. Source files means constraint information and component
information available in the component, hdl and smartgen directories.

Files are archived as shown in the table below for the different selections.

Folder Name Files
All Project Files Only Source Files Only

component All Files All Files All Files
constraint All Files All Files All Files
hdl All Files All Files All Files
stimulus All Files All Files All Files
viewdraw All Files All Files All Files
smartgen All Files All Files All Files
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Folder Name Files
All Project Files Only Source Files Only

firmware All Files All Files All Files
CoreConsole All Files All Files All Files
SoftConsole/Keil/lAR All Files All Files All Files
simulation All Files *.ini, *.bfm, *.do., *.vec *.ini, *.bfm, *.do., *.vec
synthesis All Files *.edn, *.vm, *.sdc, *.so, | *.prj files

*.prj, *.srt, *.v,

run_options.txt,

synplify.log
Designer/impl1 All Files All Files *.ide_des files
Designer/<root> All Files All Files Not archived
tooldata All Files All Files All Files

Note: *edn files are not supported in PolarFire.
Adding or Modifying Bus Interfaces in SmartDesign

SmartDesign supports automatic creation of data driven configurators based on HDL generics/parameters. You
can add a bus interface from your HDL module or you can add it from the Catalog.

To add a bus interface using your custom HDL block:
If your block has all the necessary signals to interface with the AMBA bus protocol (such as address, data, and
control signals):

1. Right-click your custom HDL block and choose Create Core from HDL. The Libero SoC creates your core
and asks if you want to add bus interfaces.

2. Click Yes to open the Edit Core Definition dialog box and add bus interfaces. Add the bus interfaces as
necessary.

3. Click OK to continue.
Now your instance has a proper AMBA bus interface on it. You can manually connect it to the bus or let Auto
Connect find a compatible connection.
To add (or modify) a bus interface to your Component:

1. Right-click your Component and choose Edit Core Definition. The Edit Core Definition dialog box opens, as
shown in the figure below.
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Figure 116 - Edit Core Definition Dialog Box
2. Click Add Bus Interface. Select the bus interface you wish to add and click OK.
3. If necessary, edit the bus interface details.

4. Click Map by Name to map the signals automatically. Map By Name attempts to map any similar signal
names between the bus definition and pin names on the instance. During mapping, bus definition signal
names are prefixed with text entered in the Map by Name Prefix field.

5. Click OK to continue.

Bus Interface Details
Bus Interface: Name of bus interface. Edit as necessary.

Bus Definition: Specifies the name of the bus interface.
Role: Identifies the bus role (master or slave).

Vendor: Identifies the vendor for the bus interface.

Version: Identifies the version for the bus interface.
Configuration Parameters

Certain bus definitions contain user configurable parameters.
Parameter: Specifies the parameter name.

Value: Specifies the value you define for the parameter.

Consistent: Specifies whether a compatible bus interface must have the same value for this bus parameter. If the
bus interface has a different value for any parameters that are marked with consistent set to yes, this bus
interface will not be connectable.
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Signal Map Definition

The signal map of the bus interface specifies the pins on the instance that correspond to the bus definition
signals. The bus definition signals are shown on the left, under the Bus Interface Definition. This information
includes the name, direction and required properties of the signal.

The pins for your instance are shown in the columns under the Component Instance. The signal element is a
drop-down list of the pins that can be mapped for that definition signal. .

If the Req field of the signal definition is Yes, you must map it to a pin on your instance for this bus interface to be
considered legal. If it is No, you can leave it unmapped.

In the Libero SoC, from the View menu choose Windows > Catalog.
The Catalog displays a list of available cores, busses and macros (see image below).

Catalog

.‘ -
Namea v
+ Bus Interfaces
+ Clock & Management
+ DSP
+ YO

Macro Library
Memory & Controllers
Peripherals

PolarFire Features
Processors

User Defined

+ + +

-

Figure 117 - Libero SoC Catalog

From the Catalog, you can create a component from the list of available cores, add a processor or peripheral, add
a bus interface to your SmartDesign component, instantiate simulation cores or add a macro (Arithmetic, Basic
Block, etc.) to your SmartDesign component.

Double-click a core to configure it and add it to your design. Configured cores are added to your list of
Components/Modules in the Design Explorer.

Click the Simulation Mode checkbox to instantiate simulation cores in your SmartDesign Testbench. Simulation
cores are basic cores that are useful for stimulus, such as driving clocks, resets, and pulses.

Viewing Cores in the Catalog
The font indicates the status of the core:
e Plain text - In vault and available for use
o Asterisk after name (*) - Newer version of the core (VLN) available for download
e [talics - Core is available for download but not in your vault
o Strikethrough - core is not valid for this version of Libero SoC

The colored icons indicate the license status. Blank means that the core is not license protected in any way.
Colored icons mean that the core is license protected, with the following meanings:

Green Key - Fully licensed; supports the entire design flow.

Yellow Key - Has a limited or evaluation license only. Precompiled simulation libraries are provided,
enabling the core to be instantiated and simulated within Libero SoC. Using the Evaluation version of the
core it is possible to create and simulate the complete design in which the core is being included. The
design is not synthesizable (RTL code is not provided). No license feature in the license.dat file is needed
to run the core in evaluation mode.You can purchase a license to generate an obfuscated or RTL netlist.
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Yellow Key with Red Circle - License is protected; you are not licensed to use this core.

Right-click any item in the Catalog and choose Show Details for a short summary of the core specifications.
Choose Open Documentation for more information on the Core. Right-click and choose Configure Core to open
the core generator.

Click the Name column heading to sort the cores alphabetically.

You can filter the cores according to the data in the Name and Description fields. Type the data into the filter field
to view the cores that match the filter. You may find it helpful to set the Display setting in the Catalog Options to
List cores alphabetically when using the filters to search for cores. By default the filter contains a beginning and
ending ™, so if you type ‘controller’ you get all cores with controller in the core name (case insensitive search) or
in the core description. For example, to list all the Accumulator cores, in the filter field type:

accu

Catalog Options

Click the Options button ““ (or the drop-down arrow next to it) to import a core, reload the Catalog, or modify the
Catalog Options.
You may want to import a core from a file when:

e You do not have access to the internet and cannot download the core, or
e A core is not complete and has not been posted to the web (you have an evaluation core)

Manually Downloading MegaVaults and Individual CPZ files

When Libero is used in an environment without automatic access to Microsemi's online IP repositories via the
Internet; see this article explaining how to download MegaVaults and individual CPZ files.

Catalog Options Dialog Box

The Catalog Options dialog box (as shown below) enables you to customize your Catalog. You can add a
repository, set the location of your vault, and change the View Settings for the Catalog. To display this dialog box,

click the Catalog Options button .
1. Dptions BE

[ Yault/Repasitaries Settings I add
: m Repositaries
-1 vault location wiww, ackel-ip.com/repositories{SgCare Remave |
w Settings v, actel-ip.comfrepositaries DirectCore

- Display
- Filters

Defaults |
o | _cm |

Figure 118 - Catalog Display Options Dialog Box

Vault/Repositories Settings

Repositories

A repository is a location on the web that contains cores that can be included in your design.

The Catalog Options dialog box enables you to specify which repositories you want to display in your Vault. The
Vault displays a list of cores from all your repositories, and the Catalog displays all the cores in your Vault.

The default repository cannot be permanently deleted; it is restored each time you open the Manage Repositories
dialog box.

Any cores stored in the repository are listed by name in your Vault and Catalog; repository cores displayed in your
Catalog can be filtered like any other core.
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Type in the address and click the Add button to add new repositories. Click the Remove button to remove a
repository (and its contents) from your Vault and Catalog. Removing a repository from the list removes the
repository contents from your Vault.

Vault location

Use this option to choose a new vault location on your local network. Enter the full domain pathname in the Select
new vault location field. Use the format:

\\server\share
and the cores in your Vault will be listed in the Catalog.
Set ENV variable to set vault location - In addition to setting the vault location using the Catalog dialog box, you
can set the vault location using the environment variable MSCC_IDE_VAULT_LOCATION. Setting the vault
through the environment variable takes precedence over all other options to set vault location.
To set the vault location on Linux, type the following command:

setenv MSCC IDE VAULT LOCATION /home/temp dir
To set the vault location on Windows:

Add a new environment variable MSCC_IDE_VAULT_LOCATION in System Properties and specify your vault
location.

Read only vault

Display

Filters

In read only Mega Vault mode, you cannot download, add, or remove cores. However, you can configure and
generate cores by creating a temporary extract location to extract the core. This temporary extract location can be
set by setting the environment variable MSCC_IDE_VAULT_EXTRACT_LOCATION. By setting this environment
variable, your configured cores are retained across sessions.
To set the extract location on Linux, type the following command:

setenv MSCC_IDE_VAULT_ EXTRACT_LOCATION /home/vault extract
To set the extract vault location on Windows:
Add a new environment variable MSCC_IDE_VAULT_EXTRACT_LOCATION in System Properties and specify
your extract location.

If you do not specify the extract location, a temporary location will be created by Libero and it will be accessed
only while the current session is active. If the session is no longer active, the temporary extract location will be
cleaned up by Libero. If you specify the extract location, it will be available for any instance of libero on that
machine, and it is your responsibility to clean up the extract location.

View Settings

Group cores by function - Displays a list of cores, sorted by function. Click any function to expand the list and
view specific cores.

List cores alphabetically - Displays an expanded list of all cores, sorted alphabetically. Double click a core to
configure it. This view is often the best option if you are using the filters to customize your display.

Show core version - Shows/hides the core version.

Filter field - Type text in the Filter Field to display only cores that match the text in your filter. For example, to
view cores that include 'sub' in the name, set the Filter Field to Name and type sub.

Display only latest version of a core - Shows/hides older versions of cores; this feature is useful if you are
designing with an older family and wish to use an older core.
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Show all local and remote cores - Displays all cores in your Catalog.

Show local cores only - Displays only the cores in your local vault in your Catalog; omits any remote cores.

Show remote cores that are not in my vault - Displays remote cores that have not been added to your vault in
your Catalog.

Changing Output Port Capacitance

Output propagation delay is affected by both the capacitive loading on the board and the I/O standard. The I/O
Attribute Editor in ChipPlanner provides a mechanism for setting the expected capacitance to improve the
propagation delay model. SmartTime automatically uses the modified delay model for delay calculations.

To change the output port capacitance and view the effect of this change in SmartTime Timing Analyzer, refer to

the following example. The figure below shows the delay from DFN1 to output port Q. It shows a delay of 6.603 ns
based on the default loading of 5 pF.
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Figure 119 - Maximum Delay Analysis View

If your board has output capacitance of 15 pf on Q, you must perform the following steps to update the timing
number:

1. Open the I/O Attribute Editor and change the output load to 15 pf.

B /O Editor - X:10_does_review/12.0_Release/94609/cce? (top)

- ] x
File Edit View Logic Tools Help
> o vy 3)
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[ |Q -, Port Name t Slew |®| Pre-Emphasis ¥ Output Drive (mAl ™ Outputload (pF) ™| [
&0 v | | PortName:
Parts a8 L) i . { - = ~ £ Macro: Q_obuf
R T N T . oo
Placed: 237,313

Pin: B9

1/0 Standard: LVOMOS25

1/0 Bank: Bank1 - DDRIO
VDOL: 2.5¢

Figure 120 - I/O Attribute Editor View
2. Select File > Save.
3. Select File > Close.
4. Open the SmartTime Timing Analyzer.

You can see that the Clock to Output delay changed to 5.952 ns.
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Core Manager

The Core Manager only lists cores that are in your current project. If any of the cores in your current project are
not in your vault, you can use the Core Manager to download them all at once.

For example, if you download a sample project and open it, you may not have all the cores in your local vault. In
this instance you can use the Core Manager to view and download them with one click. Click Download All to
add any missing cores to your vault. To add any individual core, click the green download button.

To view the Core Manager, from the View menu choose Windows > Cores.

The column headings in the Core Manager are:

Name - Core name.

Vendor - Source of the core.

Core Type - Core type.

Version - Version of the core used in your project; it may be a later version than you have in your vault. If

so, click Download All to download the latest version.

configure_design_initialization_data

This Tcl command sets the parameter values needed for generating initialization data.

configure design initialization data
-second stage start address {<sNVM address for the second initialization client>} \
-third stage uprom start address {<uPROM address for the third initialization stage client>} \
-third stage spi start address {<SPI address for the third initialization stage client>} \
-third stage snvm start address {<sNVM address for the third initialization stage client>} \
-third stage spi type {<SPIFLASH NO BINDING PLAINTEXT | SPIFLASH BINDING DEFAULT |
SPIFLASH BINDING UEKI | SPIFLASHfBINDINGﬁUEK2>}\
-third stage spi clock divider {< 1 | 2 | 4 | 6>} \
-init timeout {<int between 1 and 128 seconds>} \
—auto_calib timeout ({<Auto Calibration timeout value in milliseconds>} \
-broadcast RAMs {< 0 | 1 >} \
-custom cfg file {<Initialization file for custom configuration>}

Arguments

-second_stage_start address
String parameter for the start address of the second stage initialization client.
Specified as a 32-bit hexadecimal string.

The first stage client is always placed in sNVM, so it must be a valid sSNVM address aligned on a page
boundary.

There are 221 sNVM pages and each page is 256 bytes long, so the address will be between 0 and
DCO00.

Notes:
Although the actual size of each page is 256 bytes, only 252 bytes are available to the user.

The first stage initialization client is always added to SNVM at 0xDCO0O (page 220). So the valid addresses
for the second stage initialization client are 0x0 (page 0) to 0xDBOO (page 219).

-third stage uprom start address

String parameter for the uPROM start address of the third stage initialization client. It is optional.
Specified as a 32-bit hexadecimal string and must be valid uPROM address aligned on a block boundary.
-third stage snvm start_address

String parameter for the sNVM start address of the third stage initialization client. It is optional.

Specified as a 32-bit hexadecimal string and must be valid sNVM address.

-third stage SPI start address

String parameter for the SPIFLASH start address of the third stage initialization client. It is optional.
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Specified as a 32-bit hexadecimal string and must be valid SPIFLASH address.

-third stage_spi_ type

The value must be one of SPIFLASH_NO_BINDING_PLAINTEXT or SPIFLASH_BINDING_DEFAULT or
SPIFLASH_BINDING_UEK1 or SPIFLASH_BINDING_UEK2.

This parameter determines the valid value for parameter ‘third_stage_start_address’.

-third stage spi clock divider

Specifies the clock frequency appropriate for the SPIFLASH memory on board. The value can be 1, 2, 4,
or 6. The default value is 1 which is 80 MHz. The other values are 2-40 MHz, 4-20 MHz and 6-13.33 Mhz.

-init_timeout

Timeout value in seconds. Initialization is aborted if it does not complete before timeout expires.

The value can be between 1 and 128. The default value is 128.

-broadcast_RAMs

Specifies broadcast instructions to initialize RAM's to zero's. Value can be either 0 or 1. It is optional.
-custom cfg file

Specifies the initialization file for custom configuration. It is optional

Example
Example to initialize data with sNVM client

configure design_initialization data
-second stage start address {0x0000aa00}
-third stage uprom start address {0x00000000}
-third stage_ snvm start address {0x0000aa00}
-third stage spi start address {0x00000400}
-third stage spi_ type {SPIFLASH NO_BINDING PLAINTEXT}
-third stage spi_clock _divider {4}
-init_timeout 85
-—auto_calib_ timeout {1400}
-broadcast RAMs {0}

Example to initialize data with uPROM client

configure design_initialization data
-second stage start address {0x00000000}
-third stage uprom start address {0xfffffee2}
-third stage_snvm start address {0x00000000}
-third stage spi start address {0x00000400}
-third stage spi_ type {SPIFLASH NO_BINDING PLAINTEXT}
-third stage spi clock divider {4}
-init_timeout 45
-—auto_calib_timeout {2000}
-broadcast RAMs {0}

Example to initialize data with SPI-FLASH client

configure design_initialization data
-second stage start address {0x00000000}
-third stage uprom start address {0x00000000}
-third stage_snvm start address {0x00000000}
-third stage spi start address {0x000AC120}
-third stage spi_ type {SPIFLASH BINDING UEKZ2}
-third stage spi clock divider ({2}
-init_timeout 20
-—auto_calib_ timeout {500}

-broadcast RAMs {1}
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See Also
generate design_initialization data

Configure Permanent Locks for Production

Configure Permanent Locks for Production is a GUI-based tool that guides the user step by step on how to
configure the Permanent Locks for Production. The wizard has six steps/pages executed in sequential order. One
Time Programmable (OTP) settings in the Permanent Locks page are applied to configured Security settings from
the Configure Security tool. The subsequent pages have read only fields, which will be affected by Permanent
Lock settings. These settings can only be configured by the Configure Security tool.

If you configure any Permanent Lock settings, you will be forced to go through each page to review the Security
settings to make sure they are as desired. The settings cannot be changed once they have been programmed.

. Permanent Locks
. User keys in Configure Security
. Update Policy in Configure Security

. Debug Policy in Configure Security

. Microsemi Factory Access in Configure Security

o O~ WON -

. JTAG/SPI Slave Commands Policy in Configure Security

Summary Window
The summary window displays the summary of the current page configuration settings. Based on the selection
made in the first page, the summary for the subsequent pages change. The window will scroll to the current page
as you move from page to page.

Back

Click Back to return to the previous step.

Next
Click Next to proceed to the next step.
Finish
Click Finish to complete the configuration after executing the all the steps in sequential order.

Save Summary to File
Click Save Summary to File to save the display in the Summary field to a file.

configure _snvm

Tcl command; configures the sNVM clients in the sSNVM tab of the Design and Memory Initialization tool. Can
specify user sSNVM clients using this command.

Note: You must run Generate Design Initialization Data (generate_design_initialization_data) after configuring
sNVM (configure_snvm) and/or Design Initialization (configure_design_initialization_data).

configure snvm \
-cfg file <path to configuration file.cfg>

Arguments
-cfg _file path to configuration file.cfg
Specifies the path to the configuration file of the sSNVM client. It is mandatory.

Examples

configure snvm \
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{../../Downloads/mpf dg0852 liberosocvl2p0_df/Libero_Project/TVS_Demo/designer/TVS_Demo/

SNVM.cfg

See Also

generate design initialization data

SPM_OTP

Configures the parameters for SPM_OTP.

configure tool \
[-name SPM OTP] \

[-params permanently disable debugging 0 | 1] \

[-params permanently disable dpk 0

| 11\

[-params permanently disable factory access 0 |
[-params permanently disable prog interfaces 0 |
[-params permanently disable upkl 0 | 1] \
[-params permanently disable upk2 0 | 1] \
[-params permanently write protect fabric 0 | 1]

1]
1]

The following tables list the parameter names and values.

configure_tool —name {SPM_OTP} parameter:value pair

\

\

Name

Type

Value

Description

permanently_disable_debugg
ing

bool

false | true |0 | 1

Specifies that the SmartDebug access
control and reading temperature and
voltage sensor settings is either
permanently enabled or disabled. A value
of true/1 will permanently disable
debugging. The default value is false.

permanently_disable_dpk

bool

false | true |0 | 1

Specifies that the Debug Pass Key is
either permanently enabled or disabled. A
value of true/1 will permanently disable
FlashLock DPK unlocking. The default
value is false.

permanently_disable_factory
_access

bool

false | true |0 | 1

Specifies that the access policy for
Microsemi factory test mode is either
permanently enabled or disabled. A value
of true/1 will permanently disable
Microsemi factory test mode. The default
value is false.

permanently_disable_prog_in
terfaces

bool

false | true |0 | 1

Specifies that the Programming interfaces
such as Auto Programming, JTAG, SPI
Slave are either permanently enabled or
disabled. A value of true/1 will
permanently disable all of the
programming interfaces. The default value
is false.

permanently_disable_upk1

bool

false | true |0 | 1

Specifies that the User Key UPK1 is either
permanently enabled or disabled. A value
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Name Value

Type

Description

of true/1 will permanently disable
FlashLock UPK1 unlocking. The default
value is false.

permanently_disable_upk2 bool false | true | 0| 1

Specifies that the User Key UPK2 is either
permanently enabled or disabled. A value
of true/1 will permanently disable
FlashLock UPK2 unlocking. The default
value is false.

permanently_write_protect f | bool

abric

false | true | 0 | 1

Specifies that the write protection for fabric
is either permanently enabled or disabled.
A value of the true/1 will make the fabric
one-time programmable. The default value
is false.

Examples

The following example specifies that SPM_OTP tool is configured to permanently disable user keys UPK1 and

UPK2.
configure tool \

-name {SPM_OTP} \

-params {permanently disable debugging:false} \
-params {permanently disable dpk:false} \
-params {permanently disable factory access:false} \
-params {permanently disable prog interfaces:false}
-params {permanently disable upkl:true} \
-params {permanently disable upk2:true} \

-params {permanently write protect fabric:false}

\

The following example specifies that SPM_OTP tool is configured to permanently disable programming interfaces.

configure tool \
-name {SPM OTP} \
-params {permanently disable debugging:false} \
-params {permanently disable dpk:false} \
-params {permanently disable factory access:false} \
-params {permanently disable prog interfaces:true} \

\
{permanently disable upk2:false} \

-params {permanently disable upkl:false}
-params

-params {permanently write protect fabric:false}

See Also
remove permanent locks

Importing Source Files — Copying Files Locally

Designer in Libero SoC cannot import files from outside your project w

ithout copying them to your local project

folder. You may import source files from other locations, but they are always copied to your local folder. Designer
in Libero SoC always audits the local file after you import; it does not audit the original file.

When the Project Manager asks you if you want to copy files "locally",

it means 'copy the files to your local project

folder'. If you do not wish to copy the files to your local project folder, you cannot import them. Your local project

folder contains files related to your Libero SoC project.
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Files copied to your local folders are copied directly into their relevant directory: netlists are copied to the
synthesis folder; source files are copied to hdl folder and constraint files to constraint folder, etc. The files are also

added to the Libero SoC project; they appear in the Files tab.

Create Clock Constraint Dialog Box

Use this dialog box to enter a clock constraint setting.

It displays a typical clock waveform with its associated clock information. You can enter or modify this information,
and save the final settings as long as the constraint information is consistent and defines the clock waveform
completely. The tool displays errors and warnings if information is missing or incorrect.

To open the Create Clock Constraint dialog box (shown below) from the SmartTime Constraints Editor, choose
Constraints > Clock.

oy (%=

Clock Name : |dk1 | Clock Source : |EtJ:lDI'tS {PLL_REF_CLK}] |

f—parind : ns — My Frequency: Mhz
—_—

]

e Offset : ppe— Duty cyde : »

[ Add this dock to existing one with same source

Comment : |

Help 0K Cancel

Figure 121 - Create Clock Constraint Dialog Box

Clock Source
Enables you to choose a pin from your design to use as the clock source.

The drop-down list is populated with all explicit clocks. You can also select the Browse button to access all
potential clocks. The Browse button displays the Select Source Pins for Clock Constraint Dialog Box.

Clock Name

Specifies the name of the clock constraint. This field is required for virtual clocks when no clock source is
provided.

Period
When you edit the period, the tool automatically updates the frequency value.
The period must be a positive real number. Accuracy is up to 3 decimal places.

Frequency
When you edit the frequency, the tool automatically updates the period value.
The frequency must be a positive real number. Accuracy is up to 3 decimal places.

Starting Clock Edge Selector
Click the Up or Down arrow to use the rising or falling edge as the starting edge for the created clock.
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Offset
Indicates the shift (in nanoseconds) of the first clock edge with respect to instant zero common to all clocks in the
design.
The offset value must be a positive real number. Accuracy is up to 2 decimal places. Default value is 0.

Duty Cycle
This number specifies the percentage of the overall period that the clock pulse is high.
The duty cycle must be a positive real number. Accuracy is up to 4 decimal places. Default value is 50%.

Add this clock to existing one with same source

Check this box if you want to add a new clock constraint on the same source without overwriting the existing clock
constraint. The new clock constraint name must be different than the existing name. Otherwise, the new
constraint will overwrite the existing one even if you check this box.

Comment
Enables you to save a single line of text that describes the clock constraints purpose.

See Also
Specifying Clock Constraints

Select Source Pins for Clock Constraint Dialog Box

Use this dialog box to find and choose the clock source from the list of available pins.

To open the Select Source Pins for the Clock Constraint dialog box (shown below) from the SmartTime
Constraints Editor, click the Browse button to the right of the Clock source field in the Create Clock Constraint

dialog box.
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Select a Type and Pattern to start selection
Filter available pins :

Type : Pattern :

All Pins . Search

Available Pins:

DFMT_0/CLE A
DFN1_0/D

DFM1_0/Q

DFMT_1/CLE

DEN1_1/Q

D_ibuf/PAD

D_ibuf/Y ¥

Add Add all Remove Remove All

Assigned Pins:

DFMN1_1/D

Help oK Cancel

Figure 122 - Select Source Pins for Clock Constraint Dialog Box
Filter Available Pins
Type — Displays the Type of the Available Pins in the design. The Pin Type options available for the Source are:

e AllPins
e Input Ports
e All Nets

Pattern — The default is *, which is a wild-card match for all. You can specify any string value.
Click Search to filter the available pins based on the specified pin Type and Pattern.
Available Pins

The list box displays the available pins. If you change the pattern value, the list box shows the available pins
based on the filter.

Use Add, Add All to add the pins from the Available Pins list to Assigned Pins or Remove, Remove All to delete
the pins from the Assigned Pins list.

Assigned Pins

Displays pins selected from the Available Pins list. Select Pins from this list and click OK to add the Source Pins
for Clock Constraint.

See Also
Specifying clock constraints

Specifying Clock Constraints

Specifying clock constraints is the most effective way to constrain and verify the timing behavior of a sequential
design. Use clock constraints to meet your performance goals.

192



PolarFire FPGA Design Flow User Guide

To specify a clock constraint:

& Microsemi

a A3\ MicrRocHIP company

1. Add the constraint in the editable constraints grid or open the Create Clock Constraint dialog box using one

of the following methods:

e Click the icon in the Constraints Editor.

e Right-click the Clock in the Constraint Browser and choose Add Clock Constraint.
e Double-click Clock in the Constraint Browser.

e Choose Clock from the Constraints drop-down menu (Constraints > Clock)

The Create Clock Constraint dialog box appears (as shown below).

(N ? =
Clock Name : | | Clock Source : |
#———Period : \ lns ———nie Frequency: [ ]‘ Mhz
—
[=

e Offset: e Duly cyde : —

0.000 ns 50.0000 %
[ Add this dock to existing one with same source
Comment : J

Help OK Cancel

Figure 123 - Create Clock Constraint Dialog Box

2. Select the pin to use as the clock source. You can click the Browse button to display the Select Source Pins

for Clock Constraint Dialog Box (as shown below).

Note: Do not select a source pin when you specify a virtual clock. Virtual clocks can be used to define a

clock outside the FPGA that is used to synchronize |/Os.

Use the Choose the Clock Source Pin dialog box to display a list of source pins from which you can
choose. By default, it displays the explicit clock sources of the design. To choose other pins in the
design as clock source pins, select Filter available objects - Pin Type as Explicit clocks, Potential
clocks, All Ports, All Pins, All Nets, Pins on clock network, or Nets in clock network. To display a
subset of the displayed clock source pins, you can create and apply a filter.

Multiple source pins can be specified for the same clock when a single clock is entering the FPGA

using multiple inputs with different delays.
Click OK to save these dialog box settings.

Modify the Duty cycle, if needed.
Modify the Offset of the clock, if needed.
Modify the first edge direction of the clock, if needed.

© ® N Ok W

Click OK. The new constraint appears in the Constraints List.

Specify the Period in nanoseconds (ns) or Frequency in megahertz (MHz).
Modify the Clock Name. The name of the first clock source is provided as default.

Select the check box for Add this clock to an existing one with the same source, if needed.

Note: When you choose File > Save, the Timing Constraints Editor saves the newly created constraint in

the database.
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[ File Constraints Tools Edit Help
I o R I M I L 1}

Constraints Editor

= Constraints
& Requirements Syntax
% Clock
% Generated Clock ‘
Input Delay ‘z 3 ‘cLKu,PAD |[DEtJDns {CLKD,Il 3‘000‘ 333‘333‘ EU‘UUUUUU‘Nsmg =
Output Delay
External Check
Clock To Out
5 Exceptions
Max Delay
Min Delay
Multicycle
T False Path
& Advanced
Disable Timing
Clock Source Latency
Clock Uncertainity
Clock Groups

Period First | Offset
(ns) Edge | (ns)

Dutycyde
(%)

Clock Name il Waveform Comments

Clock Source | Add ‘ File

=

Click within this row to add a constraint.

u‘uuu| U.UULSU| ] ‘X‘\lujum,re'|

Figure 124 - Timing Constraint View

Create Generated Clock Constraint Dialog Box

Use this dialog box to specify generated clock constraint settings.

It displays a relationship between the clock source and its reference clock. You can enter or modify this
information, and save the final settings as long as the constraint information is consistent. The tool displays errors
and warnings if the information is missing or incorrect.

To open the Create Generated Clock Constraint dialog box (shown below) from the SmartTime Constraints
Editor, choose Constraints > Generated Clock.
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Clock Pin:

oty

Reference Pin:
Clock |
ﬁ |’ Conditioning]

TCIU:I: Port

FPGA

Generated Clodk Name :

*  The generated frequency is such that :
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™ The generated dock edges are based on the reference edges :

I~ The edges are shifted by the following delays : I |

the same as "'I the reference waveform.

[T AnExternal feedback is used to generate the dock.

PLL Cutput: | _!
PLL Feedback: | _i

The generated waveform is

[~ Add this dock to existing one with same source
Master Clock: | 1|

[ [ esoesieanpie: 139

Edge Shift (=xample: 0.0 0.5 1.0)

[T Phase shiftis apphed by PLL.

Phase shift: 0,00 degree

Comment : [

_ heo |

_ x|

Figure 125 - Create Generated Clock Constraint

Clock Pin

Enables you to choose a pin from your design to use as a generated clock source.

The drop-down list is populated with all unconstrained explicit clocks. You can also select the Browse button to
access all potential clocks and pins from the clock network. The Browse button displays the Select Generated

Clock Source dialog box.

Reference Pin

Enables you to choose a pin from your design to use as a generated reference pin. You can select the Browse
button to access all the available reference pins. The Browse button displays the Select Generated Clock

Reference dialog box.

Generated Clock Name

Specifies the name of the Generated clock constraint. This field is required for virtual clocks when no clock source

is provided.
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Generated Frequency

Specify the values to calculate the generated frequency: a multiplication factor and/or division factor (must be
positive integers) is applied to the reference clock to compute the generated clock.

Generated Clock Edges

Frequency of the generated clock can also be specified by selecting the Generated Clock Edges option. Specify
the integer values that represent the edges from the source clock that form the edges of the generated clock.
Three values must be specified to generate the clock. If you specify less than three, a tool tip indicates an error.

The following example shows how to specify the clock edges.

LSB MSB

FF1 FF2
clk—> p— >

[e]

1 2 3 4 5 6 7 8
e | L I L T L

1 2 3 3
o D S N (S
MSB————J |

2-bit ripple counter

If LSB is the generated clock from CLK clock source, the edge values must be [1 3 5].
If MSB is the generated clock from CLK clock source, the edge values must be [1 5 9].

Edge Shift

Specify a list of three floating point numbers that represents the amount of shift, in library time units, that the
specified edges are to undergo to yield the final generated clock waveform. These floating point values can be
positive or negative. Positive value indicates a shift later in time, while negative indicates a shift earlier in time.

For example: An edge shift of {1 1 1} on the LSB generated clock, would shift each derived edge by 1 time unit.
To create a 200MHz clock from a 100MHz clock, use edge { 1 2 3} and edge shift {0 -2.5 -5.0}

Generated Waveform

Specify whether the generated waveform is the same or inverted with respect to the reference waveform. Click
OK.

Phase

This field is primarily used to report the information captured from the CCC configuration process, and when
constraint is auto-generated. Meaningful phase values are: 0, 45, 90, 135, 180, 225, 270, and 315. This field is
used to report the information captured from the CCC configuration process, and when the constraint is auto-
generated.

PLL Output

This field refers to the CCC GL0/1/2/3 output that is fed back to the PLL (in the CCC). This field is primarily used
to report the information captured from the CCC configuration process, and when constraint is auto-generated.
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PLL Feedback
This field refers to the manner in which the GL/0/1/2/3 output signal of the CCC is connected to the PLL's FBCLK
input. This field is primarily used to report the information captured from the CCC configuration process, and when
constraint is auto-generated.

Add Clock to Existing Clock
Specifies that the generated clock constraint is a new clock constraint in addition to the existing one at the same
source. The name of the clock constraint should be different from the existing clock constraint. When this option is
selected, master clock must be specified.

Master Clock
Specifies the master clock used for the generated clock when multiple clocks fan into the master pin. It can be
selected from the drop-down menu. This option is used in conjunction with the add option of the generated clock.

Comment
Enter a single line of text that describes the generated clock constraints purpose.

See Also
create generated clock (SDC)

Specifying Generated Clock Constraints

Select Generated Clock Source

Select Generated Clock Source Dialog Box

Use this dialog box to find and choose the generated clock source from the list of available pins.

To open the Select Generated Clock Source dialog box (shown below) from the Timing Constraints Editor,
open the Create Generated Clock Constraint dialog box and click the Browse button for the Clock Pin.
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i nevoted Clotk Soumce (=]

Select a type and pattern to start a search
Filter available pins :

Pin Type : Pattern :
All Register Output Pins - ||+ || Filter
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv,/rgsl/genblkl.awrs/currstate[0]/C h

CorefXldInterconnect_0/MstConvertor_loop([0].mstrconv/rgsl/genblkl.awrs/currstate[1]/0
CorefXldInterconnect_/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[18]/C
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[19]/C
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[20]/0
CorefiXldInterconnect_(/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[21]/0
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[23]/C
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[24]/C
CoreAXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[25]/C
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[26]/C
CoreAXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[27]/C
CorefXldInterconnect_0/MstConvertor_loop[0]. mstrconv/rgsl/genblkl.awrs/holdDat[28]/C
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[29]/C
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[30]/C
CorefiXldInterconnect_(0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[31]/0
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[32]/C
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[33]/C

Coref¥ldnterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[34]/C M
£ >

Help Ok Cancel

Figure 126 - Select Generated Clock Source Dialog Box
Filter Available Pins

Pin type — Displays the Available Pin types. The Pin Type options for Generated Clock Source are:
e OQutput Ports
o All Register Output Pins

e AllPins
e All Nets
e Input Ports

Pattern — The default pattern is *, which is a wild-card match for all. You can specify any string value.
Select Filter to filter the available pins based on the specified Pin Type and Pattern.

The list box displays the list of available pins based on the filter. Select the pins from the list and click OK to select
the Generated Clock Source Pin.

Specifying Generated Clock Constraints

Specifying a generated clock constraint enables you to define an internally generated clock for your design and
verify its timing behavior. Use generated clock constraints and clock constraints to meet your performance goals.

To specify a generated clock constraint:

1. Open the Create Generated Clock Constraint dialog box using one of the following methods:
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e Click the icon.

* Right-click the Generated Clock in the Constraint Browser and choose Add Generated
Clock.

e Double-click the Generated Clock Constraints grid. The Create Generated Clock
Constraint dialog box appears (as shown below).

Clock: Fin:
Reference Pin:
— ona | E
J [ Cincuitry
TCIt'u:k Port FPGA
Generated Clodk Name :
*  The generated frequency is such that :
fidock) = freference) * i 1)1
™ The generated dock edges are based on the reference edges : I_ I_ I_ Edges (example : 13 5)
I~ The edges are shifted by the following delays : I | | Edige Shift (example: 0.0 0.5 1.0)

The generated waveform is the same as "'I the reference waveform.

[T Anexternal feedback is used to generate the dodk.

PLOUGUE | )
== . | _I Phase chift : |:'.'.- degres

[~ Phase shiftis apphed by PLL.

[~ Add this dock to exdsting ane with same source
Master Clock: | =

comnnt: |

Help oK | Cancel |
Figure 127 - Create Generated Clock Constraint

2. Select a Clock Pin to use as the generated clock source. To display a list of available generated clock
source pins, click the Browse button. The_Select Generated Clock Source dialog box appears (as shown
below).
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n nerz - e [(? |[=]

Select a type and pattern to start a search

Filter available pins :

Pin Type : Pattern :
All Register Output Pins - ||+ || Filter
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv,/rgsl/genblkl.awrs/currstate[0]/C h

CorefXldInterconnect_0/MstConvertor_loop([0].mstrconv/rgsl/genblkl.awrs/currstate[1]/0
CorefXldInterconnect_/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[18]/C
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[19]/C
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[20]/0
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CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[23]/C
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CoreAXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[27]/C
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CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[29]/C
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[30]/C
CorefiXldInterconnect_(0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[31]/0
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[32]/C
CorefXldInterconnect_0/MstConvertor_loop[0].mstrconv/rgsl/genblkl.awrs/holdDat[33]/C
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£ >

Help Ok Cancel

Figure 128 - Select Generated Clock Source Dialog Box

3. Specify a Reference Pin. To display a list of available clock reference pins, click the Browse button. The
Select Generated Clock Reference dialog box appears.

Specify the Generated Clock Name(optional).

5. Specify the values to calculate the generated frequency: a multiplication factor and/or a division factor (both
positive integers).

6. Specify the orientation of the generated clock edges based on the reference edges by entering values for
the edges and the edge shifts. This is optional.

7. Specify the first edge of the generated waveform either same as or inverted with respect to the reference
waveform.

8. Specify the PLL output and PLL feedback pins, if an External feedback is used to generate the clock.
9. Specify the Phase shift applied by the PLL in degrees.

10. Specify the Master Clock, if you want to add this to an existing one with the same source.

11. Click OK. The new constraint appears in the Constraints List.

Tip:  From the File menu, choose Save to save the newly created constraint in the database.
Select Generated Clock Reference Dialog Box

Use this dialog box to find and choose the generated clock reference pin from the list of available pins.
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To open the Select Generated Clock Reference dialog box (shown below) from the SmartTime Constraints Editor,
open the Create Generated Clock Constraint Dialog Box dialog box and click the Browse button for the Clock
Reference.

i T CIoTE REjerenee (=]

Select a type and pattern to start a search

Filter available pins :

Pin Type : Pattern :

Input Ports = ¥ Filter

CLED_PAD
D

Help Ok Cancel

Figure 129 - Select Generated Clock Reference Dialog Box
Filter Available Pins
Pin type — Displays the Available Pin types. The Pin Type options for Generated Clock Reference are:
e Input Ports
e AllPins
Pattern — The default pattern is *, which is a wild-card match for all. You can specify any string value.
Select Filter to filter the available pins based on the specified Pin Type and Pattern.

The list box displays the list of available pins based on the filter. Select the pins from the list and click OK to select
the Generated Clock Reference Pin.

See Also

Specifying generated clock constraints

Design Hierarchy in the Design Explorer

The Design Hierarchy tab displays a hierarchical representation of the design based on the source files in the
project. It also displays elaborated hierarchy constructed by propagating correct values for parameters and
generics. The software continuously analyzes the source files and updates the content. The Design Hierarchy tab
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(see figure below) displays the structure of the modules and components as they relate to each other along with
parameter/generic names and its values on the tool tip for which the module is instantiated. It also displays

architecture name for a given entity and Configuration for VHDL modules.

Design Hierarchy &

Build Hierarchy Show: |Components ¥ I%;
= il work -

-2 PCle_EP_Demo
AXIA Interconnect (COREAXIMNTERCOMNMNECT v2.5.100)
= ] AxitoAPB
IP] AHBtoAPE (COREAHBTOAPB3_v3.1.100)
IP] AXltoAHBL (COREAXITOAHEL v3.3.102)
IP] Core_AHBL (CoreAHBLite v5.3.101)
IP] Core_APE (CoreAPB3_v4.1.100)
CCC_111MHz (PF_CCC_v1.0.115)
=] CoreDMA_IO_CTRL
IP] CorefXl4 Lite (COREAXIAINTERCONMNECT v2.5.100)
IP] CoreDM&A_Controller (COREAXIADMACONTROLLER v2.0.100)
- UART_SD
Core_UART (COREUART v5.6.102)
F'=}[ cmd_ctrlr (CMD_CTRLR.w) [work]
+ ; pattern_gen_checker (PATTERMN_GEM_CHECKER.v) [work]
@u axiddma_init (AXIADMA_INIT v} [work]
@y axi_io_ctrl (AXI_1O_CTRL.v) [work]
=3 pCle_EP
= PCle EP_PCle REF_CLK 0 _PF XCVWR_REF_CLK (PCle EP_PCle REF CLK 0_PF XCVE_REF_CLK.w) [...
- |55l PCle_EP_PClexd_0_PF_PCIE (PCle_EP_PClexd 0_PF_PCIEw) [work]
E'=§|_ G5_APBLINK_MASTER (g5_apblink_master.v) [work]
PCle TL_CLK
UP] PCle TX_PLL (PF_T¥_PLL v1.0.115)
+ E'=f[ sw_debounce (SW_Debouncew) [work]
I&] PF_DDR3_SS (PF_DDR3.v2.3.120)
IE] PF_DDR4_SS (PF_DDR4_v2.3.120)
[IP] PF_RESET (CORERESET_PF v2.1.100)
[IE] SRAM_AXI (PF_SRAM_AHBL_AX_v1.1.129)
@ COREAXIADMACOMNTROLLER_LIB
fifil COREAHBLITE_LIB ﬂ

e

=

.
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Figure 130 - Design Hierarchy
A module can have multiple elaborations depending on the different parameters/generics used in the instantiation
of the module and all of these elaborated modules will be shown in the Design Hierarchy. The parameterized
instantiated module will be shown as
elab<num>:<modulename>

Modules are instantiated with their actual names in the SmartDesign. If a module with elaborated name in the
Design Hierarchy has to be instantiated in the SmartDesign, an instance of the original module is created in the
SmartDesign. The following figure shows the design hierarchy with elaborated modules.
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¥ [3 top_module (top_module .v) [work]

- %‘ counter_shifter (counter_shifter.v) [work]
async_load (async_load.v) [work]
counter_down (counter_down.v) [work]
counter_up (counter_up.v) [weork]
shift_leftt (shift_lsft.v) [work]
shift_rightt (shift_right.v) [work]
ab0:icounter_shifter (counter_shifter.v) [work]
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= async_load (async_load.v) [work]
counter_down (counter_down.w) [work]
counter_up (counter_up.v) [work]
=] shift_left (shift_left.v) [work]
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Figure 131 - Design Hierarchy with Elaborated modules(Verilog)
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Figure 132 - Design Hierarchy with Elaborated modules(VHDL)
Modules which are not part of the elaboration will be shown in the complete hierarchy but they remain grayed out.
When you create a core from a module, all the elaborated modules of that module will be shown as HDL+ core
modules. You can get the parameter value of an elaborated module by selecting Show Module parameters on
the right click menu of the elaborated module.
Note: A tool tip on each module shows all the parameters with their values for the instantiated module.
Note: Synthesis output will be the same for different elaborations of the same module i.e. elab0:module1 and
elab1:module1 will have the same synthesis output. When one of the elaborated module is set as root, all the
elaborations will be highlighted in the Design Hierarchy as shown in the below figure.
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Figure 133 - Design Hierarchy when one of the elaborated module is set as root

You can change the display mode of the Design Hierarchy by selecting Components or Modules from the Show
drop-down list. The components view displays the entire design hierarchy; the modules view displays only
schematic and HDL modules.

You can build the Design Hierarchy and Simulation Hierarchy by clicking the Build Hierarchy button.

) ~"a Build Hierarchy |
A yellow icon l'indicates that the Design Hierarchy is out of date (invalidated). Any change to

the design sources/stimuli invalidates the Design Hierarchy/Stimulus Hierarchy. Click the Build Hierarchy button
to rebuild the Design Hierarchy.

The file name (the file that defines the block) appears next to the block name in parentheses.

To view the location of a component, right-click and choose Properties. The Properties dialog box displays the
path name, created date, and last modified date.

All integrated source editors are linked with the SoC software. If a source is modified and the modification
changes the hierarchy of the design, the Build Hierarchy automatically updates to reflect the change.

If you want to update the Design Hierarchy, from the View menu, choose Refresh Design Hierarchy.
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To open a component:

Double-click a component in the Design Hierarchy to open it. Depending on the block type and design state,
several possible options are available from the right-click menu. You can instantiate a component from the Design
Hierarchy to the SmartDesign Canvas. See the SmartDesign User Guide for more information.

Icons in the Hierarchy indicate the type of component and the state, as shown in the table below.
Table 5 - Design Hierarchy Icons

Icon Description
5o} SmartDesign component
('3 80| SmartDesign component with HDL netlist not generated
IP core was instantiated into SmartDesign but the HDL netlist has not

been generated

E Core

w Error during core validation
[3 Updated core available for download
B HDL netlist

Digest File

Users can verify which bitstream file was programmed onto their devices by running the VERIFY or
VERIFY_DIGEST actions on each device that was programmed. This is a costly and time-consuming process. To
speed up the verification process, digests are printed during bitstream generation and bitstream programming.
These digests can be compared to verify that all of the devices were programmed with the correct bitstream file.

The bitstream file is divided into three major component sections: FPGA fabric, eNVM, and Security. A valid
bitstream will contain a combination of any of the three primary bitstream components.

Use Case

When a customer creates a design in Libero and then exports the STAPL file (for FlashPro) or programming job
(for FlashPro Express), the digest of each of the primary components is printed in the Libero log window and
saved in a digest file under the export folder. The digest file is a text file containing the bitstream component name
with its corresponding digest. The name of the digest file will match the name of the STAPL/programming job
exported, and will be appended with a “.digest” extension.

The customer then sends the STAPL/programming job to a production programming house. Now, when the
devices are programmed, the digest of each of the primary components is printed in the log window. The
production programming house saves the log files and sends the devices along with log files back to the
customer. The customer can then verify that the correct design was programmed on the device by matching the
digests in the log file with that in the *.digest file under the Libero export folder.

Example Using STAPL File

If a STAPL file is exported, the digests will be printed in the log window, as shown in the example below.
Libero log:

Opened 'D:/flashpro_files/m2s005_digestl/designer/al_MSS/al_MSS_fp/al MSS.pro'

The 'open project' command succeeded.

PDB file
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'D:\flashpro files\m2s005_digestl\designer\al MSS\4a8552f8-57ee-4baa-97ee-
2baab7ee2baa.pdb' has

been loaded successfully.

DESIGN : al MSS; CHECKSUM : DE15; PDB_VERSION : 1.9
The 'load programming data' command succeeded.
Sucessfully exported STAPL file:

'D:\flashpro files\m2s005 digestl\designer\al MSS\export\al MSS.stp'; file programs
Fabric

and eNVM.

Fabric component digest:

276fbefb0al8cc0deld45e£c84589745ee02fc2adbccl259fbeb674094754014

eNVM component digest:

6b2c2353e25¢5982643¢c32640acl6c581874c8950300135622¢c126ee22d8blde

Finished: Thu Jan 22 12:37:32 2015 (Elapsed time 00:00:06)

The 'export single stapl' command succeeded.

The 'set programming file' command succeeded.

Project saved.

The 'save project' command succeeded.

Project closed.
The export folder will contain the exported STAPL file along with digest file. In this example, there will be two files,
“a1_MSS.stp” and “a1_MSS_stp.digest”. The content of the a1_MSS_stp.digest file is shown below:

Fabric component digest: 276fbefb0al8cc0deld45efc84589745ee02fc2adbccl259fbeb674094754014

eNVM component digest: 6b2c2353e25c5982643c32640acl6c581874c8950300135622¢cl26ee22d8blde
When the device is programmed in the production programming house by loading the STAPL file in FlashPro, the
log will be as follows:

programmer '73207' : Scan Chain...

Warning: programmer '73207' : Vpump has been selected on programmer AND an externally
provided Vpump has also been detected. Using externally provided Vpump voltage source.

programmer '73207' : Check Chain...

programmer '73207' : Scan and Check Chain PASSED.

programmer '73207' : device 'M2S/M2GL005(S)' : Executing action PROGRAM

programmer '73207' : device 'M2S/M2GL005(S)' : Family: SmartFusion2

programmer '73207' : device 'M2S/M2GLO005(S)' : Product: M2S005

programmer '73207' : device 'M2S/M2GLO005(S)' : EXPORT ISC_ENABLE_RESULT[32] = 007c6b44
programmer '73207' : device 'M2S/M2GL005(S)' : EXPORT CRCERR: [1] = 0

programmer '73207' : device 'M2S/M2GLO0O05(S)' : EXPORT EDCERR: [1] = 0

programmer '73207' : device 'M2S/M2GL005(S)' : TEMPGRADE: ROOM

programmer '73207' : device 'M2S/M2GLO0O05(S)"' : EXPORT VPPRANGE: [3] = 2

programmer '73207' : device 'M2S/M2GLO005(S)' : VPPRANGE: HIGH

programmer '73207' : device 'M2S/M2GL005(S)' : EXPORT TEMP: [8] = 6b

programmer '73207' : device 'M2S/M2GL005(S)' : EXPORT VPP: [8] = 7c

programmer '73207' : device 'M2S/M2GL005(S)' : Programming FPGA Array and eNVM...
programmer '73207' : device 'M2S/M2GLO0O05(S)"' : EXPORT Fabric component digest[256] =
276fbefb0a18cc0deld456fc84589745eeO2fc2adbcc1259fbeb674094754014

programmer '73207' : device 'M2S/M2GL005(S)' : EXPORT eNVM component digest[256] =
62c2353e25¢5982643¢32640acl16c581874c8950300135622c1l26ee22d8blde

programmer '73207' : device 'M2S/M2GL005(S)"'

programmer '73207' : device 'M2S/M2GLO0O05(S)' : EXPORT DSN[128] =
c6e99c2d1a992£f13cf8231c4be847ach

programmer '73207' : device 'M2S/M2GL005(S)"'

programmer '73207' : device 'M2S/M2GLO0O05(S)"' : Finished: Thu Jan 22 17:57:37 2015

(Elapsed time 00:00:19)

207



& Microsemi

a A3\ MicrRocHIP company

PolarFire FPGA Design Flow User Guide

programmer '73207' : device 'M2S/M2GLO005(S)' : Executing action PROGRAM PASSED.
programmer '73207' : Chain programming PASSED.
Chain Programming Finished: Thu Jan 22 17:57:37 2015 (Elapsed time 00:00:19)
o -0 -0 -0 -0 - o0
The log file is saved and sent back to the customer, who can verify that the device was programmed with the
correct design by comparing the digests in the log file to the contents of the a1_MSS_stp.digest file.

Example Using Programming Job

If a programming job is exported, the digests will be printed in the log window, as shown in the example below.
Libero log:

Software Version: 11.5.1.5

Opened 'D:/flashpro_files/m2s005 digestl/designer/al_MSS/al_MSS_ fp/al MSS.pro'
The 'open project' command succeeded.

PDB file

'D:\flashpro files\m2s005 digestl\designer\al MSS\83ce6816-1e56-496b-9e56-
d96ble56d96b.pdb' has

been loaded successfully.

DESIGN : al MSS; CHECKSUM : DE15; PDB_VERSION : 1.9
The 'load programming data' command succeeded.
Sucessfully exported STAPL file:

'D:\flashpro files\m2s005 digestl\designer\al MSS\exportlal MSS M2S005.stp'; file
programs

Fabric and eNVM.

Fabric component digest:

276fbefb0al8cc0deld45e£c84589745ee02fc2adbccl259fbeb674094754014

eNVM component digest:

602c2353e25¢c5982643c32640acl6c581874¢c8950300135622¢c126ee22d8blde

Finished: Wed Jan 28 16:48:56 2015 (Elapsed time 00:00:06)

The 'export single stapl' command succeeded.

The 'set programming file' command succeeded.

Project saved.

The 'save project' command succeeded.

Project closed.
The export folder will contain the exported programming job along with digest file. In this example, there will be
two files, “a1_MSS.job” and “a1_MSS_job.digest” . The content of the a1_MSS_job.digest file is shown below:

Fabric component digest: 276fbefb0al8cc0deld45efc84589745ee02fc2adbccl259fbeb674094754014

eNVM component digest: 6b2c2353e25c5982643¢c32640acl6c581874c8950300135622¢cl126ee22d8blde
When the device is programmed in the production programming house by loading the programming job in
FlashPro Express, the log will be as follows:

programmer '73207' : Scan Chain...

Warning: programmer '73207' : Vpump has been selected on programmer AND an externally
provided Vpump has also been detected. Using externally provided Vpump voltage source.
programmer '73207' : Check Chain...

programmer '73207' : Scan and Check Chain PASSED.

programmer '73207' : device 'M2S/M2GL005(S)' : Executing action PROGRAM

programmer '73207' : device 'M2S/M2GL005(S)' : Family: SmartFusion2

programmer '73207' : device 'M2S/M2GLO005(S)' : Product: M2S5005

programmer '73207' : device 'M2S/M2GLO005(S)' : EXPORT ISC _ENABLE RESULT[32] = 007c6b44
programmer '73207' : device 'M2S/M2GLO005(S)"' : EXPORT CRCERR: [1] = 0

programmer '73207' : device 'M2S/M2GL005(S)' : EXPORT EDCERR: [1] = 0

programmer '73207' : device 'M2S/M2GLO005(S)' : TEMPGRADE: ROOM
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programmer '73207' : device 'M2S/M2GLO0O05(S)"' : EXPORT VPPRANGE: [3] = 2

programmer '73207' : device 'M2S/M2GLO05(S)' : VPPRANGE: HIGH

programmer '73207' : device 'M2S/M2GL005(S)' : EXPORT TEMP: [8] = 6b

programmer '73207' : device 'M2S/M2GL005(S)' : EXPORT VPP: [8] = 7c

programmer '73207' : device 'M2S/M2GL005(S)' : Programming FPGA Array and eNVM...
programmer '73207' : device 'M2S/M2GL005(S)' : EXPORT Fabric component digest[256] =
276fbefb0al8ccO0deld45e£fc84589745ee02fc2adbccl259fbeb674094754014

programmer '73207' : device 'M2S/M2GL005(S)' : EXPORT eNVM component digest[256] =
62c2353e25¢5982643¢32640acl16c581874c8950300135622c1l26ee22d8blde

programmer '73207' : device 'M2S/M2GL005(S)"'

programmer '73207' : device 'M2S/M2GLO005(S)' : EXPORT DSN[128] =
c6e99c2d1a992£f13cf8231c4be847ach

programmer '73207' : device 'M2S/M2GL005(S)"'

programmer '73207' : device 'M2S/M2GLO0O05(S)"' : Finished: Thu Jan 22 17:57:37 2015
(Elapsed time 00:00:19)

programmer '73207' : device 'M2S/M2GLO005(S)' : Executing action PROGRAM PASSED.
programmer '73207' : Chain programming PASSED.

Chain Programming Finished: Thu Jan 22 17:57:37 2015 (Elapsed time 00:00:19)
0O-0-0-0=-0=-20

The log file is saved and sent back to the customer, who can verify that the device was programmed with the
correct design by comparing the digests in the log file above to the contents of the a1_MSS_job.digest file.

See Also
Export Bitstream

Design Rules Check

The Design Rules Check runs automatically when you generate your SmartDesign; the results appear in the
5l FEPOILS Mo A ]

 ——
® OO |k
Reports tab. You can also initiate a Design Rules Check by clicking on the e .'*-'.‘ button

of the SmartDesign Canvas tab menu.
To view the results, from the Design menu, choose Reports.
e Status displays an icon to indicate if the message is an error or a warning (as shown in the figure below).
Error messages are shown with a small red sign and warning messages with a yellow exclamation point.

o Message identifies the specific error/warning (see list below); click any message to see where it appears on
the Canvas

e Details provides information related to the Message
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Reports & X | StartPage & X | X & X ‘
4 Project Summary
polarfire_countl6.log DRC Report: xxx
4 o reports
4 o0x Status Message Details
soa_DRCxml & Floating Driver Floating output bus pin COREABC_0:I0_0OUT[0]
4 d3 @  Required Pin Connection Unconnected input pin COREABC_0:NSYSRESET
d3_manifestixt R R . .
4 43 DDRPHY BLK ©  Required Pin Connection Unconnected input pin COREABC_0:PCLK
"43 DDRPHY BLK .. A Floating Driver Floating output pin COREABC_0:PRESETN
A Unconnected Bus Unconnected bus interface pin COREABC_0:APB3master
Interface
@  Undriven Pin Unconnected input pin CoreAXI4Interconnect_0:ACLK
@  Undriven Pin Unconnected input pin CoreAXI4Interconnect_(0:ARESETN
A mﬂ Unconnected bus interface pin CoreAXI4Interconnect_0:AXI4mslave0
A mﬂ Unconnected bus interface pin CoreAXI4Interconnect_0:AXI4mslavel
iy mﬂ Unconnected bus interface pin CoreAXI4Interconnect_0:AXI4mslave2
& mﬂ Unconnected bus interface pin CoreAXI4Interconnect_0:AXI4mslave3
& Unconnected Bus Hnrnnne crad hue inbarfara nin Cara AVTATAtarcann A AVTArclad

Figure 134 - Design Rules Check Results

Message Types:

Unused Instance - You must remove this instance or connect at least one output pin to the rest of the design.

Out-of-date Instance - You must update the instance to reflect a change in the component referenced by this
instance.

Undriven Pin - To correct the error you must connect the pin to a driver or change the state, i.e. tie low (GND) or
tie high (VCC).

Floating Driver - You can mark the pin unused if it is not going to be used in the current design. Pins marked
unused are ignored by the Design Rules Check.

Unconnected Bus Interface - You must connect this bus interface to a compatible port because it is required
connection.

Required Bus Interface Connection — You must connect this bus interface before you can generate the design.
These are typically silicon connection rules.

Exceeded Allowable Instances for Core — Some IP cores can only be instantiated a certain number of times for
legal design because of silicon limitations. You must remove the extra instances.

Incompatible Family Configuration — The instance is not configured to work with this project’s Family setting.
Either it is not supported by this family or you need to re-instantiate the core.

Incompatible Die Configuration — The instance is not configured to work with this project's Die setting. Either it
is not supported or you need to reconfigure the Die configuration.

No RTL License, No Obfuscated License, No Evaluation License — You do not have the proper license to
generate this core. Contact Microsemi SoC to obtain the necessary license.

No Top level Ports - There are no ports on the top level. To auto-connect top-level ports, right-click the Canvas
and choose Auto-connect

Self-Instantiation - A component cannot instantiate itself-This is reported only in the Log/Message Window.
Editable Constraints Grid

The Constraints Editor enables you to add, edit and delete.
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ConstraintsEditor - [Canstraints Editor] — O =
File Constraints Tools Edit Help - 8 %
B &I o fn B Ve B B B @ oW

Constraints Editor

= Constraints A .
4 Period | Frequency | Dutycycle | First | Offset
= Requirements | Syntax Clock Hame Clock Source (ns) (MHz) (%) Edge (ns) Waveform

{Clock
Generated Clock
Input Delay
Output Delay
External Check
Clock To Qut

= Exceptions
Max Delay
Min Delay
Multicycle
False Path

= Advanced
Disable Timing
Clock Source Late...
Clock Uncertainity v < >

1 |Click within this row to add a constraint

Figure 135 - Constraints Editor
To add a new constraint:

1. Select a constraint type from the constraint browser.

2. Enter the constraint values in the first row and click the green check mark to apply your changes. To cancel
the changes press the red cancel mark.

3. The new constraint is added to the Constraint List. The green syntax flag indicates that the constraint was
successfully checked.

To edit a constraint:

1. Select a constraint type from the constraint browser.

2. Select the constraint, edit the values and click the green check mark to apply your changes. To cancel the
changes press the red cancel mark. The green syntax flag indicates that the constraint was successfully
checked.

To delete a constraint:

1. Select a constraint type from the constraint browser.
2. Right-click the constraint you want to delete and choose Delete Constraint.

export_spiflash_image

This Tcl command exports a SPI Flash image file to a specified directory.

export spiflash image -file name {name of file} -export dir {absolute path to folder location}

Arguments
-file name name of file
The name of the image file.
-export_dir absolute path to folder location

Folder/directory location.
See Also

Export Flash Image
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extended run_lib

Note: This is not a Tcl command; it is a shell script that can be run from the command line.

The extended_run_lib Tcl script enables you to run the multiple pass layout in batch mode from a
command line.

$ACTEL SW DIR/bin/libero script:S$ACTEL SW DIR/scripts/extended run lib.tcl
logfile:extended run.log “script args:-root path/designer/module name [-n numPasses] [-—
starting seed index numIndex] [-compare criteria value] [-c clockName] [-analysis value] [-
slack criteria value] [-stop on success] [-timing driven|-standard] [-power driven value]
[-placer high effort valuel]”

Note:

e There is no option to save the design files from all the passes. Only the (Timing or Power) result reports
from all the passes are saved.

Arguments
-root path/designer/module name
The path to the root module located under the designer directory of the Libero project.
[-n numPasses]
Sets the number of passes to run. The default number of passes is 5.
[-starting seed index numIndex]

Indicates the specific index into the array of random seeds which is to be the starting point for the passes.
Value may range from 1 to 100. If not specified, the default behavior is to continue from the last seed
index that was used.

[-compare criteria value]

Sets the criteria for comparing results between passes. The default value is set to frequency when the —c
option is given or timing constraints are absent. Otherwise, the default value is set to violations.

Value Description

frequency Use clock frequency as criteria for comparing the results between passes. This
option can be used in conjunction with the -c option (described below).

violations Use timing violations as criteria for comparing the results between passes. This
option can be used in conjunction with the -analysis, -slack_criteria and -
stop_on_success options (described below).

power Use total power as criteria for comparing the results between passes, where lowest
total power is the goal.

[-c clockName]

Applies only when the clock frequency comparison criteria is used. Specifies the particular clock that is to
be examined. If no clock is specified, then the slowest clock frequency in the design in a given pass is
used. The clock name should match with one of the Clock Domains in the Summary section of the Timing
report.

[-analysis valuel

Applies only when the timing violations comparison criteria is used. Specifies the type of timing violations
(the slack) to examine. The following table shows the acceptable values for this argument:

Value Description

max Examines timing violations (slack) obtained from maximum delay analysis. This is
the default.
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Value Description
min Examines timing violations (slack) obtained from minimum delay analysis.
[-slack _criteria value]
Applies only when the timing violations comparison criteria is used. Specifies how to evaluate the timing
violations (slack). The type of timing violations (slack) is determined by the -analysis option. The following
table shows the acceptable values for this argument:
Value Description
worst Sets the timing violations criteria to Worst slack. For each pass obtains the most
amount of negative slack (or least amount of positive slack if all constraints are met)
from the timing violations report. The largest value out of all passes will determine
the best pass. This is the default.
tns Sets the timing violations criteria to Total Negative Slack (tns). For each pass it
obtains the sum of negative slack values from the first 100 paths from the timing
violations report. The largest value out of all passes determines the best pass. If no
negative slacks exist for a pass, then the worst slack is used to evaluate that pass.
[-stop_on_success]
Applies only when the timing violations comparison criteria is used. The type of timing violations (slack) is
determined by the -analysis option. Stops running the remaining passes if all timing constraints have been
met (when there are no negative slacks reported in the timing violations report).
[-timing driven|-standard]
Sets layout mode to timing driven or standard (non-timing driven). The default is -timing_driven or the
mode used in the previous layout command.
[-power_driven value]
Enables or disables power-driven layout. The default is off or the mode used in the previous layout
command. The following table shows the acceptable values for this argument:
Value Description
off Does not run power-driven layout.
on Enables power-driven layout.
[-placer_high effort value]
Sets placer effort level. The default is off or the mode used in the previous layout command. The following
table shows the acceptable values for this argument:
Value Description
off Runs layout in regular effort.
on Activates high effort layout mode.
Return
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Exceptions
None

See Also
Place and Route - PolarFire

Multiple Pass Layout - PolarFire

Files Tab and File Types

The Files tab displays all the files associated with your project, listed in the directories in which they appear.

Right-clicking a file in the Files tab provides a menu of available options specific to the file type. You can delete
files from the project and the disk by selecting Delete from the right-click menu.

You can instantiate a component by dragging the component to a SmartDesign Canvas or by selecting
Instantiate in SmartDesign from the right-click menu. See the SmartDesign User Guide for more details.

You can configure a component by double-clicking the component or by selecting Open Component from the
right-click menu.

File Types

When you create a new project in the Libero SoC it automatically creates new directories and project files. Your
project directory contains all of your 'local' project files. If you import files from outside your current project,
the files must be copied into your local project folder. (The Project Manager enables you to manage your
files as you import them.)

Depending on your project preferences and the version of Libero SoC you installed, the software creates
directories for your project.

The top level directory (<project_name>) contains your PRJ file; only one PRJ file is enabled for each Libero SoC
project.

component directory - Stores your SmartDesign components (SDB and CXF files) for your Libero SoC project.
constraint directory - All your constraint files (SDC, PDC)

designer directory - *_ba.sdf, *_ba.v(hd), STP, TCL (used to run designer), designer.log (logfile)

hdl directory - all hdl sources. *.vhd if VHDL, *.vand *.h if Verilog, *.sv if SystemVerilog

simulation directory - meminit.dat, modelsim.ini files

smartgen directory - GEN files and LOG files from generated cores

stimulus directory - BTIM and VHD stimulus files

synthesis directory - *.edn, *_syn.prj (Synplify log file), *.srr (Synplify lodfile), *.tcl (used to run synthesis) and
many other files generated by the tools (not managed by Libero SoC)

tooldata directory - includes the log file for your project with device details.

generate design_initialization_data

This Tcl command creates the memory files on disk, adds the initialization clients to the target memories, and
writes the configuration files to disk.

This command also runs validation on the saved configuration files and writes out errors (if any) in the log. This
command causes the Ul of the Configure Design Initialization Data and Memories tool to refresh and show the
latest configuration and validation errors (if any) in the tables.

This command takes no parameters.

generate design initialization data
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See Also

confiqure design initialization data

Importing Files

Anything that describes your design, or is needed to program the device, is a project source. These may include
schematics, HDL files, simulation files, testbenches, etc. Import these source files.

To import a file:
1. From the File menu, choose Import Files.
2. InFiles of type, choose the file type.
3. InLook in, navigate to the drive/folder where the file is located.
4. Select the file to import and click Open.
Note: You cannot import a Verilog File into a VHDL project and vice versa.
File Types for Import
File Type File Extension
Behavioral and Structural VHDL; VHDL Package *.vhd, *.vhdl
Design Block Core *.gen
Verilog Include *.h
Behavioral and Structural Verilog *V, *.sv
Netlist Verilog *.vm
Stimulus *.vhd, * .vhdI,
*V, *.sv
Memory file *.mem
Components (Designer Blocks, Synplify DSP) *.oxf

Bus Interfaces

When you add a bus interface the Edit Core Definition dialog box provides the following Microsemi SoC-specific
bus interfaces:

e AHB — Master, Slave, Mirrored Master, MirroredSlave

e APB — Master, Slave, Mirroredmaster, MirroredSlave

o AXI - Master, Slave, MirroredMaster, MirrorSlave, System
e AXl 4 - Master, Slave, MirroredMaster, MirrorSlave

Layout Error Message: layoutg4NoValidPlacement

This is a generic error produced by the placer when it is unable to place a design. The most common cause for
this failure is that the placer was unable to find a solution which could fit the design into the chip, either because
the design is close to maximum utilization, or logic cannot be fit into user-defined region constraints.

If Libero is unable to find a legal placement, a list of unplaced cells will be provided in the log. The cells in this list
may not be the cause of the placement problem; it is quite possible that some other constrained block of logic

215



& Microsemi

a A3\ MicrRocHIP company

PolarFire FPGA Design Flow User Guide

which was placed first and now prohibits further placement. However, starting with the unplaced cell list is the
easiest and most likely course:

e The simplest potential solution is to remove all placement constraints of the unplaced cells, and re-run Place
& Route.

However, the cells in this list may not be the cause of the placement problem; it is quite possible that some other
constrained block of logic which was placed first and now prohibits further placement. If removing the placement
constraints on the unplaced cells does not succeed:

¢ Remove all region constraints and re-run Place & Route. Some designers make it a practice to put all their
region constraints in a single, separate PDC file; in which case they need only disable that file.

o If this Place & Route re-run still fails, there may be wider issues with the design's size and
complexity that cannot be addressed by changes to P&R options.

e [f the unconstrained Place & Route re-run succeeds, then the user should add back constraints a
few regions at a time in order of "simplicity". Usually, big regions with lots of free space are
"simpler" for the placer, whereas tall/narrow regions with high utilization are "harder". Re-run Place
& Route with each constraint restoration and repeat the process until the failing region(s) is
identified.

Depending on requirements, the failing region may be handled by removing or changing it's
constraints, or revising its design to use less resources.

The user may also re-run the Placer in high-effort mode. Applying high-effort mode to a design which is very full
can incur additional runtime and may produce a placement solution which may not meet tight timing constraints,
owing to the fact that the placer will aggressively attempt to fit the design. In practice, customers are encouraged
to apply the previous suggestions first; and utilize high-effort mode only when other approaches have been
exhausted.

Layout Error Message: layoutg4DesignHard

This design is very difficult to place, and high-effort techniques were required to make it fit. This may lead to
increased layout runtime and diminished timing performance.

This message typically appears in designs with high utilization -- a very full design, or a design with region
constraints which are, themselves, very full. It can also occur in designs with moderate utilization but with
numerous, long carry chains.

No immediate action is required on the user's part. However, if this notice is observed during Layout, the resultant
performance of the design and the runtime of the Layout tools may not be optimal, and there is a strong possibility
that reducing the size of the design, or relaxing region and floorplanning constraints, will help to improve timing
closure and runtime.

list_clock groups

This Tcl command lists all existing clock groups in the design.

list clock groups

Arguments
None

Example
list_clock _groups
See Also

set clock groups
remove clock groups
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Specifying I/O States During Programming - I/O States and BSR Details

The /O States During Programming dialog box enables you to set custom 1/O states prior to programming.

I/0 State (Output Only)
Sets your I/O states during programming to one of the values shown in the list below.
e 1—1/Os are set to drive out logic High
e 0-—1/Os are set to drive out logic Low

o Last Known State: I/Os are set to the last value that was driven out prior to entering the programming mode,
and then held at that value during programming

e Z - Tri-State: I/Os are tristated

When you set your I/O state, the Boundary Scan Register cells are set according to the table below. Use the
Show BSR Details option to set custom states for each cell.

Table 6 - Default I/O Output Settings

Output State Settings
Input Control Output
(Output Enable)
Z (Tri-State) 1 0 0
0 (Low) 1 1 0
1 (High) 0 1 1
Last_Known_State |Last Known_State |Last Known_State |Last Known_State

Table Key:
e 1 —High: I/Os are set to drive out logic High
e 0 - Low: I/Os are set to drive out logic Low

e Last Known_State - I/Os are set to the last value that was driven out prior to entering the programming
mode, and then held at that value during programming

Boundary Scan Registers - Enabled with Show BSR Details

Sets your I/O state to a specific output value during programming AND enables you to customize the values for
the Boundary Scan Register (Input, Output Enable, and Output). You can change any Don't Care value in
Boundary Scan Register States without changing the Output State of the pin (as shown in the table below).

For example, if you want to Tri-State a pin during programming, set Output Enable to 0; the Don't Care indicates
that the other two values are immaterial.

If you want a pin to drive a logic High and have a logic 1 stored in the Input Boundary scan cell during
programming, you may set all the values to 1.

Table 7 - BSR Details I/O Output Settings

Output State Settings
Input Output Enable Output
Z (Tri-State) Don't Care 0 Don't Care
0 (Low) Don't Care 1 0
1 (High) Don't Care 1 1
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Output State Settings
Input Output Enable Output
Last Known State Last State Last State Last State

Table Key:

1 — High: I/Os are set to drive out logic High

0 — Low: I/Os are set to drive out logic Low

Don't Care — Don’t Care values have no impact on the other settings.

Last_Known_State — Sampled value: I/Os are set to the last value that was driven out prior to entering the
programming mode, and then held at that value during programming

The figure below shows an example of Boundary Scan Register settings.

Specify I/0 States During Programming

Load from File. .. | Save ko file... | ¥ show BSR Details
_ Boundary Scan Registers -
Port HName Macro Cell Pin Number Input %l:.lapl;‘::g Dutput
BIST ADLIB:INBUF T2 a 1 1
BYPASS_IO ADLIB:IMBUF K1 1] 1 1
CLE. ADLIB:INBUF B1 a 1 1
ENOUT ADLIB:INBUF J16 a 1 1
LED ADLIB:OUTBUF M3 1 1 a
MOMITOR[O] ADLIB:OUTBUF ES 1 1 a
MOMNITOR[1] ADLIB:OUTBUF c7 1 a a
MOMNITOR[2] ADLIB:OUTBUF k] 1 a a
MOMITOR[3] ADLIB:OUTBUF D7 1 a a
MOMNITOR[4] ADLIB:OUTBUF A1 1 a a
OEa ADLIB:INBUF E4 1 a a
OEb ADLIB:INBUF F1 1 a a
O5C_EN ADLIB:INBUF K3 1 a a
PAD[10] ADLIB:BIBUF_LYCMOS33U ME 1 a a
PAD[11] ADLIB:BIBUF_LYCMOS33D R? 1 a a
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 1 a a
PAD[13] ADLIB:BIBUF_LYCMOS33D c12 1 a a
PAD[14] ADLIB:BIBUF_LYCMOS33U RE 1 a a LI
Help | OF I Cancel |

Save Project As Dialog Box

The Save Project As dialog box enables you to save your entire project with a new name and location.

Figure 136 - Boundary Scan Registers

To access this dialog box, choose Save Project As from the Project menu.

218



& Microsemi

PolarFire FPGA Design Flow User Guide :
a A3\ MicrRocHIP company

@ Saves [T I=)
Project name:

Project location:

|!!{:‘n,lﬂ_dcncs_re'-.-'iewH,ll.D_ReIease‘n,g4_exp |

Content
] Copy links locally

Files: All -

Help Ok Cancel

Figure 137 - Save Project As Dialog Box
Project Name
Type the project name for your modified project.
Project Location

Accept the default location or Browse to the new location where you can save and store your project. All files for
your project are saved in this directory.

Content

Copy links locally - Select this checkbox to copy the links from your current project into your new project. If you
do not select this checkbox, the links will not be copied and you must add them manually.

Files
e All - Includes all your project and source files; the state of the project is retained.

e Project files only - Copies only the project-related information required to retain the state of the project.

e Source files only - Copies all the source files into the specified location. This means the configuration of all
the tools in the tool chain is retained but the states are not. Source files means constraint information and
component information available in the component, hdl and smartgen directories.

Files are saved as shown in the table below.

Folder Name Files
All Project Source

component All All Files All Files
Files

constraint All All Files All Files
Files

hdl All All Files All Files
Files
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Folder Name Files
All Project Source

stimulus All All Files All Files
Files

smartgen All All Files All Files
Files

firmware All All Files All Files
Files

CoreConsole All All Files All Files
Files

SoftConsole/Keil/IAR [ All All Files All Files
Files

Phy_Synthesis All All Files Not Copied
Files

simulation All *.ini, *.bfm, *.do., *.vec *.ini, *.bfm,
Files *.do., *.vec

synthesis All *.edn, *.vm, *.sdc, *.so, *.prj, *.srr, *.prj files
Files | *.v, run_options.txt, synplify.log

Designer/impl1 All All Files *.ide_des
Files files

Designer/<root> All All Files Not Copied
Files

tooldata All All Files All Files
Files

Note: *.edn files are not supported in PolarFire.
Project Settings Dialog Box
The Project Settings dialog box enables you to modify your Device, HDL, and Design Flow settings and your

Simulation Options. In Libero SoC, from the Project menu, click Project Settings.
The following figure shows an example of the Project Settings dialog box.
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- o Project settings
Currently selected device i MPF200TS_ES.1FULLPKGE
Stions Part filter
Family | PolarFire s Die: | All % | Package Al =
Speed: A = Range: Al s
Reset filters
Search part

Part Number v | DFF User 10 uSHAM LSRAM Math H-Chip Globals  PLL oLL (=
ILLPKGE | 192408 368 1764 616 1] A8 [] [}
MPFI0OT_ES-1FCGI152E | 299544 512 2772 952 524 48 8 []
MPFI00T ES-1FCGABAE | 299544 242 2772 a52 924 48 8 8
MPFIDOT ES-1FCGTR4E | 299544 388 2772 a52 924 48 8 8
MPFI00T ES-1FCSGSIBE 299544 300 21712 952 924 48 8 8
299544 284 2772 a52 924 48 B 8
299544 512 2772 a52 924 48 8 ]
299544 242 2772 952 924 48 8 8
E 3 299544 ELT) 2772 952 924 48 8 8
MPEIDOT_ES-FCSGSIGE | 299544 300 2172 952 924 48 8 8
MPFI00T ES-FOVGABAE 299544 284 2772 952 924 48 8 []
MPF300TS_ES-1FCGI152E 299544 512 2772 a52 924 48 8 ]
MPFI0OTS ES-1FCGAB4E 299544 242 2772 952 924 48 8 ]
MPFI00TS_ES-1FCSG536E 299544 300 7 952 924 48 8 8

MPFI0OTS_ES-FCGLIS2E | 209544 512 2772 952 524 4B 8 (I

‘ '

Help | Ciose

Figure 138 - Project Settings Dialog Box

Device Selection

Sets the device Die and Package for your project. See the New Project Creation Wizard - Device Selection page
for a detailed description of the options.

Device Settings
Default /0 Technology - Sets all your I/Os to a default value. You can change the values for individual I/Os in
the 1/O Attributes Editor.

System controller suspended mode - When enabled (usually for safety-critical applications), the System
Controller is held in a reset state after the completion of device initialization. This state protects the device from
unintended device programming or zeroization of the device due to SEUs (Single Event Upsets). In this mode, the
System Controller cannot provide any system services such as Flash*Freeze service, cryptographic services or
programming services.

Design Flow
See the Project Settings: Design flow topic for more information.

Analysis Operating Conditions

Sets the Operating Temperature Range, the Core Voltage Range, and Default I/O Voltage Range from the
picklist's provided. Typical values are COM/IND/MIL; but others are sometimes defined.

Only EXT and IND ranges are available for PolarFire at present.
Once the "Range" value is set, the Minimum/Typical/Maximum values for the selected range are displayed.

These settings are propagated to Verify Timing, Verify Power, and Backannotated Netlist for you to perform
Timing/Power Analysis.

Simulation Options and Simulation Libraries
Sets your simulation options. See the Project Settings: Simulation Options topic for more information.

Project Settings: Simulation - Options and Libraries

Using this dialog box, you can set change how Libero SoC handles Do files in simulation, import your own Do
files, set simulation run time, and change the DUT name used in your simulation. You can also change your
library mapping.

To access this dialog box, from the Project menu choose Project Settings and click to expand Simulation
options or Simulation libraries.

For Simulation options click the option you wish to edit: DO file, Waveforms, Vsim commands, Timescale.
For Simulation libraries click on the library you wish to change the path for.
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Generate VD fie
sim commands
Timescale VCD fie name:
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Smartfusion? User defined DO fle;
D0 command parameters:
hele St

Figure 139 - Project Settings: DO File

DO file

o Use automatic DO file - Select if you want the Project Manager to automatically create a DO file that will
enable you to simulate your design.

e Simulation Run Time - Specify how long the simulation should run. If the value is 0, or if the field is empty,
there will not be a run command included in the run.do file.

e Testbench module name - Specify the name of your testbench entity name. Default is “testbench,” the
value used by WaveFormer Pro.

e Top Level instance name - Default is <top_0>, the value used by WaveFormer Pro. The Project Manager
replaces <top> with the actual top level macro when you run simulation (presynth/postsynth/postlayout).

¢ Generate VCD file - Click the checkbox to generate a VCD file.

e VCD file name - Specifies the name of your generated VCD file. The default is power.vcd; click power.vcd
and type to change the name.

o User defined DO file - Enter the DO file name or click the browse button to navigate to it.
o DO command parameters - Text in this field is added to the DO command.

Waveforms
¢ Include DO file - Including a DO file enables you to customize the set of signal waveforms that will be
displayed in ModelSim.

o Display waveforms for - You can display signal waveforms for either the top-level testbench or for the
design under test. If you select top-level testbench then Project Manager outputs the line 'add wave
/testbench/*' in the DO file run.do. If you select DUT then Project Manager outputs the line 'add wave
/testbench/DUT/*' in the run.do file.

¢ Log all signals in the design - Saves and logs all signals during simulation.

Vsim Commands

e Resolution - The default is 1ps.Some custom simulation resolutions may not work with your simulation
library. Consult your simulation help for more information on how to work with your simulation library and
detect infinite zero-delay loops caused by high resolution values.

e Additional options - Text entered in this field is added to the vsim command.

¢ SRAM ECC Simulation -
Two options can be added to specify the simulated error and correction probabilities of all ECC
SRAMs in the design.

o -gERROR_PROBABILITY=<value>, where 0 <= value <= 1
e -gCORRECTION_PROBABILITY=<value>, where 0 <= value <= 1
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e During Simulation, the SB_CORRECT and DB_DETECT flags on each SRAM block will be
raised based on generated random numbers being below the specified <value>s.
Timescale

TimeUnit - Enter a value and select s, ms, us, ns, ps, or fs from the pull-down list, which is the time base for
each unit. The default setting is ns.

Precision - Enter a value and select s, ms, us, ns, ps, or fs from the pull-down list. The default setting is ps.

Simulation Libraries

Restore Defaults- Sets the library path to default from your Libero SoC installation.

Library path - Enables you to change the mapping for your simulation library (both Verilog and VHDL).
Type the pathname or click the Browse button to navigate to your library directory.

Project Settings: Design flow

To access the Design flow page, from the Project menu choose Project Settings and click the Design flow tab.

© o [@][=
Device selection
Device settings HOL source files language options e
Design flow
Analysis operating conditions Libero SaC supports mixed-HDL language designs; you can import Verilog and VHDL in the same project. Discard
= Simulation options Far Verilog files you can enable the System Verilog syntax option if your Verilog files contain System Verilog constructs.
DO file Far VHDL fies, you may choose between YHDL-2008 and VHDL-83.
Waveforms
Vsim commands Verlag
Timescal le & .
= Simulation libraries * System Verilog Verilog 2001
Polarfire
COREAXI4DMACONTROLLER_LIB VHDL
COREAHBLITE_LIB - -
COREAHBTOAPB3_LIB VHDL-2008 VHDL-93
COREAXITOAHBL LIB
COREAPEZ LIB FOL generated fles language aptions
HDL files generated by Libero SoC such as configured cores, SmartDesign components and postdayout gate level netists use the preferred language option.
& Veriog  VHDL
Black flow
I™" Enable block creation
Root PCle_EP_Demo
¥ Enable synthesis
[™ Enable FPGA Hardware Breakpoint Auto Instantiation
Reports
Maximum number of high fanout nets to be displayed: |10
[V Abort flow if errors are found in Physical Design Constraints (PDC)
[¥ Abort flow if errors are found in Timing Constraints (SDC)

Figure 140 - Project Settings Dialog Box — Design Flow Tab

HDL source files language options

Libero SoC supports mixed-HDL language designs. You can import Verilog and VHDL in the same project.

Sets your HDL to VHDL or Verilog. For VHDL, you can choose VHDL-2008 or VHDL-93. For Verilog, you can
choose System Verilog (if your Verilog files contain System Verilog constructs) or Verilog 2001.

Note: Libero SoC supports the following Verilog and VHDL IEEE standards for Modelsim and SynplifyPro:

Verilog 2005 (IEEE Standard 1364-2005)
Verilog 2001 (IEEE Standard 1364-2001)
Verilog 1995 (IEEE Standard 1364-1995)
SystemVerilog 2012 (IEEE Standard 1800-2012)
VHDL-2008 (IEEE Standard 1076-2008)
VHDL-93 (IEEE Standard 1076-1993)
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HDL generated files language options

HDL files generated by Libero SoC can be set to use VHDL or Verilog. If there are no other considerations, it is
generally recommended to use the same HDL language as you are using for HDL source files, as this may
reduce the cost of simulation licenses.

Block flow

Enable block creation - Enables you to create and publish design blocks (*.cxz files) in Libero SoC. Design
blocks are low-level components that may have completed the place-and-route step and met the timing and
power requirements. These low-level design blocks can then be imported into a Libero SoC project and re-used
as components in a higher level design. See Designing with Designer Block Components in Online Help for more
information.

Root <module_name>

Enable synthesis - Option to enable or disable synthesis for your root file; useful if you wish to skip synthesis on
your root file by default.

Enable FPGA Hardware Breakpoint Auto Instantiation - The FHB (FPGA Hardware Breakpoint) Auto
Instantiation feature automatically instantiates an FHB instance per clock domain that is using gated clocks
(GLO/GL1/GL2/GL3) from an FCCC instance. The FHB instances gate the clock domain they are instantiated on.
These instances can be used to force halt the design or halt the design through a live probe signal. Once a
selected clock domain or all clock domains are halted, you can play or step on the clock domains, either
selectively or all at once. FPGA Hardware Breakpoint controls in the Smart Debug Ul provide control of the
debugging cycle.

Note: The default format for Sythesis gate level netlist is Verilog for PolarFire devices.

Reports

Maximum number of high fanout nets to be displayed - Enter the number of high fanout nets to be displayed.
The default value is 10. This means the top 10 nets with the highest fanout will appear in the
<root>_compile_netlist_resource.xml> Report.

Abort Flow Conditions

Abort Flow if Errors are found in Physical Design Constraints (PDC) — Check this checkbox to abort Place
and Route if the I/O or Floorplanning PDC constraint file contains errors.

Abort Flow if Errors are found in Timing Constraints (SDC) — Check this checkbox to abort Place and Route if
the Timing Constraint SDC file contains errors.

remove_clock _groups

This Tcl command removes a clock group by name or by ID.

remove clock groups [-id id# | —name groupname] \
[-physically exclusive | -logically exclusive | -asynchronous]

Note: The exclusive flag is not needed when removing a clock group by ID.

Arguments
-id id#
Specifies the clock group by the ID.

—nhame groupname
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Specifies the clock group by name (to be always followed by the exclusive flag).

[-physically exclusive | -logically exclusive | - asynchronous]

Example

Removal by group name
remove_clock groups -name mygroup3 -physically exclusive

Removal by goup ID

remove clock groups -id 12

See Also

set clock groups
list clock groups

remove_permanent_locks

Removes all the locks configured in SPM_OTP. This command can only be used when at least one lock is
disabled using SPM_OTP.

remove permanent locks

Example

remove_permanent locks

See Also
SPM OTP

Search in Libero SoC

Search options vary depending on your search type.

To find afile:

1. Use CTRL + F to open the Search window.

2. Enter the name or part of name of the object you wish to find in the Find field. "™ indicates a wildcard, and [*-
*] indicates a range, such as if you search for a1, a2, ... a5 with the string a[1-5].

3. Set the Options for your search (see below for list); options vary depending on your search type.

4. Click Find All (or Next if searching Text).
Searching an open text file, Log window or Reports highlights search results in the file itself.

All other results appear in the Search Results window (as shown in the figure below).

Match case: Select to search for case-sensitive occurrences of a word or phrase. This limits the search so it only
locates text that matches the upper- and lowercase characters you enter.

Match whole word: Select to match the whole word only.

| Search Results '_ﬁni

| |
I Besuits For WOLE in 'Current Open Sneriesgn’ for B |

t
L
pf_poie to_dded top:ACLE Pin
8 vy axid inkercormect w SLACLE [Pin
vy core AN SRAM OACLE Pin

H e

Figure 141 - Search Results

Current Open SmartDesign
Searches your open SmartDesign, returns results in the Search window.
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Type: Choose Instance, Net or Pin to narrow your search.
Query: Query options vary according to Type.

Type Query Option Function
Instance Get Pins Search restricted to all pins
Get Nets Search restricted to all nets
Get Unconnected Pins Search restricted to all unconnected pins
Net Get Instances Searches all instances
Get Pins Search restricted to all pins
Pin Get Connected Pins Search restricted to all connected pins
Get Associated Net Search restricted to associated nets
Get All Unconnected Pins Search restricted to all unconnected pins

Current Open Text Editor

Searches the open text file. If you have more than one text file open you must place the cursor in it and click
CTRL + F to search it.

Find All: Highlights all finds in the text file.

Next: Proceed to next instance of found text.

Previous: Proceed to previous instance of found text.

Replace with: Replaces the text you searched with the contents of the field.
Replace: Replaces a single instance.

Replace All: Replaces all instances of the found text with the contents of the field.

Design Hierarchy
Searches your Design Hierarchy; results appear in the Search window.
Find All: Displays all finds in the Search window.

Stimulus Hierarchy
Searches your Stimulus Hierarchy; results appear in the Search window.
Find All: Displays all finds in the Search window.

Log Window

Searches your Log window; results are highlighted in the Log window - they do not appear in the Search Results
window.

Find All: Highlights all finds in the Log window.
Next: Proceed to next instance of found text.
Previous: Proceed to previous instance of found text.

Reports
Searches your Reports; returns results in the Reports window.
Find All: Highlights all finds in the Reports window.
Next: Proceed to next instance of found text.
Previous: Proceed to previous instance of found text.
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Files

Searches your local project file names for the text in the Search field; returns results in the Search window.
Find All: Lists all search results in the Search window.

Files on disk

Searches the files' content in the specified directory and subdirectories for the text in the Search field; returns
results in the Search window.

Find All: Lists all finds in the Search window.
File type: Select a file type to limit your search to specific file extensions, or choose *.* to search all file types.

set_clock groups

set_clock_groups is an SDC command which disables timing analysis between the specified clock groups. No
paths are reported between the clock groups in both directions. Paths between clocks in the same group continue
to be reported.

set clock groups [-name name]
[-physically exclusive | -logically exclusive | -asynchronous]
[-comment comment string]
—group clock list

Note: If you use the same name and the same exclusive flag of a previously defined clock group to create a new
clock group, the previous clock group is removed and a new one is created in its place.

Arguments
—name name
Name given to the clock group. Optional.
-physically exclusive

Specifies that the clock groups are physically exclusive with respect to each other. Examples are multiple
clocks feeding a register clock pin. The exclusive flags are all mutually exclusive. Only one can be
specified.

-logically exclusive

Specifies that the clocks groups are logically exclusive with respect to each other. Examples are clocks
passing through a mux.

—asynchronous

Specifies that the clock groups are asynchronous with respect to each other, as there is no phase
relationship between them. The exclusive flags are all mutually exclusive. Only one can be specified.

Note: The exclusive flags for the arguments above are all mutually exclusive. Only one can be specified.
-group clock list

Specifies a list of clocks. There can any number of groups specified in the set_clock_groups command.

Example
set_clock groups -name mygroup3 -physically exclusive \

—group [get clocks clk 1] -group [get clocks clk 2]

See Also

list clock groups
remove clock groups

set_auto_update mode

This command enables or disables auto update.

set auto update mode {01}
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If set_auto update mode is 0, auto update is disabled. If set_auto _update mode is 1, auto update is enabled.

set_plain_text_client

This Tcl command is added to the sSNVM .cfg file that is given as the parameter to the configure_snvm command.
Plain-text Non-Authenticated clients have 252 bytes available for user data in each page of SNVM.

set plain text client
-client name {<name>}
-number of bytes <number>
-content type {MEMORY FILE | STATIC FILL}
-content file format {Microsemi-Binary 8/16/32 bit}
—content file {<path>}
-start page <number>
-use for simulation O
-reprogram 0 | 1
-use as rom 0 | 1

Arguments
-client_name
The name of the client. Needs to start with an alphabetic letter. Underscores and numerals are allowed at
all positions other than the first.
-number_ of bytes
The size of the client specified in bytes.
-content type
Source of data for the client. This can either be a memory file, or all zeros. Allowed values are
MEMORY_FILE or STATIC_FILL
-content file format
Only ‘Microsemi-Binary 8/16/32 bit’ is supported at this time.
-content_file
Path of the memory file. This can be absolute, or relative to the project.
-start _page
The page number in sSNVM where data for this client will be placed.
-use_for simulation
Only value 0 is allowed.
—-reprogram
Boolean field; specifies whether the client will be programmed into the final design or not. Possible values
are Oor 1.
-use_as_rom 0

Boolean field; specifies whether the client will allow only reads, or both read and writes. Possible values
areOor1.

Example

set plain text client \
-client name {a} \
-number of bytes 12 \
-content type {MEMORY FILE} \
-content file format {Microsemi-Binary 8/16/32 bit} \
-content file {D:/local z folder/work/memory files/binary8x12.mem} \
-start page 1 \
-use for simulation 0 \
-reprogram 1 \
-use_as_rom 0
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See Also
set plain _text auth client

set cipher text auth client
set usk client

set_plain_text_auth_client

This Tcl command is added to the sSNVM .cfg file that is given as the parameter to the configure_snvm command.
Plain-text Authenticated clients have 236 bytes available for user data in each page of sSNVM.

set plain text auth client
-client name {<name>}
-number of bytes <number>
-content type {MEMORY FILE | STATIC FILL}
-content file format {Microsemi-Binary 8/16/32 bit}
—-content file {<path>}
-start page <number>
-use for simulation O
-reprogram 0 | I
-use_as _rom 0 | I

Arguments
-client name

The name of the client. Needs to start with an alphabetic letter. Underscores and numerals are allowed at
all positions other than the first.

-number_of bytes
The size of the client specified in bytes.
-content_ type

Source of data for the client. This can either be a memory file, or all zeros. Allowed values are
MEMORY_FILE or STATIC_FILL

-content file format
Only ‘Microsemi-Binary 8/16/32 bit' is supported at this time.
-content file
Path of the memory file. This can be absolute, or relative to the project.
-start _page
The page number in sSNVM where data for this client will be placed.
-use_for simulation
Only value 0 is allowed.
—-reprogram
Boolean field; specifies whether the client will be programmed into the final design or not. Possible values
areOor1.
-use_as_rom 0
Boolean field; specifies whether the client will allow only reads, or both read and writes. Possible values
areOor1.
PolarFire

Example

set plain text auth client \
-client name {b} \
-number of bytes 12 \
-content type {MEMORY FILE} \
-content file format {Microsemi-Binary 8/16/32 bit} \
-content file {D:/local z folder/work/memory files/binary8x12.mem} \
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-start page 2 \

-use for simulation 0 \
-reprogram 1 \
-use_as_rom 0

See Also
set plain_text client

set cipher text auth client

set _usk client

set_cipher_text auth_client

This Tcl command is added to the sSNVM .cfg file that is given as the parameter to the configure_snvm command.
Cipher-text Authenticated clients have 236 bytes available for user data in each page of SNVM.

set cipher text auth client
-client name {<name>}
-number of bytes <number>
-content type {MEMORY FILE | STATIC FILL}
-content file format {Microsemi-Binary 8/16/32 bit}
—-content file {<path>}
-start page <number>
-use for simulation O
-reprogram 0 | I
-use_as rom 0 | I

Arguments
-client_name

The name of the client. Needs to start with an alphabetic letter. Underscores and numerals are allowed at
all positions other than the first.

-number of bytes
The size of the client specified in bytes.
—-content_ type

Source of data for the client. This can either be a memory file, or all zeros. Allowed values are
MEMORY_FILE or STATIC_FILL

-content file format

Only ‘Microsemi-Binary 8/16/32 bit' is supported at this time.

-content file

Path of the memory file. This can be absolute, or relative to the project.

-start_page

The page number in sSNVM where data for this client will be placed.

-use_for simulation

Only value 0 is allowed.

—reprogram

Boolean field; specifies whether the client will be programmed into the final design or not. Possible values
areOor1.

-use_as_rom 0

Boolean field; specifies whether the client will allow only reads, or both read and writes. Possible values
areOor1.

Example

set cipher text auth client \
-client name {c} \
-number of bytes 12 \
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-content type {MEMORY FILE} \

-content file format {Microsemi-Binary 8/16/32 bit} \

-content file {D:/local z folder/work/memory files/binary8x12.mem} \
-start page 3 \

-use for simulation 0 \

-reprogram 1 \

See Also
set plain _text client

set plain _text auth client

set usk client

set_usk client

This Tcl command is added to the sSNVM .cfg file that is given as the parameter to the configure_snvm command.
The USK client is required if sSNVM has one or more clients of type ‘Authenticated’.

set cipher text auth client
-start page <number>
-key <Hexadecimal string of size 24>
-use for simulation 0 | 1
-reprogram 0 | I

Arguments
-start _page
The page number in sSNVM where data for this client will be placed.
-key
A string of 24 hexadecimal characters.
-use_for simulation
Boolean field specifies whether the client will be used for simulation or not. Possible values are 0 or 1.
—-reprogram
Boolean field; specifies whether the client will be programmed into the final design or not. Possible values
are Oor 1.

Example

set _usk client \
-start page 4 \
-key {D8C8831F3A2F72EDC569503F} \
-use for simulation 0 \
—-reprogram 1

See Also
set plain _text client

set plain _text auth client

set cipher text auth client

set_clock uncertainty

Tcl command; specifies simple clock uncertainty for single clock and clock-to-clock uncertainty between
two clocks (from and to).

set clock uncertainty [-setup] [-hold] uncertainty [object list -from from clock | -
rise from rise from clock | -fall from fall from clock —-to to clock | -rise to rise to clock |
-fall to fall to clock]
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Arguments
uncertainty
Specifies the time in nanoseconds that represents the amount of variation between two clock edges.
object list
Specifies a list of clocks, ports, or pins for simple uncertainty; the uncertainty is applied either to

destination flops clocked by one of the clocks in the object list option , or destination flops whose clock
pins are in the fanout of a port or a pin specified in the object_list option.

-from

Specifies that the clock-to-clock uncertainty applies to both rising and falling edges of the source clock
list. Only one of the -from, -rise from, Or -fall from arguments can be specified for the constraint to
be valid.

-rise from
Specifies that the clock-to-clock uncertainty applies only to rising edges of the source clock list. Only one
of the -from, -rise from, Or -fall from arguments can be specified for the constraint to be valid.

-fall from

Specifies that the clock-to-clock uncertainty applies only to falling edges of the source clock list. Only one
of the -from, -rise from, Or -fall from arguments can be specified for the constraint to be valid.

from clock/rise from clock/fall from clock

Specifies the list of clock names as the uncertainty source.

-to

Specifies that the clock-to-clock uncertainty applies to both rising and falling edges of the destination clock
list. Only one of the -to, -rise to, 0Or-fall to arguments can be specified for the constraint to be valid.
-rise_to

Specifies that the clock-to-clock uncertainty applies only to rising edges of the destination clock list. Only
one of the -to, -rise to,0Or-fall to arguments can be specified for the constraint to be valid.

-fall to

Specifies that the clock-to-clock uncertainty applies only to falling edges of the destination clock list. Only
one of the -to, -rise to,0Or-fall to arguments can be specified for the constraint to be valid.

to clock/rise to clock/fall to clock
Specifies the list of clock names as the uncertainty destination.
—-setup
Specifies that the uncertainty applies only to setup checks. If none or both -setup and -ho1d are present,
the uncertainty applies to both setup and hold checks.
-hold
Specifies that the uncertainty applies only to hold checks. If none or both -setup and -ho1d are present,
the uncertainty applies to both setup and hold checks.

Description
set_clock_uncertainty command sets the timing uncertainty of clock networks. It can be used to model clock jitter
or add guard band in timing analysis. Either simple clock uncertainty or clock-to-clock uncertainty can be
specified.
Simple clock uncertainty can be set on a clock or on any pin in the clock network. It will then apply to any path
with the capturing register in the forward cone of the uncertainty. If multiple simple uncertainty applies to a
register, the last one (in the propagation order from the clock source to the register) is used.
Clock-to-clock uncertainty applies to inter-clock paths. Both “from” clock and “to” clock must be specified. Clock-
to-clock uncertainty has higher priority than simple uncertainty. If both are set (a clock-to-clock uncertainty and a
simple clock uncertainty on the “to” clock), the simple clock uncertainty will be ignored for inter-clock paths, only
the clock-to-clock uncertainty will be used.

Examples
Simple Clock Uncertainty constraint examples:

set clock uncertainty 2 -setup [get clocks clk]
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set clock uncertainty 2 [get clocks clk]
Clock to Clock Uncertainty constraint examples:
set clock uncertainty 10 -from Clkl -to Clk2
set clock uncertainty 0 -from Clkl -fall to { Clk2 Clk3 } -setup

set_clock uncertainty 4.3 -fall from { Clkl Clk2 } -rise to *

set_clock uncertainty 0.1 -rise from [ get clocks { Clkl Clk2 } ] -fall to { Clk3 Clk4d }
-setup

set _clock uncertainty 5 -rise from Clkl -to [ get_clocks {*} ]

Organize Source Files Dialog Box — Synthesis

The Organize Source Files dialog box enables you to set the source file order in the Libero SoC.
Click the Use list of files organized by User radio button to Add/Remove source files for the selected tool.

To specify the file order:

1. In the Design Flow window under Implement Design, right-click Synthesize and choose Organize Input
Files > Organize Source Files. The Organize Source Files dialog box appears.

2. Click the Use list of files organized by User radio button to Add/Remove source files for the selected tool.

3. Select a file and click the Add or Remove buttons as necessary. Use the Up and Down arrows to change the
order of the Associated Source files.

4. Click OK.

Ml Organize Source files of alpha_proj2 for Synthesize tool HE

Click ta select a Source file in the praject, and use the Add button ko pass the file ta the kool
Use the Remove button bo remove Source files,
Use the UpfDown arrow buttons ko specify the order of the Source files when they're passed to the kool

Use list of files organized by
™ Libero (default list)

" User LI il

Source files in the project Qrigin Acsociated Source files Crigin

j hdl_w10_1.w User j custom_apb_peripheral v User

Add

Remaye |

e | concel_|

Figure 142 - Organize Source Files Dialog Box

SmartDesign Testbench

SmartDesign Testbench is a GUI-based tool that enables you to design your testbench hierarchy. Use
SmartDesign Testbench to instantiate and connect stimulus cores or modules to drive your design.

You can create a SmartDesign Testbench by right-clicking a SmartDesign component in the Design Hierarchy
and choosing Create Testbench > SmartDesign.

SmartDesign Testbench automatically instantiates the selected SmartDesign component into the Canvas.

You can also double-click Create SmartDesign Testbench in the Design Flow window to add a new
SmartDesign testbench to your project.

New testbench files appear in the Stimulus Hierarchy.

SmartDesign Testbench automatically instantiates your SmartDesign component into the Canvas.
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You can instantiate your own stimulus HDL or simulation models into the SmartDesign Testbench Canvas and
connect them to your DUT (design under test). You can also instantiate Simulation Cores from the Catalog.
Simulation cores are simulation models (such as DDR memory simulation models) or basic cores that are useful
for stimulus generation (such as Clock Generator, Pulse Generator, or Reset Generator).

Click the Simulation Mode checkbox in the Catalog to view available simulation cores.

Refer to the SmartDesign User Guide for more information.

Specify I/0 States During Programming Dialog Box

The /O States During Programming dialog box enables you to specify custom settings for I/Os in your
programming file. This is useful if you want to set an I/O to drive out specific logic, or if you want to use a custom
I/O state to manage settings for each Input, Output Enable, and Output associated with an I/O.

Load from file

Load from file enables you to load an I/O Settings (*.ios) file. You can use the IOS file to import saved custom
settings for all your I/Os. The exported 10S file have the following format:

e Used I/Os have an entry in the 10S file with the following format:

set prog io state -portName {<design port name>} -input <value> -outputEnable <value> -
output <value>

e Unused I/Os have an entry in the 10S file with the following format:

set_prog io state -pinNumber {<device_ pinNumber>} -input <value> -outputEnable <value> -
output <value>

Where <value> is:
e 1-1/Ois set to drive out logic High
e 0-1/0Ois set to drive out logic Low

e Last_Known_State: /O is set to the last value that was driven out prior to entering the programming mode,
and then held at that value during programming

e Z- Tri-State: I/O is tristated

Save to file

Saves your I/O Settings File (*.ios) for future use. This is useful if you set custom states for your I/Os and want to
use them again later in conjunction with a PDC file.

Port Name
Lists the names of all the ports in your design.

Macro Cell
Lists the I/O type, such as INBUF, OUTBUF, PLLs, etc.

Pin Number
The package pin associate with the 1/O.

I/0 State (Output Only)

Your custom /O State set during programming. This heading changes to Boundary Scan Register if you select
the BSR Details checkbox; see the Specifying I/O States During Programming - /0O States and BSR Details help
topic for more information on the BSR Details option.
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Specify I/0 States During Programming
Load from File. .. Save ko file... [™ show BSR Details
Port Hame Macro Cell Pin Humber 1/0 State [Output Only) j
BIST ADLIB:INBUF T2 1
BvPA55_10 ADLIB:INBUF K1 1
CLE. ADLIB:INBUF B1 1
ENOUT ADLIB:INBUF J16 1
LED ADLIB:OUTBUF M3 a
MOMITOR[O] ADLIB:OUTBUF ES a
MOMNITOR[1] ADLIB:OUTBUF c7 d
MOMNITOR[2] ADLIB:OUTBUF k] d
MOMITOR[3] ADLIB:OUTBUF D7 d
MOMNITOR[4] ADLIB:OUTBUF A1 d
OEa ADLIB:INBUF E4 d
OEb ADLIB:INBUF F1 d
O5C_EN ADLIB:INBUF K3 d
PAD[10] ADLIB:BIBUF_LYCMOS33U ME d
PAD[11] ADLIB:BIBUF_LYCMOS33D R? d
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 d
PAD[13] ADLIB:BIBUF_LYCMOS33D c12 d
PAD[14] ADLIB:BIBUF_LYCMOS33U RE d LI
Help | OF I Cancel |

Figure 143 - /O States During Programming Dialog Box
Specifying 1/0 States During Programming - I/O States and BSR Details

The I/O States During Programming dialog box enables you to set custom 1/O states prior to programming.

1/0 State (Output Only)
Sets your I/O states during programming to one of the values shown in the list below.
e 1-1/Os are set to drive out logic High
e 0 -1/Os are set to drive out logic Low

e Last Known State: I/Os are set to the last value that was driven out prior to entering the programming mode,
and then held at that value during programming

e Z - Tri-State: I/Os are tristated

When you set your I/O state, the Boundary Scan Register cells are set according to the table below. Use the
Show BSR Details option to set custom states for each cell.

Table 8 - Default I/O Output Settings

Output State Settings
Input Control Output
(Output Enable)
Z (Tri-State) 1 0 0
0 (Low) 1 1 0
1 (High) 0 1 1
Last_Known_State |Last Known_State |Last Known_State |Last Known_State

Table Key:
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e 1 - High: I/Os are set to drive out logic High
e 0 - Low: I/Os are set to drive out logic Low
e Last Known_State - I/Os are set to the last value that was driven out prior to entering the programming

mode, and then held at that value during programming

Boundary Scan Registers - Enabled with Show BSR Details

& Microsemi

a A3\ MicrRocHIP company

Sets your I/O state to a specific output value during programming AND enables you to customize the values for

the Boundary Scan Register (Input, Output Enable, and Output). You can change any Don't Care value in
Boundary Scan Register States without changing the Output State of the pin (as shown in the table below).

For example, if you want to Tri-State a pin during programming, set Output Enable to 0; the Don't Care indicates
that the other two values are immaterial.

If you want a pin to drive a logic High and have a logic 1 stored in the Input Boundary scan cell during

programming, you may set all the values to 1.

Table 9 - BSR Details I/O Output Settings

Output State Settings
Input Output Enable Output
Z (Tri-State) Don't Care 0 Don't Care
0 (Low) Don't Care 1 0
1 (High) Don't Care 1 1
Last Known State Last State Last State Last State

Table Key:

e 1 —High: I/Os are set to drive out logic High
e 0 - Low: I/Os are set to drive out logic Low
e Don't Care — Don’t Care values have no impact on the other settings.

e Last_Known_State — Sampled value: I/Os are set to the last value that was driven out prior to entering the

programming mode, and then held at that value during programming

The figure below shows an example of Boundary Scan Register settings.
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Specify I/0 States During Programming
Load from File. .. Save ko file... ¥ show BSR Details

_ Boundary Scan Registers -

Port HName Macro Cell Pin Number Input %l:.lapl;‘::g Dutput j
BIST ADLIB:INBUF T2 a 1 1
BvPA55_10 ADLIB:INBUF K1 a 1 1
CLE. ADLIB:INBUF B1 a 1 1
ENOUT ADLIB:INBUF J16 a 1 1
LED ADLIB:OUTBUF M3 1 1 a
MOMITOR[O] ADLIB:OUTBUF ES 1 1 a
MOMNITOR[1] ADLIB:OUTBUF c7 1 a a
MOMNITOR[2] ADLIB:OUTBUF k] 1 a a
MOMITOR[3] ADLIB:OUTBUF D7 1 a a
MOMNITOR[4] ADLIB:OUTBUF A1 1 a a
OEa ADLIB:INBUF E4 1 a a
OEb ADLIB:INBUF F1 1 a a
O5C_EN ADLIB:INBUF K3 1 a a
PAD[10] ADLIB:BIBUF_LYCMOS33U ME 1 a a
PAD[11] ADLIB:BIBUF_LYCMOS33D R? 1 a a
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 1 a a
PAD[13] ADLIB:BIBUF_LYCMOS33D c12 1 a a

PAD[14] ADLIB:BIBUF_LYCMOS33U RE 1 a a LI

Help | OF I Cancel |

Figure 144 - Boundary Scan Registers
Stimulus Hierarchy

To view the Stimulus Hierarchy, from the View menu choose Windows > Stimulus Hierarchy.
The Stimulus Hierarchy tab displays a hierarchical representation of the stimulus and simulation files in the
project. The software continuously analyzes and updates files and content. The tab (see figure below) displays
the structure of the modules and component stimulus files as they relate to each other.

Stimulus Hierarchy g x

Build Hierarchy Show: |Components ¥ [ Show Root Testbenches
= i} work

= ES_[ testbnch (testbnch.v) [work] {
+ Ef[ COREUART comp_COREUART comp_0_COREUART (CoreUART ) [w-:urk]

testbench (testbench.) [work]

FIFQ_CDC_FIFO_CDC_ 0 COREFIFO (COREFIFC W) [work]

clock_driver (clock_drivery) [work]

elabl:fifo_driver (fifo_drivera) [work]

elabl:fifo_monitor (fifo_monitor.) [work]

elabl:gd_dp_ext_mem (gd_dp_ext_mem.v) [work]

Test_PRES (Test_PRBS.w) [work]

MEM_WegPR. (MEM_WeqR.wv) [work]

gd _dp_ext_memn (g4_dp_ext_mem.v) [work]

fifo_monitor (fifo_meonitor.y) [work]

fifo_driver (fifo_driver.w) [work]
+ ES_[ corereset_pf th (corereset_pf tha) [work]

%} [ User HDL Stimulus Files

+}-Ell

BERID

s

=
=

=l

@5" EIPEIPEIE [+

Figure 145 - Stimulus Hierarchy Dialog Box
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Expand the hierarchy to view stimulus and simulation files. Right-click an individual component and choose Show
Module to view the module for only that component.

Select Components, instance or Modules from the Show drop-down list to change the display mode. The
Components view displays the stimulus hierarchy; the modules view displays HDL modules and stimulus files.

The file name (the file that defines the module or component) appears in parentheses.
Click Show Root Testbenches to view only the root-level testbenches in your design.

Right-click and choose Properties; the Properties dialog box displays the pathname, created date, and last
modified date.

All integrated source editors are linked with the SoC software; if you modify a stimulus file the Stimulus Hierarchy
automatically updates to reflect the change.

To open a stimulus file:
Double-click a stimulus file to open it in the HDL text editor.

Right-click and choose Delete from Project to delete the file from the project. Right-click and choose Delete
from Disk and Project to remove the file from your disk.

Icons in the Hierarchy indicate the type of component and the state, as shown in the table below.
Table 10 - Design Hierarchy Icons

Icon Description

SmartDesign component

('3 50| SmartDesign component with HDL netlist not generated

D) SmartDesign testbench

0 E SmartDesign testbench with HDL netlist not generated

IP core was instantiated into SmartDesign but the HDL netlist has not been
generated
=N HDL netlist

Timing Exceptions Overview

Use timing exceptions to overwrite the default behavior of the design path. Timing exceptions include:

e Setting multicycle constraint to specify paths that (by design) will take more than one cycle.

e Setting a false path constraint to identify paths that must not be included in the timing analysis or the
optimization flow.

e Setting a maximum/minimum delay constraint on specific paths to relax or to tighten the original clock
constraint requirement.

Tool Profiles Dialog Box

The Tool Profiles dialog box enables you to add, edit, or delete your project tool profiles.

Each Libero SoC project can have a different profile, enabling you to integrate different tools with different
projects.

The following table shows the supported tool versions in this release.
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Tool Supported Version
Modelsim ME 10.5¢
Modelsim ME Pro 10.5¢
Synplify Pro ME N-2017.09M SP1-1
Identify ME N-2017.09M SP1

Table 11 - Table for supported tool versions

To set or change your tool profile:
1. From the Project menu, choose Tool Profiles. Select the type of tool you wish to add.
o To add a tool: Select the tool type and click the Add button . Fill out the tool profile and click OK.

o To change a tool profile: After selecting the tool, click the Edit button to select another tool,
change the tool name, or change the tool location.

o Toremove a tool from the project:After selecting a tool, click the Remove button.
2.  When you are done, click OK.

4 Tools = R
Synthesis Synshests profies !;+ J I)ﬂ
2enummon Active Hame Path
Stimulus
Prograrnaming @ G0 Syplfy ProME D: Mhcrosemi'Uibeno 1L 7\ Evmpkfy bnlsynplfy_pro.exe

| Ientify Debugger s
syrpify_basch “aroduction Eynopsys Sypifripcismplfy_120 150 345E 1- T,
| sympirfyPF VomSsqatest Sreleases e ot Synonsys S ymph fy \Symplfy L3018
EF_synphify VidmS'sgatest Siysleases et Synonsys \Synpi iy \Synplify L2086
| Hep | Export Frafies.., . oK Cangel :

Figure 146 - Libero SoC Tool Profiles Dialog Box

The tool profile with the padlock icon indicates that it is a pre-defined tool profile (the default tool that comes with
the Libero SoC Installation.)

To export the tool profile and save it for future use, click the Export Tool Profiles dialog box and save the tool
profile file as a tool profile *.ini file. The tool profile *.ini file can be imported into a Libero SoC project (File >
Import > Others) and select Tool Profiles (*.ini) in the File Type pull-down list.

User Preferences Dialog Box — Design Flow Preferences

This dialog box allows you to set your personal preferences for how Libero SoC manages the design flow across
the projects you create.
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P = — — b
»¥ Preferences @Iéj
O - s = will "~
Softw dat:
ottware update Constraint flow
Log window
Startup | Warn me when derived timing constraints generation override existing constraints (enhanced constraint flow).
Internet Access
Text editor Design flow rule checks
IP Cores
T B V| Warn me when Firmware application must be recompiled because of hardware configuration changes.
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Figure 147 - Preferences Dialog Box — Design Flow Preferences

Constraint Flow

¢ Warn me when derived timing constraints generation override existing constraints (enhanced
constraint flow).

Libero SoC can generate/derive timing constraints for known hardware blocks and IPs such as
SERDES, CCC. Check this box to have Libero SoC pop up a warning message when the generated
timing constraints for these blocks override the timing constraints you set for these blocks. This box is
checked by default.

Design Flow Rule Checks

o Warn me when Firmware applications must be recompiled because of hardware configuration
changes.

Check this box if you want Libero SoC to display a warning message. This box is checked by default.
o Warn me when I/Os are not all assigned and locked before programming data generation.

I/Os should always be assigned and locked before programming data generation. Check this box if
you want Libero SoC to display a warning message. This box is checked by default.

SmartDesign Generation Options

¢ Generate recursively

In this mode, all subdesigns must be successfully generated before a parent can be generated. An
attempt to generate a SmartDesign results in an automatic attempt to generate all subdesigns.

¢ Generate non-recursively

In this mode, the generation of only explicitly selected SmartDesigns is attempted. The generation of a
design can be marked as successful even if a subdesign is ungenerated (either never attempted or
unsuccessful).

Note: These preferences are stored on a per-user basis across multiple projects; they are not project-specific.
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Synopsys Design Constraints (SDC)

Synopsys Design Constraints (SDC) is a Tcl-based format used by Synopsys tools to specify the design intent,
including the timing and area constraints for a design. Microsemi tools use a subset of the SDC format to capture
supported timing constraints. Any timing constraint that you can enter using Designer tools can also be specified

in an SDC file.
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Use the SDC-based flow to share timing constraint information between Microsemi tools and third-party EDA

tools.

Command

Action

create clock

Creates a clock and defines its characteristics

create generated clock

characteristics

Creates an internally generated clock and defines its

set clock latency

definition pin of a clock within SmartTime

Defines the delay between an external clock source and the

set clock uncertainty

waveforms or maximum skew

Defines the timing uncertainty between two clock

set false path

excluded from the timing analysis

Identifies paths that are to be considered false and

set _input delay

Defines the arrival time of an input relative to a clock

set max delay

Specifies the maximum delay for the timing paths

set min delay

Specifies the minimum delay for the timing paths

set _multicycle path

Defines a path that takes multiple clock cycles

set output delay

Defines the output delay of an output relative to a clock

See Also
SDC Syntax Conventions

libero_design_flow_SDC_commands

SDC Syntax Conventions

The following table shows the typographical conventions that are used for the SDC command syntax.

Syntax Notation

Description

command -argument

Commands and arguments appear in courier New typeface.

variable

Variables appear in blue, italic courier new typeface. You must

substitute an appropriate value for the variable.

[-argument value]

Optional arguments begin and end with a square bracket.

Note: SDC commands and

arguments are case sensitive.
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Example
The following example shows syntax for the create_clock command and a sample command:

create clock -period period value [-waveform edge list] source
create clock -period 7 -waveform {2 4}{CLKl}

Wildcard Characters
You can use the following wildcard characters in names used in the SDC commands:

Wildcard What it does

\ Interprets the next character literally

* Matches any string

Note: The matching function requires that you add a backslash (\) before each slash in the pin names in
case the slash does not denote the hierarchy in your design.

Special Characters ([ ], { }, and )

Square brackets ([ ]) are part of the command syntax to access ports, pins and clocks. In cases where these
netlist objects names themselves contain square brackets (for example, buses), you must either enclose the
names with curly brackets ({}) or precede the open and closed square brackets ([ ]) characters with a backslash
(\). If you do not do this, the tool displays an error message.

For example:
create clock -period 3 clk\[0\]
set max delay 1.5 -from [get pins ffI1\[5\]:CLK] -to [get clocks {clk[0]}]

Although not necessary, Microsemi recommends the use of curly brackets around the names, as shown in the
following example:

set false path -from {datal} -to [get_pins {regl:D}]
In any case, the use of the curly bracket is mandatory when you have to provide more than one name.

For example:
set false path -from {data3 datad4} -to [get_pins {reg2:D reg5:D}]

Entering Arguments on Separate Lines

If a command needs to be split on multiple lines, each line except the last must end with a backslash (\) character
as shown in the following example:

set_multicycle path 2 -from \

[get pins {regl*}] \

-to {reg2:D}

See Also
About SDC Files

create_clock

SDC command; creates a clock and defines its characteristics.

create clock -name clock name -add -period period value [-waveform edge list] source

Arguments
-name clock name

Specifies the name of the clock constraint. This parameter is required for virtual clocks when no clock
source is provided.
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—add

Specifies that a new clock constraint is created at the same source as the existing clock without overriding
the existing constraint. The name of the new clock constraint with the -add option must be different than
the existing clock constraint. Otherwise, it will override the existing constraint, even with the -add option.
The -name option must be specified with the -add option.

-period period value

Specifies the clock period in nanoseconds. The value you specify is the minimum time over which the
clock waveform repeats. The period_value must be greater than zero.

-waveform edge list

Specifies the rise and fall times of the clock waveform in ns over a complete clock period. There must be
exactly two transitions in the list, a rising transition followed by a falling transition. You can define a clock
starting with a falling edge by providing an edge list where fall time is less than rise time. If you do not
specify -waveform option, the tool creates a default waveform, with a rising edge at instant 0.0 ns and a
falling edge at instant (period_value/2)ns.

source

Specifies the source of the clock constraint. The source can be ports or pins in the design. If you specify a
clock constraint on a pin that already has a clock, the new clock replaces the existing one. Only one
source is accepted. Wildcards are accepted as long as the resolution shows one port or pin.

Description

Creates a clock in the current design at the declared source and defines its period and waveform. The
static timing analysis tool uses this information to propagate the waveform across the clock network to the
clock pins of all sequential elements driven by this clock source.

The clock information is also used to compute the slacks in the specified clock domain that drive
optimization tools such as place-and-route.

Exceptions
None

Examples

The following example creates two clocks, one on port CK1 with a period of 6, and the other on port CK2 with a
period of 6, a rising edge at 0, and a falling edge at 3:

create_clock -name {my user clock} -period 6 CKI1

create clock -name {my other user clock} -period 6 -waveform {0 3} {CK2}
The following example creates a clock on port CK3 with a period of 7, a rising edge at 2, and a falling edge at 4:

create clock -period 7 -waveform {2 4} [get_ports {CK3}]
The following example creates a new clock constraint clk2, in addition to clk1, on the same source port clk1
without overriding it.

create clock -name clkl -period 10 -waveform {0 5} [get ports clkl]

create clock -name clk2 -add -period 20 -waveform {0 10} [get ports clkl]
The following example does not add a new clock constraint, even with the -add option, but overrides the existing

clock constraint because of the same clock names. Note: To add a new clock constraint in addition to the existing
clock constraint on the same source port, the clock names must be different.

create clock -name clkl -period 10 -waveform {0 5} [get ports clkl]

create clock -name clkl -add -period 50 -waveform {0 25} [get ports clkl]

Microsemi Implementation Specifics

e The -waveform in SDC accepts waveforms with multiple edges within a period. In Microsemi design
implementation, only two waveforms are accepted.

e SDC accepts defining a clock on many sources using a single command. In Microsemi design
implementation, only one source is accepted.

e The source argument in SDC create_clock command is optional. This is in conjunction with the -name
argument in SDC to support the concept of virtual clocks. In Microsemi implementation, source is a
mandatory argument as -name and virtual clocks concept is not supported.
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The -domain argument in the SDC create_clock command is not supported.

See Also

SDC Syntax Conventions

create_generated_clock

SDC command; creates an internally generated clock and defines its characteristics.

create generated clock -name clock name [-add] [-master clock clock name] -source
reference pin [-divide by divide factor] [-multiply by multiply factor] [-invert] source -
pll output pll feedback clock -pll feedback pll feedback input[-edges values] [-edge shift
values]
Arguments
—name clock name

Specifies the name of the clock constraint. This parameter is required for virtual clocks when no clock

source is provided.

—add

Specifies that the generated clock constraint is a new clock constraint in addition to the existing one at the

same source. The name of the clock constraint should be different from the existing clock constraint. With

this option, -master_clock option and -name options must be specified.

-master_clock clock name

Specifies the master clock used for the generated clock when multiple clocks fan into the master pin. This

option must be used in conjuction with -add option of the generated clock.

Notes:
1. The master_clock option is used only with the -add option for the generated clocks.
2. If there are multiple master clocks fanning into the same reference pin, the first generated clock specified will
always use the first master clock as its source clock.
3. The subsequent generated clocks specified with the -add option can choose any of the master clocks as

their source clock (including the first master clock specified).

-source reference pin

Specifies the reference pin in the design from which the clock waveform is to be derived.

-divide_by divide factor

Specifies the frequency division factor. For instance if the divide_factoris equal to 2, the generated clock
period is twice the reference clock period.

-multiply by multiply factor

Specifies the frequency multiplication factor. For instance if the muiltiply _factor is equal to 2, the generated
clock period is half the reference clock period.

—-invert

Specifies that the generated clock waveform is inverted with respect to the reference clock.

source

Specifies the source of the clock constraint on internal pins of the design. If you specify a clock constraint
on a pin that already has a clock, the new clock replaces the existing clock. Only one source is accepted.
Wildcards are accepted as long as the resolution shows one pin.

-pll_output pll feedback clock

Specifies the output pin of the PLL which is used as the external feedback clock. This pin must drive the
feedback input pin of the PLL specified using the —pll_feedback option. The PLL will align the rising edge

of the reference input clock to the feedback clock. This is a mandatory argument if the PLL is operating in
external feedback mode.

-pll feedback pll feedback input
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Specifies the feedback input pin of the PLL. This pin must be driven by the output pin of the PLL specified
using the —pll_output option. The PLL will align the rising edge of the reference input clock to the external
feedback clock. This is a mandatory argument if the PLL is operating in external feedback mode.

-edges values

Specify the integer values that represent the edges from the source clock that form the edges of the
generated clock. Three values must be specified to generate the clock. If you specify less than three, a
tool tip indicates an error.

-edge_shift values

Specify a list of three floating point numbers that represents the amount of shift, in nanoseconds, that the
specified edges are to undergo to yield the final generated clock waveform. These floating point values
can be positive or negative. Positive value indicates a shift later in time, while negative indicates a shift
earlier in time.

For example: An edge shift of {1 1 1} on the LSB generated clock, would shift each derived edge by 1
nanosecond.

To create a 200MHz clock from a 100MHz clock, use edge { 1 2 3} and edge shift {0 -2.5 -5.0}.

Description

Creates a generated clock in the current design at a declared source by defining its frequency with
respect to the frequency at the reference pin. The static timing analysis tool uses this information to
compute and propagate its waveform across the clock network to the clock pins of all sequential elements
driven by this source.

The generated clock information is also used to compute the slacks in the specified clock domain that
drive optimization tools such as place-and-route.

Examples

The following example creates a generated clock on pin U1/reg1:Q with a period twice as long as the period at
the reference port CLK.

create generated clock -name {my user clock} -divide_ by 2 -source [get ports

{CLK}] Ul/regl:Q
The following example creates a generated clock at the primary output of myPLL with a period % of the period at
the reference pin clk.

create generated clock -divide by 3 -multiply by 4 -source clk [get pins {myPLL:CLK1}]
The following example creates a new generated clock gen2 in addition to gen1 derived from same master clock
as the existing generated clock, and the new constraints is added to pin r1/CLK.

create generated clock -name genl -multiply by 1 -source [get ports clkl] [get pins

r1/CLK]

create generated clock -name gen2 -add -master clock clkl -source [get ports clkl] -

multiply by 2 [get pins rl/CLK]
The following example does not create a new generated clock constraint in addition to the existing clock, but will
override even with the -add option enabled, because the same names are used.

create generated clock -name gen2 -source [get ports clkl] -multiply by 3 [get pins

rl/CLK]

create_generated clock -name gen2 -source [get ports clkl] -multiply by 4 -master clock

clkl -add [get pins rl/CLK]
The following example creates a generated clock on pin U1/reg1:Q with a period twice as long as the period at
the reference port CLK.

create generated clock -name {my user clock} -divide by 2 -source [get ports {CLK}]

Ul/regl/Q
The following example creates a generated clock at the primary output of myPLL with a period % of the period at
the reference pin clk.

create generated clock -divide by 3 -multiply by 4 -source clk [get pins {myPLL/CLK1}]
The following example creates a generated clock named system_clk on the GL2 output pin of FCCC_0 with a
period equal to half the period of the source clock. The constraint also identifies GL2 output pin as the external
feedback clock source and CLK2 as the feedback input pin for FCCC_0.
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create generated clock -name { system clk } \
-multiply by 2 \

-source { FCCC_0/CCC_INST/CLK3_PAD } \

-pll output { FCCC_0/CCC_INST/GL2 } \
-pll_feedback { FCCC_O0/CCC_INST/CLK2 } \

{ FCCC_0/CCC_INST/GL2 }

Microsemi Implementation Specifics

e SDC accepts either —-multiply_by or —divide_by option. In Microsemi design implementation, both are
accepted to accurately model the PLL behavior.

o SDC accepts defining a generated clock on many sources using a single command. In Microsemi design
implementation, only one source is accepted.

e The -duty_cycle ,-edges and —edge_shift options in the SDC create_generated_clock command are not
supported in Microsemi design implementation.
See Also
SDC Syntax Conventions

remove_clock uncertainty

SDC command; Removes a clock-to-clock uncertainty from the current timing scenario.
remove clock uncertainty -from | -rise from | -fall from from clock list -to | -rise to| -
fall to to clock list -setup {value} -hold {value}

remove clock uncertainty -id constraint ID

Arguments
—-from

Specifies that the clock-to-clock uncertainty applies to both rising and falling edges of the source clock
list. You can specify only one of the -from, -rise from, Or -fall fromarguments for the constraint to be
valid.

-rise from

Specifies that the clock-to-clock uncertainty applies only to rising edges of the source clock list. You can
specify only one of the -from, -rise from, Or -fall from arguments for the constraint to be valid.
-fall from

Specifies that the clock-to-clock uncertainty applies only to falling edges of the source clock list. You can
specify only one of the -from, -rise from, Or -fall from arguments for the constraint to be valid.

from clock list

Specifies the list of clock names as the uncertainty source.

-to

Specifies that the clock-to-clock uncertainty applies to both rising and falling edges of the destination clock
list. You can specify only one of the -to, -rise_to, Oor -fall to arguments for the constraint to be valid.
-rise to

Specifies that the clock-to-clock uncertainty applies only to rising edges of the destination clock list. You
can specify only one of the -to, -rise to, 0or-fall to arguments for the constraint to be valid.

-fall to

Specifies that the clock-to-clock uncertainty applies only to falling edges of the destination clock list. You
can specify only one of the -to, -rise to, 0or-fall to arguments for the constraint to be valid.

to clock list

Specifies the list of clock names as the uncertainty destination.
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-setup

Specifies that the uncertainty applies only to setup checks. If none or both -setup and -ho1d are present,
the uncertainty applies to both setup and hold checks.

-hold

Specifies that the uncertainty applies only to hold checks. If none or both -setup and -ho1d are present,
the uncertainty applies to both setup and hold checks.

-id constraint ID

Specifies the ID of the clock constraint to remove from the current scenario. You must specify either the
exact parameters to set the constraint or its constraint ID.

Description

Removes a clock-to-clock uncertainty from the specified clock in the current scenario. If the specified
arguments do not match clocks with an uncertainty constraint in the current scenario, or if the specified ID
does not refer to a clock-to-clock uncertainty constraint, this command fails.

Do not specify both the exact arguments and the ID.

Exceptions
None

Examples
remove clock uncertainty -from Clkl -to Clk2

remove_clock uncertainty -from Clkl -fall to { Clk2 Clk3 } -setup

remove clock uncertainty 4.3 -fall from { Clkl Clk2 } -rise to *

remove clock uncertainty 0.1 -rise from [ get clocks { Clkl Clk2 } ] -fall to { Clk3
Clk4 } -setup

remove clock uncertainty 5 -rise from Clkl -to [ get clocks {*} ]

remove clock uncertainty -id $clockId

See Also
SDC Syntax Conventions

set clock uncertainty

set_clock_latency

SDC command; defines the delay between an external clock source and the definition pin of a clock
within SmartTime.

set clock latency -source [-rise][-fall][-early][-late] delay clock

Arguments
—source
Specifies a clock source latency on a clock pin.
-rise
Specifies the edge for which this constraint will apply. If neither or both rise are passed, the same latency
is applied to both edges.
-fall
Specifies the edge for which this constraint will apply. If neither or both rise are passed, the same latency
is applied to both edges.
—-invert
Specifies that the generated clock waveform is inverted with respect to the reference clock.
-late

Optional. Specifies that the latency is late bound on the latency. The appropriate bound is used to provide
the most pessimistic timing scenario. However, if the value of "-late" is less than the value of "-early",
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optimistic timing takes place which could result in incorrect analysis. If neither or both "-early" and "-late"
are provided, the same latency is used for both bounds, which results in the latency having no effect for
single clock domain setup and hold checks.

—early

Optional. Specifies that the latency is early bound on the latency. The appropriate bound is used to
provide the most pessimistic timing scenario. However, if the value of "-late" is less than the value of "-
early", optimistic timing takes place which could result in incorrect analysis. If neither or both "-early" and
"-late" are provided, the same latency is used for both bounds, which results in the latency having no
effect for single clock domain setup and hold checks.

delay
Specifies the latency value for the constraint.
clock

Specifies the clock to which the constraint is applied. This clock must be constrained.

Description

Clock source latency defines the delay between an external clock source and the definition pin of a clock
within SmartTime. It behaves much like an input delay constraint. You can specify both an "early" delay
and a"late" delay for this latency, providing an uncertainty which SmartTime propagates through its
calculations. Rising and falling edges of the same clock can have different latencies. If only one value is
provided for the clock source latency, it is taken as the exact latency value, for both rising and falling
edges.

Exceptions
None

Examples

The following example sets an early clock source latency of 0.4 on the rising edge of main_clock. It also
sets a clock source latency of 1.2, for both the early and late values of the falling edge of main_clock. The
late value for the clock source latency for the falling edge of main_clock remains undefined.

set _clock latency -source -rise -early 0.4 { main_clock }

set _clock latency -source -fall 1.2 { main_clock }

Microsemi Implementation Specifics

SDC accepts a list of clocks to -set_clock_latency. In Microsemi design implementation, only one clock pin can
have its source latency specified per command.

See Also
SDC Syntax Conventions

set_clock to_ output

SDC command; defines the timing budget available inside the FPGA for an output relative to a clock.

set clock to output delay value -clock clock ref [-max] [-min] output list

Arguments
delay value
Specifies the clock to output delay in nanoseconds. This time represents the amount of time available
inside the FPGA between the active clock edge and the data change at the output port.
—-clock clock ref

Specifies the reference clock to which the specified clock to output is related. This is a mandatory
argument.
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—max

Specifies that delay value refers to the maximum clock to output at the specified output. If you do not
specify —-max or —min options, the tool assumes maximum and minimum clock to output delays to be
equal.

-min

Specifies that de1ay value refers to the minimum clock to output at the specified output. If you do not
specify —-max or —min options, the tool assumes maximum and minimum clock to output delays to be
equal.

output 1list
Provides a list of output ports in the current design to which delay_value is assigned. If you need to
specify more than one object, enclose the objects in braces ({}).

set_clock uncertainty

SDC command; specifies simple clock uncertainty for single clock and clock-to-clock uncertainty between two
clocks (from and to).

set clock uncertainty [-setup] [-hold] uncertainty [object list -from from clock | -
rise from rise from clock | -fall from fall from clock —-to to clock | -rise to rise to clock |
-fall to fall to clock]

Arguments
uncertainty
Specifies the time in nanoseconds that represents the amount of variation between two clock edges.
object list
Specifies a list of clocks, ports, or pins for simple uncertainty; the uncertainty is applied either to

destination flops clocked by one of the clocks in the object list option , or destination flops whose clock
pins are in the fanout of a port or a pin specified in the object_list option.

-from

Specifies that the clock-to-clock uncertainty applies to both rising and falling edges of the source clock
list. Only one of the -from, -rise from, Or -fall from arguments can be specified for the constraint to
be valid.

-rise from
Specifies that the clock-to-clock uncertainty applies only to rising edges of the source clock list. Only one
of the -from, -rise from, Or -fall from arguments can be specified for the constraint to be valid.

-fall from

Specifies that the clock-to-clock uncertainty applies only to falling edges of the source clock list. Only one
of the -from, -rise from, Or -fall from arguments can be specified for the constraint to be valid.

from clock/rise from clock/fall from clock

Specifies the list of clock names as the uncertainty source.

-to

Specifies that the clock-to-clock uncertainty applies to both rising and falling edges of the destination clock
list. Only one of the -to, -rise to, 0Or-fall to arguments can be specified for the constraint to be valid.
-rise_to

Specifies that the clock-to-clock uncertainty applies only to rising edges of the destination clock list. Only
one of the -to, -rise to,0Or-fall to arguments can be specified for the constraint to be valid.

-fall to

Specifies that the clock-to-clock uncertainty applies only to falling edges of the destination clock list. Only
one of the -to, -rise to, 0Or-fall to arguments can be specified for the constraint to be valid.

to clock/rise to clock/fall to clock
Specifies the list of clock names as the uncertainty destination.
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-setup

Specifies that the uncertainty applies only to setup checks. If none or both -setup and -ho1d are present,
the uncertainty applies to both setup and hold checks.

-hold

Specifies that the uncertainty applies only to hold checks. If none or both -setup and -ho1d are present,
the uncertainty applies to both setup and hold checks.

Description

set_clock_uncertainty command sets the timing uncertainty of clock networks. It can be used to model clock jitter
or add guard band in timing analysis. Either simple clock uncertainty or clock-to-clock uncertainty can be
specified.

Simple clock uncertainty can be set on a clock or on any pin in the clock network. It will then apply to any path

with the capturing register in the forward cone of the uncertainty. If multiple simple uncertainty applies to a
register, the last one (in the propagation order from the clock source to the register) is used.

Clock-to-clock uncertainty applies to inter-clock paths. Both “from” clock and “to” clock must be specified. Clock-
to-clock uncertainty has higher priority than simple uncertainty. If both are set (a clock-to-clock uncertainty and a
simple clock uncertainty on the “to” clock), the simple clock uncertainty will be ignored for inter-clock paths, only
the clock-to-clock uncertainty will be used.

Exceptions
None

Examples
Simple Clock Uncertainty constraint examples:

set clock uncertainty 2 -setup [get clocks clk]
set clock uncertainty 2 [get clocks clk]
Clock to Clock Uncertainty constraint examples:
set clock uncertainty 10 -from Clkl -to Clk2
set clock uncertainty 0 -from Clkl -fall to { Clk2 Clk3 } -setup

set_clock uncertainty 4.3 -fall from { Clkl Clk2 } -rise to *

set_clock uncertainty 0.1 -rise from [ get clocks { Clkl Clk2 } ] -fall to { Clk3 Clk4d }
—-setup

set _clock uncertainty 5 -rise from Clkl -to [ get_clocks {*} ]

Microsemi Implementation Specifics

e SDC accepts a list of clocks to -set_clock_uncertainty.

See Also
SDC Syntax Conventions

set_disable timing

SDC command; disables timing arcs within the specified cell and returns the ID of the created constraint if
the command succeeded.

set disable timing [-from from port] [-to to port] cell name

Arguments
-from from port
Specifies the starting port.
-to to port
Specifies the ending port.

cell name
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Specifies the name of the cell in which timing arcs will be disabled.

Description

This command disables the timing arcs in the specified cell, and returns the ID of the created constraint if
the command succeeded. The —from and —to arguments must either both be present or both omitted for
the constraint to be valid.

Examples
The following example disables the arc between a2:A and a2:Y.

set disable timing -from portl -to port2 cellname

This command ensures that the arc is disabled within a cell instead of between cells.

Microsemi Implementation Specifics

e None

See Also
SDC Syntax Conventions

set_external check

SDC command; defines the external setup and hold delays for an input relative to a clock.

set external check delay value -clock clock ref [-setup] [-hold] input 1list

Arguments
delay value
Specifies the external setup or external hold delay in nanoseconds. This time represents the amount of
time available inside the FPGA for the specified input after a clock edge.
-clock clock ref
Specifies the reference clock to which the specified external check is related. This is a mandatory
argument.
-setup O -hold
Specifies that delay_value refers to the setup/hold check at the specified input. This is a mandatory
argument if —hold is not used. You must specify either -setup or -hold option.
input list
Provides a list of input ports in the current design to which delay_value is assigned. If you need to specify
more than one object, enclose the objects in braces ({}).

Description

The set_external_check command specifies the external setup and hold times on input ports relative to a clock
edge. This usually represents a combinational path delay from the input port to the clock pin of a register internal
to the current design. For in/out (bidirectional) ports, you can specify the path delays for both input and output
modes. The tool uses external setup and external hold times for paths starting at primary inputs.

A clock is a singleton that represents the name of a defined clock constraint. This can be an object accessor that
will refer to one clock. For example:

[get_clocks {system clk}]

[get clocks {sys* clk}]

Examples
The following example sets an external setup check of 12 ns and an external hold check of 6 ns for port data_in
relative to the rising edge of CLK1:
set external check 12 -clock [get clocks CLKl] -setup [get ports data in]
set external check 6 -clock [get clocks CLK1] -hold [get ports data_in]
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See Also
SDC Syntax Conventions

set _false path

SDC command; identifies paths that are considered false and excluded from the timing analysis.

set false path [-from from list] [-through through list] [-to to list]

Arguments
-from from list
Specifies a list of timing path starting points. A valid timing starting point is a clock, a primary input, an
inout port, or a clock pin of a sequential cell.
-through through list
Specifies a list of pins, ports, cells, or nets through which the disabled paths must pass.
-to to list

Specifies a list of timing path ending points. A valid timing ending point is a clock, a primary output, an
inout port, or a data pin of a sequential cell.

Description

The set_false_path command identifies specific timing paths as being false. The false timing paths are
paths that do not propagate logic level changes. This constraint removes timing requirements on these
false paths so that they are not considered during the timing analysis. The path starting points are the
input ports or register clock pins, and the path ending points are the register data pins or output ports.
This constraint disables setup and hold checking for the specified paths.

The false path information always takes precedence over multiple cycle path information and overrides
maximum delay constraints. If more than one object is specified within one -through option, the path can
pass through any objects.

Examples

The following example specifies all paths from clock pins of the registers in clock domain clk1 to data pins
of a specific register in clock domain clk2 as false paths:

set false path -from [get clocks {clkl}] -to reg 2:D

The following example specifies all paths through the pin UO/U1:Y to be false:
set false path -through U0/Ul:Y

Microsemi Implementation Specifics
SDC accepts multiple -through options in a single constraint to specify paths that traverse multiple points in the
design. In Microsemi design implementation, only one —through option is accepted.
See Also
SDC Syntax Conventions

set_input_delay

SDC command; defines the arrival time of an input relative to a clock.

set input delay delay value -clock clock ref [-max] [-min] [-clock fall] [-rise] [-fall] [-
add delay] input list

Arguments
delay value

Specifies the arrival time in nanoseconds that represents the amount of time for which the signal is
available at the specified input after a clock edge.
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-clock clock_ref

Specifies the clock reference to which the specified input delay is related. This is a mandatory argument.
If you do not specify -max or -min options, the tool assumes the maximum and minimum input delays to
be equal.

—max

Specifies that delay_value refers to the longest path arriving at the specified input. If you do not specify -
max or -min options, the tool assumes maximum and minimum input delays to be equal.

-min

Specifies that delay_value refers to the shortest path arriving at the specified input. If you do not specify -
max or -min options, the tool assumes maximum and minimum input delays to be equal.

-clock fall

Specifies that the delay is relative to the falling edge of the clock reference. The default is the rising edge.
-rise

Specifies that the delay is relative to a rising transition on the specified port(s). If -rise or -fall is not
specified, then rising and falling delays are assumed to be equal.

-fall

Specifies that the delay is relative to a falling transition on the specified port(s). If -rise or -fall is not
specified, then rising and falling delays are assumed to be equal.

-add_delay

Specifies that this input delay constraint should be added to an existing constraint on the same port(s).
The -add_delay option is used to capture information on multiple paths with different clocks or clock edges
leading to the same input port(s).

input list
Provides a list of input ports in the current design to which delay_value is assigned. If you need to specify
more than one object, enclose the objects in braces ({}).

Notes:

e The behavior of the -add_delay option is identical to that of PrimeTime(TM)

e If, using the -add_delay mechanism, multiple constraints are otherwise identical, except they specify
different -max or -min values

e the surviving -max constraint will be the maximum of the -max values
o the surviving -min constraint will be the minimum of the -min values

Description

The set_input_delay command sets input path delays on input ports relative to a clock edge. This usually
represents a combinational path delay from the clock pin of a register external to the current design. For
in/out (bidirectional) ports, you can specify the path delays for both input and output modes. The tool adds
input delay to path delay for paths starting at primary inputs.

A clock is a singleton that represents the name of a defined clock constraint. This can be:
e asingle port name used as source for a clock constraint

e asingle pin name used as source for a clock constraint; for instance reg1:CLK. This name can be
hierarchical (for instance toplevel/block1/reg2:CLK)

e an object accessor that will refer to one clock: [get_clocks {clk}]

Examples
The following example sets an input delay of 1.2ns for port data1 relative to the rising edge of CLK1:
set input delay 1.2 -clock [get clocks CLK1l] [get ports datal]

The following example sets a different maximum and minimum input delay for port IN1 relative to the
falling edge of CLK2:

set input delay 1.0 -clock fall -clock CLK2 —-min {IN1}
set input delay 1.4 -clock fall -clock CLK2 -max {IN1}
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The following example demonstrates an override condition of two constraints. The first constraint is
overridden because the second constraint specifies a different clock for the same output:
set_input delay 1.0 -clock CLKl -max {IN1}
set input delay 1.4 -clock CLK2 -max {IN1}
The next example is almost the same as the previous one, however, in this case, the user has specified -
add_delay, so both constraints will be honored:
set input delay 1.0 -clock CLKl -max {IN1}
set input delay 1.4 -add delay -clock CLK2Z -max {IN1}
The following example is more complex:
e All constraints are for an input to port PAD1 relative to a rising edge clock CLK2. Each combination of {-rise,

-fall} x {-max, -min} generates an independent constraint. But the max rise delay of 5 and the max rise delay
of 7 interfere with each other.

e For a -max option, the maximum value overrides all lower values. Thus the first constraint will be overridden
and the max rise delay of 7 will survive.

set_input delay 5 -max -rise -add_delay [get clocks CLK2] [get ports PAD1] # will be
overridden

set_input delay 3 -min -fall -add _delay [get clocks CLK2] [get ports PAD1]
set input delay 3 -max -fall -add delay [get clocks CLK2] [get ports PAD1]
set _input delay 7 -max -rise -add_delay [get clocks CLK2] [get ports PAD1]

Microsemi Implementation Specifics

In SDC, the -clock is an optional argument that allows you to set input delay for combinational designs.
Microsemi's implementation currently requires this argument.

See Also
SDC Syntax Conventions

set_max_delay (SDC)

SDC command; specifies the maximum delay for the timing paths.

set max delay delay value [-from from list] [-to to list]

Arguments
delay value
Specifies a floating point number in nanoseconds that represents the required maximum delay value for
specified paths.
e [f the path starting point is on a sequential device, the tool includes clock skew in the
computed delay.

e [f the path starting point has an input delay specified, the tool adds that delay value to the
path delay.

o [f the path ending point is on a sequential device, the tool includes clock skew and library
setup time in the computed delay.

o [f the ending point has an output delay specified, the tool adds that delay to the path
delay.

-from from list

Specifies a list of timing path starting points. A valid timing starting point is a clock, a primary input, an
inout port, or a clock pin of a sequential cell.

-to to list
Specifies a list of timing path ending points. A valid timing ending point is a clock, a primary output, an
inout port, or a data pin of a sequential cell.
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Description

This command specifies the required maximum delay for timing paths in the current design. The path
length for any startpoint in from_list to any endpoint in to_list must be less than delay_value.

The tool automatically derives the individual maximum delay targets from clock waveforms and port input
or output delays. For more information, refer to the create clock, set_input delay, and set output delay
commands.

The maximum delay constraint is a timing exception. This constraint overrides the default single cycle
timing relationship for one or more timing paths. This constraint also overrides a multicycle path
constraint.

Examples

The following example sets a maximum delay by constraining all paths from ff1a:CLK or ff1b:CLK to
ff2e:D with a delay less than 5 ns:

set _max _delay 5 -from {ffla:CLK fflb:CLK} -to {ff2e:D}

The following example sets a maximum delay by constraining all paths to output ports whose names start
by “out” with a delay less than 3.8 ns:

set _max _delay 3.8 -to [get_ports out*]

Microsemi Implementation Specifics
The —through option in the set_max_delay SDC command is not supported.

See Also
SDC Syntax Conventions

set_min_delay

SDC command; specifies the minimum delay for the timing paths.

set min delay delay value [-from from list] [-to to list]

Arguments
delay value
Specifies a floating point number in nanoseconds that represents the required minimum delay value for
specified paths.
e [f the path starting point is on a sequential device, the tool includes clock skew in the computed
delay.
e [f the path starting point has an input delay specified, the tool adds that delay value to the path delay.

e [f the path ending point is on a sequential device, the tool includes clock skew and library setup time
in the computed delay.

o [f the ending point has an output delay specified, the tool adds that delay to the path delay.
-from from list
Specifies a list of timing path starting points. A valid timing starting point is a clock, a primary input, an
inout port, or a clock pin of a sequential cell.
-to to list
Specifies a list of timing path ending points. A valid timing ending point is a clock, a primary output, an
inout port, or a data pin of a sequential cell.

Description

This command specifies the required minimum delay for timing paths in the current design. The path
length for any startpoint in from_list to any endpoint in to_list must be less than delay_value.

The tool automatically derives the individual minimum delay targets from clock waveforms and port input
or output delays. For more information, refer to the create clock, set_input delay, and set output delay
commands.
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The minimum delay constraint is a timing exception. This constraint overrides the default single cycle
timing relationship for one or more timing paths. This constraint also overrides a multicycle path
constraint.

Examples

The following example sets a minimum delay by constraining all paths from ff1a:CLK or ff1b:CLK to ff2e:D
with a delay less than 5 ns:

set min delay 5 -from {ffla:CLK fflb:CLK} -to {ff2e:D}

The following example sets a minimum delay by constraining all paths to output ports whose names start
by “out” with a delay less than 3.8 ns:

set min delay 3.8 -to [get ports out*]

Microsemi Implementation Specifics
The —through option in the set_min_delay SDC command is not supported.

See Also
SDC Syntax Conventions

set multicycle path

SDC command; defines a path that takes multiple clock cycles.

set multicycle path ncycles [-setup] [-hold] [setup only] [-from from list] [-through
through list] [-to to list]

Arguments
ncycles
Specifies an integer value that represents a number of cycles the data path must have for setup or hold

check. The value is relative to the starting point or ending point clock, before data is required at the ending
point.

—-setup

Optional. Applies the cycle value for the setup check only. This option does not affect the hold check. The
default hold check will be applied unless you have specified another set_multicycle_path command for the
hold value.

-hold
Optional. Applies the cycle value for the hold check only. This option does not affect the setup check.

Note: If you do not specify "-setup” or "-hold", the cycle value is applied to the setup check and the
default hold check is performed (ncycies -1).

-setup only

Optional. Specifies that the path multiplier is applied to setup paths only. The default value for hold check
(which is 0) is applied.

-from from list

Specifies a list of timing path starting points. A valid timing starting point is a clock, a primary input, an
inout port, or a clock pin of a sequential cell.

-through through list

Specifies a list of pins or ports through which the multiple cycle paths must pass.

-to to list

Specifies a list of timing path ending points. A valid timing ending point is a clock, a primary output, an
inout port, or a data pin of a sequential cell.
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Description

Setting multiple cycle paths constraint overrides the single cycle timing relationships between sequential
elements by specifying the number of cycles that the data path must have for setup or hold checks. If you
change the multiplier, it affects both the setup and hold checks.

False path information always takes precedence over multiple cycle path information. A specific maximum
delay constraint overrides a general multiple cycle path constraint.

If you specify more than one object within one -through option, the path passes through any of the
objects.

Examples
The following example sets all paths between reg1 and reg2 to 3 cycles for setup check. Hold check is
measured at the previous edge of the clock at reg2.
set multicycle path 3 -from [get pins {regl}] -to [get pins {reg2}]
The following example specifies that four cycles are needed for setup check on all paths starting at the

registers in the clock domain ck1. Hold check is further specified with two cycles instead of the three
cycles that would have been applied otherwise.

set multicycle path 4 -setup -from [get clocks {ckl}]
set multicycle path 2 -hold -from [get clocks {ckl}]

The following example specifies that four cycles are needed for setup only check on all paths starting at
the registers in the clock domain REF_CLK_0.

set multicycle path -setup only 4 -from [ get clocks { REF CLK 0 } ]

Microsemi Implementation Specifics

e SDC allows multiple priority management on the multiple cycle path constraint depending on the scope of
the object accessors. In Microsemi design implementation, such priority management is not supported. All
multiple cycle path constraints are handled with the same priority.

See Also
SDC Syntax Conventions

set_output_delay

SDC command; defines the output delay of an output relative to a clock.

set output delay delay value -clock clock ref [-max] [-min] [-clock fall] [-rise] [-fall] [-
add delay] output list

Arguments
delay value
Specifies the amount of time before a clock edge for which the signal is required. This represents a
combinational path delay to a register outside the current design plus the library setup time (for maximum
output delay) or hold time (for minimum output delay).
-clock clock ref
Specifies the clock reference to which the specified output delay is related. This is a mandatory argument.
If you do not specify -max or -min options, the tool assumes the maximum and minimum input delays to
be equal.
—max
Specifies that delay_value refers to the longest path from the specified output. If you do not specify -max
or -min options, the tool assumes the maximum and minimum output delays to be equal.
-min
Specifies that delay_value refers to the shortest path from the specified output. If you do not specify -max
or -min options, the tool assumes the maximum and minimum output delays to be equal.
-clock_fall
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Specifies that the delay is relative to the falling edge of the clock reference. The default is the rising edge.
-rise

Specifies that the delay is relative to a rising transition on the specified port(s). If -rise or -fall is not
specified, then rising and falling delays are assumed to be equal.

-fall

Specifies that the delay is relative to a falling transition on the specified port(s). If -rise or -fall is not
specified, then rising and falling delays are assumed to be equal.

-add_delay

Specifies that this output delay constraint should be added to an existing constraint on the same port(s).
The -add_delay option is used to capture information on multiple paths with different clocks or clock edges
leading from the same output port(s).

output list
Provides a list of output ports in the current design to which delay_value is assigned. If you need to
specify more than one object, enclose the objects in braces ({}).

Notes:

The behavior of the -add_delay option is identical to that of PrimeTime(TM)
If, using the -add_delay mechanism, multiple constraints are otherwise identical, except they specify
different -max or -min values

e the surviving -max constraint will be the maximum of the -max values

o the surviving -min constraint will be the minimum of the -min values

Description

The set_output_delay command sets output path delays on output ports relative to a clock edge. Output
ports have no output delay unless you specify it. For in/out (bidirectional) ports, you can specify the path
delays for both input and output modes. The tool adds output delay to path delay for paths ending at
primary outputs.

Examples
The following example sets an output delay of 1.2ns for port OUT1 relative to the rising edge of CLK1:
set output delay 1.2 -clock [get clocks CLK1l] [get ports OUT1]

The following example sets a different maximum and minimum output delay for port OUT1 relative to the
falling edge of CLK2:

set_output delay 1.0 -clock fall -clock CLKZ -min {OUT1}
set output delay 1.4 -clock fall -clock CLK2 -max {OUT1}
The following example demonstrates an override condition of two constraints. The first constraint is
overridden because the second constraint specifies a different clock for the same output:
set output delay 1.0 {OUT1} -clock CLKl -max
set output delay 1.4 {OUT1} -clock CLK2 -max
The next example is almost the same as the previous one, however, in this case, the user has specified -
add_delay, so both constraints will be honored:
set output delay 1.0 {OUT1} -clock CLKl -max
set output delay 1.4 {OUT1l} -add delay -clock CLK2 -max
The following example is more complex:
All constraints are for an output to port PAD1 relative to a rising edge clock CLK2. Each combination of {-

rise, -fall} x {-max, -min} generates an independent constraint. But the max rise delay of 5 and the max rise
delay of 7 interfere with each other.

For a -max option, the maximum value overrides all lower values. Thus the first constraint will be overridden
and the max rise delay of 7 will survive.

set output delay 5 [get clocks CLK2] [get ports PADl] -max -rise -add delay # will be
overridden

set output delay 3 [get clocks CLK2] [get ports PADl] -min -fall -add delay
set output delay 3 [get clocks CLK2] [get ports PADl] -max -fall -add delay
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set output delay 7 [get clocks CLK2] [get ports PADl] -max -rise -add delay

Microsemi Implementation Specifics
e In SDC, the -clock is an optional argument that allows you to set the output delay for combinational designs.
Microsemi Implementation currently requires this option.
See Also
SDC Syntax Conventions

Design Object Access Commands

Design object access commands are SDC commands. Most SDC constraint commands require one of these
commands as command arguments.

Microsemi software supports the following SDC access commands:

Design Object Access Command

Cell get cells

Clock get clocks

Net get nets

Port get ports

Pin get pins

Input ports all_inputs

Output ports all_outputs

Registers all_registers

See Also

About SDC Files

all_inputs
Design object access command; returns all the input or inout ports of the design.

all inputs
Arguments
e None
Exceptions
e None
Example

set _max delay -from [all inputs] -to [get clocks ckl]
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Microsemi Implementation Specifics

e None

See Also
SDC Syntax Conventions

all_outputs

Design object access command; returns all the output or inout ports of the design.

all outputs

Arguments
e None
Exceptions
e None
Example
set max delay -from [all inputs] -to [all outputs]

Microsemi Implementation Specifics

None

See Also
SDC Syntax Conventions

all_registers
Design object access command; returns either a collection of register cells or register pins, whichever you specify.

all registers [-clock clock name] [-cells] [-data pins ]
[-clock pins] [-async pins] [-output pins]
Arguments

-clock clock name
Creates a collection of register cells or register pins in the specified clock domain.
-cells

Creates a collection of register cells. This is the default. This option cannot be used in combination with
any other option.

-data_pins

Creates a collection of register data pins.

-clock pins

Creates a collection of register clock pins.
-async_pins

Creates a collection of register asynchronous pins.
-output_pins

Creates a collection of register output pins.
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Description
This command creates either a collection of register cells (default) or register pins, whichever is specified.
If you do not specify an option, this command creates a collection of register cells.
Exceptions
e None
Examples

set max delay 2 -from [all registers] -to [get ports {out}]
set max delay 3 -to [all registers -async pins]

set false path —-from [all registers -clock clkl1l50]

set multicycle path -to [all registers -clock c* -data pins

—-clock_pins]
Microsemi Implementation Specifics

e None

See Also
SDC Syntax Conventions

get_cells

Design object access command; returns the cells (instances) specified by the pattern argument.

get cells pattern

Arguments
pattern
Specifies the pattern to match the instances to return. For example, "get_cells U18*" returns all instances
starting with the characters "U18", where “*” is a wildcard that represents any character string.
Description
This command returns a collection of instances matching the pattern you specify. You can only use this
command as part of a —from, -to, or —through argument for the following constraint exceptions: set_max
delay, set_multicycle_path, and set_false_path design constraints.
Exceptions
None
Examples

set max delay 2 -from [get cells {reg*}] -to [get ports {out}]
set false path -through [get cells {Rblock/muxA}]
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Microsemi Implementation Specifics

e None

See Also
SDC Syntax Conventions

get_clocks
Design object access command; returns the specified clock.

get clocks pattern

Arguments
pattern
Specifies the pattern to match to the SmartTime on which a clock constraint has been set.
Description
e [f this command is used as a —from argument in maximum delay (set_max_path_delay), false path
(set_false path), and multicycle constraints (set_multicycle path), the clock pins of all the registers related
to this clock are used as path start points.
e [f this command is used as a —to argument in maximum delay (set_max_path_delay), false path
(set_false path), and multicycle constraints (set_multicycle path), the synchronous pins of all the
registers related to this clock are used as path endpoints.
Exceptions
e None
Example

set max delay -from [get ports datal] -to \
[get_clocks ckl]

Microsemi Implementation Specifics

None

See Also
SDC Syntax Conventions

get_pins
Design object access command; returns the specified pins.

get pins pattern

Arguments

pattern

Specifies the pattern to match the pins.
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Exceptions
None
Example
create clock -period 10 [get pins clock gen/reg2:Q]
Microsemi Implementation Specifics

e None

See Also
SDC Syntax Conventions

get_nets

Design object access command; returns the named nets specified by the pattern argument.

get nets pattern

Arguments
pattern
Specifies the pattern to match the names of the nets to return. For example, "get_nets N_255*" returns all
nets starting with the characters "N_255", where “*” is a wildcard that represents any character string.
Description
This command returns a collection of nets matching the pattern you specify. You can only use this
command as source objects in create clock (create clock) or create generated clock
(create generated clock) constraints and as -through arguments in set false path (set false path), set
minimum delay (set_min_delay), set maximum delay (set_max_delay), and set multicycle path
(set _multicycle path) constraints.
Exceptions
None
Examples

set _max _delay 2 -from [get ports RDATAl] -through [get nets {net chkpl net chkqgi}]
set false path —-through [get nets {Tblk/rm/n*}]

create clcok -name mainCLK -per 2.5 [get nets {cknet}]
Microsemi Implementation Specifics

None

See Also
SDC Syntax Conventions

get_ports
Design object access command; returns the specified ports.
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get ports pattern

Argument
pattern
Specifies the pattern to match the ports. This is equivalent to the macros $in()[<pattern>] when used as —
from argument and $out()[<pattern>] when used as —to argument or $ports()[<pattern>] when used as a —
through argument.
Exceptions
None
Example

create clock -period 10[get ports CKI1]
Microsemi Implementation Specifics

None

See Also
SDC Syntax Conventions
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